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Preface

This guide describes asynchronous transfer mode (ATM) and what you do to start 
and customize ATM services on a Nortel Networks™ router.

You can use the Bay Command Console (BCC™) or Site Manager to configure 
ATM on a router. In this guide, you will find instructions for using both the BCC 
and Site Manager. 

Before You Begin

Before using this guide, you must complete the following procedures. For a new 
router:

• Install the router (see the installation guide that came with your router).

• Connect the router to the network and create a pilot configuration file (see 
Quick-Starting Routers, Configuring Remote Access for AN and Passport 
ARN Routers, or Connecting ASN Routers to a Network).

Make sure that you are running the latest version of Nortel Networks BayRS™ and 
Site Manager software. For information about upgrading BayRS and Site 
Manager, see the upgrading guide for your version of BayRS.
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Configuring ATM Services
Text Conventions

This guide uses the following text conventions:

angle brackets (< >) Indicate that you choose the text to enter based on the 
description inside the brackets. Do not type the 
brackets when entering the command. 

Example: If the command syntax is:
ping <ip_address>, you enter:
ping 192.32.10.12

bold text Indicates command names and options and text that 
you need to enter.

Example: Enter show ip {alerts | routes}.

Example: Use the dinfo command. 

braces ({}) Indicate required elements in syntax descriptions 
where there is more than one option. You must choose 
only one of the options. Do not type the braces when 
entering the command.

Example: If the command syntax is:
show ip {alerts | routes}, you must enter either:
show ip alerts or show ip routes, but not both.

brackets ([ ]) Indicate optional elements in syntax descriptions. Do 
not type the brackets when entering the command.

Example: If the command syntax is: 
show ip interfaces [-alerts], you can enter either:
show ip interfaces or show ip interfaces -alerts.

ellipsis points (. . . ) Indicate that you repeat the last element of the 
command as needed.

Example: If the command syntax is:
ethernet/2/1 [<parameter> <value>] . . . , you enter
ethernet/2/1 and as many parameter-value pairs as 
needed.
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italic text Indicates new terms, book titles, and variables in 
command syntax descriptions. Where a variable is two 
or more words, the words are connected by an 
underscore.

Example: If the command syntax is:
show at <valid_route>
valid_route is one variable and you substitute one value 
for it.

screen text Indicates system output, for example, prompts and 
system messages.

Example: Set Trap Monitor Filters

separator ( > ) Shows menu paths. 

Example: Protocols > IP identifies the IP option on the 
Protocols menu. 

vertical line ( | ) Separates choices for command keywords and 
arguments. Enter only one of the choices. Do not type 
the vertical line when entering the command.

Example: If the command syntax is:
show ip {alerts | routes}, you enter either:
show ip alerts or show ip routes, but not both.
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Configuring ATM Services
Acronyms

This guide uses the following acronyms:

AAL ATM adaptation layer

ABR available bit rate

AFI authority and format identifier

AIS alarm indication signal

ALC adaptation layer controller

ARE ATM Routing Engine

ARP Address Resolution Protocol

ATM asynchronous transfer mode

BFE Blacker front-end encryption

B-ISDN Broadband Integrated Services Digital Network

BUS broadcast and unknown server

CBR constant bit rate

CES circuit emulation service

CLP cell loss priority

CPCS common part convergence sublayer

CS convergence sublayer

CSU channel service unit

DCE data communication equipment

DDN Defense Data Network

DSU data service unit

DTE data terminal equipment

ELAN emulated local area network

ER error recovery

FIB forwarding information base

GCRA generic cell rate algorithm

GFC generic flow control
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HEC header error control

IETF Internet Engineering Task Force

ILI Intelligent Link Interface

ILMI Interim Local Management Interface

IP Internet Protocol

IPX Internetwork Packet Exchange

ITU-T International Telecommunication Union - Telecommunication 
Standardization Sector

LANE local area network emulation

LE LAN emulation

LEC LAN emulation client

LECS LAN emulation configuration server

LES LAN emulation server

LIS logical IP subnet

LLC Logical Link Control

LUNI LAN emulation UNI

MAC media access control

MBS maximum burst size

MCR minimum cell rate

MIB management information base

MPLS Multiprotocol Label Switching

MPOA Multi-Protocol over ATM

MTU maximum transmission unit

NHRP Next Hop Resolution Protocol

NLPID Network Layer Protocol ID

NML Native Mode LAN

NNI network-to-network interface

OAM Operations and Management

OAM&P Operations, Administration, Maintenance and Provisioning
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OC-3 Optical Carrier-level 3

OSI Open Systems Interconnection

OSPF Open Shortest Path First

PCR peak cell rate

PD poll data

PDN Public Data Network

PDU protocol data unit

PHY physical [layer]

PMD physical medium dependent

PT payload type

PVC permanent virtual circuit

QoS quality of service

RDI remote defect indication

RIP Routing Information Protocol

RS resynchronization

SAAL signaling AAL

SAP service access point

SAR segmentation and reassembly

SCR sustainable cell rate

SD sequenced data

SDU service data unit

SMDS Switched Multimegabit Data Service

SNAP Subnetwork Access Protocol

SNMP Simple Network Management Protocol

SONET/SDH Synchronous Optical Network/Synchronous Digital Hierarchy

SPE synchronous payload envelope

SRM System Resource Module

SSCOP Service Specific Connection Oriented Protocol

SSCS service specific convergence sublayer
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Hard-Copy Technical Manuals

You can print selected technical manuals and release notes free, directly from the 
Internet. Go to the www25.nortelnetworks.com/library/tpubs/ URL. Find the 
product for which you need documentation. Then locate the specific category and 
model or version for your hardware or software product. Use Adobe Acrobat 
Reader to open the manuals and release notes, search for the sections you need, 
and print them on most standard printers. Go to Adobe Systems at the 
www.adobe.com URL to download a free copy of the Adobe Acrobat Reader.

You can purchase selected documentation sets, CDs, and technical publications 
through the Internet at the www1.fatbrain.com/documentation/nortel/ URL.

STP shielded twisted pair

SVC switched virtual circuit

TDM time division multiplexing

TOH transport overhead

UBR unspecified bit rate

UBRPLUS unspecified bit rate plus

UNI user-to-network interface

UTP unshielded twisted pair

VBR variable bit rate

VBRNRT variable bit rate non-real-time

VBRRT variable bit rate real-time

VC virtual circuit

VCC virtual channel connection

VCI virtual channel identifier

VCL virtual channel link

VPC virtual path connection

VPI virtual path identifier

WAN wide area network
308612-14.20 Rev 00 xxvii

http://www25.nortelnetworks.com/library/tpubs
http://www.adobe.com
http://www.adobe.com
http://www1.fatbrain.com/documentation/nortel/


Configuring ATM Services
How to Get Help

If you purchased a service contract for your Nortel Networks product from a 
distributor or authorized reseller, contact the technical support staff for that 
distributor or reseller for assistance.

If you purchased a Nortel Networks service program, contact one of the following 
Nortel Networks Technical Solutions Centers:

An Express Routing Code (ERC) is available for many Nortel Networks products 
and services. When you use an ERC, your call is routed to a technical support 
person who specializes in supporting that product or service. To locate an ERC for 
your product or service, go to the www12.nortelnetworks.com/ URL and click 
ERC at the bottom of the page.

Technical Solutions Center Telephone

EMEA (33) (4) 92-966-968

North America (800) 2LANWAN or (800) 252-6926

Asia Pacific (61) (2) 9927-8800

China (800) 810-5000
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Chapter 1
Understanding ATM,

ATM Router Redundancy, and OAM

This chapter describes the concepts underlying ATM and, where appropriate, the 
specific ways that Nortel Networks implements these concepts on its routers. It 
contains the following information:

Topic Page

ATM General Information 1-2

Classical IP over ATM Concepts 1-28

ATM LAN Emulation Concepts 1-33

CES Concepts (Passport 5430) 1-38

ATM Router Redundancy Concepts 1-39

WAN SVC Concepts 1-40

PVC Operations and Management Concepts 1-41

For More Information 1-43

Where to Go Next 1-44
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ATM General Information

Asynchronous transfer mode (ATM) is a connection-oriented, cell-based 
technology that relays traffic across a Broadband Integrated Services Digital 
Network (B-ISDN). ATM provides a cost-effective way of transmitting voice, 
video, and data across a network.

ATM Cells

An ATM cell is a fixed-length packet of 53 bytes. It consists of a 5-byte header 
containing address information and a fixed, 48-byte information field. Figure 1-1 
shows a diagram of an ATM cell.

Figure 1-1. ATM Cell

This fixed-length cell size allows you to predict network delays, making ATM 
suitable for carrying real-time information (for example, voice and video) as well 
as data.

ATM allows the network to operate at a much higher rate than typical 
packet-switching protocols (for example, frame relay or X.25), because it 
provides no error protection or flow control. Instead, ATM relies on the source and 
destination devices to perform error-recovery functions such as retransmission of 
lost packets.

48-byte
information field

5-byte
header

ATM0001A
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Cell Header

After dividing the data into 48-byte segments for transmission, the end device — 
that is, the ATM data service unit/channel service unit (DSU/CSU) or native ATM 
device — attaches the required header information (Figure 1-2).

Figure 1-2. ATM Cell Header 

The fields in each ATM cell header provide all the information necessary for 
networking. These fields include the following:

• Generic flow control (GFC): The first 4 bits of the cell header contain the 
GFC. The GFC controls traffic flow onto the ATM network by controlling the 
user-to-network interface (UNI).

• Virtual path identifier (VPI): The next 8 bits of the cell header (that is, the last 
half of byte 1 and the first half of byte 2) contain the VPI. The VPI specifies a 
virtual path on the physical ATM link. See “Data Transmission” on page 1-4 
for additional information about virtual paths.
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5-byte
header
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Virtual path identifier (VPI) Virtual channel identifier (VCI)
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• Virtual channel identifier (VCI): The next 16 bits of the cell header (that is, 
the last half of byte 2, byte 3, and the first half of byte 4) contain the VCI. The 
VCI specifies a virtual channel within the virtual path on the physical ATM 
link. See “Data Transmission” on page 1-4 for additional information about 
virtual channels.

• Payload type (PT): The next 3 bits (that is, bits 5 through 7 of byte 4) indicate 
the type of information the cell is carrying (for example, user data or 
management information).

• Cell loss priority (CLP): The last bit of byte 4 indicates the priority of the cell 
and whether the network can discard the cell under heavy traffic conditions. 
Setting the bit to 1 indicates the network may discard the cell if necessary.

• Header error control (HEC): The last byte of the header field contains the 
HEC. Its primary function is to guard against misdelivery of cells due to 
header or single-bit errors. However, the HEC does not gauge the quality of 
the data in the information field.

Cell Information Field

Following the 5-byte cell header is a 48-byte information field containing user 
data. The ATM adaptation layer (AAL) organizes the data in this field. See “ATM 
Layers” on page 1-6 for additional information about the AAL.

Data Transmission

Data transmission (also called cell switching) through the ATM network relies on 
the establishment of logical connections between ATM devices. ATM is a 
connection-oriented service. This means that an ATM device cannot transmit 
information until it establishes a connection with a receiving device. These 
connections consist of virtual channels, virtual paths, and transmission paths.

A virtual channel is a logical connection between two communicating ATM 
devices. Each virtual channel can carry a different protocol or traffic type. The 
virtual channel transports cells that have a common identifier, the VCI, that is part 
of the cell header. You can establish virtual channels permanently or set them up 
dynamically, allowing the network to adjust itself to the traffic demand. 
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A virtual path is a set of virtual channels between a common source and 
destination. The virtual channels in a virtual path are logically associated with a 
common identifier, the virtual path identifier (VPI), that is part of the cell header. 
You can base cell switching on either the VPI alone, or on a combination of the 
VPI and VCI.

Virtual paths enable you to separate network transport functions into those related 
to an individual logical connection (virtual channel) and those related to a group 
of logical connections (virtual path).

A transmission path is a physical connection that comprises several virtual paths, 
each virtual path containing several virtual channels. The transmission path can 
support multiple virtual paths across a single connection to the network.

Figure 1-3 shows the relationships between the virtual channel, the virtual path, 
and the transmission path.

Figure 1-3. ATM Transmission Components
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Protocol Prioritization

You can set the priorities for the traffic sent across a synchronous line interface 
using a process called protocol prioritization. The ability to prioritize traffic is 
important for an application that is time sensitive and that requires a fast response.

For example, a user at router A participating in a Telnet session with router B 
requires a more immediate response than does a user at router A performing a file 
transfer with router B.

You must manually start protocol prioritization on an ATM circuit. You can use 
protocol prioritization for IP traffic traveling over an ATM PVC.

For more information about protocol prioritization, see Configuring Traffic Filters 
and Protocol Prioritization.

Permanent and Switched Virtual Connections

Virtual channels and virtual paths allow you to establish virtual channel links 
(VCLs). You can create VCLs as either permanent virtual circuits (PVCs) or 
switched virtual circuits (SVCs). After you establish a PVC, you can transfer 
information over it at any time. SVCs activate, through signaling and network 
switching, only when there is information ready for transmission.

ATM Layers

The B-ISDN protocol reference model, on which ATM is based, consists of four 
layers (Figure 1-4). Each layer communicates only with the layer directly above it 
and the layer directly below it.
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Figure 1-4. B-ISDN ATM Protocol Reference Model

The following layers relate directly to how Nortel Networks routers support ATM:

• Physical layer

• ATM layer

• ATM adaptation layer (AAL) 

Physical Layer

In a Nortel Networks Backbone Node (BN®) router, Intelligent Link Interface 
(ILI) pairs provide access and processing. An ILI pair consists of a link module 
and a processor module that work together to process and transmit information 
over a network. Nortel Networks provides an ATM Routing Engine (ARE) link 
module in conjunction with an ARE processor.

In addition, Nortel Networks provides a hub version of the ATM ARE ILI pair, the 
Model 5782 ATM router. This single hub module, incorporating the ILI functions 
of the link module and the processor module, resides in a System 5000BH chassis. 
See Using the Model 5782 ATM Virtual Network Router for more information.

The ILI pair and the Model 5782 ATM router are functionally identical, and you 
configure them in much the same way. Unless otherwise noted, the remainder of 
this guide treats the router ILI pair and the Model 5782 as if they were the same.
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The Passport® 5430 supports an ATM T1/E1 PMC module that provides one T1 or 
E1 interface. The ATM T1/E1 interface provides ATM WAN connectivity and 
allows the consolidation of data, voice, and video in one WAN connection.

Depending on the ATM router type, you can connect directly to an ATM network 
over any of the following physical interfaces:

• Optical carrier level 3 (OC-3)

• Digital service level 3 (DS-3)

• E-3 (the European equivalent of the North American DS-3)

• DS-1

• E-1

Although Nortel Networks uses raw bandwidth to describe line rates, inherent 
overhead within the media limits maximum bandwidth for the line. Use Table 1-1 
to determine the maximum bandwidth for the media you are using.

ATM Layer

The ATM layer defines how two nodes transmit information between them. It is 
concerned with the format and size of the cells and the contents of the headers. 
The addresses of the cells are meaningful only to the two adjacent local nodes 
(that is, usually not to the end nodes).

Table 1-1. Maximum Bandwidth by Media Type

Media
Raw
Bandwidth (Mb/s)

Maximum
Bandwidth (Mb/s) Maximum Cells/s

OC-3 SONET/SDH 155 149.76 353207

DS-3 (Cbit and M23 
framing)

44.736 40.704 96000

E-3 (G.832 framing) 34.368 33.920 80000

E-3 (G.751 framing) 34.368 30.528 72000

DS-1 1.544 1.536 3622

E-1 2.048 1.92 4528
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ATM Adaptation Layer

The ATM adaptation layer (AAL) converts upper-layer protocol data into formats 
that are compatible with the requirements of the ATM layer, enabling ATM to 
handle different types of information within the same format.

The AAL is divided into two sublayers: the convergence sublayer (CS) and the 
segmentation and reassembly (SAR) sublayer. The two sublayers convert variable- 
length messages into 48-byte segments, while ensuring the integrity of the data.

The CCITT (now ITU-T) has defined different types of AALs to handle different 
kinds of traffic. Nortel Networks ATM routers support a CS function compatible 
with AAL 5, as defined in Section 1 of the CCITT (now ITU-T) B-ISDN Protocol 
Reference Model (PRM).

In AAL 5, only a trailer attaches to the data from the upper-layer protocols to 
create a CS PDU. AAL 5 divides the protocol data unit (PDU) into a 48-octet SAR 
PDU; however, it does not add an SAR header and trailer. This 48-octet SAR PDU 
becomes the payload of the ATM cell (Figure 1-5).

Figure 1-5. ATM Adaptation Layer 5

Note: AAL 5 does not attach an SAR header or trailer to the PDU. 
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Service Records and Virtual Circuits

ATM devices communicate using virtual circuits (VCs). These VCs transmit and 
receive ATM cells containing upper-layer protocols. Nortel Networks ATM 
routers use service records to provide a way of creating logical interfaces (within 
the physical ATM interface) for these upper-layer protocols. In essence, these 
service records allow you to:

• Organize multiple VCs into logical groups.

• Create direct point-to-point connections.

• Assign, delete, and modify upper-layer protocols for just one PVC or for a 
group of VCs at any given time.

Supported Protocols

Depending on the data encapsulation type and virtual connection type (PVC, 
SVC, or WAN SVC) that you choose for the service record, the router supports 
various protocols.

Table 1-2 lists all supported protocols for standard PVCs and SVCs using
LLC/SNAP, NLPID, NULL, LANE 802.3, or LANE 802.5 data encapsulation.

Table 1-2. Protocols Supported for Standard PVCs and SVCs

PVC Using LLC/
SNAP, NLPID, or 
NULL

SVC Using 
LLC/SNAP
or NULL (RFC 
1577)

SVC Using LANE 
802.3

SVC Using LANE 
802.5

WAN SVC 
Using 
LLC/SNAP

Bridge IP Bridge Bridge IP

Spanning Tree RIP Spanning Tree Spanning Tree RIP

Native Mode LAN BGP Native Mode LAN IP IPX

IP OSPF/MOSPF IP RIP RIP/SAP

RIP IPv6 RIP OSPF/MOSPF

EGP AHB BGP BootP

PIM NHRP OSPF/MOSPF NHRP

NHRP RSVP BootP RSVP

RSVP NAT Router Discovery NAT

NAT L2TP IGMP/IGMP Relay L2TP

(continued)
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L2TP DiffServ DVMRP DiffServ

DiffServ IPv6 NetBIOS IPX

BGP PIM RIP/SAP

OSPF/MOSPF NHRP Source Routing

BootP RSVP SR Spanning Tree

IGMP/IGMP Relay NAT Translate/LB

DVMRP L2TP LLC2

NetBIOS DiffServ DLSw

DECnet IV DECnet IV APPN

VINES VINES

IPX IPX

RIP/SAP RIP/SAP

OSI XNS

TARP RIP (XNS)

Source Routing AppleTalk

SR Spanning Tree LLC2

Translate/LB DLSw

XNS

RIP (XNS)

Caution: Ethernet and token ring emulated LANs can support different 
protocols. When adding a protocol to a LANE service record with an 
unspecified emulated LAN type, ensure that the protocols you add are 
supported by the emulated LAN (Ethernet or token ring) that you want to join.

Table 1-2. Protocols Supported for Standard PVCs and SVCs (continued)

PVC Using LLC/
SNAP, NLPID, or 
NULL

SVC Using 
LLC/SNAP
or NULL (RFC 
1577)

SVC Using LANE 
802.3

SVC Using LANE 
802.5

WAN SVC 
Using 
LLC/SNAP
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Things to Remember

When enabling protocols on a service record, keep the following in mind:

• A PVC service record requires that you add at least one PVC for the service 
record to operate.

• Each ATM service record globally controls:

-- All protocols for any standard PVCs and SVCs that it contains

-- All nonbridging protocols for any hybrid PVCs that it contains

• Selecting LANE to run on an SVC service record defines that service record 
as belonging to an emulated LAN. Any protocols on that service record 
operate as if they were running over a traditional Ethernet or token ring LAN.

• When running IP over a NULL encapsulated PVC service record, you must 
change the Address Resolution parameter to None. You must then add an IP 
adjacent host with the MAC address equal to the VPI/VCI of the PVC. See 
Configuring IP, ARP, RARP, RIP, and OSPF Services for information about 
the Address Resolution parameter.

Rules for Editing Protocols

Depending on the type of virtual circuit you are using, Site Manager requires you 
to add additional protocols, or delete and edit existing protocols, from specific 
protocol menus.

Use Table 1-3 to locate the appropriate protocol menu for each access mode.

Remember, hybrid PVCs use their service record configurations for nonbridging 
protocols and their individual configurations for bridging protocols.

Table 1-3. Locating and Using Site Manager Protocol Menus

Site Manager Menu Location PVCs and SVCs Hybrid PVCs Only

ATM Service Records List window ! !†

ATM Virtual Channel Link window !*

* For nonbridging protocols
†For bridging protocols
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Data Encapsulation Methods

Nortel Networks ATM routers support multiprotocol encapsulation (as defined in 
RFC 1483), enabling the router to multiplex (combine) and demultiplex (separate) 
bridged or routed protocol data units (PDUs).

For transmission, the encapsulation process adds a header from 2 through 8 octets 
in length to the PDU to allow decoding. The decoding process determines the 
proper service access point (SAP).

When receiving information, the encapsulation method evaluates the header to 
determine whether the PDU is a valid routed or bridged cell. If it is valid, the 
encapsulation method then strips the header from the cell and passes the cell to the 
appropriate SAP for routing or bridging.

You can choose from four data encapsulation types:

• LANE

• LLC/SNAP

• NULL

• NLPID

How you assign a data encapsulation type and which type takes precedence 
depends on the virtual circuit type and, for PVCs, the order in which you assign 
the encapsulation type.

Each ATM device must encapsulate PDUs before sending them to the SAR 
sublayer.

LANE Encapsulation

LANE provides Ethernet (IEEE 802.3) or token ring (IEEE 802.5) encapsulation 
of ATM PDUs for transmission over an emulated LAN. You can assign LANE 
encapsulation to SVCs only.
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LLC/SNAP Encapsulation

Logical Link Control/Subnetwork Access Protocol (LLC/SNAP; RFC 1483) 
allows multiplexing of multiple protocols over a single ATM virtual circuit. In this 
approach, an IEEE 802.2 Logical Link Control (LLC) header prefixes each PDU. 
You can assign LLC/SNAP encapsulation to:

• PVC service records

• SVC service records

• WAN SVC service records

• Individual PVCs

NULL Encapsulation

RFC 1483 refers to NULL encapsulation as “VC-based multiplexing.” This 
method performs upper-layer protocol multiplexing implicitly using ATM virtual 
circuits. You can assign NULL encapsulation to:

• PVC service records

• SVC service records

• Individual PVCs that are also members of an LLC/SNAP service record

NLPID Encapsulation

You can use Network Layer Protocol ID (NLPID; RFC 1490) encapsulation in an 
ATM environment for frame relay/ATM internetworking. You can assign NLPID 
encapsulation to PVC service records.

Note: Assigning LLC/SNAP to an SVC service record automatically enables 
the technology defined in RFC 1577, Classical IP and ARP over ATM. For 
information about RFC 1577, see “Classical IP over ATM Concepts” on 
page 1-28.

Note: Assigning NULL to an SVC service record automatically enables the 
technology defined in RFC 1577, Classical IP and ARP over ATM. For 
information about RFC 1577, see “Classical IP over ATM Concepts” on 
page 1-28.
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Selecting a Data Encapsulation Method

Generally speaking, the designers of these data encapsulation methods envisioned 
that NULL encapsulation would dominate in environments where the dynamic 
creation of large numbers of ATM VCs is fast and economical. These conditions 
usually exist in private ATM networks.

LLC/SNAP encapsulation is an alternative for environments in which it is not 
practical to have a separate VC for each carried protocol (for example, if the ATM 
network supports only PVCs, or if billing depends heavily on the number of 
simultaneous virtual circuits).

The choice of multiplexing methods that two ATM stations use to exchange 
connectionless network traffic depends on the type of virtual circuit involved: 

• For PVCs, you select the multiplexing method when you manually configure 
the connection.

• For SVCs, the stations themselves negotiate the multiplexing method by 
sending B-ISDN signaling messages. These messages include “low-layer 
compatibility” information that allows negotiation of AAL5 and the carried 
(encapsulated) protocol.

Selecting LLC/SNAP Encapsulation

When the same virtual circuit carries several protocols, select LLC/SNAP 
encapsulation. LLC/SNAP encapsulation attaches an LLC/SNAP header before 
the PDU. This header includes information that the receiving ATM station needs 
to properly process the incoming PDU. For bridged PDUs, this header also 
includes the type of the bridged media.

Selecting NULL Encapsulation (VC-Based Multiplexing) 

In NULL encapsulation, the carried network protocol is identified implicitly by 
the virtual circuit connecting the two ATM stations. Because each protocol must 
travel over a separate virtual circuit, there is no need to include explicit 
multiplexing information in the payload of the PDU. For this reason, the 
bandwidth requirements and processing overhead remain minimal.

Note: Routed and bridged PDUs are always encapsulated within the payload 
field of the AAL5 CPCS PDU, regardless of the selected multiplexing method.
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You can either manually configure the carried protocol or let the signaling 
procedures negotiate it dynamically during call establishment.

NULL encapsulated cells do not receive a header in a routed environment. In a 
bridged environment, the content of the PDU itself includes the necessary 
information for bridging the multiplexed protocols.

Encapsulation Rules for PVCs

How you assign data encapsulation to individual PVCs depends to a degree on the 
data encapsulation type you assigned to the service record that contains those 
PVCs. Table 1-4 provides suggestions for assigning data encapsulation to PVCs 
and hybrid PVCs that reside on these service records.

When assigning a data encapsulation type to a PVC or group of PVCs, keep the 
following in mind:

• When you add a PVC, it reads and uses the data encapsulation type specified 
in its ATM service record.

• You can globally assign a data encapsulation type to all nonhybrid PVCs in a 
particular service record, or you can assign a data encapsulation type to 
individual group PVCs.

• If you change the data encapsulation value for the service record, all new 
PVCs that you add to that service record use the new value.

• You must assign a data encapsulation type to hybrid-mode PVCs individually. 
You cannot assign data encapsulation to a hybrid-mode PVC using the service 
record.

• When you use the copy function, the new PVC uses the data encapsulation 
type of the existing PVC.

Table 1-4. Assigning Data Encapsulation to Individual PVCs

Service Record Data 
Encapsulation Type

Individual PVC Data 
Encapsulation Type

Hybrid PVC Data 
Encapsulation Type

LLC/SNAP NULL or LLC/SNAP LLC/SNAP

NULL NULL or LLC/SNAP LLC/SNAP

NLPID NLPID NLPID
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• When running IP over a NULL encapsulated PVC service record, you must 
change the Address Resolution parameter to None. You must then add an IP 
adjacent host with the MAC address equal to the VPI/VCI of the PVC. See 
Configuring IP, ARP, RARP, RIP, and OSPF Services for information about 
the Address Resolution parameter.

PVC Access Methods

You can set up PVCs to access an ATM network in the following ways:

• Multiple PVCs per service record

• One PVC per service record

• Hybrid access PVCs

Multiple PVCs

Upper-layer protocols treat each service record on an ATM network interface as a 
single access point. These protocols use a single network address to send all traffic 
destined for the network to the ATM network interface. Figure 1-6 shows a 
conceptual drawing of multiple PVCs accessing an ATM network through each 
service record.

Figure 1-6. Multiple PVCs per Service Record
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Configuring multiple PVCs per service record uses network addressing most 
efficiently. Although you need to configure each PVC manually, you need only 
define and associate protocols with the ATM network service record. All the 
PVCs that you configure for a given ATM service record carry the protocols that 
you select and configure to run on that service record.

A configuration using multiple PVCs per service record works best in either fully 
meshed environments or in nonmeshed environments where systems not directly 
connected to each other have no need to communicate. You can configure multiple 
PVCs per service record as long as you do not need to separate protocols by PVC 
(that is, all PVCs accept the same protocols).

There are, however, ways to configure upper-layer protocols, such as IP or 
Internetwork Packet Exchange (IPX), to allow systems in nonmeshed networks to 
fully communicate. See the documentation for these protocols for more 
information.

One PVC

A configuration using one PVC per service record works the same way as one 
using multiple PVCs per service record. When you define only one PVC per 
service record, upper-layer protocols treat the ATM network as a series of direct 
point-to-point connections, viewing each PVC as an individual network interface.

You can configure each PVC with different protocols and parameter settings. This 
allows you to connect to different network sites using, for example, different types 
of data encapsulation (Figure 1-7).

Note: When you configure multiple PVCs per service record, all PVCs use the 
data encapsulation type that you set for the ATM service record. See “Data 
Encapsulation Methods” on page 1-13 for more information.
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Figure 1-7. One PVC per Service Record
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Figure 1-8. Hybrid Access PVCs
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Using Hybrid PVCs for Transparent Bridging

In Figure 1-9, traffic is bridged between site A and site B. The bridge (router 1) is 
running on the ATM network interface, and its PVCs are not defined as
hybrid/bridged VCs.

Figure 1-9. Example of a Bridged Network
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SVC Access Methods

SVCs use signaling messages to dynamically establish, maintain, and clear a 
switched virtual connection at the UNI. These messages (as defined by the Q.2931 
standard for signaling protocols) allow the router to assess the availability of an 
ATM end point (device), establish a connection with that device, maintain that 
connection for the duration of data transfer, and then clear the connection when 
the transfer is complete.

Assigning ATM Addresses

An ATM address is composed of a network prefix and a user part. Nortel 
Networks routers use the autogeneration feature to create the user part of the ATM 
address by combining the MAC address of the ATM interface with a unique 
selector byte to create unique addresses (Figure 1-10). You can also enter ATM 
addresses manually.

Figure 1-10. ATM Address Components
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Entering an ATM Address Network Prefix

The ATM address network prefix specifies the ATM domain of which the service 
record is a part. This 13-byte portion of the ATM address can range from 
XX000000000000000000000000 to XXFFFFFFFFFFFFFFFFFFFFFFFF.

The XX byte must contain a value of 39, 45, or 47. These values define the 
authority and format identifier (AFI). The AFI byte identifies the group 
responsible for allocating the prefix and the format the prefix uses. For more 
information about the AFI byte, refer to the ATM Forum UNI specification.

Entering an ATM address network prefix is optional. If you do not enter a network 
prefix in the specified range, the service record accepts the first prefix value that it 
receives from the switch.

Entering an ATM Address User Part

The ATM address user part (suffix) consists of a 6-byte end-station identifier and a 
1-byte selector field. This 7-byte portion of the ATM address can range from 
00000000000000 to FFFFFFFFFFFFFF.

You can either allow the router to generate this value automatically, or you can 
enter the value manually.

ATM Traffic Parameters

The ATM User-Network Interface Specification defines the following traffic 
parameters:

• Peak cell rate (PCR) — The upper traffic rate limit for an individual VC

• Sustainable cell rate (SCR) — The upper bound on the conforming average 
rate of an individual PVC or control VC

• Maximum burst size (MBS) — The maximum length of a cell stream allowed 
on a particular VC (configurable on the Passport 5430 only)

These parameters help to prioritize and control the traffic on each VC. How you 
configure your ATM traffic parameters depends on the characteristics of the 
individual connections that you want to set up (for example, the desired maximum 
cell rate, average cell rate, and burst size).
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You can change ATM traffic parameters several times before deciding on a 
particular set. The following sections describe the traffic parameters and provide 
some basic guidelines for customizing them on an ATM PVC or ATM control VC 
(that is, the signaling VC or ILMI VC).

Using the PCR

The PCR specifies the upper traffic limit, in cells/second, that the ATM 
connection can support.

How you set the PCR depends on:

• The optical transmission rate of your ATM device

• The amount of traffic you expect on a particular VC

• The rate you want for each VC

When setting the PCR, keep the following considerations in mind:

• Each VC can have its own PCR.

• The PCR cannot exceed the maximum rate for the physical media. For 
example, you cannot exceed 149.76 Mb/s for an OC-3c line.

• The PCR specifies the desired rate for the attached physical media (that is, 
OC-3c, DS-3, or E-3). It does not specify the rate for the ATM network as a 
whole. For example, you can specify a full 149.76 Mb/s for each PVC or 
control VC on an OC-3c connection. However, if the VC ultimately connects 
to a lower-speed link (for example, T1 or E1), your PCR is limited to the 
maximum rate for that media.

• ATM VCs may fail to operate with PCR values lower than 128 cells/s.

• The E-3 framing mode setting affects the maximum PCR setting.

Note: You do not need to manually configure traffic parameters for SVCs (as 
you must for PVCs and control VCs), because SVCs dynamically negotiate 
these parameters before sending data.
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Using the SCR

The SCR is the upper bound on the conforming average rate of an individual PVC, 
control VC, or WAN SVC. The average rate is the number of cells transmitted 
over the link divided by the duration of the connection. The duration of the 
connection is the total amount of time it takes from connection setup to 
connection release.

The SCR allows you to define future cell flow on a PVC, control VC, or WAN 
SVC in greater detail than by using only the PCR. The SCR controls the rate over 
time — not at a specific instant of time — and can help you use your network 
resources more efficiently. In other words, the SCR allows sufficient bandwidth 
for operation, but does not allow a bandwidth as high as the PCR.

The SCR value maps directly to an MCR (minimum cell rate) value. In other 
words, when you configure the SCR on a device, you actually configure the upper 
bound of an average rate. Like the SCR, the MCR defines the minimum amount of 
guaranteed bandwidth allowed for PVCs, control VCs, or WAN SVCs on the 
ATM line. The MCR (that is, SCR) not only controls the rate over time, it 
guarantees this rate.

When setting the SCR, keep the following considerations in mind:

• The SCR maps directly to the MCR.

• The MCR provides guaranteed bandwidth for PVCs, control VCs, or WAN 
SVCs while allowing sufficient bandwidth for SVCs to operate.

• To be useful, the SCR must not exceed the PCR. 

• If you know the user average rate, set the SCR approximately 10 percent 
higher than this value.

• ATM VCs may fail to operate with SCR values lower than 128 cells/s.

• Entering 0 for the SCR turns off this function and specifies that the ATM 
router uses “best effort” for SCR.

• The E-3 framing mode setting affects the maximum SCR setting.
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Using the MBS

The MBS specifies the maximum number of sequential cells allowed on a VC 
before that VC must relinquish bandwidth to other VCs waiting to transmit. This 
burst occurs at or close to the peak cell rate.

When setting the MBS, we suggest that you select a value larger than the largest 
packet that your PVC or control VC can transmit (that is, the size of the maximum 
AAL CPCS transmit SDU). For example, if your VC accepts packets that are less 
than 4608 bytes long (PVC default), set your MBS value between 45 and 50 cells.

As a guideline, use this formula to determine your MBS value:

Note: Only the Passport 5430 supports the use of the MBS. The BN and 
System 5000™ routers (Model 5782) do not support the MBS parameter.

Maximum packet size (in bytes)

48 bytes/cell
=      MBS value (in cells)

For example:

4608 bytes (default)

48 bytes/cell
=     96 cells

ATM0016A
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ARP and Inverse ARP Support

ATM supports the Address Resolution Protocol (ARP), enabling the router to 
dynamically resolve IP network layer protocol-to-VPI/VCI address mappings. 
ATM learns the address of the virtual circuit by detecting the virtual circuit that 
delivered the ARP response.

ATM also supports Inverse ARP. However, you can use Inverse ARP only if both 
the local and remote routers support it.

Nortel Networks uses both proprietary and standard ARP and Inverse ARP for 
PVCs that run IP. The method that the PVC uses depends on how you configure 
address resolution for the IP interface. See Configuring IP, ARP, RARP, RIP, and 
OSPF Services for additional information about configuring address resolution.

Nortel Networks uses standard ARP and Inverse ARP for SVCs running classical 
IP (RFC 1577) and SVCs running LAN emulation.

ATM Error Checking

ATM verifies that the VPI/VCI is valid with respect to the PVCs configured for 
the ATM circuit. It also verifies the header format. ATM verifies valid SVC 
connection through signaling messages.

Simulated Multicast Packet Support

Simulated multicasting is generally used in certain address resolution techniques 
and for applications that require the delivery of identical information to multiple 
recipients. Nortel Networks ATM routers simulate multicasting by sending a copy 
of the multicast or broadcast packet to every available virtual circuit on a 
particular logical interface.

Converting Mb/s to Cells/s

Several ATM traffic parameters require you to enter values in cells per second 
(cells/s). To convert to cells/s, divide the number of bits/s by 424 (the number of 
bits per ATM cell).
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Classical IP over ATM Concepts

RFC 1577, Classical IP and ARP over ATM, describes an administrative entity 
within an ATM network called a logical IP subnet (LIS). Each ATM LIS consists 
of multiple network devices — hosts and routers — connected to the ATM network 
and configured with interfaces to the same IP subnet.

Each LIS operates and communicates independently in an ATM network. A host 
connected to an ATM network communicates directly with other hosts in its own 
LIS. To communicate with hosts in another LIS, the host must use an IP router. 
This router can connect to multiple LISs.

An ATM LIS must meet the following requirements:

• All members of the LIS (hosts and routers) must have the same IP network/
subnet address and mask.

• All members must be directly connected to the ATM network using SVCs.

• All members must access hosts outside the LIS through a router.

• All members must be able to communicate by means of ATM with every other 
member of the LIS (that is, the virtual connection topology must be fully 
meshed).

Number of bits/second

Number of bits/ATM cell
=      Number of cells/second

For example:

100,000,000 bits/s

424 bits/cell
=     235,849 cells/s

ATM0021A
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An ATM LIS can replace an IP LAN. In Figure 1-11, for example, three IP host 
systems and an IP router have interfaces to an Ethernet LAN. To communicate 
with each other on the LAN, the devices use the MAC addresses that they obtain 
using ARP or static routes. For communication beyond the LAN, the devices use 
IP addresses.

Figure 1-11. IP Local Area Network
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communication within the LIS, the devices use ATM addresses obtained using 
ATMARP; for communication beyond the LIS, the devices use IP addresses.

For example, to send a message to host B, host A uses host B’s ATM address. To 
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Figure 1-12. ATM Logical IP Subnet
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ATM Address Resolution

An address resolution protocol defines a mechanism that enables an IP router to 
use the IP address of a network device to learn the physical address of that device. 
An Ethernet LAN uses ARP as its address resolution scheme. A LIS uses an 
address resolution scheme called ATMARP as defined by RFC 1577.

On a LAN, defined as a broadcast medium, a router obtains the physical address 
of a network device by broadcasting an ARP request. In a LIS, which uses a 
nonbroadcast ATM medium, a router sends an ATMARP request to an ATMARP 
server.

Each IP interface on the LIS opens a VC to the ATMARP server and registers its 
IP address and ATM address (Figure 1-12 on page 1-30). Using this information, 
the server builds and maintains a table that maps LIS IP addresses to ATM 
addresses.

A router that needs the ATM address of a host on the LIS sends an ATMARP 
request to the server. When the server returns a response containing the address, 
the router extracts the ATM address of the host from the response and opens an 
SVC directly to the host using ATM UNI signaling.

If the server does not have an entry for the requested IP address, it returns a 
negative acknowledgment, signifying that the destination is unreachable.
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Configuring an ATM Service Record for ATMARP

When you configure a service record to act as an ATMARP client or server:

• Define a classical IP service record.

-- Specify SVC as the virtual circuit type for the service record. All network 
devices on a LIS must connect over SVCs.

-- Specify LLC/SNAP or NULL as the encapsulation type for the service 
record. RFC 1577 defines LLC/SNAP as the encapsulation type for 
ATMARP.

For more information about how to create an SVC service record to run 
classical IP, see Chapter 2, “Starting ATM and ATM Router Redundancy.”

• Add IP and IP routing protocols to the circuit.

• Configure the ATMARP mode as either a client or a server.

For a description of the ATM-specific IP parameters necessary for classical IP 
ATMARP operation over ATM, see “Configuring ATMARP on an IP 
Interface” on page 7-8 and “ATMARP Parameters” on page A-85.

For full compatibility with RFC 1577, you may need to specify a maximum 
transmission unit (MTU) size of 9188 bytes. See “Defining the Interface MTU” 
on page 3-3 (for the BCC) or the Site Manager Interface MTU parameter 
description on page A-5 for additional information about setting the MTU size.

When configuring the router as a client, you must define the server switch address. 
The client sends ATMARP requests to the server switch address. 

Note: If you remove and replace a link module that is configured as an 
ATMARP client, the client loses connectivity until the ATMARP server 
registration refresh interval for that client expires (900-second default). This 
loss of connectivity occurs only when the client is configured to autogenerate 
the ATM address user part (see “Disabling and Reenabling User Part 
Autogeneration” on page 7-3 for additional information about autogenerating 
ATM addresses).
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Configuring an ATM Address for an Adjacent Host

An adjacent host is a network device on the local LIS. You must manually 
configure an ATM address for all hosts on the LIS that do not implement 
ATMARP. The adjacent host entry associates the ATM address of the adjacent 
host with its IP address.

For a description of the Site Manager parameters required for creating adjacent 
hosts in a classical IP over ATM environment, see “Adjacent Host Parameters” on 
page A-87.

For complete information about adding, editing, and deleting adjacent hosts, see 
Configuring IP, ARP, RARP, RIP, and OSPF Services.

ATM LAN Emulation Concepts

LAN emulation allows virtual communication of traditional LAN devices and 
applications over an ATM network. An ATM network can run one or more 
emulated LANs. However, each emulated LAN is independent of the others and 
devices cannot communicate directly across emulated LAN boundaries.

This section provides general information about LAN emulation as described by 
the ATM Forum. For more information about LAN emulation, refer to the ATM 
Forum document LAN Emulation Over ATM (Version 1.0).

For instructions on how to customize LAN emulation on your ATM router, see 
Chapter 8, “Customizing LAN Emulation Service Records and Clients.”

LAN Emulation Connectivity

An emulated LAN can provide Ethernet (IEEE 802.3) or token ring (IEEE 802.5) 
connectivity. With an emulated Ethernet or token ring network over ATM, 
software applications can interact as if they were connected to a traditional LAN.

Note: Communication between emulated LANs is possible through routers 
and bridges only (possibly implemented on the same end station).
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LAN Emulation Components

Each ATM domain contains a LAN emulation configuration server (LECS). Each 
emulated LAN comprises a group of LAN emulation clients (LECs), a LAN 
emulation server (LES), and a broadcast and unknown server (BUS). These 
servers provide specific LAN emulation services.

LAN Emulation Configuration Server

The LAN emulation configuration server (LECS) assigns individual LE clients to 
different emulated LANs. The LECS does this by giving the client the ATM 
address of the LAN emulation server (LES). This method allows you to assign a 
client to an emulated LAN based on the client’s physical location (ATM address) 
or the identity of a LAN destination it represents.

LAN Emulation Clients

The LAN emulation client (LE client or LEC) is the interface, or virtual portion of 
an interface, through which an end station forwards data, resolves addresses, and 
provides other control functions. The LE client provides the MAC-level emulated 
Ethernet or token ring service interface to the upper-layer protocol. It also controls 
the LAN emulation UNI (LUNI) interface when communicating with other 
devices on the emulated LAN.

The LE client uses the configuration protocol to obtain information from the 
LECS. This protocol allows the LE client to locate the LES and set up a 
bidirectional, control direct virtual channel connection. The LE client 
automatically obtains all of the necessary configuration data (including the LES 
address) from the LECS.

LAN Emulation Server

The LES controls and coordinates LE client access to the emulated LAN. When 
an LE client joins an emulated LAN, it registers its ATM address with the LES. 
When the LES obtains the ATM address of the LE client, it also obtains the 
client’s physical location (from the MAC address or route descriptor).

LE clients query the LES to obtain the ATM address associated with a specific 
MAC address or route descriptor. After an LE client receives the ATM address of 
the LE client it wants to reach, the individual clients communicate directly.
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Broadcast and Unknown Server

To emulate a traditional LAN, the emulated LAN must provide the connectionless 
data delivery of a shared network to its LE clients and be able to handle broadcast 
and multicast data. The broadcast and unknown server (BUS) fulfills this 
requirement by distributing all broadcast, multicast, and unknown traffic to and 
from all LE clients on an emulated LAN.

For example, when an LE client sets up its initial configuration, it obtains the 
MAC address of the BUS from the LES. Using this MAC address, the LE client 
sets up a multicast send virtual channel connection (VCC) to the BUS. In turn, the 
BUS registers the LE client as part of its emulated LAN.

To broadcast data, an LE client uses the multicast send VCC to transmit 
information to the BUS. The BUS then retransmits the data, through multiple 
point-to-point connections or one point-to-multipoint connection, to each LE 
client on the emulated LAN.

Redundant LES/BUS

Nortel Networks ATM routers support LAN emulation server (LES) and broadcast 
and unknown server (BUS) redundancy. This redundancy reduces the risk of 
network failure by overcoming a single point of failure in accessing the LES.
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LAN Emulation States

As defined in the ATM Forum LAN Emulation Over ATM specification, LE clients 
enter various states of communication while attempting to join an emulated LAN. 
These states (referred to as “phases” by the ATM Forum) indicate the progress of 
an LE client as it connects with an emulated LAN (Figure 1-13).

Figure 1-13. LAN Emulation States

Note: The numbers that follow each state appear in the ATM LEC status 
record (wfAtmLecStatusEntry). 

Operational state (7)

 BUS connect state (6)

Initial registration state (5)

Join state (4)

Configure state (3)

LECS connect state (2)

Initial state (1)

After experiencing
any failure, or
terminating its
connection to the
emulated LAN,
the LE client
returns to the
initial state.

If the LE client
loses the BUS
connection, it can
attempt to reconnect.

ATM0034A
1-36 308612-14.20 Rev 00



Understanding ATM, ATM Router Redundancy, and OAM
 

The following sections briefly describe each LAN emulation state. Refer to the 
ATM Forum LAN Emulation Over ATM specification for more information about 
LAN emulation states.

Initial State

An LE client always starts in the initial state before attempting to connect to the 
LECS.

LECS Connect State

An LE client enters the LECS connect state when it attempts to connect to the 
LECS.

Configure State

An LE client enters the configure state when it attempts to retrieve the necessary 
information (that is, the ATM address of the LES, LAN type, LAN name, 
Maximum MTU, and various timeout values) required to join an emulated LAN.

Join State

An LE client enters the join state when it attempts to join an emulated LAN. 
Joining an emulated LAN requires that the LE client:

• Set up a control VCC to communicate with the LES.

• Send a join request (containing the client MAC address) to the LES.

• Accept a control distributed VCC to receive control data from the LES.

• Receive a valid join response from the LES containing a LAN emulation 
client ID (LECID).

Note: Only one ATM LE client per Nortel Networks ATM router can join an 
emulated LAN at any point in time. However, you can always move a LAN 
emulation client to the appropriate emulated LAN using network management 
software.
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Initial Registration State

An LE client enters the initial registration state when it attempts to register 
multiple MAC addresses with the LES.

BUS Connect State

An LE client enters the BUS connect state when it attempts to set up a VCC to the 
BUS.

Operational State

An LE client enters the operational state after successfully completing the 
requirements to join an emulated LAN.

CES Concepts (Passport 5430)

Circuit emulation service (CES) is a set of services that support the emulation of 
existing time division multiplexing (TDM) circuits over an ATM network. CES 
provides a constant bit rate (CBR) VC that performs just like a synchronous 
point-to-point private line (for example, E1 or T1) including all channelization 
and telephony signaling where required.

CES is only available for the Passport 5430.

You can configure support for video streaming data over ATM AAL 1 
encapsulation using CES. The default CES settings are sufficient for most 
configurations. However, you can customize the CES settings as needed.

See “Starting CES (Passport 5430)” on page 2-8 for information about how to 
start CES. To customize CES, see Chapter 10, “Customizing CES (Passport 
5430).”

Note: The router LE client provides the MAC address only for its own ATM 
interface. Because it does not register multiple MAC addresses, the router 
never enters this state. The router LE client acts as a proxy for bridge MAC 
addresses not learned on this circuit.
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ATM Router Redundancy Concepts

Nortel Networks ATM routers support warm standby router redundancy. This 
redundancy protects a network from the irrecoverable failure of an entire ATM 
router. You configure routers to be members of a router redundancy group.

Figure 1-14 illustrates router redundancy in a Nortel Networks ATM environment.

Figure 1-14. Router Redundancy
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Router redundancy requires at least two routers to be members of a router 
redundancy group. One router acts as the primary router and provides normal 
routing/bridging services. The other router acts as the secondary, backup router 
and takes over if the primary router fails.

All members of an ATM router redundancy group must have the following 
characteristics:

• Be the same ATM router type, for example, BCN®, BLN®, or System 5000.

• Have the same hardware configuration, including CPU and interface module 
types, and slot and port locations of the backed-up interfaces.

• Have the same software configuration. That is, you must be running the same 
router software version and have the same loadable modules configured.

• Contain both a primary configuration file and a secondary configuration file.

• Have at least one legacy LAN connection between the routers in the 
redundancy group.

WAN SVC Concepts

ATM WAN SVCs provide an SVC connection that the router dynamically 
establishes for data transfer and then tears down after a configurable inactive 
period of time. When configuring ATM WAN SVCs, you provide a static mapping 
of an ATM address to IP or IPX protocol addresses on the same service record.

This section provides general information about ATM WAN SVCs. 

For instructions on how to create a WAN SVC service record, see “Adding a 
Service Record for WAN SVCs” on page 2-13. For instructions on how to 
customize WAN SVCs on your ATM router, see Chapter 9, “Customizing WAN 
SVC Service Records and WAN SVCs.”

Note: Nortel Networks recommends at least two legacy LAN connections 
between routers in the redundancy group.
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Creating a Network of Adjacent Hosts

You can create a network of routers that are connected by ATM WAN SVCs by 
configuring IP or IPX adjacent hosts. On each router, you should configure the 
following:

• One WAN SVC service record for each IP subnet or IPX subnetwork

• Adjacent host entries for each router in the same subnet

Each adjacent host that you configure has a static mapping to an ATM address. 
After you configure adjacent hosts, you can specify PCR and SCR settings for the 
WAN SVCs to any adjacent host by configuring the traffic shaping parameters. 

For information about how to configure traffic shaping, see “Enabling Traffic 
Parameters” on page 9-7.

Routing Updates

The way the router sends routing updates over a WAN SVC differs depending on 
the number of adjacent hosts per circuit. If you configure only one adjacent host 
per circuit, Nortel Networks recommends that you set the routing mode to 
dial-optimized so that the router sends routing updates only when data traffic 
causes the router to establish an SVC to the adjacent host.

When you configure multiple adjacent hosts per circuit, the router should send 
routing updates periodically to ensure that all hosts in the subnet have complete 
knowledge of the network topology. In this case, you should use the normal 
routing mode instead of dial-optimized routing.

For more information about configuring routing updates, see “Changing the 
Routing Update Policy” on page 9-5.

PVC Operations and Management Concepts

In most ATM networks, if a PVC fails, the remote device does not receive 
notification of the failure at the ATM layer. Instead, the device receives this 
information from a non-ATM source such as a routing protocol that operates 
above the ATM layer. The PVC Operations and Management (OAM) feature 
provides a mechanism by which ATM devices can receive prompt failure 
information.
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PVC OAM has two methods of detecting PVC failure: loopback cells and alarms. 
You can use either of these methods separately or both methods together. When 
using OAM loopback cells, the time can decrease to only a few seconds; when 
using OAM alarms, the detection is almost instantaneous.

OAM Loopback

The OAM loopback method uses loopback cells to detect a lost connection. When 
OAM loopback is enabled, the PVC sends loopback cells at a designated interval. 
If a remote device does not return loopback responses, and the PVC loses a 
specified number of cells, the service record alerts the upper-layer protocol that 
the link is down. The PVC continues to send OAM loopback cells over the service 
record. When it receives a specified number of OAM loopback responses, it 
declares the link operational and begins sending traffic again.

OAM Alarms

If the ATM router connects to an ATM switch that uses OAM alarms, you can 
enable alarm detection on the ATM router. With OAM alarms enabled, when the 
router receives an alarm indication signal (AIS) alarm from the switch, it alerts the 
upper-layer protocol that the ATM link is down; it does not wait for an OAM 
loopback response from the remote device.

After receiving an AIS alarm, the router sends a remote defect indication (RDI) 
response to the switch to indicate that it received the alarm. The switch continues 
to send AIS alarms until the link is operational again. If the router does not receive 
an AIS alarm for 3 seconds, it declares the link operational and begins sending 
traffic again.

Note: For OAM loopback to function properly, you must configure it on all 
PVCs on an interface. Link status is based on the OAM loopback status of all 
PVCs on the interface.
1-42 308612-14.20 Rev 00



Understanding ATM, ATM Router Redundancy, and OAM
 

For More Information

For more information about ATM, refer to the following documents:

ATM Forum. ATM User-Network Interface Specification. Version 3.0. September 
1993.

ATM Forum. LAN Emulation Over ATM. Version 1.0. January 1995.

Bellcore Document SR-NWT-001763, Issue 1. Preliminary Report on Broadband 
ISDN Transfer Protocols. December 1990.

———, FA-NWT-001109. Broadband ISDN Transport Network Elements 
Framework Generic Criteria. December 1990.

———, FA-NWT-001110. Broadband ISDN Switching System Framework 
Generic Criteria. December 1990.

De Prycker, M. Asynchronous Transfer Mode: Solution for Broadband ISDN. Ellis 
Horwood Limited, 1991.

Grossman, D., E. Hoffman, F. Liaw, A. Malis, A. Mankin, and M. Perez. ATM 
Signaling Support for IP over ATM. RFC 1755. Network Working Group. 
February 1995.

Handel, R. and M. Huber. Integrated Broadband Networks: An Introduction to 
ATM-Based Networks. Reading, Mass.: Addison-Wesley, 1991.

Heinanen, J. Multiprotocol Encapsulation over ATM Adaptation Layer 5.
RFC 1483. Network Working Group. July 1993.

ITU-T. B-ISDN — ATM Adaptation Layer — Service Specific Connection 
Oriented Protocol (SSCOP). Final Draft. March 10, 1994.

Laubach, M. Classical IP and ARP over ATM. RFC 1577. Network Working 
Group. January 1994.
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Where to Go Next

Use the following table to determine where to go next.

If you want to Go to

Start ATM. Chapter 2

Change default settings for ATM interface parameters. Chapter 3

Change default settings for ATM signaling parameters. Chapter 4

Change default settings for ATM PVC service record and PVC 
parameters.

Chapter 5

Customize traffic shaping parameters for the Passport 5430. Chapter 6

Change default settings for classical IP service record parameters. Chapter 7

Change default settings for LAN Emulation client service record 
parameters.

Chapter 8

Change default settings for ATM WAN SVC service record and WAN 
SVC parameters.

Chapter 9

Change the default settings for CES parameters. Chapter 10

Change default settings for the ATM router redundancy parameter. Chapter 11

Obtain information about Site Manager parameters. Appendix A

Monitor ATM using the BCC show commands. Appendix B
1-44 308612-14.20 Rev 00



 

Chapter 2
Starting ATM and ATM Router Redundancy

This chapter describes how to create a basic ATM configuration by specifying 
values for required parameters only and accepting default values for all other 
parameters. This chapter contains the following information:

For overview information about ATM, see Chapter 1, “Understanding ATM, ATM 
Router Redundancy, and OAM.”

Starting Configuration Tools

Before configuring ATM, refer to the following user guides for instructions on 
how to start and use the Nortel Networks configuration tool of your choice.

Topic Page

Starting Configuration Tools 2-1

Starting ATM Services 2-2

Starting ATM Router Redundancy 2-20

Deleting ATM from the Router 2-26

Where to Go Next 2-27

Configuration Tool User Guide

Bay Command Console (BCC) Using the Bay Command Console (BCC)

Site Manager Configuring and Managing Routers with
Site Manager
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Starting ATM Services

You can use the BCC or Site Manager to start ATM on the router using default 
values for all parameters.

Using the BCC

To start ATM on a router using the BCC:

1. Add ATM to the configuration.

2. Enable ATM signaling (if you plan to define either a LANE or classical IP 
service record on a BN or Model 5782).

3. Define an ATM service record.

4. If you defined a PVC service record, add at least one virtual circuit to that 
service record.

5. Enable protocols on the ATM service record.

Adding ATM to the Configuration

To add ATM to a BN or System 5000 configuration, navigate to the top-level 
prompt and enter:

atm slot <slot_number> [module <module_number>] connector 
<connector_number>

slot_number is the number of the chassis slot containing the link module.

module_number is used when you configure an ATM interface on the System 
5000 chassis (that is, the Model 5782 Centillion™ Multiprotocol Engine). The 
module number for the ATM interface is always 2.

connector_number is the number of a connector on the link module.

Note: The top-level prompt for BCC configuration on the System 5000 
platform is “stack.” However, the remainder of this guide uses the “box” 
prompt associated with the BN and Passport 5430 platforms in its examples.
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For example, the following command adds ATM to the BN configuration on slot 
5, connector 1:

box# atm slot 5 connector 1
atm/5/1#

To add ATM to a Passport 5430 configuration, navigate to the box prompt and 
enter:

atm slot <slot_number> pci-slot <pci_slot> module <module_number> 
connector <connector_number> mode {t1 | e1}

slot_number is the number of the chassis slot containing the ATM T1/E1 PMC 
module.

pci_slot is the number of the PCI slot containing the ATM T1/E1 PMC module. 
The PCI slot number for the ATM T1/E1 PMC module is always 1.

module_number is always 2 for the ATM interface.

connector_number is the number of a connector on the ATM T1/E1 PMC module.

mode t1 or mode e1 specifies whether the ATM interface is a T-1 or E-1 
interface.

For example, the following command adds an ATM T1 interface to the Passport 
5430 configuration on slot 1, PCI slot 1, module 2, connector 1:

box# atm slot 1 pci-slot 1 module 2 connector 1 mode t1
atm/1/1/2/1#

Enabling Signaling (LANE and Classical IP Service Records Only)

To enable signaling on an ATM interface, navigate to the ATM prompt and enter:

signaling

For example, the following command enables UNI V3.0 (default) signaling on 
slot 5, connector 1:

atm/5/1# signaling
signaling/5/1#
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Defining an ATM Service Record

Using the BCC, you can define PVC, classical IP, and LANE service records.

Defining PVC Service

To define a PVC service record, navigate to the ATM interface prompt and enter:

pvc-service <service_name> encapsulation <encapsulation_type>

service_name is a unique text string that you assign to the service record.

encapsulation_type is the data encapsulation type that you want the PVC service 
record to use: llc-snap, null, or nlpid.

For example, the following command defines a PVC service record with the name 
“boston” on ATM slot 5, connector 1:

atm/5/1# pvc-service boston encapsulation llc-snap
pvc-service/boston#

Note: On the Passport 5430, you can add PVC service records only.

Note: You must add at least one PVC to a PVC service record. Go to “Adding 
PVCs” on page 2-6 for instructions.
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Defining Classical IP Service

To define a classical IP service record, navigate to the ATM interface prompt and 
enter:

classical-ip-service <service_name> encapsulation <encapsulation_type>

service_name is a unique text string that you assign to the service record.

encapsulation_type is the data encapsulation type that you want the classical IP 
service record to use.

For example, the following command defines a classical IP service record with the 
name “dallas” on ATM slot 5, connector 1: 

atm/5/1# classical-ip-service dallas encapsulation llc-snap
classical-ip-service/dallas#

Defining LEC Service

To define a LAN emulation client (LEC) service record, navigate to the ATM 
interface prompt and enter:

lec-service <service_name> 

service_name is a unique text string that you assign to the service record.

For example, the following command defines a LEC service record with the name 
“newyork” on ATM slot 5, connector 1: 

atm/5/1# lec-service newyork 
lec-service/newyork#
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Adding PVCs

You must add at least one PVC to a PVC service record for that service record to 
operate. A PVC is defined by its VPI/VCI pair.

A virtual path is a set of virtual channels between a common source and 
destination. The virtual channels within a virtual path logically associate with a 
common identifier. This identifier is called the virtual path identifier (VPI) and is 
part of the cell header.

A virtual channel is a logical connection between two communicating ATM 
entities. Each virtual channel can carry a different protocol or traffic type. The 
virtual channel transports cells that have a common identifier. The identifier is 
called the virtual channel identifier (VCI) and is part of the cell header.

To add a PVC to a PVC service record, navigate to the ATM PVC service prompt 
and enter:

pvc vpi <vpi_number> vci <vci_number>

vpi_number identifies the virtual path of the PVC. The header can contain a 
maximum of 8 VPI bits for a UNI connection. This bit range allows for path 
identifiers from 0 through 255.

vci_number identifies the virtual channel of the PVC. For the Passport 5430, the 
header can contain a maximum of 13 VCI bits. This bit range allows for channel 
identifiers from 32 through 8191 on the Passport 5430. For all other platforms 
supporting ATM, the header can contain a maximum of 16 VCI bits. However, the 
allowable range for routers other than the Passport 5430 is from 32 through 8192.

Note: ATM does not allow duplicate VPI/VCI pairs on the same physical 
interface (that is, on the same link module). However, duplicate VPI/VCI pairs 
can exist on different physical interfaces (that is, on different link modules).

Note: Following the recommendation of the ATM Forum, virtual channel 
identifiers from 0 through 31 are reserved for signaling and added 
functionality.
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For example, the following command adds PVC 0/130 to the configuration on 
PVC service record boston:

pvc-service/boston# pvc vpi 0 vci 130
pvc/0/130#

Adding Protocols to an ATM Service Record

The BCC supports IP and IPX configuration over ATM. Table 2-1 indicates which 
service records support the IP and IPX protocols.

Adding IP

To add IP to a service record, navigate to the ATM service record prompt and 
enter:

ip address <address> mask <mask>

address and mask are a valid IP address and its associated subnet mask, expressed 
in either dotted-decimal notation or in bit notation.

For example, the following command configures an IP address of 2.2.2.2 and a 
subnet mask of 255.255.255.0 on ATM PVC service record boston:

pvc-service/boston# ip address 2.2.2.2 mask 255.255.255.0
ip/2.2.2.2/255.255.255.0#

Table 2-1. Service Record Protocol Support

Service Record Type IP IPX

pvc-service ! !

classical-ip-service !

lec-service ! !

Note:  If you are adding IP to a PVC service record configured for null 
encapsulation, you must set the IP address-resolution parameter to none; 
you must also configure an IP adjacent host with the MAC address set to the 
VPI/VCI of the PVC on this same service record. For instructions on creating 
adjacent host entries, see Configuring IP, ARP, RARP, RIP, and OSPF Services.
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Adding IPX

To add IPX to a service record, navigate to the service record prompt and enter:

ipx address <address>

address is a valid IPX address.

For example, the following command configures an IPX address of 0000001a on 
ATM PVC 0/130:

pvc-service/boston# ipx address 0000001a
ipx/0000001a#

Starting CES (Passport 5430)

To connect an ATM PVC to a dual synchronous connector, you must set the PVC 
AAL encapsulation type to AAL 1. For information about how to set the AAL 
type, see “Setting the AAL Type” on page 6-17.

To start CES, navigate to the ATM PVC prompt and enter:

ces sslot <slot_number> spci-slot <pci_number> smodule <module_number> 
sconnector <conn_number> 

slot_number is the number of the chassis slot containing the dual synchronous 
module. The slot number for the dual synchronous module is always 1.

pci_number is the number of the PCI slot containing the dual synchronous 
module.

module_number is always 1 for the dual synchronous module.

connector_number is the connector associated with this interface.

For example, to connect an ATM PVC, located at slot 1, PCI slot 1, module 2, 
connector 1 with a VCI/VPI pair of 32/33, to the dual synchronous connector 
located at slot 1, PCI slot 4, module 2, connector 2, enter the following command:

pvc/1/1/2/1/32/33# ces 1/4/2/2
ces/0/33/1/4/2/2# 

Note: For complete information about how to configure a dual synchronous 
port as a CES H.110 circuit, see Configuring TDM Services.
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Using Site Manager

To start ATM on a router using Site Manager:

1. Create an ATM circuit.

2. Define an ATM service record.

3. Enable protocols on the ATM service record.

4. If you defined a PVC service record, add at least one virtual circuit to that 
service record.

Creating an ATM Circuit

If you are configuring a Passport 5430, go to the next section. If you are 
configuring a BN or System 5000, go to “Creating an ATM Circuit on a BN or 
System 5000” on page 2-10.

Creating an ATM Circuit on a Passport 5430

To create an ATM circuit on a Passport 5430, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM T1/E1 interface (ATM1) in 
slot 1, PCI slot 1, module 2.

The Add Circuit window opens.

2. Click on OK to accept the default circuit 
name.

The ATM Configuration window opens.

3. Click on ATM. The Edit ATM Connector window opens.

4. Go to “Defining an ATM Service Record” 
on page 2-10.
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Creating an ATM Circuit on a BN or System 5000

To create an ATM circuit on a BN or System 5000, complete the following tasks:

Defining an ATM Service Record

The Configuration Manager allows you to define service records for a specific 
data encapsulation type. Depending on the data encapsulation type you choose, 
the Configuration Manager also allows you to select a PVC, SVC, or WAN SVC 
connection type for that service record.

Table 2-2 identifies which data encapsulation types you can apply to permanent 
and switched virtual circuits. For an explanation of the different data 
encapsulation types, and rules for assigning data encapsulation, see Chapter 1, 
“Understanding ATM, ATM Router Redundancy, and OAM.”

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on an ATM link module interface 
(ATM1).

The Add Circuit window opens.

2. Click on OK to accept the default circuit 
name.

The Select Connection Type window 
opens.

3. Click on ATM. The Initial ATM Signaling Config window 
opens.

4. If you plan to configure only PVCs on this 
interface, set the Enable ATM Signaling 
parameter to Disable. Otherwise, accept 
the default settings for signaling.

5. Click on OK. The Edit ATM Connector window opens.

6. Go to the next section to define a service 
record on the circuit.

Caution: You cannot edit the Data Encapsulation Type or Virtual Connection 
Type parameters after you assign them to a service record. However, you can 
edit the Data Encapsulation Type for individual PVCs.
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Adding a Service Record for PVCs

To add a service record for PVCs, complete the following tasks:

Table 2-2. Data Encapsulation Types for PVCs, SVCs, and WAN SVCs

Data Encapsulation Type
Permanent 
Virtual Circuit

Switched Virtual 
Circuit

WAN Switched 
Virtual Circuit

LANE !

LLC/SNAP ! ! !

NLPID !

NULL ! !

Note: The values for some parameters are contingent on the values of others. 
If you change a parameter, press the Enter or Tab key to advance from one 
parameter cell to another. If you neglect this step, the Configuration Manager 
may not display the appropriate options for other parameters.

Site Manager Procedure

You do this System responds

1. In the Edit ATM Connector window, click 
on Service Attributes.

The ATM Service Records List window 
opens.

2. Click on Add. The ATM Service Record Parameters 
window opens.

3. Set the Data Encapsulation Type 
parameter to LLC/SNAP, NLPID, or NULL. 
Click on Help or see the parameter 
description on page A-15.

4. Press the Enter or Tab key to advance to 
the Virtual Connection Type parameter.

5. Set the Virtual Connection Type 
parameter to PVC. Click on Help or see 
the parameter description on page A-15.

6. Click on OK. The Select Protocols window opens.

7. Go to “Enabling Protocols on an ATM 
Service Record” on page 2-15.
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Adding a Service Record for Classical IP

To add a service record for classical IP, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on an ATM link module interface 
(ATM1).

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on Add. The ATM Service Record Parameters 
window opens.

5. Set the Data Encapsulation Type 
parameter to LLC/SNAP or NULL. Click 
on Help or see the parameter description 
on page A-15.

6. Click on OK. The Select Protocols window opens.

7. Configure IP and any other protocols on 
this service record. (See “Enabling 
Protocols on an ATM Service Record” on 
page 2-15.)

The ATM ARP Configuration window 
opens.

8. Set the following parameters:
• ATM ARP Mode 
• ARP Server ATM Address Network 

Prefix 
• ARP Server ATM Address User Part 
Click on Help or see the parameter 
descriptions beginning on page A-85.

9. Click on OK. You return to the ATM Service Records 
List window.

10. Click on Done. You return to the Edit ATM Connector 
window.

11. Click on Done. You return to the Select Connection Type 
window.

12. Click on Done. You return to the Configuration Manager 
window.
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Adding a Service Record for LANE

To add a service record for LANE, complete the following tasks:

Adding a Service Record for WAN SVCs

To add a service record for WAN SVCs, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on an ATM link module interface 
(ATM1).

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on Add. The ATM Service Record Parameters 
window opens.

5. Click on OK. The Select Protocols window opens.

6. Go to “Enabling Protocols on an ATM 
Service Record” on page 2-15.

Note: The values for some parameters are contingent on the values of others. 
If you change one parameter, press the Enter or Tab key to advance from one 
parameter cell to another. If you neglect this step, the Configuration Manager 
may not display the appropriate options for other parameters.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on an ATM link module interface 
(ATM1).

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

(continued)
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4. Click on Add. The ATM Service Record Parameters 
window opens.

5. Set the Data Encapsulation Type 
parameter to LLC/SNAP. Click on Help or 
see the parameter description on page 
A-15.

6. Press the Enter or Tab key to advance to 
the Virtual Connection Type parameter.

7. Change the Virtual Connection Type 
parameter to MUXED_SVC. Click on Help 
or see the parameter description on 
page A-15.

8. Change the WAN SVC Routing Mode to 
Normal or Dial-Optimized. Click on Help 
or see the parameter description on 
page A-20.

9. Click on OK. The Select Protocols window opens.

10. Go to “Enabling Protocols on an ATM 
Service Record” on page 2-15.

Note: After you create a WAN SVC service record, to complete the WAN 
SVC configuration you must also configure IP or IPX adjacent host entries for 
all routers to be connected to this router with WAN SVCs. For information 
about how to configure an IP adjacent host, see Configuring IP, ARP, RARP, 
RIP, and OSPF Services. For information about how to configure an IPX 
adjacent host, see Configuring IPX Services.

Site Manager Procedure (continued)

You do this System responds
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Enabling Protocols on an ATM Service Record

Depending on the data encapsulation type and virtual connection type (PVC or 
SVC) that you choose for the service record, the router supports various protocols.

You can select and configure protocols immediately after you create a service 
record, or you can exit the Select Protocols window and add protocols at a later 
time.

Adding Protocols Immediately After Creating a Service Record

To add protocols to a service record immediately after creating it, complete the 
following tasks:

Site Manager Procedure

You do this System responds

1. In the Select Protocols window, click on 
the protocols that you want to add.

A check mark appears in the box for each 
protocol that you select.

2. Click on OK. For each protocol that you select, the 
Configuration Manager displays a 
protocol-specific window prompting you 
for required information.

Click on Help for any parameter, or see 
the appropriate protocol-specific guide.
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Adding Protocols to an Existing Service Record

To add protocols to an existing service record, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on an ATM interface (ATM1).

Either the Select Connection Type 
window opens (BN or System 5000), or 
the ATM Configuration window opens 
(Passport 5430).

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the service record to which you 
want to add protocols.

The Protocols menu selection becomes 
active.

5. Click on Protocols. The Protocols menu opens.

6. Choose Add/Delete. The Select Protocols window opens.

7. Click on the protocols that you want to 
add.

A check mark appears in the box for each 
protocol that you select.

8. Click on OK. For each protocol that you select, the 
Configuration Manager displays a 
protocol-specific window prompting you 
for required information.

Click on Help for any parameter, or see 
the appropriate protocol-specific guide.
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Removing Protocols from a Service Record

To remove protocols from a service record, complete the following tasks: 

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on an ATM interface (ATM1).

Either the Select Connection Type 
window opens (BN or System 5000), or 
the ATM Configuration window opens 
(Passport 5430).

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the service record from which you 
want to remove protocols.

The Protocols menu selection becomes 
active.

5. Click on Protocols. The Protocols menu opens.

6. Choose Add/Delete. The Select Protocols window opens. 
Protocols that are currently selected have 
check marks next to them. 

7. Click on the protocols that you want to 
delete.

The check mark is removed from the 
boxes next to the protocols that you click 
on.

8. Click on OK. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

10. Click on Done. You return to the ATM Configuration 
window or the Select Connection Type 
window.

11. Click on Done. You return to the Configuration Manager 
window.
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Adding PVCs

You must add at least one virtual circuit to a PVC service record for that service 
record to operate. When you finish configuring the protocols for a PVC service 
record, the ATM Virtual Channel Link window opens.

To add a PVC to a PVC service record, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on an ATM interface (ATM1).

Either the Select Connection Type 
window opens (BN or System 5000), or 
the ATM Configuration window opens 
(Passport 5430).

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record to which 
you want to add a virtual circuit.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on Add. The ATM Virtual Channel Link 
Parameters window opens.

7. Set the VPI Number parameter. Click on 
Help or see the parameter description on 
page A-22.

8. Set the VCI Number parameter. Click on 
Help or see the parameter description on 
page A-22.

9. Click on OK. You return to the ATM Virtual Channel 
Link window.

10. Click on Done. You return to the ATM Service Records 
List window.

11. Click on Done. You return to the Edit ATM Connector 
window.

12. Click on Done. You return to the ATM Configuration or 
the Select Connection Type window.

13. Click on Done. You return to the Configuration Manager 
window.
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Starting CES (Passport 5430)

To connect an ATM PVC to a dual synchronous connector, you must set the PVC 
AAL encapsulation type to AAL 1. For information about how to set the AAL 
type, see “Setting the AAL Type” on page 6-17.

To start CES, complete the following tasks:

Note: For complete information about how to configure a dual synchronous 
port as a CES H.110 circuit, see Configuring TDM Services.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM connector. 

The ATM Configuration window opens. 

2. Click on CES. The ATM Virtual Circuits window opens.

3. Click on Connect. The CES H110 Circuits window opens

4. Highlight a CES H.110 circuit and click on 
Connect.

An arrow, indicating a circuit connection, 
appears between the ATM PVC and CES 
circuits. 

5. Click on Done. You return to the ATM Virtual Circuits 
window.

6. Click on Done. You return to the ATM Configuration 
window.

7. Click on Done. You return to the Configuration Manager 
window.
308612-14.20 Rev 00 2-19



Configuring ATM Services
Starting ATM Router Redundancy

This section describes how to start ATM router redundancy. For more information 
about ATM router redundancy, see “ATM Router Redundancy Concepts” on page 
1-39. For general information about router redundancy and detailed descriptions 
of router redundancy parameters, see Configuring Interface and Router 
Redundancy.

To configure router redundancy, you first create a template router redundancy 
group configuration file. After creating this group configuration file, you then use 
it to create each member configuration file twice: once as a primary file, which the 
router uses when it boots as the primary member of the redundancy group, and 
again as a secondary file, which the router uses in its role as a secondary member.

Note: You can configure router redundancy in Site Manager local mode only.

Note: The Clear function allows you to clear all protocols from all circuits on 
which you configured router redundancy. The Clear function does not, 
however, delete the configured router redundancy information.

The Clear function is useful when converting a primary router redundancy 
configuration file to a secondary configuration file, because a typical 
secondary configuration does not include any of the protocols contained in the 
primary configuration.
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Creating a Group Configuration File

To create a redundancy group configuration file template, complete the following 
steps. All group members will use the values that you configure in this file.

Site Manager Procedure

You do this System responds

1. In the Site Manager window, choose 
Tools.

The Tools menu opens.

2. Choose Router Redundancy. The Router Redundancy menu opens.

3. Choose Group Configuration. The file selection window opens.

4. Enter template.cfg as the file name.

5. Click on OK. The Select Router Model window opens.

6. Select a router and click on Confirm. The Configuration Manager window 
opens.

7. Click on an empty slot. The Module List window opens.

8. Choose a LAN module (for example, 
Ethernet, token ring, or FDDI) and click on 
OK.

The Configuration Manager window 
opens.

9. Click on the connector you want to 
configure for router redundancy.

The Add Circuit window opens.

10. Click on OK. The Select Protocols window opens.

11. Select Router Redundancy.

You can also select other protocols that 
you want to configure.

12. Click on OK. Site Manager asks if you want to add 
VLAN circuits.

13. Click on No. The Router Redundancy Circuit window 
opens.

14. Set the Primary MAC Address 
parameter. Click on Help or see 
Configuring Interface and Router 
Redundancy for details.

15. Click on OK. The R.R. Group Global Parameters 
Configuration window opens.

(continued)
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For detailed descriptions of router redundancy parameters not described in this 
section, see Configuring Interface and Router Redundancy.

16. Set the Bid Duration parameter to at least 
90 seconds. Click on Help or see the 
parameter description in Configuring 
Interface and Router Redundancy.

17. Click on OK. The Configuration Manager window 
opens.

18. Click on the slot that contains the ATM 
module.

The Module List window opens.

19. Choose the ATM module type that resides 
on the router and click on OK.

The Configuration Manager window 
opens.

20. Click on the ATM1 connector that you want 
to configure for router redundancy.

The Add Circuit window opens.

21. Click on OK. The Select Connection Type window 
opens.

22. Click on ATM. The Initial ATM Signaling Config window 
opens.

23. Click on OK. The Edit ATM Connector window opens.

24. Click on Configure ATM Router 
Redundancy.

The Router Redundancy Circuit window 
opens.

25. Click on OK. You return to the Edit ATM Connector 
window.

26. Click on Done. You return to the Select Connection Type 
window.

27. Click on Done. You return to the Configuration Manager 
window.

28. Click on File. The File menu opens.

29. Choose Save. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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Creating Member Configuration Files

After creating a group configuration file, you use that file to create a primary and 
secondary configuration file for each member of an ATM router redundancy 
group.

Creating a Primary Configuration File

To create a primary configuration file, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Site Manager window, choose 
Tools.

The Tools menu opens.

2. Choose Router Redundancy. The Router Redundancy menu opens.

3. Choose Member Configuration. The file selection window opens.

4. Select the group configuration file, 
template.cfg.

5. Click on Open File. The Configuration Manager window 
opens.

6. Choose Protocols. The Protocols menu opens.

7. Choose Router Redundancy. The Router Redundancy menu opens.

8. Choose Member Configuration. The R.R. Member Global Parameters 
Configuration window opens.

9. Click on OK. The Configuration Manager window 
opens.

10. Choose File. The File menu opens.

11. Choose Save As. The Save Configuration File window 
opens.

12. Enter a file name (for example, alpha.pri) 
and click on Primary Save.

You return to the Configuration Manager 
window.
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Creating a Secondary Configuration File

To create a secondary configuration file, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Site Manager window, choose 
Tools.

The Tools menu opens.

2. Choose Router Redundancy. The Router Redundancy menu opens.

3. Choose Member Configuration. The file selection window opens.

4. Select the primary configuration file.

5. Click on Open File. The Configuration Manager window 
opens.

6. Choose Protocols. The Protocols menu opens.

7. Choose Router Redundancy. The Router Redundancy menu opens.

8. Choose Member Configuration. The R.R. Member Global Parameters 
Configuration window opens.

9. Set the Primary Configuration File Path 
parameter. Click on Help or see 
Configuring Interface and Router 
Redundancy for details.

10. Click on OK. The Configuration Manager window 
opens.

11. Choose Protocols. The Protocols menu opens.

12. Choose Router Redundancy. The Router Redundancy menu opens.

13. Choose Clear. Site Manager clears all protocols except 
router redundancy from circuits with 
router redundancy configured.

14. Choose File. The File menu opens.

15. Choose Save As. The Save Configuration File window 
opens.

16. Enter a file name (for example, alpha.sec) 
and click on Secondary Save.

You return to the Configuration Manager 
window.
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Downloading Member Configuration Files to the Routers

After creating a primary and secondary configuration file for each member of an 
ATM router redundancy group, you must download those files to each router.

See Configuring and Managing Routers with Site Manager for instructions on 
downloading files.

When downloading the configuration files, keep the following in mind:

• Nortel Networks recommends that the routers all have the same primary and 
secondary configurations.

• You should name the secondary configuration file config. The router boots 
using the config file if it restarts.

• Each router must have a unique member ID.

• Each router should have a unique priority.

If the primary and secondary routers have identical configurations, you can repeat 
the primary and secondary file configurations, using a different member ID. If the 
configurations differ, you can modify the nonredundant parts of the configuration 
before saving the configuration file.
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Deleting ATM from the Router

You can use the BCC or Site Manager to delete ATM from the router.

Using the BCC

To delete ATM from the router, navigate to the ATM prompt and enter:

delete

For example, the following command deletes ATM from slot 5, connector 1:

atm/5/1# delete
box#

Using Site Manager

To delete ATM from the router using Site Manager, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on Protocols.

The Protocols menu opens.

2. Choose ATM. The ATM menu opens.

3. Choose Delete ATM. Site Manager asks whether you really 
want to delete ATM.

4. Click on OK. Site Manager deletes ATM from the 
router. You return to the Configuration 
Manager window.
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Where to Go Next

Use the following table to determine where to go next. 

If you want to Go to

Learn about ATM concepts. Chapter 1

Change default settings for ATM interface parameters. Chapter 3

Change default settings for ATM signaling parameters. Chapter 4

Change default settings for ATM PVC service record and PVC 
parameters.

Chapter 5

Customize traffic shaping parameters for the Passport 5430. Chapter 6

Change default settings for classical IP service record parameters. Chapter 7

Change default settings for LAN Emulation client service record 
parameters.

Chapter 8

Change default settings for ATM WAN SVC service record and WAN 
SVC parameters.

Chapter 9

Change the default settings for CES parameters. Chapter 10

Change default settings for the ATM router redundancy parameter. Chapter 11

Obtain information about Site Manager parameters. Appendix A

Monitor ATM using the BCC show commands. Appendix B
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Chapter 3
Customizing an ATM Interface

When you start ATM on the router, all parameters use their default values. 
Depending on the requirements of your network, you may want to change some of 
these values. This chapter describes how to customize interface (or “line”) details 
and includes the following information:

Topic Page

Disabling and Reenabling the ATM Driver 3-2

Defining the Interface MTU 3-3

Defining the Data Path Notify Function 3-5

Defining the SVC Inactivity Timeout 3-7

Assigning the Framing Mode 3-9

Defining the Clocking Signal Source 3-11

Specifying DS-3 Line Buildout 3-12

Specifying DS-1 Transmit Waveform 3-13

Turning DS-3, E-3, DS-1, and E-1 Scrambling On and Off 3-14

Enabling and Disabling Per-VC Clipping 3-16

Disabling and Reenabling an ATM Interface 3-18

Disabling and Reenabling Signaling on an Interface 3-19

Autogenerating ATM Addresses 3-20

Defining the Maximum Number of VPCs 3-23

Defining the Maximum Number of VCCs 3-23

Where to Go Next 3-24
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Disabling and Reenabling the ATM Driver

By default, when you create an ATM circuit, the line driver is enabled. You can 
disable and reenable the line driver for the specific connector without removing 
the physical line from the ATM receptacle.

Using the BCC

To disable the line driver, navigate to the ATM prompt (for example,
box; atm/11/1) and enter:

state disabled

For example, the following command disables the line driver on the ATM 
connector:

atm/11/1# state disabled
atm/11/1#

To reenable the line driver, navigate to the prompt and enter:

state enabled

For example, the following command reenables the line driver on the ATM 
connector:

atm/11/1# state enabled
atm/11/1#
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Using Site Manager

To disable or reenable the line driver, complete the following tasks:

Defining the Interface MTU

The maximum transmission unit (MTU) is the largest possible unit of data that the 
physical medium can transmit. By default, the interface allows an MTU size of 
4608 octets. This value can handle most packet sizes. However, you can set the 
MTU to any value from 1 to 9188 octets.

Using the BCC

To modify the interface MTU, navigate to the ATM prompt (for example,
box; atm/11/1) and enter:

mtu <integer>

integer is the MTU size in octets.

For example, the following command sets the MTU size to 9188 octets:

atm/11/1# mtu 9188
atm/11/1#

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to disable or reenable.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on Line Attributes. The ATM Line Driver Attributes window 
opens.

3. Set the Enable parameter. Click on Help 
or see the parameter description on 
page A-5.

4. Click on OK. You return to the ATM Configuration or 
the Select Connection Type window.

5. Click on Done. You return to the Configuration Manager 
window.
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Using Site Manager

To modify the MTU value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on Line Attributes. The ATM Line Driver Attributes window 
opens.

3. Set the Interface MTU parameter. Click on 
Help or see the parameter description on 
page A-5.

4. Click on OK. You return to the ATM Configuration or 
the Select Connection Type window.

5. Click on Done. You return to the Configuration Manager 
window.
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Defining the Data Path Notify Function

The data path notify function specifies whether the router disables the interface 
between the driver and the higher-level software (the data path interface) when 
you disconnect the cable from the ATM interface.

If you enable this function (the default), when you disconnect the cable from the 
interface, the router disables the data path interface after a time you specify.

If you disable this function, the router does not disable the data path interface and 
continues to send information to the higher-level software.

When you enable the data path notify function, you can also change how long you 
want the ATM router to wait before disabling the data path interface. By default, 
when the state of the physical interface changes from operational to 
nonoperational, the router waits 1 second. However, you can set this timer to any 
value from 0 to 3600 seconds.

Using the BCC

To disable the data path notify function, navigate to the ATM prompt (for 
example, box; atm/11/1) and enter:

dp-notify disabled

For example, the following command disables the data path notify function on the 
ATM interface:

atm/11/1# dp-notify disabled
atm/11/1#

To reenable the data path notify function, navigate to the ATM prompt and enter:

dp-notify enabled

To change the data path notify timeout value, navigate to the ATM prompt and 
enter:

dp-notify-timeout <integer>

integer is the amount of time (in seconds) that the router can wait before the data 
path notify function activates.
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For example, the following command sequence reenables the data path notify 
function on the ATM interface and sets the data path notify timeout value to 2400 
seconds:

atm/11/1# dp-notify enabled
atm/11/1# dp-notify-timeout 2400
atm/11/1#

Using Site Manager

To disable or reenable the data path notify function or to change the data path 
notify timeout value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on Line Attributes. The ATM Line Driver Attributes window 
opens.

3. Set the Data Path Enable parameter. 
Click on Help or see the parameter 
description on page A-6.

4. Set the Data Path Notify Timeout 
parameter. Click on Help or see the 
parameter description on page A-6.

5. Click on OK. You return to the ATM Configuration or 
the Select Connection Type window.

6. Click on Done. You return to the Configuration Manager 
window.
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Defining the SVC Inactivity Timeout

When you enable the SVC inactivity timeout function (the default), the router 
automatically terminates any SVCs that have not received or transmitted any cells. 
If you disable the SVC inactivity timeout function, all SVCs on the line remain 
open until you close them by another method.

When enabled, the SVC inactivity timeout function also requires a timer value. 
This timer value specifies how long you want the ATM router to wait before 
disabling inactive SVCs. By default, if the router does not receive or transmit any 
cells for 1200 seconds, the inactive SVCs are disabled. However, you can set this 
timer to any value from 60 to 3600 seconds.

Using the BCC

To disable the SVC inactivity timeout function, navigate to the ATM prompt (for 
example, box; atm/11/1) and enter:

vc-inactivity-control disabled

For example, the following command disables the SVC inactivity timeout 
function on the ATM interface:

atm/11/1# vc-inactivity-control disabled
atm/11/1#

To reenable the SVC inactivity timeout function, navigate to the ATM prompt and 
enter:

vc-inactivity-control enabled

To change the SVC inactivity timeout value, navigate to the ATM prompt and 
enter:

vc-inactivity-timeout <integer>

integer is the amount of time (in seconds) that the router can wait before it 
disables inactive SVCs.
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For example, the following command sequence reenables the SVC inactivity 
timeout function on the ATM interface and sets the SVC inactivity timeout value 
to 2400 seconds:

atm/11/1# vc-inactivity-control enabled
atm/11/1# vc-inactivity-timeout 2400
atm/11/1#

Using Site Manager

To enable or disable the SVC inactivity timeout function or to modify the SVC 
inactivity timeout parameter, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on Line Attributes. The ATM/ARE Line Driver Attributes 
window opens.

3. Set the SVC Inactivity Timeout Enable 
parameter. Click on Help or see the 
parameter description on page A-7.

4. Set the SVC Inactivity Timeout (Secs) 
parameter. Click on Help or see the 
parameter description on page A-7.

5. Click on OK. You return to the ATM Configuration or 
the Select Connection Type window.

6. Click on Done. You return to the Configuration Manager 
window.
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Assigning the Framing Mode

You can assign a framing mode to an ATM line, depending on the interface type 
that your device uses. Table 3-1 lists the supported framing modes for each 
interface type on the BN and System 5000 routers.

By default, the ATM line uses SONET framing for OC-3 interfaces, Cbit framing 
for DS-3 interfaces, and G.832 framing for E-3 interfaces.

The Passport 5430 ATM T1/E1 PMC module provides T1 and E1 connectivity. If 
you set the interface mode to T1, the default framing mode is T1ADM; you can 
set the framing mode to T1PLCP. If you set the interface mode to E1, the default 
framing mode is E1ADM; you can set the framing mode to E1PLCP.

Using the BCC

To change the framing mode on a BN or System 5000, navigate to the ATM 
prompt (for example, box; atm/11/1) and enter:

framing-mode <mode>

mode is one of the following framing modes:

• sdh • g751

• sonet • g832

• cbit • cbitnofallback

• m32 • clearchannel

Table 3-1. Supported Framing Modes for ATM Interfaces (BN and System 5000)

Framing Mode

Interface
Type SDH SONET DS3_CBIT DS3_M32 E3_G751 E3_G832 CBITnofallback

Clear
Channel

OC-3 ! !

DS-3 ! ! !

E-3 ! !
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For example, the following command sets the framing mode to SDH:

atm/11/1# framing-mode sdh
atm/11/1#

To change the framing mode on a Passport 5430, navigate to the ATM prompt 
(box; atm/1/1/2/1) and enter:

framing-mode <mode>

mode is one of the following framing modes:

• t1adm • e1adm

• t1plcp • e1plcp

For example, the following command sets the framing mode to E1PLCP:

atm/1/1/2/1# framing-mode e1plcp
atm/11/1#

Using Site Manager

To assign the framing mode to an ATM line, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on Line Attributes. The ATM Line Driver Attributes window 
opens.

3. Set the Framing Mode parameter. Click 
on Help or see the parameter description 
on page A-8.

4. Click on OK. You return to the ATM Configuration or 
the Select Connection Type window.

5. Click on Done. You return to the Configuration Manager 
window.
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Defining the Clocking Signal Source

You can specify either an internal or external clocking source for time signals. 
Internal clocking uses the router clock; external clocking uses the line clock.

Using the BCC

To change the source of the ATM clocking signal, navigate to the ATM prompt 
(for example, box; atm/11/1) and enter:

clock-signal-source <source>

source is either internal (default) or external.

For example, the following command changes the ATM clocking signal source to 
external:

atm/11/1# clock-signal-source external
atm/11/1#

Using Site Manager

To change the clocking signal source for the ATM line, complete the following 
tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on Line Attributes. The ATM Line Driver Attributes window 
opens.

3. Set the Clocking Signal Source 
parameter. Click on Help or see the 
parameter description on page A-8.

4. Click on OK. You return to the ATM Configuration or 
the Select Connection Type window.

5. Click on Done. You return to the Configuration Manager 
window.
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Specifying DS-3 Line Buildout

On modules that use a DS-3 interface, you can specify how the router conditions 
signals to mitigate attenuation. Specify a short line (the default) for a line less than 
225 feet (ft) long. Specify a long line for a line length of 225 ft or more.

Using the BCC

To change the DS-3 line buildout, navigate to the ATM prompt (for example, box; 
atm/11/1) and enter:

ds3-line-build-out <length>

length is either short (default) or long.

For example, the following command changes the DS-3 line buildout to long:

atm/11/1# ds3-line-build-out long
atm/11/1#

Using Site Manager

To modify the DS-3 line buildout, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM link module interface 
(ATM1) that you want to modify.

The Select Connection Type window 
opens.

2. Click on Line Attributes. The ATM/ARE Line Driver Attributes 
window opens.

3. Set the DS3 Line Build Out parameter. 
Click on Help or see the parameter 
description on page A-9.

4. Click on OK. You return to the Select Connection Type 
window.

5. Click on Done. You return to the Configuration Manager 
window.
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Specifying DS-1 Transmit Waveform

On modules that use a DS-1 interface, you can specify how the router conditions 
signals to mitigate attenuation. You can choose a long line length from 0.0 
decibels (dB) through 22.5 dB or a short line length from 0 feet through 660 feet.

Using the BCC

To change the DS-1 transmit waveform, navigate to the ATM T1 prompt (for 
example, box; atm/1/1/2/1; atm-t1) and enter:

tx-waveform <length>

length is a value from either 0 to 22.5 db for a long line and from 0 to 660 feet for 
a short line. 0.0db, 7.5db, 15.0db, 22.5db, 0-110ft, 110-220ft, 220-330ft, 
330-440ft, 440-550ft, 550-660ft

length is one of the following values:

• 0.0db • 0-110ft

• 7.5db • 110-220ft

• 15.0db • 220-330ft

• 22.5db • 330-440ft

• 440-550ft

• 550-660ft

For example, the following command changes the transmit waveform to a length 
of 220 to 330 feet:

atm-t1/1/1/2/1# tx-waveform 220-330ft
atm-t1/1/1/2/1#
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Using Site Manager

To modify the transmit waveform, complete the following tasks:

Turning DS-3, E-3, DS-1, and E-1 Scrambling On and Off

Some ATM network equipment can exhibit sensitivity to certain bit patterns (for 
example, 101010... or 000000...). This sensitivity can cause problems on the ATM 
network. Turning on the scrambling function (the default setting) randomizes the 
bit pattern in the cell payload sufficiently to guarantee cell synchronization.

Although some equipment can operate with scrambling disabled, Nortel Networks 
recommends that you scramble the cell payload.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1).

The ATM Configuration window opens.

2. Click on Physical Layer Configuration. The Physical Layer Configuration window 
opens.

3. Click on T1. The Edit T1 Clock Parameters window 
opens.

4. Click on Port Details. The Edit T1 Port Parameters window 
opens.

5. Set the Transmit Waveform parameter. 
Click on Help or see the parameter 
description on page A-9.

6. Click on OK. You return to the Physical Layer 
Configuration window.

7. Click on Done. You return to the ATM Configuration 
window.

8. Click on Done. You return to the Configuration Manager 
window.

Caution: ATM devices with different settings for scrambling cannot 
communicate. For example, if you configure a router to enable scrambling and 
configure a hub to disable scrambling, the router and hub cannot communicate.
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Using the BCC

DS-3 and E-3 Scrambling

To turn off DS-3 and E-3 scrambling, navigate to the ATM prompt (for example,
box; atm/11/1) and enter:

scrambling off

For example, the following command turns off scrambling on the ATM connector:

atm/11/1# scrambling off
atm/11/1#

To turn scrambling back on, navigate to the ATM prompt and enter:

scrambling on

For example, the following command turns the ATM connector scrambling back 
on:

atm/11/1# scrambling on
atm/11/1#

DS-1 and E-1 Scrambling

To turn off DS-1 and E-1 scrambling, navigate to the ATM prompt (for example, 
box; atm/1/1/2/1) and enter:

scrambling off

For example, the following command turns off scrambling on the Passport 5430 
ATM connector:

atm/1/1/2/1# scrambling off
atm/1/1/2/1#

To turn scrambling back on, navigate to the ATM prompt and enter:

scrambling on

For example, the following command turns scrambling back on:

atm1/1/1/2/1# scrambling on
atm/1/1/2/1#
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Using Site Manager

To turn cell scrambling on or off, complete the following tasks:

Enabling and Disabling Per-VC Clipping

Per-VC clipping provides an added traffic-shaping option that allows you to 
modify how your ATM line responds to oversubscribed traffic. By default, per-VC 
clipping is disabled on a line. However, you can enable or disable per-VC clipping 
at any time.

When enabled, this option clips frames intended for an oversubscribed VC when 
the number of frames in memory exceeds a predetermined limit.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on Line Attributes. The ATM Line Driver Attributes window 
opens.

3. Set the DS3/E3 Scrambling or (Cell 
Scrambling) parameter. Click on Help or 
see the parameter description on 
page A-10.

4. Click on OK. You return to the ATM Configuration or 
the Select Connection Type window.

5. Click on Done. You return to the Configuration Manager 
window.

Note: Changing the state of this parameter tears down all active VCs on the 
interface. The new state takes effect after VC connections are reestablished.
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Using the BCC

To enable per-VC clipping, navigate to the ATM prompt (for example,
box; atm/11/1) and enter:

clipping enabled

For example, the following command enables per-VC clipping on the ATM 
interface:

atm/11/1# clipping enabled
atm/11/1#

To disable per-VC clipping, navigate to the ATM prompt and enter:

clipping disabled

For example, the following command disables per-VC clipping on the ATM 
interface:

atm/11/1# clipping disabled
atm/11/1#

Using Site Manager

To enable or disable per-VC clipping, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on Line Attributes. The ATM Line Driver Attributes window 
opens.

3. Set the Per-VC Clipping parameter. Click 
on Help or see the parameter description 
on page A-10.

4. Click on OK. You return to the ATM Configuration or 
the Select Connection Type window.

5. Click on Done. You return to the Configuration Manager 
window.
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Disabling and Reenabling an ATM Interface

By default, the ATM interface is enabled when you create the circuit. However, 
you can disable or reenable the interface at any time. When the interface is 
enabled, traffic can flow over the interface. When the interface is disabled, traffic 
cannot flow over the interface.

Using the BCC

To disable or reenable the ATM logical interface, navigate to the ATM interface 
prompt (for example, box; atm/1/1/2/1; atm-interface) and enter:

state {disabled | enabled}

For example, the following commands disable and reenable the ATM interface:

atm-interface/1/1/2/1# state disabled
atm-interface/1/1/2/1# state enabled
atm-interface/1/1/2/1#

Using Site Manager

To disable or reenable the ATM interface, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on Interface Attributes. The ATM Interface Attributes window 
opens.

3. Set the Administrative State parameter. 
Click on Help or see the parameter 
description on page A-11.

4. Click on Done. You return to the ATM Configuration 
window or the Select Connection Type 
window.

5. Click on Done. You return to the Configuration Manager 
window.
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Disabling and Reenabling Signaling on an Interface

By enabling ATM signaling (the default setting), you can configure switched 
features (for example, SVCs and LAN emulation) on the interface. If you do not 
intend to configure any switched features on the interface (that is, you want the 
interface to run only PVCs), disable signaling to make additional system resources 
available.

To disable or reenable signaling on the ATM interface, complete the following 
tasks:

Note: The Passport 5430 supports only PVCs; you cannot enable signaling on 
the Passport 5430.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM link module interface 
(ATM1) that you want to modify.

The Select Connection Type window 
opens.

2. Click on Interface Attributes. The ATM Interface Attributes window 
opens.

3. Set the Enable ATM Signaling parameter. 
Click on Help or see the parameter 
description on page A-11.

4. Click on Done. You return to the Select Connection Type 
window.

5. Click on Done. You return to the Configuration Manager 
window.
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Autogenerating ATM Addresses

You can automatically generate the user part (suffix) of SVC ATM addresses. 
When autogenerating this portion of the ATM addresses, you can use either the 
ATM hardware MAC address or a MAC address override value as the end-station 
identifier.

Enabling or Disabling the Hardware MAC Address Feature

If enabled, the hardware MAC address feature uses the MAC address of the ATM 
interface when automatically generating the ATM address user part. Disabling this 
feature uses the MAC address override value (refer to “Entering a MAC Address 
Override Value” on page 3-21) when automatically generating the ATM address 
user part.

Using the BCC

To disable the hardware MAC address feature, navigate to the ATM interface 
prompt (for example, box; atm/11/1; atm-interface) and enter:

use-hardware-mac disabled

For example, the following command disables the use of the hardware MAC 
address:

atm-interface/11/1# use-hardware-mac disabled
atm-interface/11/1#

To reenable the hardware MAC address feature, navigate to the ATM interface 
prompt and enter:

use-hardware-mac enabled

Note: The Passport 5430 supports only PVCs; you do not configure ATM 
addresses on the Passport 5430.

Note: If you disable the hardware MAC address feature, you must enter a 
MAC address override value.
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For example, the following command reenables the use of the hardware MAC 
address:

atm-interface/11/1# use-hardware-mac enabled
atm-interface/11/1#

Using Site Manager

To disable or reenable the use of the hardware MAC address, complete the 
following tasks:

Entering a MAC Address Override Value

The MAC address override value redefines the hardware MAC address for the 
interface. It also defines the end-station identifier for the interface when 
automatically generating the user part (suffix) of an SVC ATM address.

Using a MAC address override value is very helpful when you want to hot-swap 
ATM link modules. For example, when hot-swapping ATM link modules, you can 
enter the MAC address of the original ATM link module as the MAC address 
override value for the new ATM link module. This allows you to keep the 
information already configured on the existing ATM link module while 
maintaining the integrity of the existing client information on the network.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on an ATM interface (ATM1).

The Select Connection Type window 
opens.

2. Click on Interface Attributes. The ATM Interface Attributes window 
opens.

3. Set the Use Hardware MAC Address 
parameter. Click on Help or see the 
parameter description on page A-12.

4. Click on Done. You return to the Select Connection Type 
window.

5. Click on Done. You return to the Configuration Manager 
window.
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To change the MAC address override value, navigate to the ATM interface prompt 
(for example, box; atm/11/1; atm-interface) and enter:

mac-override <mac_address>

mac_address is the MAC address you want this interface to use.

For example, the following command changes the MAC address for the ATM 
interface:

atm-interface/11/1# mac-override 000011111aaa
atm-interface/11/1#

Using Site Manager

To change the MAC address that the ATM interface uses, complete the following 
tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM link module interface 
(ATM1) that you want to modify.

The Select Connection Type window 
opens.

2. Click on Interface Attributes. The ATM Interface Attributes window 
opens.

3. Set the MAC Address Override 
parameter. Click on Help or see the 
parameter description on page A-13.

4. Click on Done. You return to the Select Connection Type 
window.

5. Click on Done. You return to the Configuration Manager 
window.
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Defining the Maximum Number of VPCs

You can define the maximum number of virtual path connections (VPCs) that the 
ATM interface can have.

To change the maximum number of VPCs, navigate to the ATM interface prompt 
(for example, box; atm/11/1; atm-interface) and enter:

vpcs-maximum <integer>

integer is the maximum number of VPCs the ATM interface can use.

For example, the following command limits the number of VPCs to 128:

atm-interface/11/1# vpcs-maximum 128
atm-interface/11/1#

Defining the Maximum Number of VCCs

You can define the maximum number of virtual channel connections (VCCs) that 
each ATM virtual path can have.

To change the maximum number of VCCs, navigate to the ATM interface prompt 
(for example, box; atm/11/1; atm-interface) and enter:

vccs-maximum <integer>

integer is the maximum number of VCCs each virtual path can use.

For example, the following command limits the number of VCCs to 128:

atm-interface/11/1# vccs-maximum 128
atm-interface/11/1#
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Where to Go Next

Use the following table to determine where to go next:

If you want to Go to

Learn about ATM concepts. Chapter 1

Start ATM. Chapter 2

Change default settings for ATM signaling parameters. Chapter 4

Change default settings for ATM PVC service record and PVC 
parameters.

Chapter 5

Customize traffic shaping parameters for the Passport 5430. Chapter 6

Change default settings for classical IP service record parameters. Chapter 7

Change default settings for LAN Emulation client service record 
parameters.

Chapter 8

Change default settings for ATM WAN SVC service record and WAN 
SVC parameters.

Chapter 9

Change the default settings for CES parameters. Chapter 10

Change default settings for the ATM router redundancy parameter. Chapter 11

Obtain information about Site Manager parameters. Appendix A

Monitor ATM using the BCC show commands. Appendix B
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Chapter 4
Customizing Signaling

When you start ATM on the router, all parameters use their default values. 
Depending on the requirements of your network, you may want to change some of 
these values. This chapter describes how to customize signaling details and 
includes the following information:

Topic Page

Defining Signaling 4-2

Defining Signaling Timers 4-16

Defining ILMI 4-29

Defining Control VCs 4-39

Defining SSCOP/Signaling AAL 4-61

Where to Go Next 4-72
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Defining Signaling

ATM signaling allows the router to dynamically establish, maintain, and clear a 
switched virtual connection at the UNI. Using a series of messages, as defined by 
the Q.2931 standard for signaling protocol (Figure 4-1), the router:

1. Assesses the availability of an ATM end point (device).

2. Establishes a connection with that device.

3. Maintains that connection for the duration of the data transfer.

4. Clears the connection when the transfer is complete.

Figure 4-1. SVC/PVC Signaling Protocol Stack

Nortel Networks ATM routers support ATM signaling functions as defined in the 
ATM Forum ATM User-Network Interface specification (Versions 3.0, 3.1, and 
4.0).

Q.2931

Q.SAAL

Protocol

Data 
encapsulation

ATM adaptation layer
(AAL5)

ATM layer

Physical layer

ATM0039A
4-2 308612-14.20 Rev 00



Customizing Signaling
 

Disabling and Reenabling Signaling

By default, signaling is enabled on an interface when you create the signaling 
object (BCC) or when you create the circuit (Site Manager). However, you can 
disable and reenable signaling on an interface at any time.

Using the BCC

To disable signaling, navigate to the signaling prompt (for example,
box; atm/11/1; signaling/11/1) and enter:

state disabled

For example, the following command disables signaling on the ATM connector:

signaling/11/1# state disabled
signaling/11/1#

To reenable signaling, navigate to the signaling prompt and enter:

state enabled

For example, the following command reenables signaling on the ATM connector:

signaling/11/1# state enabled
signaling/11/1#

Note: Disabling ATM signaling on an interface automatically sets the data 
encapsulation type to LLC/SNAP and the virtual connection type to PVC for 
any new service records.
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Using Site Manager

To disable or reenable signaling, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling. The ATM Signaling Parameters window 
opens.

4. Set the Enable parameter. Click on Help 
or see the parameter description on 
page A-49.

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.
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Assigning the UNI Signaling Protocol Standard

The UNI signaling protocol standard specifies how the interface defines Service 
Specific Connection Oriented Protocol (SSCOP) frames. The ATM Forum 
Versions 3.0, 3.1, and 4.0 methods of defining SSCOP frames are incompatible.

You must assign the same protocol standard for both the router interface and the 
switch interface to which this interface connects. 

Accept the default, ATM Forum UNI Version 3.0, if the switch interface uses 
ATM Forum UNI Version 3.0 to define SSCOP frames. Change the UNI signaling 
standard to UNI Version 3.1 or 4.0 if the switch interface uses ATM Forum UNI 
Version 3.1 or 4.0, respectively, to define SSCOP frames.

Using the BCC

To change the UNI version, navigate to the signaling prompt (for example,
box; atm/11/1; signaling/11/1) and enter:

uni-version <version>

version is the UNI signaling version, either v30 (default), v31, or v40.

For example, the following command changes the UNI signaling protocol 
standard to Version 3.1.

signaling/11/1# uni-version v31
signaling/11/1#
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Using Site Manager

To change the UNI version, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling. The ATM Signaling Parameters window 
opens.

4. Set the Protocol Standard parameter. 
Click on Help or see the parameter 
description on page A-50.

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.
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Specifying the Maximum Number of SVC Applications

You can specify the maximum number of SVC applications that you want to 
operate on the circuit. The number of applications corresponds to the number of 
LANE or IP (RFC 1577) clients allowed for the circuit.

By default, you can have up to 20 SVC applications on the circuit. However, you 
can specify a value from 1 to 32,767.

Using the BCC

To change the maximum number of SVC applications, navigate to the signaling 
prompt (for example, box; atm/11/1; signaling/11/1) and enter:

svc-applications-maximum <integer>

integer is a value from 1 to 32767.

For example, the following command sets the maximum number of SVC 
applications on the ATM circuit to 100.

signaling/11/1# svc-applications-maximum 100
signaling/11/1#
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Using Site Manager

To modify the maximum number of SVC applications on the circuit, complete the 
following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling. The ATM Signaling Parameters window 
opens.

4. Set the Max Number of SVC 
Applications parameter. Click on Help or 
see the parameter description on 
page A-50.

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.
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Setting Connection Thresholds

Connection thresholds allow you to control the number of point-to-point 
connections, point-to-multipoint connections, and parties in a multipoint 
connection allowed on the circuit at any given time.

Setting the Maximum Number of Point-to-Point Connections

By default, you can have up to 1,000 simultaneous point-to-point connections on a 
circuit at any given time. However, you can specify a value from 0 to 32,767 
connections.

Using the BCC

To change the maximum number of point-to-point connections, navigate to the 
signaling prompt (for example, box; atm/11/1; signaling/11/1) and enter:

point-to-point-maximum <integer>

integer is a value from 0 to 32767.

For example, the following command sets the maximum number of point-to-point 
connections on the ATM circuit to 2000:

signaling/11/1# point-to-point-maximum 2000
signaling/11/1#
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To modify the maximum number of point-to-point connections on the circuit, 
complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling. The ATM Signaling Parameters window 
opens.

4. Set the Max Point to Point Connections 
parameter. Click on Help or see the 
parameter description on page A-51.

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.
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Setting the Maximum Number of Point-to-Multipoint Connections

By default, you can have up to 40 simultaneous point-to-multipoint connections 
on a circuit at any given time. However, you can specify a value from 0 to 32,767 
connections.

Using the BCC

To change the maximum number of point-to-multipoint connections, navigate to 
the signaling prompt (for example, box; atm/11/1; signaling/11/1) and enter:

point-to-multipoint-maximum <integer>

integer is a value from 0 to 32767.

For example, the following command sets the maximum number of 
point-to-multipoint connections on the ATM circuit to 100:

signaling/11/1# point-to-multipoint-maximum 100
signaling/11/1#
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Using Site Manager

To modify the maximum number of point-to-multipoint connections on the 
circuit, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling. The ATM Signaling Parameters window 
opens.

4. Set the Max Point to Multipoint 
Connections parameter. Click on Help or 
see the parameter description on 
page A-51.

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.
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Setting the Maximum Number of Parties in Multipoint Connections

By default, you can have one party in each multipoint connection on a circuit at 
any given time. However, you can specify a value from 0 to 32,767 parties.

Using the BCC

To change the maximum number of parties in multipoint connections, navigate to 
the signaling prompt (for example, box; atm/11/1; signaling/11/1) and enter:

parties-multipoint-maximum <integer>

integer is a value from 0 to 32767.

For example, the following command sets the maximum number of parties in 
multipoint connections to 2:

signaling/11/1# parties-multipoint-maximum 2
signaling/11/1#

Using Site Manager

To modify the maximum number of parties allowed in multipoint connections, 
complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling. The ATM Signaling Parameters window 
opens.

4. Set the Max Parties in Multipoint 
Connections parameter. Click on Help or 
see the parameter description on 
page A-52.

5. Click on Done. You return to the Edit ATM Connector 
window.

(continued)
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Setting the Minimum Memory Threshold

The minimum memory threshold defines the minimum percentage of buffer 
memory required to enable a new call. The default value is 20 percent, but you can 
specify a percentage from 10 to 100 percent in increments of 10 (for example, 10 
percent, 30 percent, and so on).

Using the BCC

To change the minimum memory threshold, navigate to the signaling prompt (for 
example, box; atm/11/1; signaling/11/1) and enter:

minimum-memory-threshold <value>

value is a percentage from 10 to 100 (in increments of 10).

For example, the following command sets the minimum memory threshold value 
to 30 percent:

signaling/11/1# minimum-memory-threshold 30
signaling/11/1#

Using Site Manager

To change the minimum memory threshold, complete the following tasks:

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

(continued)

Site Manager Procedure (continued)

You do this System responds
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Defining Signaling Timer Resolution

The signaling timer resolution specifies how much time has elapsed (in tenths of a 
second) between successive timer events.

To change the signaling timer resolution, navigate to the signaling prompt (for 
example, box; atm/11/1; signaling/11/1) and enter:

signaling-timer-resolution <value>

value is the amount of time (in tenths of a second) that you want the signaling 
timer resolution to use.

For example, the following command sets the signaling timer resolution to 2048:

signaling/11/1# signaling-timer-resolution 2048
signaling/11/1#

3. Click on ATM Signaling. The ATM Signaling Parameters window 
opens.

4. Set the Min Memory Threshold 
parameter. Click on Help or see the 
parameter description on page A-52.

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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Defining Signaling Timers

You can change the default values for signaling timers. Table 4-1 provides the 
BCC name, Site Manager name, default value, range, and description for each 
timer.

Caution: Nortel Networks strongly recommends that you use default timer 
values. These values work properly under most ATM network conditions. 
However, if you do change any of the timer values, you must also change the 
values at the other end of the UNI (that is, at the local ATM switch).

Table 4-1. Signaling Timer Descriptions

BCC
Name

Site 
Manager 
Name

Default
Value Range Description

alert-rx-timer T301 180 180 to 
1024

Specifies the Alert Received timer value (in 
seconds). This timer begins when the circuit 
initiates a call/connection request by receiving an 
ALERT message over the signaling VC.

The Alert Received timer stops when the circuit 
receives a CONNECT message (indicating 
connection) from the network.

If the circuit does not receive a CONNECT 
message within the allotted time, it clears the 
connection.

This timer can be used with UNI Version 4.0 and 
later.

(continued)
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setup-tx-timer T303 4 1 to 24 Specifies the Setup Sent timer value (in seconds). 
This timer begins when the circuit initiates a call/
connection request by sending a SETUP message 
over the signaling VC.

The Setup Sent timer stops when the circuit 
receives a CONNECT message (indicating 
connection), a CALL PROCEEDING message 
(indicating that the network received the SETUP 
message), or a RELEASE COMPLETE message 
(indicating the rejection of the SETUP message) 
from the network.

If the circuit does not receive one of these 
messages within the allotted time, it transmits the 
SETUP message again. If the circuit still does not 
receive a response, it clears the connection.

setup-ack-rx-timer T304 30 30 to 120 Specifies the Setup Acknowledgement timer value 
(in seconds). This timer begins when the circuit 
receives a SETUP ACK message after initiating a 
call/connection request, and restarts when the 
circuit sends an INFO message over the signaling 
VC. 

The Setup Acknowledgement timer stops when the 
circuit receives a CONNECT message (indicating 
connection), a CALL PROCEEDING message 
(indicating that the network received the SETUP 
message), or an ALERT from the network.

If the circuit does not receive one of these 
messages within the allotted time, it clears the 
connection.

This timer can be used with UNI Version 4.0 and 
later.

(continued)

Table 4-1. Signaling Timer Descriptions (continued)

BCC
Name

Site 
Manager 
Name

Default
Value Range Description
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release-tx-timer T308 30 1 to 180 Specifies the Release Sent timer value (in 
seconds). This timer begins when the circuit sends 
a RELEASE message to initiate clearing of an SVC. 
Sending a RELEASE message places the network 
in the Release Request state.

The Release Sent timer stops when the circuit 
receives from the network either a RELEASE 
message (that is, both the circuit and the network 
sent RELEASE messages at the same time) or a 
RELEASE COMPLETE message.

If the timer expires before the circuit receives one of 
these messages, the circuit transmits the RELEASE 
message again. If the circuit still does not receive a 
response, the circuit releases the call reference and 
begins a restart procedure.

datalink-connect-
timer

T309 10 1 to 540 Specifies the SAAL Data Link Connect timer value 
(in seconds). This timer begins when a signaling 
AAL malfunction occurs.

The SAAL Data Link Connect timer stops when the 
circuit reestablishes SAAL (that is, when the circuit 
sends an AAL-ESTABLISH-REQUEST and 
receives an AAL-ESTABLISH-CONFIRM message).

If the timer expires before the circuit can reestablish 
SAAL, the circuit clears the connection.

call-proceeding-
rx-timer

T310 10 1 to 60 Specifies the Call Proceeding Received timer value 
(in seconds). This timer begins when the circuit 
receives a CALL PROCEEDING message from the 
network.

If the signaling VC does not receive a CONNECT or 
RELEASE message before this timer expires, it 
clears the connection for that virtual circuit.

(continued)

Table 4-1. Signaling Timer Descriptions (continued)

BCC
Name

Site 
Manager 
Name

Default
Value Range Description
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connect-tx-timer T313 4 1 to 24 Specifies the Connect Sent timer value (in 
seconds). This timer begins when the circuit sends 
a CONNECT message to the network.

The Connect Sent timer stops when the circuit 
receives a CONNECT ACKNOWLEDGE message 
from the network (indicating the completion of the 
ATM connection for that interface).

If the timer expires before the circuit receives a 
CONNECT ACKNOWLEDGE message, the circuit 
clears the connection.

restart-request-tx-
interface-timer

T316 120 1 to 720 Specifies the Restart Request Sent on Interface 
timer value (in seconds). This timer begins when 
the circuit sends a RESTART message to the 
network. The circuit uses the RESTART message to 
return all VCs on the interface to the idle condition.

The Restart Request Sent on Interface timer stops 
when the circuit receives a RESTART 
ACKNOWLEDGE message from the network.

If the timer expires before the circuit receives a 
RESTART ACKNOWLEDGE message, the circuit 
can retransmit the RESTART message (see 
“Setting the Number of Allowable Restart 
Messages” on page 4-25). If the circuit still does not 
receive a response, the circuit enters the null state 
until the appropriate maintenance action is taken.

(continued)

Table 4-1. Signaling Timer Descriptions (continued)

BCC
Name

Site 
Manager 
Name

Default
Value Range Description
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restart-request-tx-
channel-timer

T316c 120 1 to 720 Specifies the Restart Request Sent on Channel 
timer value (in seconds). This timer begins when 
the circuit sends a RESTART message to the 
network. The circuit uses the RESTART message to 
return this individual VC on the interface to the idle 
condition.

The Restart Request Sent on Channel timer stops 
when the circuit receives a RESTART 
ACKNOWLEDGE message from the network.

If the timer expires before the circuit receives a 
RESTART ACKNOWLEDGE message, the circuit 
can retransmit the RESTART message (see 
“Setting the Number of Allowable Restart 
Messages” on page 4-25). If the circuit still does not 
receive a response, the circuit enters the null state 
until the appropriate maintenance action is taken.

status-enquiry-tx-
timer

T322 4 1 to 24 Specifies the Status Enquiry Sent timer value (in 
seconds). This timer begins when the circuit sends 
a STATUS ENQUIRY message to the network. This 
message checks the validity of a call by requesting 
the call state (that is, active, in progress, or null).

The Status Enquiry Sent timer stops when the 
circuit receives a STATUS message from the 
network.

If the timer expires before the circuit receives a 
STATUS message, the circuit can retransmit the 
STATUS ENQUIRY message (see “Setting the 
Number of Allowable Status Enquiries” on 
page 4-26). If the circuit still does not receive a 
response, the circuit clears the call.

(continued)

Table 4-1. Signaling Timer Descriptions (continued)

BCC
Name

Site 
Manager 
Name

Default
Value Range Description
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disconnect-timer TDisc 4 1 to 180 Specifies the SAAL Data Link Disconnect timer 
value (in seconds). This internal timer alerts upper 
layers that the link is down. The timer begins if the 
entire link goes down for any reason.

When the link goes down, the SAAL sends a 
DISCONNECT REQUEST message to the 
upper-layer application manager. The SAAL sends 
a disconnect request every time the SAAL Data 
Link Disconnect timer expires and continues to 
send this message until the link becomes 
operational.

alerting-rx-timer T397 180 180 to 
1024

Specifies the Alerting Received timer value (in 
seconds). This timer begins when the circuit 
receives an ALERTING or ADD PARTY ALERTING 
message over the signaling VC. 

The Alerting Received timer stops when the circuit 
receives an ADD PARTY ACKNOWLEDGE 
message. The first time that the timer expires, the 
circuit sends a DROP PART or RELEASE message. 
When the timer expires a second time, the timer will 
not restart.

This timer can be used with UNI Version 4.0 and 
later.

(continued)

Table 4-1. Signaling Timer Descriptions (continued)

BCC
Name

Site 
Manager 
Name

Default
Value Range Description
308612-14.20 Rev 00 4-21



Configuring ATM Services
drop-party-tx-
timer

T398 4 1 to 24 Specifies the Drop Party Sent timer value (in 
seconds). This timer applies to multipoint 
connections only and begins when the circuit sends 
a DROP PARTY message to a party (the receiver of 
the message) on the network.

The Drop Party Sent timer stops when the circuit 
receives a DROP PARTY ACKNOWLEDGE 
message (indicating that the end point used for the 
party has been released) or a RELEASE message 
(indicating that the end point used for the party has 
been released and there are no remaining parties).

The first time that the timer expires, the circuit 
sends a DROP PARTY ACKNOWLEDGE or a 
RELEASE message. When the timer expires a 
second time, it will not restart.

add-party-tx-
timer

T399 14 1 to 84 Specifies the Add Party Sent timer value (in 
seconds). This timer applies to multipoint 
connections only and begins when the circuit sends 
an ADD PARTY message to a party (the receiver of 
the message) on the network.

The Add Party Sent timer stops when the circuit 
receives an ADD PARTY ACKNOWLEDGE 
message (indicating the connection to the party), an 
ADD PARTY REJECT message (indicating the 
inability to add the party), or a RELEASE message 
(indicating the inability to add the party and the 
absence of any remaining parties).

The first time that the timer expires, the circuit 
sends a DROP PARTY or a RELEASE message. 
When the timer expires a second time, it will not 
restart.

If the timer expires before the circuit receives an 
ADD PARTY ACKNOWLEDGE, ADD PARTY 
REJECT, or RELEASE message, the circuit clears 
the party. 

Table 4-1. Signaling Timer Descriptions (continued)

BCC
Name

Site 
Manager 
Name

Default
Value Range Description
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Using the BCC

To change a timer value, navigate to the signaling timers prompt (for example,
box; atm/11/1; signaling/11/1; timers/11/1) and enter:

<timer_name> <integer>

timer_name is the BCC name for the timer (see Table 4-1 for the names and 
descriptions of signaling timers).

integer is the time value (in seconds) that you want the timer to use.

For example, the following command changes the disconnect timer to 8 seconds:

timers/11/1# disconnect-timer 8
timers/11/1#

Using Site Manager

To change a signaling timer value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling. The ATM Signaling Parameters window 
opens.

(continued)
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4. Set one or more of the following timers:
• T301
• T303
• T304
• T308
• T309
• T310
• T313
• T316
• T316c
• T322
• TDisc
• T397
• T398
• T399
Click on Help or see the parameter 
descriptions beginning on page A-55.

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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Defining Retransmissions

The ATM circuit can retransmit a specified number of RESTART and STATUS 
ENQUIRY messages before it considers the link down. You can control how many 
of these messages the circuit retransmits.

Setting the Number of Allowable Restart Messages

By default, the circuit can retransmit three RESTART messages before it 
considers the link down. However, you can set the number of RESTART messages 
that the circuit can send to a value from 1 to 100.

Using the BCC

To change the number of times the ATM circuit can retransmit RESTART 
messages, navigate to the signaling timer prompt (for example,
box; atm/11/1; signaling/11/1; timers/11/1) and enter:

restarts-retransmitted <integer>

integer is the number of times a circuit can retransmit RESTART messages.

For example, the following command changes the number of times to 8:

timers/11/1# restarts-retransmitted 8
timers/11/1#

Using Site Manager

To change the number of times the circuit can retransmit RESTART messages, 
complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling. The ATM Signaling Parameters window 
opens.

(continued)
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Setting the Number of Allowable Status Enquiries

By default, the circuit can retransmit three STATUS ENQUIRY messages before it 
considers the link down. However, you can set the number of STATUS ENQUIRY 
messages that the circuit can send to a value from 1 to 100.

Using the BCC

To change the number of times the ATM circuit can retransmit STATUS 
ENQUIRY messages, navigate to the signaling timer prompt (for example,
box; atm/11/1; signaling/11/1; timers/11/1) and enter:

status-enquiries <integer>

integer is the number of times a circuit can retransmit STATUS ENQUIRY 
messages.

For example, the following command changes the number of times to 8:

timers/11/1# status-enquiries 8
timers/11/1#

4. Set the Num Restarts ReXmitted 
parameter. Click on Help or see the 
parameter description on page A-67.

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
4-26 308612-14.20 Rev 00



Customizing Signaling
 

Using Site Manager

To change the number of times the circuit can retransmit STATUS ENQUIRY 
messages, complete the following tasks:

Disabling and Reenabling Restarts

By default, signaling sends restart messages automatically when a link comes up 
from being in a down state. However, you can specify whether or not you want 
signaling to send these restart messages.

To disable automatic restart messages, navigate to the signaling prompt (for 
example, box; atm/11/1; signaling/11/1) and enter:

send-restart disabled

For example, the following command disables restart messages on the ATM 
connector:

signaling/11/1# send-restart disabled
signaling/11/1#

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling. The ATM Signaling Parameters window 
opens.

4. Set the Num Stat Enquiries ReXmitted 
parameter. Click on Help or see the 
parameter description on page A-68.

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.
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To reenable automatic restart messages, navigate to the signaling prompt and 
enter:

send-restart enabled

For example, the following command reenables restart messages on the ATM 
connector:

signaling/11/1# send-restart enabled
signaling/11/1#

Pacing Calls

You can define how the circuit paces its calls. By default, this feature is set to 0 
(off); the circuit transmits call setups at line rate. However, you can set this value 
from 0 to 2,147,483,647 calls per second.

To change how the circuit paces its calls, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling. The ATM Signaling Parameters window 
opens.

4. Set the Num Messages/Sec for Call 
Pacing parameter. Click on Help or see 
the parameter description on page A-68.

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.
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Defining ILMI

In a switched ATM network, an ATM device must register its ATM address with 
an ATM switch. The router uses the Interim Local Management Interface (ILMI) 
to send and receive initial registration data to and from an ATM switch. Using a 
series of ILMI SNMP set and get commands, the router:

1. Initializes its ATM address table for the interface (the switch also initializes its 
address table for the interface).

2. Receives the ATM address network prefix from the switch.

3. Combines this network prefix with its own user part (suffix).

4. Transmits the entire address to the switch.

Disabling and Reenabling ILMI

By default, ILMI is enabled on an interface when you enable signaling. However, 
you can disable and reenable ILMI on an interface at any time.

Using the BCC

To disable ILMI, navigate to the ILMI prompt (for example,
box; atm/11/1; signaling/11/1; ilmi/11/1) and enter:

ilmi disabled

For example, the following command disables ILMI on the ATM connector:

ilmi/11/1# ilmi disabled
ilmi/11/1#

To reenable ILMI, navigate to the ILMI prompt and enter:

ilmi enabled

For example, the following command reenables ILMI on the ATM connector:

ilmi/11/1# ilmi enabled
ilmi/11/1#
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Using Site Manager

To disable or reenable ILMI on an interface, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI).

The ATM ILMI Signaling Parameters 
window opens.

4. Set the Enable parameter. Click on Help 
or see the parameter description on 
page A-69.

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.
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Modifying ILMI Timers and Retry Counters

You can modify the following timers and their associated counters for ILMI:

• ILMI Get Request timer and retry count

• ILMI Get Next Request timer and retry count

• ILMI Set Request timer and retry count

Setting the ILMI Get Request Timer

The ILMI Get Request timer specifies the amount of time allowed for the circuit 
to receive a GET_RESPONSE message after sending a GET_REQUEST 
message. By default, the circuit waits 3 seconds for a response. However, you can 
set this timer to a value from 1 to 120 seconds.

Using the BCC

To change the ILMI Get Request timer value, navigate to the ILMI prompt (for 
example, box; atm/11/1; signaling/11/1; ilmi/11/1) and enter:

get-timer <integer>

integer is the time value (in seconds) that you want the timer to use.

For example, the following command changes the ILMI Get Request timer to 6 
seconds:

ilmi/11/1# get-timer 6
ilmi/11/1#
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Using Site Manager

To change the ILMI Get Request timer value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI).

The ATM ILMI Signaling Parameters 
window opens.

4. Set the ILMI Get Timer parameter. Click 
on Help or see the parameter description 
on page A-70.

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.
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Setting the ILMI Get Request Retry Count

The ILMI Get Request retry count specifies the number of times the circuit can 
retransmit the ILMI GET_REQUEST message before it considers the link down. 
By default, the circuit can retransmit three ILMI GET_REQUEST messages. 
However, you can set the number of retries to a value from 1 to 100.

Using the BCC

To change the ILMI Get Request retry count value, navigate to the ILMI prompt 
(for example, box; atm/11/1; signaling/11/1; ilmi/11/1) and enter:

get-retry-count <integer>

integer is the count value that you want the timer to use.

For example, the following command changes the ILMI Get Request retry count 
to 6:

ilmi/11/1# get-retry-count 6
ilmi/11/1#

Using Site Manager

To change the ILMI Get Request retry count value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI).

The ATM ILMI Signaling Parameters 
window opens.

4. Set the ILMI Get Retry Count parameter. 
Click on Help or see the parameter 
description on page A-71.

(continued)
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Setting the ILMI Get Next Request Timer

The ILMI Get Next Request timer specifies the amount of time allowed for the 
circuit to receive a GET_NEXT_RESPONSE message after sending a 
GET_NEXT_REQUEST message. By default, the circuit waits 3 seconds for a 
response. However, you can set this timer to a value from 1 to 120 seconds.

Using the BCC

To change the ILMI Get Next Request timer value, navigate to the ILMI prompt 
(for example, box; atm/11/1; signaling/11/1; ilmi/11/1) and enter:

get-next-timer <integer>

integer is the time value (in seconds) that you want the timer to use.

For example, the following command changes the ILMI Get Next Request timer 
to 6 seconds:

ilmi/11/1# get-next-timer 6
ilmi/11/1#

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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Using Site Manager

To change the ILMI Get Next Request timer value, complete the following tasks:

Setting the ILMI Get Next Request Retry Count

The ILMI Get Next Request retry count specifies the number of times the circuit 
can retransmit the ILMI GET_NEXT_REQUEST message before it considers the 
link down. By default, the circuit can retransmit three ILMI 
GET_NEXT_REQUEST messages. However, you can set the number of retries to 
a value from 1 to 100.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI).

The ATM ILMI Signaling Parameters 
window opens.

4. Set the ILMI Get Next Timer parameter. 
Click on Help or see the parameter 
description on page A-71.

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.
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Using the BCC

To change the ILMI Get Next Request retry count value, navigate to the ILMI 
prompt (for example, box; atm/11/1; signaling/11/1; ilmi/11/1) and enter:

get-next-retry-count <integer>

integer is the count value that you want the timer to use.

For example, the following command changes the ILMI Get Next Request retry 
count to 6:

ilmi/11/1# get-next-retry-count 6
ilmi/11/1#

Using Site Manager

To change the ILMI Get Next Request retry count value, complete the following 
tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI).

The ATM ILMI Signaling Parameters 
window opens.

4. Set the ILMI Get Next Retry Count 
parameter. Click on Help or see the 
parameter description on page A-71.

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.
4-36 308612-14.20 Rev 00



Customizing Signaling
 

Setting the ILMI Set Request Timer

The ILMI Set Request timer specifies the amount of time allowed for the circuit to 
receive a SET_RESPONSE message after sending a SET_REQUEST message. 
By default, the circuit waits 3 seconds for a response. However, you can set this 
timer to a value from 1 to 120 seconds.

Using the BCC

To change the ILMI Set Request timer value, navigate to the ILMI prompt (for 
example, box; atm/11/1; signaling/11/1; ilmi/11/1) and enter:

set-timer <integer>

integer is the time value (in seconds) that you want the timer to use.

For example, the following command changes the ILMI Set Request timer to 6 
seconds:

ilmi/11/1# set-timer 6
ilmi/11/1#

Using Site Manager

To change the ILMI Set Request timer value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI).

The ATM ILMI Signaling Parameters 
window opens.

4. Set the ILMI Set Timer parameter. Click 
on Help or see the parameter description 
on page A-72.

5. Click on Done. You return to the Edit ATM Connector 
window.

(continued)
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Setting the ILMI Set Request Retry Count

The ILMI Set Request retry count specifies the number of times the circuit can 
retransmit the ILMI SET_REQUEST message before it considers the link down. 
By default, the circuit can retransmit three ILMI SET_REQUEST messages. 
However, you can set the number of retries to a value from 1 to 100.

Using the BCC

To change the ILMI Set Request retry count value, navigate to the ILMI prompt 
(for example, box; atm/11/1; signaling/11/1; ilmi/11/1) and enter:

set-retry-count <integer>

integer is the count value that you want the timer to use.

For example, the following command changes the ILMI Set Request retry count 
value to 6:

ilmi/11/1# set-retry-count 6
ilmi/11/1#

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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Using Site Manager

To change the ILMI Set Request retry count value, complete the following tasks:

Defining Control VCs

Control VCs are dedicated VPI/VCI pairs reserved for signaling and ILMI 
messages. These VCs remain in an operational state as long as signaling is 
enabled on the ATM interface.

Having dedicated PVCs defined for signaling and ILMI allows the ATM router to 
send and receive initial registration data to and from an ATM switch.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI).

The ATM Signaling Parameters window 
opens.

4. Set the ILMI Set Retry Count parameter. 
Click on Help or see the parameter 
description on page A-72.

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.

Caution: Because most ATM devices use standard VPI/VCI pairs for 
signaling, Nortel Networks recommends that you not change the control VC 
values. However, you can redefine the signaling and ILMI control VCs for 
your specific network.
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Changing VPI Numbers

By default, the VPI for both the signaling and ILMI control VC is 0. However, 
you can change the VPI number to any value from 0 to 255.

Using the BCC

To change the signaling VPI number, navigate to the signaling prompt (for 
example, box; atm/11/1; signaling/11/1) and enter:

vpi <integer>

integer is the VPI number that you want the signaling VC to use.

For example, the following command changes the signaling VPI number to 8:

signaling/11/1# vpi 8
signaling/11/1#

To change the ILMI VPI number, navigate to the ILMI prompt (for example,
box; atm/11/1; signaling/11/1; ilmi/11/1) and enter:

vpi <integer>

integer is the VPI number that you want the ILMI VC to use.

For example, the following command changes the ILMI VPI number to 8:

ilmi/11/1# vpi 8
ilmi/11/1#
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Using Site Manager

To change the signaling VPI number, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling. The ATM Signaling Parameters window 
opens.

4. Click on Sig VC. The ATM Control VC for Signaling 
window opens.

5. Set the VPI parameter. Click on Help or 
see the parameter description on 
page A-53.

6. Click on Done. You return to the ATM Signaling 
Parameters window.

7. Click on Done. You return to the Edit ATM Connector 
window.

8. Click on Done. You return to the Select Connection Type 
window.

9. Click on Done. You return to the Configuration Manager 
window.
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To change the ILMI VPI number, complete the following tasks:

Changing VCI Numbers

By default, the VCI for the signaling control VC is 5 and the VCI for the ILMI 
control VC is 16. However, you can change the VCI number to any value from 1 
to 8192.

Using the BCC

To change the signaling VCI number, navigate to the signaling prompt (for 
example, box; atm/11/1; signaling/11/1) and enter:

vci <integer>

integer is the VCI number that you want the signaling VC to use.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI).

The ATM ILMI Signaling Parameters 
window opens.

4. Click on ILMI VC. The ATM Control VC for ILMI window 
opens.

5. Set the ILMI VPI parameter. Click on Help 
or see the parameter description on 
page A-69.

6. Click on Done. You return to the ATM ILMI Signaling 
Parameters window.

7. Click on Done. You return to the Edit ATM Connector 
window.

8. Click on Done. You return to the Select Connection Type 
window.

9. Click on Done. You return to the Configuration Manager 
window.
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For example, the following command changes the signaling VCI number to 32:

signaling/11/1# vci 32
signaling/11/1#

To change the ILMI VCI number, navigate to the ILMI prompt (for example,
box; atm/11/1; signaling/11/1; ilmi/11/1) and enter:

vci <integer>

integer is the VCI number that you want the ILMI VC to use.

For example, the following command changes the ILMI VCI number to 32:

ilmi/11/1# vci 32
ilmi/11/1#

Using Site Manager

To change the signaling VCI number, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling. The ATM Signaling Parameters window 
opens.

4. Click on Sig VC. The ATM Control VC for Signaling 
window opens.

5. Set the VCI parameter. Click on Help or 
see the parameter description on 
page A-54.

6. Click on Done. You return to the ATM Signaling 
Parameters window.

7. Click on Done. You return to the Edit ATM Connector 
window.

8. Click on Done. You return to the Select Connection Type 
window.

9. Click on Done. You return to the Configuration Manager 
window.
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To change the ILMI VCI number, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI).

The ATM ILMI Signaling Parameters 
window opens.

4. Click on ILMI VC. The ATM Control VC for ILMI window 
opens.

5. Set the ILMI VCI parameter. Click on Help 
or see the parameter description on 
page A-70.

6. Click on Done. You return to the ATM ILMI Signaling 
Parameters window.

7. Click on Done. You return to the Edit ATM Connector 
window.

8. Click on Done. You return to the Select Connection Type 
window.

9. Click on Done. You return to the Configuration Manager 
window.
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Modifying Control VC Traffic Parameters

You can modify the following traffic parameters for both the signaling and the 
ILMI control VCs:

• Peak cell rate (PCR)

• Sustainable cell rate (SCR)

• Maximum burst size (MBS)

For additional information about traffic parameters, see “ATM Traffic Parameters” 
on page 1-23.

Setting the PCR

The peak cell rate (PCR) specifies the upper traffic limit, in cells/s, that the ATM 
connection can support.

By default, the PCR is set to 4,716 cells/s. Table 4-2 lists the valid ranges for each 
Nortel Networks ATM router.

For additional information about the PCR, see “Using the PCR” on page 1-24.

Table 4-2. Valid PCR Ranges

ATM Router Range (Cells/s)

ATM ARE OC-3 SONET/SDH ILI pairs 128 to 353,207

Model 5782 Centillion MPE 128 to 353,207

ATM ARE DS-3 ILI pairs 128 to 96,000

ATM ARE E-3 ILI pairs; G.832 framing mode 128 to 80,000

ATM ARE E-3 ILI pairs; G.751 framing mode 128 to 72,000
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Using the BCC

To change the PCR value for the signaling VC, navigate to the signaling VC 
prompt (for example, box; atm/11/1; signaling/11/1; signaling-vc/11/1/0/5) and 
enter:

pcr <integer>

integer is the PCR value that you want the signaling VC to use.

For example, the following command changes the PCR value to 8000:

signaling-vc/11/1/0/5# pcr 8000
signaling-vc/11/1/0/5#

To change the PCR value for the ILMI VC, navigate to the ILMI VC prompt (for 
example, box; atm/11/1; signaling/11/1; ilmi-vc/11/1/0/16) and enter:

pcr <integer>

integer is the PCR value that you want the ILMI VC to use.

For example, the following command changes the ILMI VC PCR value to 8000:

ilmi-vc/11/1/0/16# pcr 8000
ilmi-vc/11/1/0/16#
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Using Site Manager

To change the signaling PCR value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling. The ATM Signaling Parameters window 
opens.

4. Click on Sig VC. The ATM Control VC for Signaling 
window opens.

5. Set the Xmit Peak Cell Rate (cells/s) 
parameter. Click on Help or see the 
parameter description on page A-73.

6. Click on Done. You return to the ATM Signaling 
Parameters window.

7. Click on Done. You return to the Edit ATM Connector 
window.

8. Click on Done. You return to the Select Connection Type 
window.

9. Click on Done. You return to the Configuration Manager 
window.
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To change the ILMI PCR value, complete the following tasks:

Setting the SCR

The sustainable cell rate (SCR) is the upper bound on the conforming average rate 
of an individual PVC or control VC. The average rate is the number of cells 
transmitted over the link divided by the duration of the connection. The duration 
of the connection is the total amount of time it takes from connection setup to 
connection release.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI).

The ATM ILMI Signaling Parameters 
window opens.

4. Click on ILMI VC. The ATM Control VC for ILMI window 
opens.

5. Set the Xmit Peak Cell Rate (cells/s) 
parameter. Click on Help or see the 
parameter description on page A-73.

6. Click on Done. You return to the ATM ILMI Signaling 
Parameters window.

7. Click on Done. You return to the Edit ATM Connector 
window.

8. Click on Done. You return to the Select Connection Type 
window.

9. Click on Done. You return to the Configuration Manager 
window.
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By default, the SCR is set to 4,716 cells/s. Table 4-3 lists the valid ranges for each 
Nortel Networks ATM router. To disable the SCR, set the value to 0.

For additional information about the SCR, see “Using the SCR” on page 1-25.

Using the BCC

To change the SCR value for signaling VCs, navigate to the signaling VC prompt 
(for example, box; atm/11/1; signaling/11/1; signaling-vc/11/1/0/5) and enter:

scr <integer>

integer is the SCR value that you want the signaling VC to use.

For example, the following command changes the signaling VC SCR value to 
8000:

signaling-vc/11/1/0/5# scr 8000
signaling-vc/11/1/0/5#

To change the ILMI SCR value, navigate to the ILMI VC prompt (for example, 
box; atm/11/1; signaling/11/1; ilmi-vc/11/1/0/16) and enter:

scr <integer>

integer is the SCR value that you want the ILMI VC to use.

For example, the following command changes the ILMI VC SCR value to 8000:

ilmi-vc/11/1/0/16# scr 8000
ilmi-vc/11/1/0/16#

Table 4-3. Valid SCR Ranges

ATM Router Range (Cells/s)

ATM ARE OC-3 SONET/SDH ILI pairs 0, 128 to 353,207

Model 5782 0, 128 to 353,207

ATM ARE DS-3 ILI pairs 0, 128 to 96,000

ATM ARE E-3 ILI pairs; G.832 framing mode 0, 128 to 80,000

ATM ARE E-3 ILI pairs; G.751 framing mode 0, 128 to 72,000
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Using Site Manager

To change the signaling SCR value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling. The ATM Signaling Parameters window 
opens.

4. Click on Sig VC. The ATM Control VC for Signaling 
window opens.

5. Set the Xmit Sustainable Cell Rate 
(cells/s) parameter. Click on Help or see 
the parameter description on page A-74.

6. Click on Done. You return to the ATM Signaling 
Parameters window.

7. Click on Done. You return to the Edit ATM Connector 
window.

8. Click on Done. You return to the Select Connection Type 
window.

9. Click on Done. You return to the Configuration Manager 
window.
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To change the ILMI SCR value, complete the following tasks:

Setting the MBS

The maximum burst size (MBS) specifies the maximum number of sequential 
cells allowed on a VC before that VC must relinquish bandwidth to other VCs 
waiting to transmit. This burst occurs at or close to the peak cell rate.

When setting the MBS, you should select a value larger than the largest packet 
your control VC can transmit (that is, the size of the maximum AAL CPCS 
transmit SDU). For example, if your VC accepts packets that are less than 4,608 
bytes long (PVC default), set your MBS value between 45 and 50 cells.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI).

The ATM ILMI Signaling Parameters 
window opens.

4. Click on ILMI VC. The ATM Control VC for ILMI window 
opens.

5. Set the Xmit Sustainable Cell Rate 
(cells/s) parameter. Click on Help or see 
the parameter description on page A-74.

6. Click on Done. You return to the ATM ILMI Signaling 
Parameters window.

7. Click on Done. You return to the Edit ATM Connector 
window.

8. Click on Done. You return to the Select Connection Type 
window.

9. Click on Done. You return to the Configuration Manager 
window.

Note: The ARE and 5782 processor modules do not support the MBS 
parameter.
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By default, the MBS is set to 40 cells. However, you can set the MBS to any value 
from 1 to 65,535 cells.

For additional information about the MBS, see “Using the MBS” on page 1-26. 
For information about setting the maximum AAL CPCS transmit SDU size, see 
“Modifying the Maximum AAL CPCS SDU Size” on page 4-55.

Using the BCC

To change the MBS value for signaling VCs, navigate to the signaling VC prompt 
(for example, box; atm/11/1; signaling/11/1; signaling-vc/11/1/0/5) and enter:

tx-burst-size <integer>

integer is the MBS value that you want the signaling VC to use.

For example, the following command changes the MBS value to 80 cells:

signaling-vc/11/1/0/5# tx-burst-size 80
signaling-vc/11/1/0/5#

To change the MBS value for ILMI VCs, navigate to the ILMI VC prompt (for 
example, box; atm/11/1; signaling/11/1; ilmi-vc/11/1/0/16) and enter:

tx-burst-size <integer>

integer is the MBS value that you want the ILMI VC to use.

For example, the following command changes the MBS value to 80 cells:

ilmi-vc/11/1/0/16# tx-burst-size 80
ilmi-vc/11/1/0/16#
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Using Site Manager

To change the signaling control VC MBS value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling. The ATM Signaling Parameters window 
opens.

4. Click on Sig VC. The ATM Control VC for Signaling 
window opens.

5. Set the Xmit Burst Size (cells) 
parameter. Click on Help or see the 
parameter description on page A-75.

6. Click on Done. You return to the ATM Signaling 
Parameters window.

7. Click on Done. You return to the Edit ATM Connector 
window.

8. Click on Done. You return to the Select Connection Type 
window.

9. Click on Done. You return to the Configuration Manager 
window.
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To change the ILMI control VC MBS value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI).

The ATM ILMI Signaling Parameters 
window opens.

4. Click on ILMI VC. The ATM Control VC for ILMI window 
opens.

5. Set the Xmit Burst Size (cells) 
parameter. Click on Help or see the 
parameter description on page A-75.

6. Click on Done. You return to the ATM ILMI Signaling 
Parameters window.

7. Click on Done. You return to the Edit ATM Connector 
window.

8. Click on Done. You return to the Select Connection Type 
window.

9. Click on Done. You return to the Configuration Manager 
window.
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Modifying the Maximum AAL CPCS SDU Size

The maximum AAL CPCS SDU value defines the maximum packet size you 
intend the control VC to transmit or receive.

Setting the Transmit SDU Size

Nortel Networks suggests that you accept the default value of 4,608 bytes for the 
maximum AAL CPCS SDU size that the control VC supports in the transmit 
direction. Most packet sizes fall well within this limit. However, you can set the 
transmit SDU size to any value from 1 to 65,535 bytes.

Using the BCC

To change the transmit SDU size for the signaling control VC, navigate to the 
signaling VC prompt (for example, box; atm/11/1; signaling/11/1;
signaling-vc/11/1/0/5) and enter:

tx-sdu-maximum <integer>

integer is the maximum SDU size that you want the signaling VC to transmit.

For example, the following command changes the maximum transmit SDU size to 
65,535 bytes:

signaling-vc/11/1/0/5# tx-sdu-maximum 65535
signaling-vc/11/1/0/5#

To change the transmit SDU size for the ILMI control VC, navigate to the ILMI 
VC prompt (for example, box; atm/11/1; signaling/11/1; ilmi-vc/11/1/0/16) and 
enter:

tx-sdu-maximum <integer>

integer is the maximum SDU size that you want the ILMI VC to transmit.

For example, the following command changes the maximum transmit SDU size to 
65,535 bytes:

ilmi-vc/11/1/0/16# tx-sdu-maximum 65535
ilmi-vc/11/1/0/16#
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Using Site Manager

To change the maximum transmit SDU size for the signaling control VC, 
complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling. The ATM Signaling Parameters window 
opens.

4. Click on Sig VC. The ATM Control VC for Signaling 
window opens.

5. Set the Maximum AAL CPCS Transmit 
SDU Size parameter. Click on Help or see 
the parameter description on page A-76.

6. Click on Done. You return to the ATM Signaling 
Parameters window.

7. Click on Done. You return to the Edit ATM Connector 
window.

8. Click on Done. You return to the Select Connection Type 
window.

9. Click on Done. You return to the Configuration Manager 
window.
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To change the maximum transmit SDU size for the ILMI control VC, complete 
the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI).

The ATM ILMI Signaling Parameters 
window opens.

4. Click on ILMI VC. The ATM Control VC for ILMI window 
opens.

5. Set the Maximum AAL CPCS Transmit 
SDU Size parameter. Click on Help or see 
the parameter description on page A-76.

6. Click on Done. You return to the ATM ILMI Signaling 
Parameters window.

7. Click on Done. You return to the Edit ATM Connector 
window.

8. Click on Done. You return to the Select Connection Type 
window.

9. Click on Done. You return to the Configuration Manager 
window.
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Setting the Receive SDU Size

Nortel Networks suggests that you accept the default value of 4,608 bytes for the 
maximum AAL CPCS SDU size that the control VC supports in the receive 
direction. Most packet sizes fall well within this limit. However, you can set the 
receive SDU size to any value from 1 to 65,535 bytes.

Using the BCC

To change the receive SDU size for the signaling control VC, navigate to the 
signaling VC prompt (for example, box; atm/11/1; signaling/11/1;
signaling-vc/11/1/0/5) and enter:

rx-sdu-maximum <integer>

integer is the maximum SDU size that you want the signaling VC to receive.

For example, the following command changes the maximum receive SDU size to 
65,535 bytes:

signaling-vc/11/1/0/5# rx-sdu-maximum 65535
signaling-vc/11/1/0/5#

To change the receive SDU size for the ILMI control VC, navigate to the ILMI 
VC prompt (for example, box; atm/11/1; signaling/11/1; ilmi-vc/11/1/0/16) and 
enter:

rx-sdu-maximum <integer>

integer is the maximum SDU size that you want the ILMI VC to receive.

For example, the following command changes the maximum receive SDU size to 
65,535 bytes:

ilmi-vc/11/1/0/16# rx-sdu-maximum 65535
ilmi-vc/11/1/0/16#
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Using Site Manager

To change the maximum receive SDU size for the signaling control VC, complete 
the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on ATM Signaling. The ATM Signaling Parameters window 
opens.

4. Click on Sig VC. The ATM Control VC for Signaling 
window opens.

5. Set the Maximum AAL CPCS Receive 
SDU Size parameter. Click on Help or see 
the parameter description on page A-76.

6. Click on Done. You return to the ATM Signaling 
Parameters window.

7. Click on Done. You return to the Edit ATM Connector 
window.

8. Click on Done. You return to the Select Connection Type 
window.

9. Click on Done. You return to the Configuration Manager 
window.
308612-14.20 Rev 00 4-59



Configuring ATM Services
To change the maximum receive SDU size for the ILMI control VC, complete the 
following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Interim Local Management 
Interface (ILMI).

The ATM ILMI Signaling Parameters 
window opens.

4. Click on ILMI VC. The ATM Control VC for ILMI window 
opens.

5. Set the Maximum AAL CPCS Receive 
SDU Size parameter. Click on Help or see 
the parameter description on page A-76.

6. Click on Done. You return to the ATM ILMI Signaling 
Parameters window.

7. Click on Done. You return to the Edit ATM Connector 
window.

8. Click on Done. You return to the Select Connection Type 
window.

9. Click on Done. You return to the Configuration Manager 
window.
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Defining SSCOP/Signaling AAL

As defined by the ATM Forum, the SSCOP (or Q.SAAL) resides between the 
ATM adaptation layer and the Q.2931 signaling layer. SSCOP/SAAL reliably 
transports signaling messages between peer Q.2931 entities over the ATM 
adaptation layer (Figure 4-2).

Figure 4-2. SVC/PVC Signaling Protocol Stack

Nortel Networks routers support SSCOP/SAAL functions as defined in the ATM 
Forum ATM User-Network Interface specification (Versions 3.0 and 3.1).
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Disabling and Reenabling SSCOP/SAAL

By default, SSCOP/SAAL is enabled on an interface when you create the circuit. 
However, you can disable or reenable this signaling on an interface at any time.

Using the BCC

To disable SSCOP on the interface, navigate to the SSCOP prompt (for example,
box; atm/11/1; signaling/11/1; sscop/11/1) and enter:

state disabled

For example, the following command disables SSCOP on the ATM interface:

sscop/11/1# state disabled
sscop/11/1#

To reenable SSCOP, navigate to the SSCOP prompt and enter:

state enabled

For example, the following command reenables SSCOP on the ATM interface:

sscop/11/1# state enabled
sscop/11/1#
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Using Site Manager

To disable or reenable SSCOP, complete the following tasks:

Defining the Link Connection Arbitration

Link connection arbitration defines whether SSCOP/SAAL initiates link 
connections (active, the default value) or waits for connections (passive).

Using the BCC

To make link connection arbitration passive, navigate to the SSCOP prompt (for 
example, box; atm/11/1; signaling/11/1; sscop/11/1) and enter:

link-connect-arbitration passive

For example, the following command specifies that SSCOP waits for connections:

sscop/11/1# link-connect-arbitration passive
sscop/11/1#

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Signaling AAL (SAAL). The ATM Signaling AAL Records List 
window opens.

4. Set the Enable parameter. Click on Help 
or see the parameter description on 
page A-77.

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.
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To change link connection arbitration to active, navigate to the SSCOP prompt 
and enter:

link-connect-arbitration active

For example, the following command specifies that SSCOP initiates connections:

sscop/11/1# link-connect-arbitration active
sscop/11/1#

Using Site Manager

To set the SSCOP link arbitration state, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Signaling AAL (SAAL). The ATM Signaling AAL Records List 
window opens.

4. Set the Link Connection Arbitration 
parameter. Click on Help or see the 
parameter description on page A-77.

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.
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Modifying SAAL Timers

You can change the default values for SSCOP/SAAL timers. For each timer, 
Table 4-4 provides the BCC name, Site Manager name, default value, range, and 
description.

Note: Nortel Networks recommends that you leave these timers set to their 
default values unless instructed to change them by Nortel Networks Customer 
Service or your switch provider.

Table 4-4. SSCOP/SAAL Timer Descriptions

BCC Name

Site 
Manager 
Name

Default 
Value Range Description

poll-timer Poll Timer 7 1 to 120 Specifies the SSCOP poll timer value (in tenths of a 
second). This value sets the allowable time between 
POLL PDU transmissions.

The poll timer ensures that the receiver continues to 
return a solicited status (STAT) PDU to the sender on a 
regular basis. The timely receipt of STAT PDUs restarts 
the poll timer and allows for more efficient transmission 
error recovery.

keep-alive-
timer

Keep Alive 
Timer

20 1 to 120 Specifies the SSCOP keep alive timer value (in tenths of 
a second). This value sets the allowable time between 
POLL PDU transmissions if there are no pending 
sequenced data (SD) PDUs.

The keep alive timer is generally greater than the poll 
timer and greater than the length of one round-trip delay.

(continued)
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Using the BCC

To change an SSCOP timer value, navigate to the SSCOP prompt (for example,
box; atm/11/1; signaling/11/1; sscop/11/1) and enter:

<timer_name> <integer>

timer_name is the BCC name for the timer (see Table 4-4 for the names and 
descriptions of SSCOP timers).

integer is the time value (in tenths of a second) that you want the timer to use.

For example, the following command changes the poll timer to 2 seconds.

sscop/11/1# poll-timer 20
sscop/11/1#

no-response-
timer

No 
Response 
Timer

70 1 to 120 Specifies the SSCOP no response timer value (in tenths 
of a second). This value sets the allowable time between 
the receipt of STAT PDUs.

So as not to interrupt the flow of data, SSCOP does not 
require a reply to every POLL PDU. This can cause 
problems in detecting a failed connection. To alleviate 
this problem, the no response timer runs parallel to the 
poll timer. If both the no response timer and the poll 
timer expire, SSCOP clears the connection.

The no response timer value must equal at least the sum 
of the keep alive timer plus the length of one round-trip 
delay.

connection-
control-timer

Connection 
Control 
Timer

10 1 to 120 Specifies the SSCOP connection control (CC) timer 
value (in tenths of a second). This value sets the 
allowable time between the transmission of begin 
(BGN), END, resynchronization (RS), and error recovery 
(ER) PDUs, as long as the sender has not received an 
acknowledgment to any of these PDUs.

The CC timer must equal at least the length of one 
round-trip delay.

Table 4-4. SSCOP/SAAL Timer Descriptions (continued)

BCC Name

Site 
Manager 
Name

Default 
Value Range Description
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Using Site Manager

To change an SSCOP/SAAL timer value, complete the following tasks:

Defining PDU Values

SSCOP/SAAL allows you to customize several values that control PDUs.

Setting the SSCOP Maximum Connection Control Value

The SSCOP maximum connection control value sets the maximum number of 
times the sender can transmit a BGN, END, RS, or ER PDU.

By default, the sender can transmit up to four of these messages. However, you 
can set this parameter to any value from 1 to 20 messages.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Signaling AAL (SAAL). The ATM Signaling AAL Records List 
window opens.

4. Set one or more of the following 
parameters:
• Poll Timer
• Keep Alive Timer
• No Response Timer
• Connection Control Timer
Click on Help or see the parameter 
descriptions beginning on page A-78.

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.
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Using the BCC

To change the maximum connection control value, navigate to the SSCOP prompt 
(for example, box; atm/11/1; signaling/11/1; sscop/11/1) and enter:

connect-control-maximum <integer>

integer is the count value that you want the controller to use.

For example, the following command changes the maximum connection control 
value to 6:

sscop/11/1# connect-control-maximum 6
sscop/11/1#

Using Site Manager

To change the maximum connection control value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Signaling AAL (SAAL). The ATM Signaling AAL Records List 
window opens.

4. Set the Max Connection Control 
parameter. Click on Help or see the 
parameter description on page A-80.

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.
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Setting the SSCOP Maximum Poll Data Value

The SSCOP maximum poll data value sets the maximum value of the poll data 
state variable before transmitting a POLL PDU. The poll data state variable 
increments upon transmission of a sequenced data PDU and resets to 0 upon 
transmission of a POLL PDU.

By default, the maximum poll data value sets the poll data state to 25. However, 
you can set this parameter to any value from 1 to 120.

Using the BCC

To change the maximum poll data value, navigate to the SSCOP prompt (for 
example, box; atm/11/1; signaling/11/1; sscop/11/1) and enter:

pd-before-poll-maximum <integer>

integer is the count value that you want the controller to use.

For example, the following command changes the maximum poll data value to 50:

sscop/11/1# pd-before-poll-maximum 50
sscop/11/1#

Using Site Manager

To change the maximum poll data value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Signaling AAL (SAAL). The ATM Signaling AAL Records List 
window opens.

4. Set the Max PD Before Poll parameter. 
Click on Help or see the parameter 
description on page A-80.

5. Click on Done. You return to the Edit ATM Connector 
window.

(continued)
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Setting the SSCOP Maximum STAT PDU Value

The SSCOP maximum STAT PDU value sets the maximum number of list 
elements allowed in a STAT PDU.

The sending device uses this value for segmentation purposes. When the number 
of list elements exceeds this value, the STAT message segments. As a general rule, 
the default value, 67, causes the STAT PDU to fill six ATM cells using
AAL 5. You can set this value to any odd integer from 3 to 119.

Using the BCC

To change the maximum number of list elements allowed in a STAT PDU, 
navigate to the SSCOP prompt (for example, box; atm/11/1; signaling/11/1; 
sscop/11/1) and enter:

stat-pdu-elements-maximum <integer>

integer is the maximum number of elements (any odd number from 3 to 119) 
allowed in a STAT PDU.

For example, the following command changes the maximum number of STAT 
PDU elements to 81:

sscop/11/1# stat-pdu-elements-maximum 81
sscop/11/1#

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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Using Site Manager

To change the maximum number of list elements allowed in a STAT PDU, 
complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Signaling AAL (SAAL). The ATM Signaling AAL Records List 
window opens.

4. Set the Max STAT PDU Elements 
parameter. Click on Help or see the 
parameter description on page A-81.

5. Click on Done. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.
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Where to Go Next

Use the following table to determine where to go next. 

If you want to Go to

Learn about ATM concepts. Chapter 1

Start ATM. Chapter 2

Change default settings for ATM interface parameters. Chapter 3

Change default settings for ATM PVC service record and PVC 
parameters.

Chapter 5

Customize traffic shaping parameters for the Passport 5430. Chapter 6

Change default settings for classical IP service record parameters. Chapter 7

Change default settings for LAN Emulation client service record 
parameters.

Chapter 8

Change default settings for ATM WAN SVC service record and WAN 
SVC parameters.

Chapter 9

Change the default settings for CES parameters. Chapter 10

Change default settings for the ATM router redundancy parameter. Chapter 11

Obtain information about Site Manager parameters. Appendix A

Monitor ATM using the BCC show commands. Appendix B
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Chapter 5
Customizing PVC Service

Records and PVCs

When you start ATM on the router, all parameters use their default values. 
Depending on the requirements of your network, you may want to change some of 
these values. This chapter describes how to customize PVC service record 
parameters and how to define the PVCs that operate on PVC service records. It 
includes the following information:

Topic Page

Disabling and Reenabling a PVC Service Record 5-2

Defining the Service Record MTU 5-3

Changing the Service Name 5-5

Deleting a Service Record 5-6

Designating a PVC as Hybrid/Bridged 5-7

Disabling and Reenabling a PVC 5-8

Modifying ATM Traffic Parameters 5-10

Modifying the Maximum AAL CPCS SDU Size 5-14

Assigning a Data Encapsulation Type 5-17

Changing PVC OAM Parameters 5-19

Copying a PVC 5-23

Deleting a PVC 5-24

Where to Go Next 5-26
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This chapter describes how to customize existing PVC service records and PVCs. 
For instructions on how to define a new PVC service record and PVC, see 
Chapter 2, “Starting ATM and ATM Router Redundancy.”

Disabling and Reenabling a PVC Service Record

By default, you enable a service record when you add it to the interface. However, 
you can disable and reenable a specific service record at any time. Disable the 
service record to stop traffic flow over it and any of its VCs. Otherwise, enable the 
service record.

Using the BCC

To disable a PVC service record, navigate to the service record prompt (for 
example, box; atm/11/1; pvc-service/boston) and enter:

state disabled

For example, the following command disables the PVC service record:

pvc-service/boston# state disabled
pvc-service/boston#

To reenable a PVC service record, navigate to the prompt and enter:

state enabled

For example, the following command reenables the PVC service record:

pvc-service/boston# state enabled
pvc-service/boston#

Note: This chapter describes PVC parameters that are common to all ATM 
routers (BN, System 5000, and the Passport 5430). The Passport 5430 also 
supports other traffic-shaping parameters not supported on the BN or the 
System 5000. For instructions on how to customize the Passport 5430 
traffic-shaping parameters, see Chapter 6, “Customizing Traffic Shaping 
Parameters for the Passport 5430.”
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Using Site Manager

To disable or reenable a PVC service record, complete the following tasks:

Defining the Service Record MTU

The maximum transmission unit (MTU) is the largest possible unit of data that the 
PVC service record can transmit. By default, the service record allows an MTU 
size of 4608 octets. This value can handle most packet sizes.

The MTU size is typically determined by the driver. However, you can override 
the driver default to accommodate connection to devices that require different 
MTU sizes. You can set the MTU to any value from 1 through 9188 octets.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Set the Enable/Disable parameter. Click 
on Help or see the parameter description 
on page A-14.

6. Click on Done. You return to the Edit ATM Connector 
window.

7. Click on Done. You return to the ATM Configuration or 
the Select Connection Type window.

8. Click on Done. You return to the Configuration Manager 
window.

Note: Some ATM devices do not negotiate MTU size. When connecting to 
such a device, Nortel Networks recommends that you specify an MTU size of 
9188 octets for full compatibility with RFC 1577.
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Using the BCC

To change the MTU value of the PVC service record, navigate to the service 
record prompt (for example, box; atm/11/1; pvc-service/boston) and enter:

mtu <integer>

integer is the MTU size in octets that you want the PVC service record to use.

For example, the following command sets the service record MTU size to 9188 
octets:

pvc-service/boston# mtu 9188
pvc-service/boston#

Using Site Manager

To change the MTU size for a service record, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Set the MTU parameter. Click on Help or 
see the parameter description on 
page A-19.

6. Click on Done. You return to the Edit ATM Connector 
window.

7. Click on Done. You return to the ATM Configuration or 
the Select Connection Type window.

8. Click on Done. You return to the Configuration Manager 
window.
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Changing the Service Name

The service name is a value that uniquely defines each service record that you 
create. In the BCC, you enter the service name when you create the service record. 
You cannot change that name. To use a different service name, you must create a 
new service record. For information about creating a service record using the 
BCC, see “Defining an ATM Service Record” on page 2-4.

In Site Manager, however, the router arbitrarily assigns a unique value to each 
service record that you create. You can accept the value that the router assigns, or 
change that value to any alphanumeric string. However, each service record must 
have a unique service name.

To change the service name, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Set the Service Name parameter. Click on 
Help or see the parameter description on 
page A-20.

6. Click on Done. You return to the Edit ATM Connector 
window.

7. Click on Done. You return to the ATM Configuration or 
the Select Connection Type window.

8. Click on Done. You return to the Configuration Manager 
window.
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Deleting a Service Record

You can use the BCC or Site Manager to delete a PVC service record.

Using the BCC

To delete a PVC service record, navigate to the service record prompt (for 
example, box; atm/11/1; pvc-service/boston) and enter:

delete

For example, the following command deletes PVC service record boston:

pvc-service/boston# delete
atm/11/1#

Using Site Manager

To delete a PVC service record, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to delete.

5. Click on Delete. Site Manager deletes the service record.

6. Click on Done. You return to the Edit ATM Connector 
window.

7. Click on Done. You return to the ATM Configuration or 
the Select Connection Type window.

8. Click on Done. You return to the Configuration Manager 
window.
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Designating a PVC as Hybrid/Bridged

PVCs do not typically allow for bridging in nonmeshed environments. If your 
network combines bridging and routing over the same interface, you need to use 
the service record portion of each PVC for routing, while at the same time 
allowing bridging to operate. To do this, you must define the PVC as a hybrid/
bridged VC.

By default, a PVC does not operate as a hybrid/bridged VC. However, you can 
configure any PVC to operate as one.

For more information about PVC access methods, including hybrid access, see 
“PVC Access Methods” on page 1-17.

To designate a PVC as hybrid/bridged, complete the following tasks:

Note: When you define a PVC as a hybrid/bridged VC, Site Manager provides 
additional Bridge, Spanning Tree, Source Routing (SR), SR Spanning Tree, 
Translational/Learning bridge (Translate/LB), and Native Mode LAN (NML) 
protocol options. These protocols run on the PVC along with the protocols 
defined in the ATM service record.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

(continued)
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Disabling and Reenabling a PVC

By default, a PVC is enabled (up) when you add it to the service record. However, 
you can disable or reenable the PVC at any time.

When the PVC is enabled, traffic can flow over it. When the PVC is disabled, 
traffic cannot flow over it.

Using the BCC

To disable a PVC, navigate to the PVC prompt (for example, box; atm/11/1; 
pvc-service/boston; pvc/11/1/0/32) and enter:

state disabled

For example, the following command disables the PVC:

pvc/11/1/0/32# state disabled
pvc/11/1/0/32#

To reenable the PVC, navigate to the PVC prompt and enter:

state enabled

For example, the following command reenables the PVC:

pvc/11/1/0/32# state enabled
pvc/11/1/0/32#

7. Set the Hybrid/Bridged VC parameter. 
Click on Help or see the parameter 
description on page A-23.

8. Click on Done. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

10. Click on Done. You return to the ATM Configuration or 
the Select Connection Type window.

11. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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Using Site Manager

To disable or reenable a PVC, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set the Administrative State parameter. 
Click on Help or see the parameter 
description on page A-23.

8. Click on Done. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

10. Click on Done. You return to the ATM Configuration or 
the Select Connection Type window.

11. Click on Done. You return to the Configuration Manager 
window.
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Modifying ATM Traffic Parameters

You can modify the following traffic parameters for PVCs:

• Peak cell rate (PCR)

• Sustainable cell rate (SCR)

• Maximum burst size (MBS)

For additional information about these traffic parameters, see “ATM Traffic 
Parameters” on page 1-23.

Setting the PCR

The peak cell rate (PCR) specifies the upper traffic limit, in cells/s, that the ATM 
connection can support.

By default, the PCR for PVCs is set to 1000 cells/s for the Passport 5430 and to 
2358 cells/s for all other platforms. Table 5-1 lists the valid ranges for each Nortel 
Networks ATM router.

For additional information about the PCR, see “Using the PCR” on page 1-24.

Note: Only the Passport 5430 supports the use of the MBS. The BN and 
System 5000 routers (Model 5782) do not support the MBS parameter. For 
instructions on setting the MBS, see “Setting the MBS” on page 6-5.

Table 5-1. Valid PCR Ranges

ATM Router Range (Cells/s)

ATM ARE OC-3 SONET/SDH ILI pairs 128 to 353,207

Model 5782 VNR 128 to 353,207

ATM ARE DS-3 ILI pairs 128 to 96,000

ATM ARE E-3 ILI pairs; G.832 framing mode 128 to 80,000

ATM ARE E-3 ILI pairs; G.751 framing mode 128 to 72,000

DS-1 on Passport 5430 10 to 3622

E-1 on Passport 5430 10 to 4528
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Using the BCC

To change the PCR value for a PVC, navigate to the PVC prompt (for example,
box; atm/11/1; pvc-service/boston; pvc/11/1/0/32) and enter:

pcr <integer>

integer is the PCR value that you want the PVC to use.

For example, the following command changes the PVC PCR value to 3000:

pvc/11/1/0/32# pcr 3000
pvc/11/1/0/32#

Using Site Manager

To change the PVC PCR value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set the Xmit Peak Cell Rate (cells/s) 
parameter. Click on Help or see the 
parameter description on page A-24.

8. Click on Done. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

(continued)
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Setting the SCR

The sustainable cell rate (SCR) is the upper bound on the conforming average rate 
of an individual PVC or control VC. The average rate is the number of cells 
transmitted over the link divided by the duration of the connection. The duration 
of the connection is the total amount of time it takes from connection setup to 
connection release.

By default, the SCR is set to 1000 cells/s for the Passport 5430. Table 5-2 lists the 
valid ranges for each Nortel Networks ATM router. To disable the SCR, set the 
value to 0.

For additional information about the SCR, see “Using the SCR” on page 1-25.

10. Click on Done. You return to the ATM Configuration or 
the Select Connection Type window.

11. Click on Done. You return to the Configuration Manager 
window.

Table 5-2. Valid SCR Ranges

ATM Router Range (Cells/s)

ATM ARE OC-3 SONET/SDH ILI pairs 0, 128 to 353,207

Model 5782 VNR 0, 128 to 353,207

ATM ARE DS-3 ILI pairs 0, 128 to 96,000

ATM ARE E-3 ILI pairs; G.832 framing mode 0, 128 to 80,000

ATM ARE E-3 ILI pairs; G.751 framing mode 0, 128 to 72,000

DS-1 on Passport 5430 10 to 3622

E-1 on Passport 5430 10 to 4528

Site Manager Procedure (continued)

You do this System responds
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Using the BCC

To change the PVC SCR value, navigate to the PVC prompt (for example,
box; atm/11/1; pvc-service/boston; pvc/11/1/0/32) and enter:

scr <integer>

integer is the SCR value that you want the PVC to use.

For example, the following command changes the PVC SCR value to 3000:

pvc/11/1/0/32# scr 3000
pvc/11/1/0/32#

Using Site Manager

To change the PVC SCR value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set the Xmit Sustainable Cell Rate 
(cells/s) parameter. Click on Help or see 
the parameter description on page A-25.

8. Click on Done. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

(continued)
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Modifying the Maximum AAL CPCS SDU Size

The maximum AAL common part convergence sublayer (CPCS) service data unit 
(SDU) value defines the maximum packet size that you intend the PVC to 
transmit or receive.

Setting the Transmit SDU Size

Nortel Networks suggests that you accept the default value of 4608 bytes for the 
maximum AAL CPCS SDU size that the VC supports in the transmit direction. 
Most packet sizes fall well within this limit. However, you can set the transmit 
SDU size to any value from 1 through 65,535 bytes.

Using the BCC

To change the transmit SDU size for the PVC, navigate to the PVC prompt (for 
example, box; atm/11/1; pvc-service/boston; pvc/11/1/0/32) and enter:

tx-sdu-maximum <integer>

integer is the maximum SDU size that you want the PVC to transmit.

For example, the following command changes the maximum transmit SDU size to 
65,535 bytes:

pvc/11/1/0/32# tx-sdu-maximum 65535
pvc/11/1/0/32#

10. Click on Done. You return to the ATM Configuration or 
the Select Connection Type window.

11. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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Using Site Manager

To change the maximum transmit SDU size for a PVC, complete the following 
tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set the Maximum AAL CPCS Transmit 
SDU Size parameter. Click on Help or see 
the parameter description on page A-27.

8. Click on Done. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

10. Click on Done. You return to the ATM Configuration or 
the Select Connection Type window.

11. Click on Done. You return to the Configuration Manager 
window.
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Setting the Receive SDU Size

Nortel Networks suggests that you accept the default value of 4608 bytes for the 
maximum AAL CPCS SDU size that the PVC supports in the receive direction. 
Most packet sizes fall well within this limit. However, you can set the receive 
SDU size to any value from 1 through 65,535 bytes.

Using the BCC

To change the receive SDU size for the PVC, navigate to the PVC prompt (for 
example, box; atm/11/1; pvc-service/boston; pvc/11/1/0/32) and enter:

rx-sdu-maximum <integer>

integer is the maximum SDU size that you want the PVC to receive.

For example, the following command changes the maximum receive SDU size to 
65,535 bytes:

pvc/11/1/0/32# rx-sdu-maximum 65535
pvc/11/1/0/32#

Using Site Manager

To change the maximum receive SDU size for a PVC, complete the following 
tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

(continued)
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Assigning a Data Encapsulation Type

By default, a PVC inherits the data encapsulation type of the service record that 
you configure it on. You can assign a different data encapsulation type to a PVC 
that overrides the encapsulation type assigned at the service record level.

For more information about assigning data encapsulation types, see “Data 
Encapsulation Methods” on page 1-13.

Using the BCC

To change the data encapsulation for a PVC, navigate to the PVC prompt (for 
example, box; atm/11/1; pvc-service/boston; pvc/11/1/0/32) and enter:

encapsulation <type>

type is one of the following data encapsulation types:

• llc/snap

• null

6. Click on the PVC that you want to modify.

7. Set the Maximum AAL CPCS Receive 
SDU Size parameter. Click on Help or see 
the parameter description on page A-27.

8. Click on Done. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

10. Click on Done. You return to the ATM Configuration or 
the Select Connection Type window.

11. Click on Done. You return to the Configuration Manager 
window.

Note: If you select NULL, the router interprets this as virtual, channel-based 
multiplexing, which is not supported for bridging.

Site Manager Procedure (continued)

You do this System responds
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• nlpid

For example, the following command changes the data encapsulation type for the 
PVC to NLPID encapsulation:

pvc/11/1/0/32# encapsulation nlpid
pvc/11/1/0/32#

Using Site Manager

To change the PVC data encapsulation type, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set the Data Encapsulation Type 
parameter. Click on Help or see the 
parameter description on page A-27.

8. Click on Done. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

10. Click on Done. You return to the ATM Configuration or 
the Select Connection Type window.

11. Click on Done. You return to the Configuration Manager 
window.
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Changing PVC OAM Parameters

The Operations and Management (OAM) feature provides a mechanism by which 
ATM devices can receive prompt notification of PVC failures. OAM uses special 
loopback cells or alarms to detect PVC failures. These mechanisms decrease the 
amount of time between an actual PVC failure and when the router is aware of this 
failure. When using OAM loopback cells, the time can decrease to only a few 
seconds; when using OAM alarms, the detection is almost instantaneous. 

For additional information about PVC OAM, see “PVC Operations and 
Management Concepts” on page 1-41. You can use the BCC or Site Manager to 
configure OAM. (For Site Manager instructions, go to page 5-22.)

Using the BCC

To configure OAM loopback, see the next section. To enable OAM alarm 
detection, see “Enabling or Disabling OAM Alarm Notification” on page 5-21.

Configuring OAM Loopback

To configure OAM loopback, you must enable loopback on the PVC and define 
the interval and thresholds for loopback detection and control.

Enabling or Disabling OAM Loopback

The OAM loopback feature specifies whether the ATM PVC sends OAM 
loopback cells. By default, OAM loopback is disabled.

To enable or disable OAM loopback for a PVC, navigate to the PVC prompt (for 
example, box; atm/11/1; pvc-service/boston; pvc/11/1/0/32) and enter:

oam-loopback-enable {enabled | disabled}

For example, the following command enables OAM loopback on PVC 11/1/0/32:

pvc/11/1/0/32# oam-loopback-enable enabled
pvc/11/1/0/32#

Note: For OAM loopback to function properly, you must configure it on all 
PVCs on a physical interface. Link status is based on the OAM loopback status 
of all PVCs on the interface.
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Modifying the OAM Loopback Cell Interval

The OAM loopback cell interval specifies how often the ATM PVC sends OAM 
loopback cells in the data stream. The default cell interval is 5 seconds. However, 
you can set the cell interval to any number of seconds.

To change the OAM loopback cell interval for a PVC, navigate to the PVC prompt 
(for example, box; atm/11/1; pvc-service/boston; pvc/11/1/0/32) and enter:

oam-loopback-cell-interval <integer>

integer is the interval, in seconds, at which you want the PVC to send OAM 
loopback cells.

For example, the following command changes the loopback cell interval to 10 
seconds:

pvc/11/1/0/32# oam-loopback-cell-interval 10
pvc/11/1/0/32#

Setting OAM Thresholds

You can set OAM cell thresholds to help the PVC determine its operational state. 
By default, the down threshold (threshold 1) allows for one lost OAM cell (no 
OAM loopback response for that cell) before declaring that the PVC is not 
operational. The up threshold (threshold 2) requires that the PVC service record 
receive two consecutive OAM loopback responses before declaring that the PVC 
is operational again. You can set either threshold to any integer value.

To set the OAM down threshold for a PVC, navigate to the PVC prompt (for 
example, box; atm/11/1; pvc-service/boston; pvc/11/1/0/32) and enter:

oam-threshold1 <integer>

integer is the minimum number of OAM cells for which a PVC does not receive 
an OAM loopback response before the ATM service record declares the PVC not 
operational.

For example, the following command sets the OAM down threshold to five cells 
on PVC 11/1/0/32:

pvc/11/1/0/32# oam-threshold1 5
pvc/11/1/0/32#
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To set the OAM up threshold for a PVC, navigate to the PVC prompt and enter:

oam-threshold2 <integer>

integer is the minimum number of consecutive loopback response cells that the 
PVC must receive before the ATM service record declares the PVC operational 
again.

For example, the following command sets the OAM up threshold to five cells on 
PVC 11/1/0/32:

pvc/11/1/0/32# oam-threshold2 5
pvc/11/1/0/32#

Enabling or Disabling OAM Alarm Notification

OAM alarm notification tells the upper-layer protocol that the PVC has received 
an OAM alarm and that the service record is down. By default, OAM alarm 
notification is disabled; that is, OAM alarms are ignored and no message is sent to 
the upper-layer protocol. You can enable and disable OAM alarm notification at 
any time.

To enable or disable OAM alarm notification for a PVC, navigate to the PVC 
prompt (for example, box; atm/1/1/2/1; pvc-service/boston; pvc/1/1/2/1/0/32) 
and enter:

oam-alarm-enable {enabled | disabled}

For example, the following command enables OAM alarm notification on
PVC 1/1/2/1/0/32:

pvc/1/1/2/1/0/32# oam-alarm-enable enabled
pvc/1/1/2/1/0/32#
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Using Site Manager

To configure PVC OAM parameters, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set one or more of the following 
parameters:
• OAM Loopback Enable
• OAM Loopback Cell Interval
• OAM Threshold 1
• OAM Threshold 2
• OAM Alarm Enable
Click on Help or see the parameter 
descriptions beginning on page A-82.

8. Click on Apply.

9. Click on Done. You return to the ATM Service Records 
List window.

10. Click on Done. You return to the Edit ATM Connector 
window.

11. Click on Done. You return to the ATM Configuration or 
the Select Connection Type window.

12. Click on Done. You return to the Configuration Manager 
window.
5-22 308612-14.20 Rev 00



Customizing PVC Service Records and PVCs
 

Copying a PVC

To copy an existing PVC, complete the following tasks:

Note: When you copy a hybrid PVC, all PVC-specific information is copied 
to the new PVC. However, the copy function does not copy the protocols that 
you selected and configured for the original PVC. You must select and 
configure any protocols that you want to operate over the newly copied PVC.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record 
containing the PVC that you want to copy.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to copy.

7. Click on Copy. The ATM Virtual Channel Link 
Parameters window opens.

8. Set the VPI Number parameter. Click on 
Help or see the parameter description on 
page A-22.

9. Set the VCI Number parameter. Click on 
Help or see the parameter description on 
page A-22.

10. Click on OK. You return to the ATM Virtual Channel 
Link window.

11. Click on Done. You return to the ATM Service Records 
List window.

12. Click on Done. You return to the Edit ATM Connector 
window.

(continued)
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Deleting a PVC

You can use the BCC or Site Manager to delete a PVC.

Using the BCC

To delete a PVC, navigate to the PVC prompt (for example, box; atm/11/1; 
pvc-service/boston; pvc/11/1/0/32) and enter:

delete

For example, the following command deletes PVC 11/1/0/32 from service record 
boston:

pvc/11/1/0/32# delete
pvc-service/boston#

13. Click on Done. You return to the ATM Configuration or 
the Select Connection Type window.

14. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
5-24 308612-14.20 Rev 00



Customizing PVC Service Records and PVCs
 

Using Site Manager

To delete a PVC, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens (BN or System 5000), or the ATM 
Configuration window opens (Passport 
5430).

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record 
containing the PVC that you want to 
delete.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to delete.

7. Click on Delete. Site Manager deletes the PVC.

8. Click on Done. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

10. Click on Done. You return to the ATM Configuration or 
the Select Connection Type window.

11. Click on Done. You return to the Configuration Manager 
window.
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Where to Go Next

Use the following table to determine where to go next.

If you want to Go to

Learn about ATM concepts. Chapter 1

Start ATM. Chapter 2

Change default settings for ATM interface parameters. Chapter 3

Change default settings for ATM signaling parameters. Chapter 4

Customize traffic shaping parameters for the Passport 5430. Chapter 6

Change default settings for classical IP service record parameters. Chapter 7

Change default settings for LAN Emulation client service record 
parameters.

Chapter 8

Change default settings for ATM WAN SVC service record and WAN 
SVC parameters.

Chapter 9

Change the default settings for CES parameters. Chapter 10

Change default settings for the ATM router redundancy parameter. Chapter 11

Obtain information about Site Manager parameters. Appendix A

Monitor ATM using the BCC show commands. Appendix B
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Chapter 6
Customizing Traffic Shaping Parameters

for the Passport 5430

This chapter describes how to customize traffic shaping parameters that are 
available only on the Passport 5430 router. For instructions on setting all other 
PVC and PVC service record parameters, see Chapter 5, “Customizing PVC 
Service Records and PVCs.” 

This chapter includes the following information:

This chapter describes how to customize existing PVC service records and PVCs. 
For instructions on how to define a new PVC service record and PVC, see 
Chapter 2, “Starting ATM and ATM Router Redundancy.”

Topic Page

Setting the Congestion Indication 6-2

Setting the Cell Loss Priority 6-3

Setting the MBS 6-5

Setting the Service Category 6-7

Setting the VBR Type 6-10

Setting the Initial Cell Rate 6-11

Setting the Minimum Cell Rate 6-13

Setting the Rate Increase Factor 6-14

Setting the Rate Decrease Factor 6-16

Setting the AAL Type 6-17

Where to Go Next 6-19
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Setting the Congestion Indication

By default, the router does not indicate whether traffic congestion occurs on this 
PVC. You can enable the congestion indication bit in the ATM cell header using 
either the BCC or Site Manager.

Using the BCC

To enable or disable congestion indication on a PVC, navigate to the PVC prompt 
(for example, box; atm/1/1/2/1; pvc-service/boston; pvc/1/1/2/1/0/33) and 
enter:

congestion-indication {on | off}

For example, the following command enables congestion indication on the PVC:

pvc/1/1/2/1/0/33# congestion-indication on
pvc/1/1/2/1/0/33#

Using Site Manager

To disable or reenable congestion indication on a PVC, complete the following 
tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The ATM Configuration window opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set the Congestion Indication 
parameter. Click on Help or see the 
parameter description on page A-28.

(continued)
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Setting the Cell Loss Priority

Cell loss priority (CLP) is defined in the last bit of byte 4 of the ATM cell header. 
The CLP bit setting enables the Passport 5430 under heavy traffic conditions to 
discard a cell marked as “discard eligible” by various policing mechanisms.

When cell loss priority is enabled, the router sets the cell loss priority (CLP) bit in 
the ATM header for all cells sent on the PVC. Cells with the CLP bit set have a 
lower priority, and if there is congestion these cells will be dropped before cells 
without the CLP bit set.

By default, CLP detection and marking is disabled. You can enable CLP detection 
and marking, and you can enable the PVC to set the CLP bit according to the drop 
preference bit of the associated IP packet.

Using the BCC

To configure the cell loss priority on a PVC, navigate to the PVC prompt (for 
example, box; atm/1/1/2/1; pvc-service/boston; pvc/1/1/2/1/0/33) and enter:

cell-loss-priority {on | off | drop-preference}

For example, the following command enables cell loss priority on the PVC:

pvc/1/1/2/1/0/33# cell-loss-priority on
pvc/1/1/2/1/0/33#

8. Click on Done. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

10. Click on Done. You return to the ATM Configuration 
window.

11. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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Using Site Manager

To disable or reenable cell loss priority on a PVC, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The ATM Configuration window opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set the Cell Loss Priority parameter. 
Click on Help or see the parameter 
description on page A-28.

8. Click on Done. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

10. Click on Done. You return to the ATM Configuration 
window.

11. Click on Done. You return to the Configuration Manager 
window.
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Setting the MBS

The maximum burst size (MBS) specifies the maximum number of sequential 
cells allowed on a VC before that VC must relinquish bandwidth to other VCs 
waiting to transmit. This burst occurs at or close to the peak cell rate.

When setting the MBS, you should select a value larger than the largest packet 
that the PVC can transmit (that is, the size of the maximum AAL CPCS transmit 
SDU). For example, if your PVC accepts packets that are less than 4608 bytes 
long (PVC default), set your MBS value between 45 and 50 cells.

By default, the MBS is set to 40 cells. However, you can set the MBS to any value 
from 1 through 65,535 cells.

For additional information about the MBS, see “Using the MBS” on page 1-26. 
For information about setting the maximum AAL CPCS transmit SDU size, see 
“Setting the Transmit SDU Size” on page 5-14.

Using the BCC

To change the PVC MBS value, navigate to the PVC prompt (for example, 
box; atm/1/1/2/1; pvc-service/boston; pvc/1/1/2/1/0/32) and enter:

tx-burst-size <integer>

integer is the MBS value that you want the PVC to use.

For example, the following command changes the PVC MBS value to 50 cells:

pvc/1/1/2/1/0/32# tx-burst-size 50
pvc/1/1/2/1/0/3#

Note: Only the Passport 5430 supports the use of the MBS. For instructions 
on setting the peak cell rate (PCR) and the sustainable cell rate (SCR), see 
“Modifying ATM Traffic Parameters” on page 5-10.
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Using Site Manager

To change the PVC MBS value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The ATM Configuration window opens 
(Passport 5430).

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set the Xmit Burst Size (cells) 
parameter. Click on Help or see the 
parameter description on page A-26.

8. Click on Done. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

10. Click on Done. You return to the ATM Configuration 
window.

11. Click on Done. You return to the Configuration Manager 
window.
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Setting the Service Category

Service categories relate traffic characteristics and quality of service (QoS) 
requirements to network behavior. Choosing a service category generally affects 
the routing and resource allocation functions.

Service categories are distinguished as being either real-time or non-real-time. 
Table 6-1 shows the available service categories. The following sections briefly 
describe each service category.

Constant Bit Rate (CBR)

The CBR service category provides a static amount of bandwidth that is 
continuously available for the duration of the connection. The CBR service is 
intended to support real-time applications, such as voice, video, and circuit 
emulation, that require tightly constrained delay variations.

When you choose the CBR service category, you can determine the bandwidth of 
the connection by setting the PCR value. If you are configuring the PVC for 
circuit emulation service (CES), set the service category to CBR.

Note: The peak cell rate (PCR), sustainable cell rate (SCR), and maximum 
burst size (MBS) are used in conjunction with the service category to shape 
traffic. For instructions on setting the PCR and SCR, see “Modifying ATM 
Traffic Parameters” on page 5-10. For instructions on setting the MBS, see 
“Setting the MBS” on page 6-5.

Table 6-1. Real-Time and Non-Real-Time Service Categories

Real-Time Service Category Non-Real-Time Service Category

constant bit rate (CBR) non-real-time variable bit rate (VBRNRT)

real-time variable bit rate (VBRRT) unspecified bit rate (UBR)

unspecified bit rate plus (UBRPLUS)

available bit rate (ABR)
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Real-Time Variable Bit Rate (VBRRT)

The VBRRT service accommodates sources that are expected to transmit data at a 
rate that varies with time. The VBRRT service is intended to support real-time 
applications, such as voice and video applications, that require tightly constrained 
delay and delay variation.

The PCR, SCR, and MBS determine the behavior of a VBRRT connection.

Non-Real-Time Variable Bit Rate (VBRNRT)

The VBRNRT service accommodates non-real-time applications that have bursty 
traffic conditions. VBRNRT service supports statistical multiplexing of 
connections. 

The PCR, SCR, and MBS determine the behavior of a VBRNRT connection.

Unspecified Bit Rate (UBR)

The UBR service supports non-real-time applications, for example, file transfer 
and e-mail. UBR service does not specify traffic-related service guarantees. 
The PCR determines the behavior of a UBR connection.

Unspecified Bit Rate Plus (UBRPLUS)

The UBRPLUS service supports non-real-time applications, for example, 
traditional computer communications, such as file transfer and e-mail. UBRPLUS 
guarantees service equal to at least the MCR. If bandwidth is available, a 
UBRPLUS virtual circuit can use up to PCR, but no higher.

Available Bit Rate (ABR)

ABR is an ATM layer service category for which the limiting ATM layer transfer 
characteristics provided by the network may change when the router establishes a 
connection. ABR service is not intended to support real-time applications.

When establishing an ABR connection, the PCR determines the maximum 
required bandwidth and the MCR determines the minimum usable bandwidth. 
The bandwidth available from the network may vary but it cannot be less than the 
MCR. When ABR is first configured, it transmits data at the initial cell rate.
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Using the BCC

To set the service category on a PVC, navigate to the PVC prompt (for example, 
box; atm/1/1/2/1; pvc-service/boston; pvc/1/1/2/1/0/33) and enter:

service-category <category>

category is the service category that you want to use: abr, cbr, ubr, ubr-plus, 
vbr-rt, vbr-nrt, or other.

For example, the following command sets the service category on the PVC to 
constant bit rate (CBR):

pvc/1/1/2/1/0/33# service-category cbr
pvc/1/1/2/1/0/33#

Using Site Manager

To set the service category on a PVC, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The ATM Configuration window opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set the Service Category parameter. 
Click on Help or see the parameter 
description on page A-29.

8. Click on Done. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

(continued)
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Setting the VBR Type

There are two different ways to schedule VBR traffic based on cell loss priority 
(CLP). Type 1 VBR causes the router to schedule cells by PCR and SCR 
according to the generic cell rate algorithm (GCRA) state, otherwise known as the 
leaky bucket. When you choose type 2 VBR and disable CLP, the router schedules 
cells by PCR.

Using the BCC

To set the VBR type on a PVC, navigate to the PVC prompt (for example, box; 
atm/1/1/2/1; pvc-service/boston; pvc/1/1/2/1/0/33) and enter:

vbr-type <type>

type is the VBR type that you want to use.

For example, the following command sets the VBR type on the PVC to type 2:

pvc/1/1/2/1/0/33# vbr-type type2
pvc/1/1/2/1/0/33#

Using Site Manager

To set the VBR type on a PVC, complete the following tasks:

10. Click on Done. You return to the ATM Configuration 
window.

11. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The ATM Configuration window opens.

2. Click on ATM. The Edit ATM Connector window opens.

(continued)

Site Manager Procedure (continued)

You do this System responds
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Setting the Initial Cell Rate

You can specify the initial cell rate at which the router transfers data for this PVC. 
By default, the minimum cell rate is set to 1000 cells per second (cells/s). For T1 
you can set the minimum cell rate to a value from 0 through 3622; for E1 you can 
set the minimum cell rate to a value from 0 through 4528.

Using the BCC

To set the initial cell rate on a PVC, navigate to the PVC prompt (for example, 
box; atm/1/1/2/1; pvc-service/boston; pvc/1/1/2/1/0/33) and enter:

initial-cell-rate <integer>

integer is the minimum cell rate that you want to use.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set the VBR Type parameter. Click on 
Help or see the parameter description on 
page A-30.

8. Click on Done. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

10. Click on Done. You return to the ATM Configuration 
window.

11. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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For example, the following command sets the initial cell rate on the PVC to 2000:

pvc/1/1/2/1/0/33# initial-cell-rate 2000
pvc/1/1/2/1/0/33#

Using Site Manager

To set the initial cell rate on a PVC, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The ATM Configuration window opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set the Initial Cell Rate (cells/second) 
parameter. Click on Help or see the 
parameter description on page A-30.

8. Click on Done. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

10. Click on Done. You return to the ATM Configuration 
window.

11. Click on Done. You return to the Configuration Manager 
window.
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Setting the Minimum Cell Rate

You determine the minimum rate at which the router transfers cells for this PVC. 
By default, the minimum cell rate is set to 10 cells/s. For T1 you can set the 
minimum cell rate to a value from 0 through 3622; for E1 you can set the 
minimum cell rate to a value from 0 through 4528.

Using the BCC

To set the minimum cell rate on a PVC, navigate to the PVC prompt (for example, 
box; atm/1/1/2/1; pvc-service/boston; pvc/1/1/2/1/0/33) and enter:

minimum-cell-rate <integer>

integer is the minimum cell rate that you want to use.

For example, the following command sets the minimum cell rate on the PVC to 
33:

pvc/1/1/2/1/0/33# minimum-cell-rate 33
pvc/1/1/2/1/0/33#

Using Site Manager

To set the minimum cell rate on a PVC, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The ATM Configuration window opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

(continued)
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Setting the Rate Increase Factor

The rate increase factor determines how quickly the cell rate for an ABR PVC can 
increase. The cell rate increases in the specified increment based on the traffic in 
the network. If bandwidth is available, the PVC begins to increase its rate in steps 
according to the rate increase factor. By default, the rate increase factor is set to 4. 
You can set a value from 0 through 15.

Using the BCC

To set the cell transfer rate increase factor on a PVC, navigate to the PVC prompt 
(for example, box; atm/1/1/2/1; pvc-service/boston; pvc/1/1/2/1/0/33) and 
enter:

rate-increase-factor <integer>

integer is the rate increase factor (from 0 through 15) that you want to use.

For example, the following commands set the service category on the PVC to 
ABR and set the rate increase factor to 7:

pvc/1/1/2/1/0/33# service-category abr
pvc/1/1/2/1/0/33# rate-increase-factor 7
pvc/1/1/2/1/0/33#

7. Set the Minimum Cell Rate (cells/
second) parameter. Click on Help or see 
the parameter description on page A-30.

8. Click on Done. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

10. Click on Done. You return to the ATM Configuration 
window.

11. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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Using Site Manager

To set the rate increase factor on a PVC, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The ATM Configuration window opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set the Rate Increase Factor parameter. 
Click on Help or see the parameter 
description on page A-31.

8. Click on Done. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

10. Click on Done. You return to the ATM Configuration 
window.

11. Click on Done. You return to the Configuration Manager 
window.
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Setting the Rate Decrease Factor

The rate decrease factor determines how quickly the cell rate for an ABR PVC can 
decrease. The cell rate decreases in the specified increment based on the traffic in 
the network. If the network is congested, the PVC begins to decrease its cell rate 
by the rate decrease factor. By default, the rate decrease factor is set to 4. You can 
set a value from 0 through 15.

Using the BCC

To set the rate decrease factor on a PVC, navigate to the PVC prompt (for 
example, box; atm/1/1/2/1; pvc-service/boston; pvc/1/1/2/1/0/33) and enter:

rate-decrease-factor <integer>

integer is the rate decrease factor (from 0 through 15) that you want to use.

For example, the following commands set the service category on the PVC to 
ABR and set the rate decrease factor to 7:

pvc/1/1/2/1/0/33# service-category abr
pvc/1/1/2/1/0/33# rate-decrease-factor 7
pvc/1/1/2/1/0/33#

Using Site Manager

To set the rate decrease factor on a PVC, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The ATM Configuration window opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

(continued)
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Setting the AAL Type

The AAL type determines the AAL encapsulation method used on this PVC. 
Accept the default value (AAL 5 encapsulation) unless you will connect the ATM 
PVC to a synchronous connector to configure a CES H.110 TDM circuit.

Using the BCC

To change the AAL encapsulation type, navigate to the PVC prompt (for example, 
box; atm/1/1/2/1; pvc-service/boston; pvc/1/1/2/1/0/33) and enter:

aal-type <type>

type is the AAL encapsulation type that you want to use, either aal1 or aal5 (the 
default value).

For example, the following command sets the AAL encapsulation type on this 
PVC to AAL 1 encapsulation:

pvc/1/1/2/1/0/32# aal-type aal1
pvc/1/1/2/1/0/32#

6. Click on the PVC that you want to modify.

7. Set the Rate Decrease Factor parameter. 
Click on Help or see the parameter 
description on page A-31.

8. Click on Done. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

10. Click on Done. You return to the ATM Configuration 
window.

11. Click on Done. You return to the Configuration Manager 
window.

Note: ATM supports the AAL 1 encapsulation type only with CES 
connections. For complete information about how to configure a CES H.110 
TDM circuit, see Configuring TDM Services.

Site Manager Procedure (continued)

You do this System responds
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Using Site Manager

To change the AAL encapsulation type on a PVC, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The ATM Configuration window opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the PVC service record that you 
want to modify.

5. Click on PVC. The ATM Virtual Channel Link window 
opens.

6. Click on the PVC that you want to modify.

7. Set the AAL Type parameter. Click on 
Help or see the parameter description on 
page A-28.

8. Click on Done. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

10. Click on Done. You return to the ATM Configuration 
window.

11. Click on Done. You return to the Configuration Manager 
window.
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Where to Go Next

Use the following table to determine where to go next.

If you want to Go to

Learn about ATM concepts. Chapter 1

Start ATM. Chapter 2

Change default settings for ATM interface parameters. Chapter 3

Change default settings for ATM signaling parameters. Chapter 4

Change default settings for ATM PVC service record and PVC 
parameters.

Chapter 5

Change default settings for classical IP service record parameters. Chapter 7

Change default settings for LAN Emulation client service record 
parameters.

Chapter 8

Change default settings for ATM WAN SVC service record and WAN 
SVC parameters.

Chapter 9

Change the default settings for CES parameters. Chapter 10

Change default settings for the ATM router redundancy parameter. Chapter 11

Obtain information about Site Manager parameters. Appendix A

Monitor ATM using the BCC show commands. Appendix B
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Chapter 7
Customizing Classical IP Service Records

When you start ATM on the router, all parameters use their default values. 
Depending on the requirements of your network, you may want to change some of 
these values.

This chapter describes how to customize ATM classical IP service record 
parameters and includes the following information:

For general information about classical IP, see “Classical IP over ATM Concepts” 
on page 1-28.

Topic Page

Disabling and Reenabling a Classical IP Service Record 7-2

Disabling and Reenabling User Part Autogeneration 7-3

Entering an ATM Address Network Prefix 7-5

Entering an ATM Address User Part 7-7

Configuring ATMARP on an IP Interface 7-8

Deleting a Service Record 7-11

Where to Go Next 7-12
308612-14.20 Rev 00 7-1



Configuring ATM Services
Disabling and Reenabling a Classical IP Service Record

By default, you enable a classical IP service record when you add it to the 
interface. However, you can disable or reenable a specific service record at any 
time. Disable the service record to stop traffic flow over it and any of its VCs. 
Otherwise, enable the service record.

Using the BCC

To disable a classical IP service record, navigate to the service record prompt (for 
example, box; atm/11/1; classical-ip-service/dallas) and enter:

state disabled

For example, the following command disables the service record:

classical-ip-service/dallas# state disabled
classical-ip-service/dallas#

To reenable the service record, navigate to the prompt and enter:

state enabled

For example, the following command reenables the service record:

classical-ip-service/dallas# state enabled
classical-ip-service/dallas#

Using Site Manager

To disable or reenable a classical IP service record, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the classical IP service record 
that you want to modify.

(continued)
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Disabling and Reenabling User Part Autogeneration

By default, when you add an SVC service record (that is, a LANE or classical IP 
service record), the user part autogeneration feature is enabled. However, you can 
disable or reenable this feature on an individual service record at any time.

For information about setting the end-station identifier for user part 
autogeneration, see “Autogenerating ATM Addresses” on page 3-20.

Using the BCC

To disable the user part autogeneration feature, navigate to the service record 
prompt (for example, box; atm/11/1; classical-ip-service/dallas) and enter:

autogenerate disabled

For example, the following command disables user part autogeneration on the 
service record:

classical-ip-service/dallas# autogenerate disabled
classical-ip-service/dallas#

To reenable user part autogeneration on the service record, navigate to the prompt 
and enter:

autogenerate enabled

5. Set the Enable/Disable parameter. Click 
on Help or see the parameter description 
on page A-14.

6. Click on Done. You return to the Edit ATM Connector 
window.

7. Click on Done. You return to the Select Connection Type 
window.

8. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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For example, the following command reenables user part autogeneration on the 
service record:

classical-ip-service/dallas# autogenerate enabled
classical-ip-service/dallas#

Using Site Manager

To disable or reenable user part autogeneration on a classical IP service record, 
complete the following tasks:

Note: If you disable autogeneration, you must manually enter an ATM address 
user part. See “Entering an ATM Address User Part” on page 7-7.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the classical IP service record 
that you want to modify.

5. Set the User Part Autogeneration 
parameter. Click on Help or see the 
parameter description on page A-16.

6. Click on Done. You return to the Edit ATM Connector 
window.

7. Click on Done. You return to the Select Connection Type 
window.

8. Click on Done. You return to the Configuration Manager 
window.
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Entering an ATM Address Network Prefix

The ATM address network prefix specifies the ATM domain of which the service 
record is a part. This 13-byte portion of the ATM address can range from 
XX000000000000000000000000 to XXFFFFFFFFFFFFFFFFFFFFFFFF.

The XX byte must contain 39, 45, or 47. These values define the authority and 
format identifier (AFI). The AFI byte identifies the group responsible for 
allocating the prefix and the format that the prefix uses. For more information 
about the AFI byte, refer to the ATM Forum UNI specification.

Entering an ATM address network prefix is optional. If you do not enter a network 
prefix in the specified range, the service record accepts the first prefix value that it 
receives from the switch.

Using the BCC

To assign an ATM address network prefix to a classical IP service record, navigate 
to the service record prompt (for example, box; atm/11/1; 
classical-ip-service/dallas) and enter:

network-prefix <address>

address is the ATM address network prefix that you want the VCs on the service 
record to use.

For example, the following command defines the ATM address network prefix on 
the service record as 39000000000000000000000000:

classical-ip-service/dallas# network-prefix 39000000000000000000000000
classical-ip-service/dallas#
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Using Site Manager

To assign an ATM address network prefix to a classical IP service record, 
complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the classical IP service record 
that you want to modify.

5. Set the ATM Addr Net Prefix parameter. 
Click on Help or see the parameter 
description on page A-17.

6. Click on Done. You return to the Edit ATM Connector 
window.

7. Click on Done. You return to the Select Connection Type 
window.

8. Click on Done. You return to the Configuration Manager 
window.
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Entering an ATM Address User Part

The ATM address user part (suffix) consists of a 6-byte end-station identifier and a 
1-byte selector field. This 7-byte portion of the ATM address can range from 
00000000000000 to FEFFFFFFFFFFFF.

You can either autogenerate this value (see “Disabling and Reenabling User Part 
Autogeneration” on page 7-3) or you can enter the value manually.

Using the BCC

To assign an ATM address user part to a classical IP service record, navigate to the 
service record prompt (for example, box; atm/11/1; classical-ip-service/dallas) 
and enter:

user-suffix <address>

address is the ATM address user part that you want the VCs on the service record 
to use.

For example, the following command defines the ATM address user part on the 
service record as 00000000000001:

classical-ip-service/dallas# user-suffix 00000000000001
classical-ip-service/dallas#

Using Site Manager

To assign an ATM address user part to a classical IP service record, complete the 
following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

(continued)
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Configuring ATMARP on an IP Interface

RFC 1577, “Classical IP and ARP over ATM,” defines an address resolution 
scheme called ATMARP. In a LIS, each IP interface opens a VC to the ATMARP 
server and registers its IP address and ATM address. A router that needs the ATM 
address of a host on the LIS sends an ATMARP request to the server. When the 
server returns a response, the router extracts the ATM address of the host from the 
response and opens an SVC directly to the host using ATM UNI signaling.

To configure ATMARP on an IP interface that is part of a classical IP LIS:

• Specify the ATMARP mode: client or server. You must configure one 
ATMARP server for each logical IP subnet that you define.

• Define the ATM address of the ATMARP server on your network. A complete 
ATM address consists of a network prefix and a user part. The user part 
consists of a 6-byte end-station identifier and a 1-byte selector field.

• Specify (for a client) the interval between registration refreshes.

• Specify (for a server) the duration for which the registration is valid.

4. Click on the classical IP service record 
that you want to modify.

5. Set the ATM Addr User Part parameter. 
Click on Help or see the parameter 
description on page A-16.

6. Click on Done. You return to the Edit ATM Connector 
window.

7. Click on Done. You return to the Select Connection Type 
window.

8. Click on Done. You return to the Configuration Manager 
window.

Note: If you do not enable ATMARP on IP interfaces on the local LIS, you 
must configure adjacent host entries to associate the ATM address of the 
adjacent host with its IP address. For complete information about creating 
adjacent hosts, see Configuring IP, ARP, RARP, RIP, and OSPF Services.

Site Manager Procedure (continued)

You do this System responds
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Using the BCC

To configure ATMARP on an IP interface in a LIS, navigate to the IP interface 
prompt on the classical IP service record (for example, box; atm/11/1; 
classical-ip-service/paris; ip/2.2.2.2/255.255.0.0) and enter:

arp-mode <mode>

mode is one of the following:

client (default)
server

If this router is an ATMARP client, specify the ATM address of the ATMARP 
server on your network by entering:

atmarp-server-address <address>

address is an ATM hexadecimal address (40 characters).

To specify a server registration interval, enter:

atmarp-server-interval <interval>

interval is any integer. The default value for a client is 900 seconds; the default 
value for a server is 1200 seconds.

To disable or reenable timing out of the connection to the ATMARP server, enter:

atmarp-server-aging <state>

state is either:

enabled (default)
disabled
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Using Site Manager

To set parameters for an ATM logical IP subnet, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
choose Protocols.

The Protocols menu opens.

2. Choose IP. The IP menu opens.

3. Choose Interfaces. The IP Interface List window opens. 

4. Click on the interface that you want to edit. Site Manager displays the parameter 
values for that interface in the IP Interface 
List window.

5. Set the following parameters:
• ATM ARP Mode 
• ARP Server ATM Address Network 

Prefix 
• ARP Server ATM Address User Part 
• Registration Refresh Interval 
• SSCS Type Field
Click on Help or see the parameter 
descriptions beginning on page A-85.

6. Click on Apply, and then click on Done. You return to the Configuration Manager 
window.
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Deleting a Service Record

You can use the BCC or Site Manager to delete a classical IP service record.

Using the BCC

To delete a classical IP service record, navigate to the service record prompt 
(for example, box; atm/11/1; classical-ip-service/dallas) and enter:

delete

For example, the following command deletes classical IP service record dallas:

classical-ip-service/dallas# delete
atm/11/1#

Using Site Manager

To delete a classical IP service record, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the classical IP service record 
that you want to delete.

5. Click on Delete. Site Manager deletes the service record.

6. Click on Done. You return to the Edit ATM Connector 
window.

7. Click on Done. You return to the Select Connection Type 
window.

8. Click on Done. You return to the Configuration Manager 
window.
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Where to Go Next

Use the following table to determine where to go next.

If you want to Go to

Learn about ATM concepts. Chapter 1

Start ATM. Chapter 2

Change default settings for ATM interface parameters. Chapter 3

Change default settings for ATM signaling parameters. Chapter 4

Change default settings for ATM PVC service record and PVC 
parameters.

Chapter 5

Customize traffic shaping parameters for the Passport 5430. Chapter 6

Change default settings for LAN Emulation client service record 
parameters.

Chapter 8

Change default settings for ATM WAN SVC service record and WAN 
SVC parameters.

Chapter 9

Change the default settings for CES parameters. Chapter 10

Change default settings for the ATM router redundancy parameter. Chapter 11

Obtain information about Site Manager parameters. Appendix A

Monitor ATM using the BCC show commands. Appendix B
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Chapter 8
Customizing LAN Emulation
Service Records and Clients

When you start ATM on the router, all parameters use their default values. 
Depending on the requirements of your network, you may want to change some of 
these values.

This chapter describes how to customize an existing LANE service record and the 
LAN emulation client (LEC) that operates on that service record. It includes the 
following information:

Topic Page

Disabling and Reenabling a LANE Service Record 8-2

Disabling and Reenabling User Part Autogeneration 8-3

Entering an ATM Address Network Prefix 8-5

Entering an ATM Address User Part 8-6

Selecting a LEC Configuration Mode 8-8

Assigning an Emulated LAN Name 8-10

Assigning an Emulated LAN Type 8-12

Specifying an Emulated LAN Segment ID 8-14

Disabling and Reenabling the LANE Client 8-15

Specifying an Owner 8-16

Assigning ATM LES Addresses 8-17

Changing the LE Server Name 8-21

Setting the Maximum Data Frame Size 8-26

Controlling Unknown Frame Distribution 8-28

(continued)
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For information about how to define a new LANE service record, see Chapter 2, 
“Starting ATM and ATM Router Redundancy.”

Disabling and Reenabling a LANE Service Record

By default, you enable a service record when you add it to the interface. However, 
you can disable and reenable a specific service record at any time. Enable the 
service record to allow traffic to flow over it and any of its VCs. Otherwise, 
disable the service record.

Using the BCC

To disable a LANE service record, navigate to the LANE service record prompt 
(for example, box; atm/11/1; lec-service/newyork) and enter:

state disabled

For example, the following command disables the LANE service record newyork:

lec-service/newyork# state disabled
lec-service/newyork#

To reenable the LANE service record, navigate to the LANE service record 
prompt and enter:

state enabled

For example, the following command reenables the LANE service record 
newyork:

lec-service/newyork# state enabled
lec-service/newyork#

Modifying LEC Timers and Retry Counters 8-32

Modifying Flush Protocol Variables 8-44

Specifying a LECS ATM Address 8-48

Enabling and Disabling LAN Emulation Version 2 8-49

Deleting a Service Record 8-50

Where to Go Next 8-52

Topic Page
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Using Site Manager

To disable or reenable a LANE service record, complete the following tasks:

Disabling and Reenabling User Part Autogeneration

By default, when you add an SVC service record (that is, a LANE or classical IP 
service record), the user part autogeneration feature is enabled. However, you can 
disable or reenable this feature on an individual service record at any time.

For information about setting the end-station identifier for user part 
autogeneration, see “Autogenerating ATM Addresses” on page 3-20.

Using the BCC

To disable the user part autogeneration feature, navigate to the LANE service 
record prompt (for example, box; atm/11/1; lec-service/newyork) and enter:

autogenerate disabled

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Set the Enable/Disable parameter. Click 
on Help or see the parameter description 
on page A-14.

6. Click on Done. You return to the Edit ATM Connector 
window.

7. Click on Done. You return to the Select Connection Type 
window.

8. Click on Done. You return to the Configuration Manager 
window.
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For example, the following command disables user part autogeneration on the 
service record newyork:

lec-service/newyork# autogenerate disabled
lec-service/newyork#

To reenable user part autogeneration on the service record, navigate to the LANE 
service record prompt and enter:

autogenerate enabled

For example, the following command reenables user part autogeneration on the 
service record newyork:

lec-service/newyork# autogenerate enabled
lec-service/newyork#

Using Site Manager

To disable or reenable user part autogeneration on a LANE service record, 
complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Set the User Part Autogeneration 
parameter. Click on Help or see the 
parameter description on page A-16.

6. Click on Done. You return to the Edit ATM Connector 
window.

7. Click on Done. You return to the Select Connection Type 
window.

8. Click on Done. You return to the Configuration Manager 
window.
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Entering an ATM Address Network Prefix

The ATM address network prefix specifies the ATM domain of which the service 
record is a part. This 13-byte portion of the ATM address can range from 
XX000000000000000000000000 to XXFFFFFFFFFFFFFFFFFFFFFFFF.

The XX byte must contain 39, 45, or 47. These values define the authority and 
format identifier (AFI). The AFI byte identifies the group responsible for 
allocating the prefix and the format the prefix uses. For more information about 
the AFI byte, refer to the ATM Forum UNI specification.

Entering an ATM address network prefix is optional. If you do not enter a network 
prefix in the specified range, the service record accepts the first prefix value that it 
receives from the switch.

Using the BCC

To assign an ATM address network prefix to a service record, navigate to the 
service record prompt (for example, box; atm/11/1; lec-service/newyork) and 
enter:

network-prefix <address>

address is the ATM address network prefix that you want the service record to 
use.

For example, the following command defines the ATM address network prefix on 
the service record as 39000000000000000000000000:

lec-service/newyork# network-prefix 39000000000000000000000000
lec-service/newyork#
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Using Site Manager

To assign an ATM address network prefix to a LANE service record, complete the 
following tasks:

Entering an ATM Address User Part

The ATM address user part (suffix) consists of a 6-byte end-station identifier and a 
1-byte selector field. This 7-byte portion of the ATM address can range from 
00000000000000 to FEFFFFFFFFFFFF.

You can either autogenerate this value (see “Disabling and Reenabling User Part 
Autogeneration” on page 8-3) or you can enter the value manually.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Set the ATM Addr Net Prefix parameter. 
Click on Help or see the parameter 
description on page A-16.

6. Click on Done. You return to the Edit ATM Connector 
window.

7. Click on Done. You return to the Select Connection Type 
window.

8. Click on Done. You return to the Configuration Manager 
window.
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Using the BCC

To assign an ATM address user part to a service record, navigate to the service 
record prompt (for example, box; atm/11/1; lec-service/newyork) and enter:

user-part <address>

address is the ATM address user part that you want the VCs on the service record 
to use.

For example, the following command defines the ATM address user part on the 
service record as 00000000000001.

lec-service/newyork# user-part 00000000000001
lec-service/newyork#

Using Site Manager

To assign an ATM address user part to a LANE service record, complete the 
following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Set the ATM Addr User Part parameter. 
Click on Help or see the parameter 
description on page A-16.

6. Click on Done. You return to the Edit ATM Connector 
window.

7. Click on Done. You return to the Select Connection Type 
window.

8. Click on Done. You return to the Configuration Manager 
window.
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Selecting a LEC Configuration Mode

A LEC can run in either automatic or manual mode. In automatic mode (the 
default selection), the LE client uses the LAN emulation server (LES) address it 
receives from the LAN emulation configuration server (LECS) to join an ELAN. 

You can bypass the LECS by choosing manual mode. For manual mode, you must 
specify the LES address and the LAN type of the ELAN you want the LE client to 
join. For information about LAN types, see “Assigning an Emulated LAN Type” 
on page 8-12. For information about configuring the LES address, see “Assigning 
ATM LES Addresses” on page 8-17.

Using the BCC

To change the LEC configuration mode, navigate to the service record prompt (for 
example, box; atm/11/1; lec-service/newyork) and enter:

config-mode <mode>

mode is the configuration mode that you want the LEC to use, either manual or 
automatic.

For example, the following command changes the LEC configuration mode to 
manual:

lec-service/newyork# config-mode manual
lec-service/newyork#
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Using Site Manager

To change the LEC configuration mode, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Configuration Mode parameter. 
Click on Help or see the parameter 
description on page A-38.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.
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Assigning an Emulated LAN Name

Emulated LAN (ELAN) names are optional values that provide administrative 
assistance when you need to distinguish a LEC as belonging to one of several 
ELANs. You can specify an ELAN name up to 128 alphanumeric characters.

If you choose not to enter an ELAN name, the LECS assigns the LE client to an 
ELAN for this domain. However, because some switches do not support a default 
emulated LAN, Nortel Networks recommends that you assign an ELAN name to 
the LEC.

Using the BCC

To assign an emulated LAN name, navigate to the service record prompt (for 
example, box; atm/11/1; lec-service/newyork) and enter:

emulated-lan-name <value>

value is the alphanumeric string that identifies the emulated LAN that you want 
this LEC to join.

For example, the following command assigns the LEC to the emulated LAN 
marketing:

lec-service/newyork# emulated-lan-name marketing
lec-service/newyork#
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Using Site Manager

To assign an emulated LAN name to a LEC, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Emulated LAN Name parameter. 
Click on Help or see the parameter 
description on page A-38.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.
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Assigning an Emulated LAN Type

The emulated LAN type specifies the data frame format that the LEC uses when it 
joins an emulated LAN. ATM allows you to choose from three emulated LAN 
types: unspecified (the default), IEEE 802.3, or IEEE 802.5.

When you assign unspecified as the LAN type, the client obtains the ELAN type 
from the LECS when it joins an emulated LAN. When you assign IEEE 802.3 or 
IEEE 802.5, the client joins only Ethernet or token ring ELANs (respectively).

Using the BCC

To change the emulated LAN type, navigate to the service record prompt (for 
example, box; atm/11/1; lec-service/newyork) and enter:

lan-type <value>

value is the type of ELAN that you want this LEC to join: unspecified, ieee8023, 
or ieee8025.

For example, the following command allows the LEC to join only Ethernet
(IEEE 802.3) emulated LANs:

lec-service/newyork# lan-type ieee8023
lec-service/newyork#

Note: If you set the LE client to run in manual configuration mode (see 
“Selecting a LEC Configuration Mode” on page 8-8), you must specify an 
ELAN type of IEEE 802.3 or IEEE 802.5.
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Using Site Manager

To change the emulated LAN type for a LANE client, complete the following 
tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Emulated LAN Type parameter. 
Click on Help or see the parameter 
description on page A-38.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.
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Specifying an Emulated LAN Segment ID

You must specify an emulated LAN segment ID when:

• The LANE client is a token ring end station. A LANE client is a token ring 
end station when it resides at the edge of a token ring network.

• You are routing IP or IPX across a source route bridging (SRB) token ring 
network.

The emulated LAN segment ID specifies the ring ID (in decimal) on which the 
LANE client resides. By default, this value is set to 0. However, you can specify a 
value from 0 to 4,095 for the token ring segment ID.

To change the emulated LAN segment ID, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Emulated LAN Segment ID 
parameter. Click on Help or see the 
parameter description on page A-45.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.
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Disabling and Reenabling the LANE Client

By default, the LANE client is enabled on a service record when you assign 
LANE data encapsulation to that service record. However, you can disable or 
reenable the LANE client on a service record at any time.

To disable or reenable a LANE client, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Enable parameter. Click on Help 
or see the parameter description on 
page A-37.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.
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Specifying an Owner

Specifying a LEC owner is optional. This entry (up to 128 alphanumeric 
characters) provides administrative assistance when distinguishing among LECs.

To specify a LEC owner, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Owner parameter. Click on Help 
or see the parameter description on 
page A-37.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.
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Assigning ATM LES Addresses

LE clients use the LAN emulation server (LES) to establish the control direct 
VCC. The LEC must know the LES address to obtain this information before it 
can join an emulated LAN. The LES address consists of a user part and a network 
prefix.

If you select manual configuration mode, you must enter at least one LES address 
(see “Selecting a LEC Configuration Mode” on page 8-8). If you select automatic 
configuration mode, you do not need to enter a LES address. The LE client 
receives the LES ATM address from the LAN emulation configuration server 
(LECS).

You can configure a prioritized list of up to four LES addresses per LAN 
emulation client. After you assign the list of addresses, the LEC references the list 
and attempts to access the first LES address entry you created. If this attempt is 
unsuccessful, the LEC attempts to connect to the next LES address, and so on. 
When the LEC reaches the last address in the list, it starts again at the beginning of 
the list until it successfully joins an emulated LAN.

Using the BCC

To specify a LES address, navigate to the service record prompt (for example, 
box; atm/11/1; lec-service/newyork) and enter:

les name <name> address <address>

name is a text string that you assign to identify the LES.

address is the full LES ATM address.

For example, the following command creates a LES with the name primary and 
the address 3900000000000000000000000000000000abcdef.

lec-service/newyork# les name primary address 39000000000000000000 
00000000000000abcdef
les/primary#
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Using Site Manager

To specify a LES address, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify. 

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Configuration Mode parameter to 
Manual. Click on Help or see the 
parameter description on page A-38.

7. Click on LES. The ATM LES List window opens.

8. Click on Add. The LANE Redundancy window opens.

9. Set the following parameters:
• LE Server ATM Address Network 

Prefix 
• LE Server ATM Address User Part 
Click on Help or see the parameter 
descriptions beginning on page A-47.

10. Click on OK. You return to the ATM LES List window.

11. Click on Done. You return to the LAN Emulation 
Parameters window.

12. Click on OK. You return to the ATM Service Records 
List window.

13. Click on Done. You return to the Edit ATM Connector 
window.

14. Click on Done. You return to the Select Connection Type 
window.

15. Click on Done. You return to the Configuration Manager 
window.
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Disabling and Reenabling a LES Entry

By default, you enable a LES entry when you add it to the service record. 
However, you can disable or reenable a specific LES entry at any time. You enable 
the LES entry to allow a LEC to access that address for information. Otherwise, 
disable the LES entry.

Using the BCC

To disable a LES entry, navigate to the LES prompt (for example, box; atm/11/1; 
lec-service/newyork; les/primary) and enter:

state disabled

For example, the following command disables the LES primary:

les/primary# state disabled
les/primary#

To reenable a LES entry, navigate to the LES prompt and enter:

state enabled

For example, the following command reenables the LES primary:

les/primary# state enabled
les/primary#
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Using Site Manager

To disable or reenable a LES entry, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify. 

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Click on LES. The ATM LES List window opens.

7. Click on the LES that you want to modify.

8. Set the Enable parameter. Click on Help 
or see the parameter description on 
page A-47.

9. Click on Done. You return to the LAN Emulation 
Parameters window.

10. Click on OK. You return to the ATM Service Records 
List window.

11. Click on Done. You return to the Edit ATM Connector 
window.

12. Click on Done. You return to the Select Connection Type 
window.

13. Click on Done. You return to the Configuration Manager 
window.
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Changing the LE Server Name

The LE server name is a value that uniquely defines each LAN emulation server 
(LES) that you create. In the BCC, you enter the LE server name when you create 
the LES. You cannot change that name. To use a different name, you must add a 
new LE server to the configuration.

In Site Manager, however, the router arbitrarily assigns a unique value to each LE 
server that you add. You can accept the value that the router assigns, or change 
that value to any alphanumeric string. However, each LE server must have a 
unique name.

Using the BCC

You cannot change the LE server name in the BCC after you use it to add a LES. 
To use a different name, you must add a new LES to the configuration. For 
information about adding a LES using the BCC, see “Assigning ATM LES 
Addresses” on page 8-17.

Using Site Manager

To change the LE server name, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify. 

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Click on LES. The ATM LES List window opens.

7. Set the LE Service Name parameter. 
Click on Help or see the parameter 
description on page A-48.

(continued)
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Inserting a LES Address Out of Sequence

Using Site Manager, you can insert a LES address between two existing LES 
addresses by completing the following tasks:

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.

Note: You cannot insert a LES address out of sequence using the BCC. The 
BCC uses the first LES that you enter as the primary, the second LES as the 
secondary, and so on.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify. 

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Click on LES. The ATM LES List window opens.

7. Click on the LES address in the list after 
which you want to add the new address.

The settings for this LES appear in the 
parameter boxes.

8. Click on Add After. The LANE Redundancy window opens.

(continued)

Site Manager Procedure (continued)

You do this System responds
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Modifying a LES Entry

You can modify the parameters associated with a LES entry at any time. To 
modify a LES entry, complete the following tasks:

9. Set the following parameters:
• LE Server ATM Address Network 

Prefix 
• LE Server ATM Address User Part 
Click on Help or see the parameter 
descriptions beginning on page A-47.

10. Click on OK. You return to the ATM LES List window.

11. Click on Done. You return to the LAN Emulation 
Parameters window.

12. Click on OK. You return to the ATM Service Records 
List window.

13. Click on Done. You return to the Edit ATM Connector 
window.

14. Click on Done. You return to the Select Connection Type 
window.

15. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify. 

(continued)

Site Manager Procedure (continued)

You do this System responds
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Deleting a LES Entry

You can delete a LES entry at any time.

Using the BCC

To delete a LES, navigate to the LES prompt (for example, box; atm/11/1; 
lec-service/newyork; les/primary) and enter:

delete

For example, the following command deletes the LES primary:

les/primary# delete
lec-service/newyork#

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Click on LES. The ATM LES List window opens.

7. Click on the LES that you want to modify.

8. Set one or more of the following 
parameters:
• Enable
• LE Server ATM Address Network 

Prefix 
• LE Server ATM Address User Part 
Click on Help or see the parameter 
descriptions beginning on page A-47.

9. Click on Done. You return to the LAN Emulation 
Parameters window.

10. Click on OK. You return to the ATM Service Records 
List window.

11. Click on Done. You return to the Edit ATM Connector 
window.

12. Click on Done. You return to the Select Connection Type 
window.

13. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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Using Site Manager

To delete a LES address, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Click on LES. The ATM LES List window opens.

7. Click on the LES address that you want to 
delete.

The settings for this LES appear in the 
parameter boxes.

8. Click on Delete.

9. Click on Done. You return to the LAN Emulation 
Parameters window.

10. Click on OK. You return to the ATM Service Records 
List window.

11. Click on Done. You return to the Edit ATM Connector 
window.

12. Click on Done. You return to the Select Connection Type 
window.

13. Click on Done. You return to the Configuration Manager 
window.
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Setting the Maximum Data Frame Size

The maximum data frame size is the largest frame that the LE client can:

• Send on the multicast send VCC.

• Receive on the multicast forward VCC.

• Send and receive on data direct VCCs.

When you accept the default, unspecified, the LEC obtains the maximum data 
frame size when it joins an ELAN. However, you can limit the maximum data 
frame size that the LEC can transmit or receive to 1,516, 4,544, 9,234, or 18,190 
octets.

The default maximum transmission unit for Token-Ring LANE is 4,544.

Using the BCC

To change the maximum data frame size, navigate to the service record prompt 
(for example, box; atm/11/1; lec-service/newyork) and enter:

maximum-data-frame-size <value>

value is the maximum data frame size that you want the LEC to transmit, 
unspecified 1,516, 4,544, 9,234, or 18,190 octets.

For example, the following command changes the maximum data frame size to 
1,516 octets:

lec-service/newyork# maximum-data-frame-size 1516
lec-service/newyork#
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Using Site Manager

To change the maximum data frame size, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The ATM Configuration window opens.

2. Click on ATM. The Edit ATM Connection window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Maximum Data Frame Size 
parameter. Click on Help or see the 
parameter description on page A-39.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.
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Controlling Unknown Frame Distribution

A frame is considered unknown when the LE client does not recognize the 
destination MAC address. An unknown frame goes to the broadcast and unknown 
server (BUS) for distribution. Setting unknown frame variables helps to limit 
unknown frame traffic to the BUS.

To control the distribution of unknown frames, you can specify the following:

• Maximum number of unknown frames that the LEC can send

• Amount of time allowed to send the unknown frames to the BUS

Setting a Maximum Unknown Frame Count

By default, a LEC can send only one unknown frame to the BUS within a 
specified unknown frame time (see the next section, “Specifying a Maximum 
Unknown Frame Time”). However, you can allow a LEC to send up to 10 
unknown frames to the BUS within the maximum unknown frame time.

Using the BCC

To change the maximum unknown frame count value, navigate to the service 
record prompt (for example, box; atm/11/1; lec-service/newyork) and enter:

maximum-unknown-frame <value>

value is the maximum number of unknown frames (from 1 to 10) that the LEC can 
send to the BUS within the maximum unknown frame time.

For example, the following command changes the maximum unknown frame 
count to 5:

lec-service/newyork# maximum-unknown-frame 5
lec-service/newyork#
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Using Site Manager

To change the maximum unknown frame count, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Max Unknown Frame Count 
parameter. Click on Help or see the 
parameter description on page A-41.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.
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Specifying a Maximum Unknown Frame Time

The unknown frame time specifies the maximum amount of time allowed to send 
unknown frames to the BUS. For instructions on setting the unknown frame count, 
see “Setting a Maximum Unknown Frame Count” on page 8-28. By default, the 
LEC can send the allowable number of unknown frames for a maximum of 1 
second. However, you can specify up to 60 seconds for the maximum unknown 
frame time.

For example, if you accept the default values for the unknown frame count and 
frame time, a LEC can send one unknown frame within 1 second for any given 
MAC address without having to initiate the Address Resolution Protocol (ARP) to 
resolve that MAC address.

Using the BCC

To change the maximum unknown frame time, navigate to the service record 
prompt (for example, box; atm/11/1; lec-service/newyork) and enter:

maximum-unknown-frame-time <value>

value is the maximum amount of time allowed (from 1 to 60 seconds) to send the 
number of unknown frames.

For example, the following command changes the maximum unknown frame time 
to 10 seconds:

lec-service/newyork# maximum-unknown-frame-time 5
lec-service/newyork#
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Using Site Manager

To change the maximum unknown frame time, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Max Unknown Frame Time 
parameter. Click on Help or see the 
parameter description on page A-41.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.
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Modifying LEC Timers and Retry Counters

You can modify the following timers and counters for each LEC:

• Control timeout

• VCC timeout period

• Maximum retry count

• Aging time

• Forward delay time

• Expected LE_ARP response time

• Path switching delay

Setting the Control Timeout

The control timeout parameter specifies the timeout period used for most request/
response control frame interactions. The default timeout is 5 seconds, but you can 
set it to any value from 5 to 32,767 seconds.

Using the BCC

To change the control timeout, navigate to the service record prompt (for example, 
box; atm/11/1; lec-service/newyork) and enter:

control-timeout <value>

value is the timeout period you want the LEC to use for control frame interactions.

For example, the following command changes the control timeout to 10 seconds:

lec-service/newyork# control-timeout 10
lec-service/newyork#
8-32 308612-14.20 Rev 00



Customizing LAN Emulation Service Records and Clients
 

Using Site Manager

To change the control timeout, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Control Timeout parameter. Click 
on Help or see the parameter description 
on page A-40.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.
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Disabling and Reenabling the VCC Timeout Period

When you enable the VCC timeout period (the default setting), the LEC can 
release any unused data direct or multicast send VCCs after the VCC timeout 
period expires. The ATM drivers provide a VCC timeout period of 20 minutes. If 
you disable the VCC timeout period, the LEC does not release any unused data 
direct or multicast send VCCs.

Using the BCC

To disable the VCC timeout period, navigate to the service record prompt (for 
example, box; atm/11/1; lec-service/newyork) and enter:

vcc-timeout disabled

For example, the following command disables the VCC timeout period on LANE 
service record newyork:

lec-service/newyork# vcc-timeout disabled
lec-service/newyork#

To reenable the VCC timeout period, navigate to the service record prompt and 
enter:

vcc-timeout enabled

For example, the following command reenables the VCC timeout period on 
LANE service record newyork:

lec-service/newyork# vcc-timeout enabled
lec-service/newyork#
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Using Site Manager

To disable or reenable the VCC timeout period, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the VCC Timeout Period Enable 
parameter. Click on Help or see the 
parameter description on page A-42.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.
308612-14.20 Rev 00 8-35



Configuring ATM Services
Setting the Maximum Retry Count

The maximum retry count specifies the maximum number of times a LEC can 
retry an LE_ARP_REQUEST (following the original request) for any given frame 
MAC address. You can allow either one (the default) or two retries.

Using the BCC

To change the maximum retry count, navigate to the service record prompt (for 
example, box; atm/11/1; lec-service/newyork) and enter:

maximum-retry-count <value>

value is the maximum number of times (1 or 2) that you want the LEC to retry an 
LE_ARP_REQUEST for any given frame MAC address.

For example, the following command changes the maximum retry count to 2:

lec-service/newyork# maximum-retry-count 2
lec-service/newyork#

Using Site Manager

To change the maximum retry count, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Max Retry Count parameter. Click 
on Help or see the parameter description 
on page A-42.

(continued)
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Setting the Aging Time

The aging time specifies the maximum amount of time that a LEC can maintain an 
entry in its LE_ARP cache without having to verify the relationship of that entry.

By default, the LEC maintains entries for 300 seconds. However, you can set the 
aging time to a value from 10 to 300 seconds.

Using the BCC

To change the aging time, navigate to the service record prompt (for example, 
box; atm/11/1; lec-service/newyork) and enter:

aging-time <value>

value is the number of seconds (from 10 to 300) that you want the LEC to 
maintain LE_ARP cache entries.

For example, the following command changes the aging time to 150 seconds:

lec-service/newyork# aging-time 150
lec-service/newyork#

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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Using Site Manager

To change the aging time, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Aging Time parameter. Click on 
Help or see the parameter description on 
page A-43.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.
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Setting the Forward Delay Time

As long as there are no changes occurring in the network topology, the forward 
delay time parameter specifies the maximum amount of time that a LEC can 
maintain an entry in its LE_ARP cache without having to verify the relationship 
of that entry.

By default, the LEC maintains entries for 15 seconds, as long as the network 
topology does not change. However, you can set the forward delay time to a value 
from 4 to 30 seconds.

Using the BCC

To change the forward delay time, navigate to the service record prompt (for 
example, box; atm/11/1; lec-service/newyork) and enter:

forward-delay-time <value>

value is the number of seconds (from 4 to 30) that you want the LEC to maintain 
LE_ARP cache entries.

For example, the following command changes the forward delay time to 15 
seconds:

lec-service/newyork# forward-delay-time 15
lec-service/newyork#

Using Site Manager

To change the forward delay time, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

(continued)
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Specifying the Expected LE_ARP Response Time

The expected LE_ARP response time specifies the amount of time that the LEC 
expects an ARP request and ARP response cycle to take. The LEC uses this value 
during retries and verifications.

By default, the LEC expects an ARP request and ARP response cycle to take a 
maximum of 3 seconds. However, you can set the LE_ARP response time to a 
value from 1 to 30 seconds.

Using the BCC

To change the expected LE_ARP response time, navigate to the LANE service 
record prompt (for example, box; atm/11/1; lec-service/newyork) and enter:

arp-response-time <value>

value is the number of seconds (from 1 to 30) that the LEC expects an ARP 
request and ARP response cycle to take.

For example, the following command changes the expected LE_ARP response 
time to 15 seconds:

lec-service/newyork# arp-response-time 15
lec-service/newyork#

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Forward Delay Time parameter. 
Click on Help or see the parameter 
description on page A-43.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
8-40 308612-14.20 Rev 00



Customizing LAN Emulation Service Records and Clients
 

Using Site Manager

To change the expected LE_ARP response time, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Expected LE_ARP Response 
Time parameter. Click on Help or see the 
parameter description on page A-43.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.
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Setting the Path Switching Delay

The path switching delay specifies the amount of time that the LEC waits after 
sending a frame over an existing VCC before it switches to a new VCC (this 
applies to multicast and data direct VCCs).

You can use the path switching delay parameter to bypass the flush protocol. 
When you disable the flush protocol, the data for a specific MAC address 
automatically begins flowing over a new VCC when the path switching delay time 
elapses. (For instructions on disabling the flush protocol, see “Modifying Flush 
Protocol Variables” on page 8-44.)

By default, the LEC waits a maximum of 6 seconds after sending a frame over an 
existing VCC before it switches to a new VCC. However, you can set the path 
switching delay to a value from 1 to 8 seconds.

Using the BCC

To change the path switching delay, navigate to the LANE service record prompt 
(for example, box; atm/11/1; lec-service/newyork) and enter:

path-switching-delay <value>

value is the number of seconds (from 1 to 8) that you want the LEC to wait after 
sending a frame over an existing VCC before switching to a new VCC.

For example, the following command changes the path switching delay to 8 
seconds:

lec-service/newyork# path-switching-delay 8
lec-service/newyork#
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Using Site Manager

To change the path switching delay, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Path Switching Delay parameter. 
Click on Help or see the parameter 
description on page A-44.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.
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Modifying Flush Protocol Variables

The flush protocol ensures that data destined for a particular MAC address arrives 
in sequence. This means that after the LEC issues a flush request, the flush 
protocol drops any cells it receives for the particular MAC address until:

• The LEC receives a flush response from that MAC address.

• The flush timeout expires for that MAC address.

If the client receives a flush response from the MAC address, the cells for this 
MAC address begin flowing over a new virtual circuit. However, if the flush 
timeout expires for this MAC address, the cells begin flowing to the BUS.

Disabling and Reenabling the Flush Protocol

You can disable or reenable the flush protocol for any LEC.

When enabled (the default), the flush protocol drops cells with the current 
destination MAC address until the LEC receives a flush response for that MAC 
address or the flush timeout expires (see “Setting the Flush Timeout” on 
page 8-46).

When the flush protocol is disabled, cells containing the destination MAC address 
are dropped until the path switching delay times out. After the path switching 
delay time elapses, the data automatically begins flowing over a new virtual 
circuit.
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Using the BCC

To disable the flush protocol, navigate to the LANE service record prompt (for 
example, box; atm/11/1; lec-service/newyork) and enter:

flush-protocol disabled

For example, the following command disables the flush protocol on LANE 
service record newyork:

lec-service/newyork# flush-protocol disabled
lec-service/newyork#

To reenable the flush protocol, navigate to the LANE service record prompt and 
enter:

flush-protocol enabled

For example, the following command reenables the flush protocol on LANE 
service record newyork:

lec-service/newyork# flush-protocol enabled
lec-service/newyork#

Using Site Manager

To disable or reenable the flush protocol, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

(continued)
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Setting the Flush Timeout

The flush timeout specifies the amount of time that the LEC waits to receive a 
flush response (after sending a flush request) before it takes recovery action by 
switching to the BUS.

By default, the LEC waits 4 seconds for a flush response. However, you can set 
the flush timeout to a value from 1 to 4 seconds.

Using the BCC

To change the flush timeout value, navigate to the service record prompt (for 
example, box; atm/11/1; lec-service/newyork) and enter:

flush-timeout <value>

value is the number of seconds (from 1 to 4) that the LEC waits for a flush 
response.

For example, the following command changes the flush timeout value to 2 
seconds:

lec-service/newyork# flush-timeout 2
lec-service/newyork#

6. Set the Flush Protocol parameter. Click 
on Help or see the parameter description 
on page A-45.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
8-46 308612-14.20 Rev 00



Customizing LAN Emulation Service Records and Clients
 

Using Site Manager

To change the flush timeout value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the Flush Timeout parameter. Click 
on Help or see the parameter description 
on page A-44.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.
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Specifying a LECS ATM Address

You can specify which LAN emulation configuration server (LECS) you want the 
LE client to use when opening a configuration VCC to the configuration service. 
Entering this ATM address is optional; if you do not enter an address, the LEC 
uses the well-known LECS ATM address to open a configuration VCC.

Using the BCC

To specify a LECS ATM address, navigate to the service record prompt (for 
example, box; atm/11/1; lec-service/newyork) and enter:

config-server-atm-address <address>

address is the ATM address of the LECS that you want the LEC to use.

For example, the following command specifies the LECS address 
3900000000000000000000000000000000000001 for LANE service record 
newyork:

lec-service/newyork# config-server-atm-address 390000000000000000000 
0000000000000000001
lec-service/newyork#

Using Site Manager

To specify a LECS ATM address, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

5. Click on LEC. The LAN Emulation Parameters window 
opens.

(continued)
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Enabling and Disabling LAN Emulation Version 2

By default, LAN Emulation Version 2 is disabled on a service record. However, 
you can enable or disable this function at any time.

If the LEC operates in an MPOA environment, you must enable the LAN 
Emulation Version 2 function. Otherwise, disable the function.

To enable or disable the LAN Emulation Version 2 function, complete the 
following tasks:

6. Set the LE Config Server ATM Address 
parameter. Click on Help or see the 
parameter description on page A-46.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LANE service record that you 
want to modify.

(continued)

Site Manager Procedure (continued)

You do this System responds
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Deleting a Service Record

You can use the BCC or Site Manager to delete a LANE service record.

Using the BCC

To delete a LANE service record, navigate to the service record prompt (for 
example, box; atm/11/1; lec-service/newyork) and enter:

delete

For example, the following command deletes the LANE service record newyork:

lec-service/newyork# delete
atm/11/1#

5. Click on LEC. The LAN Emulation Parameters window 
opens.

6. Set the LAN Emulation Version 2 
parameter. Click on Help or see the 
parameter description on page A-46.

7. Click on OK. You return to the ATM Service Records 
List window.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.

Site Manager Procedure (continued)

You do this System responds
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Using Site Manager

To delete a LANE service record, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the LAN emulation service record 
that you want to delete.

5. Click on Delete. Site Manager deletes the service record.

6. Click on Done. You return to the Edit ATM Connector 
window.

7. Click on Done. You return to the Select Connection Type 
window.

8. Click on Done. You return to the Configuration Manager 
window.
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Where to Go Next

Use the following table to determine where to go next. 

If you want to Go to

Learn about ATM concepts. Chapter 1

Start ATM. Chapter 2

Change default settings for ATM interface parameters. Chapter 3

Change default settings for ATM signaling parameters. Chapter 4

Change default settings for ATM PVC service record and PVC 
parameters.

Chapter 5

Customize traffic shaping parameters for the Passport 5430. Chapter 6

Change default settings for classical IP service record parameters. Chapter 7

Change default settings for ATM WAN SVC service record and WAN 
SVC parameters.

Chapter 9

Change the default settings for CES parameters. Chapter 10

Change default settings for the ATM router redundancy parameter. Chapter 11

Obtain information about Site Manager parameters. Appendix A

Monitor ATM using the BCC show commands. Appendix B
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Chapter 9
Customizing WAN SVC Service

Records and WAN SVCs

When you start ATM on the router, all parameters use their default values. 
Depending on the requirements of your network, you may want to change some of 
these values.

This chapter describes how to customize WAN SVC service record parameters 
and how to define the WAN SVCs that operate on WAN SVC service records. It 
includes the following information:

This chapter describes how to customize existing WAN SVC service records and 
WAN SVCs. For instructions on how to define a new WAN SVC service record 
and WAN SVC, see “Adding a Service Record for WAN SVCs” on page 2-13.

Topic Page

Disabling and Reenabling a WAN SVC Service Record 9-2

Defining the Service Record MTU 9-3

Changing the Service Name 9-4

Changing the Routing Update Policy 9-5

Modifying ATM Traffic Parameters 9-6

Assigning a Data Encapsulation Type 9-13

Deleting a WAN SVC Service Record 9-13

Where to Go Next 9-14
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Disabling and Reenabling a WAN SVC Service Record

By default, you enable a service record when you add it to the interface. However, 
you can disable and reenable a specific service record at any time. Disable the 
service record to stop traffic flow over it and any of its VCs. Otherwise, enable the 
service record.

To disable or reenable a WAN SVC service record, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the WAN SVC service record that 
you want to modify.

5. Set the Enable/Disable parameter. Click 
on Help or see the parameter description 
on page A-14.

6. Click on Done. You return to the Edit ATM Connector 
window.

7. Click on Done. You return to the Select Connection Type 
window.

8. Click on Done. You return to the Configuration Manager 
window.
9-2 308612-14.20 Rev 00



Customizing WAN SVC Service Records and WAN SVCs
 

Defining the Service Record MTU

The maximum transmission unit (MTU) is the largest possible unit of data that the 
WAN SVC service record can transmit. By default, the service record allows an 
MTU size of 4608 octets. This value can handle most packet sizes. 

The MTU size is typically determined by the driver. However, you can override 
the driver default to accommodate connection to devices that require different 
MTU sizes. You can set the MTU to any value from 1 through 9188 octets.

To change the MTU size for a service record, complete the following tasks:

Note: Some ATM devices do not negotiate MTU size. When connecting to 
such a device, Nortel Networks recommends that you specify an MTU size of 
9188 octets for full compatibility with RFC 1577.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the WAN SVC service record that 
you want to modify.

5. Set the MTU parameter. Click on Help or 
see the parameter description on 
page A-19.

6. Click on Done. You return to the Edit ATM Connector 
window.

7. Click on Done. You return to the Select Connection Type 
window.

8. Click on Done. You return to the Configuration Manager 
window.
308612-14.20 Rev 00 9-3



Configuring ATM Services
Changing the Service Name

The service name is a value that uniquely defines each service record you create. 
The router arbitrarily assigns a unique value to each service record you create. 
You can accept the assigned value, or change that value to any alphanumeric 
string. However, each service record must have a unique service name.

To change the service name, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the WAN SVC service record that 
you want to modify.

5. Set the Service Name parameter. Click on 
Help or see the parameter description on 
page A-20.

6. Click on Done. You return to the Edit ATM Connector 
window.

7. Click on Done. You return to the Select Connection Type 
window.

8. Click on Done. You return to the Configuration Manager 
window.
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Changing the Routing Update Policy

With WAN SVCs, you can configure one or more adjacent hosts for each circuit. 
The number of adjacent hosts that you configure determines the routing update 
policy you should use.

If you configure one adjacent host, you should choose the dial-optimized routing 
policy. When you choose dial-optimized routing, Site Manager automatically sets 
the RIP broadcast timers to 1 hour. You may want to change the RIP broadcast 
timer to a high value (for example, 8 hours) so that SVCs are not established as 
often. In this configuration, the router sends routing updates whenever a data 
packet or a call from the other end causes ATM to establish an SVC to the 
adjacent host. Setting the RIP broadcast timer to a high value ensures that ATM 
establishes an SVC primarily because the router needs to transmit data. 

If you configure more than one adjacent host, you should choose the normal 
routing policy. When you choose the normal routing policy, Site Manager 
automatically sets the RIP broadcast timers to 30 seconds. You can accept this 
value or change it to a higher value so that SVCs are not established as often. In 
this type of configuration, when the broadcast timer expires, ATM establishes any 
nonexisting SVCs so that the router can send routing updates simultaneously to 
each adjacent host.

For information about how to configure RIP timers for an IP interface, see 
Configuring IP, ARP, RARP, RIP, and OSPF Services. For information about how 
to configure RIP timers for an IPX interface, see Configuring IPX Services.
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To configure the routing policy, complete the following tasks: 

Modifying ATM Traffic Parameters

You can modify the following traffic parameters for WAN SVCs:

• Transmit and receive peak cell rate (PCR)

• Transmit and receive sustainable cell rate (SCR)

For additional information about traffic parameters, see “ATM Traffic Parameters” 
on page 1-23.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the WAN SVC service record that 
you want to modify.

5. Set the WAN SVC Routing Mode 
parameter. Click on Help or see the 
parameter description on page A-20.

6. Click on Done. You return to the Edit ATM Connector 
window.

7. Click on Done. You return to the Select Connection Type 
window.

8. Click on Done. You return to the Configuration Manager 
window.
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Enabling Traffic Parameters

To perform traffic shaping over the SVCs to any particular adjacent host, complete 
the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the WAN SVC service record that 
you want to modify.

5. Click on WAN SVC. The ATM WAN SVC List window opens.

6. Configure the following traffic shaping 
parameters:
• Enable/Disable
• Adjacent Host ATM Address
• Xmit Peak Cell Rate (cells/s)
• Xmit Sustainable Cell Rate (cells/s)
• Recv Peak Cell Rate (cells/s)
• Recv Sustainable Cell Rate (cells/s)
Click on Help or see the parameter 
descriptions beginning on page A-32.

7. Click on Done. You return to the Edit ATM Connector 
window.

8. Click on Done. You return to the Select Connection Type 
window.

9. Click on Done. You return to the Configuration Manager 
window.
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Specifying the Adjacent Host ATM Address

To perform traffic shaping for an adjacent host, you must enter the adjacent host 
ATM address. The adjacent host ATM address is a 20-bit hexadecimal 
representation of the IP adjacent host address or IPX adjacent host address. 

To set the adjacent host ATM address, complete the following tasks:

Note: To complete the WAN SVC configuration, you must also configure IP 
or IPX adjacent host entries for all routers to be connected to this router with 
WAN SVCs. For information about how to configure an IP adjacent host, see 
Configuring IP, ARP, RARP, RIP, and OSPF Services. For information about 
how to configure an IPX adjacent host, see Configuring IPX Services.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the WAN SVC service record that 
you want to modify.

5. Click on WAN SVC. The ATM WAN SVC List window opens.

6. Click on Add. The WAN SVC Parameters window 
opens.

7. Set the Adjacent Host ATM Address 
parameter. Click on Help or see the 
parameter description on page A-32.

8. Click on Done. You return to the Edit ATM Connector 
window.

9. Click on Done. You return to the Select Connection Type 
window.

10. Click on Done. You return to the Configuration Manager 
window.
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Setting the PCR

The peak cell rate (PCR) specifies the upper traffic limit, in cells/s, that the ATM 
connection can support.

By default, the PCR is 4716 cells/s for both the transmitting and receiving 
direction. Table 9-1 lists the valid ranges for each Nortel Networks ATM router.

For additional information about the PCR, see “Using the PCR” on page 1-24.

Table 9-1. Valid PCR Ranges

ATM Router Range (Cells/s)

ATM ARE OC-3 SONET/SDH ILI pairs 128 to 353,207

Model 5782 VNR 128 to 353,207

ATM ARE DS-3 ILI pairs 128 to 96,000

ATM ARE E-3 ILI pairs; G.832 framing mode 128 to 80,000

ATM ARE E-3 ILI pairs; G.751 framing mode 128 to 72,000

DS-1 on Passport 5430 10 to 3622

E-1 on Passport 5430 10 to 4528
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To change the WAN SVC PCR value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the WAN SVC service record that 
you want to modify.

5. Click on WAN SVC. The ATM WAN SVC List window opens.

6. Click on the WAN SVC that you want to 
modify.

7. Set the Xmit Peak Cell Rate (cells/s) and 
Recv Peak Cell Rate (cells/s) 
parameters. Click on Help or see the 
parameter descriptions on pages A-33 
and A-35.

8. Click on Done. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

10. Click on Done. You return to the Select Connection Type 
window.

11. Click on Done. You return to the Configuration Manager 
window.
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Setting the SCR

The sustainable cell rate (SCR) is the upper bound on the conforming average rate 
of an individual WAN SVC or control VC. The average rate is the number of cells 
transmitted over the link divided by the duration of the connection. The duration 
of the connection is the total amount of time it takes from connection setup to 
connection release.

By default, the SCR is 4716 cells/s for both the transmitting and receiving 
direction. Table 9-2 lists the valid ranges for each Nortel Networks ATM router. 
To disable the SCR, set the value to 0.

For additional information about the SCR, see “Using the SCR” on page 1-25.

Table 9-2. Valid SCR Ranges

ATM Router Range (Cells/s)

ATM ARE OC-3 SONET/SDH ILI pairs 0, 128 to 353,207

Model 5782 VNR 0, 128 to 353,207

ATM ARE DS-3 ILI pairs 0, 128 to 96,000

ATM ARE E-3 ILI pairs; G.832 framing mode 0, 128 to 80,000

ATM ARE E-3 ILI pairs; G.751 framing mode 0, 128 to 72,000

DS-1 on Passport 5430 10 to 3622

E-1 on Passport 5430 10 to 4528
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To change the WAN SVC SCR value, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the WAN SVC service record that 
you want to modify.

5. Click on WAN SVC. The ATM WAN SVC List window opens.

6. Click on the WAN SVC that you want to 
modify.

7. Set the Xmit Sustainable Cell Rate 
(cells/s) and Recv Sustainable Cell Rate 
(cells/s) parameter. Click on Help or see 
the parameter descriptions beginning on 
page A-34.

8. Click on Done. You return to the ATM Service Records 
List window.

9. Click on Done. You return to the Edit ATM Connector 
window.

10. Click on Done. You return to the Select Connection Type 
window.

11. Click on Done. You return to the Configuration Manager 
window.
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Assigning a Data Encapsulation Type

You must use LLC/SNAP (the default value) data encapsulation to operate on the 
WAN SVC. You assign the LLC/SNAP data encapsulation type at the service 
record level. See “Adding a Service Record for WAN SVCs” on page 2-13.

For additional information about assigning data encapsulation types, see “Data 
Encapsulation Methods” on page 1-13.

Deleting a WAN SVC Service Record

To delete a WAN SVC service record, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Service Attributes. The ATM Service Records List window 
opens.

4. Click on the WAN SVC service record that 
you want to delete.

5. Click on Delete. Site Manager deletes the service record.

6. Click on Done. You return to the Edit ATM Connector 
window.

7. Click on Done. You return to the Select Connection Type 
window.

8. Click on Done. You return to the Configuration Manager 
window.
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Where to Go Next

Use the following table to determine where to go next.

If you want to Go to

Learn about ATM concepts. Chapter 1

Start ATM. Chapter 2

Change default settings for ATM interface parameters. Chapter 3

Change default settings for ATM signaling parameters. Chapter 4

Change default settings for ATM PVC service record and PVC 
parameters.

Chapter 5

Customize traffic shaping parameters for the Passport 5430. Chapter 6

Change default settings for classical IP service record parameters. Chapter 7

Change default settings for LAN Emulation client service record 
parameters.

Chapter 8

Change the default settings for CES parameters. Chapter 10

Change default settings for the ATM router redundancy parameter. Chapter 11

Obtain information about Site Manager parameters. Appendix A

Monitor ATM using the BCC show commands. Appendix B
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Chapter 10
Customizing CES (Passport 5430)

When you start CES on the Passport 5430 router, all parameters use their default 
values. Depending on the requirements of your network, you may want to change 
some of these values.

This chapter describes how to customize two CES parameters. It includes the 
following information:

For instructions on how to start CES, see “Starting CES (Passport 5430)” on page 
2-8 (BCC instructions) or “Starting CES (Passport 5430)” on page 2-19 (Site 
Manager instructions).

Note: For information about other CES parameters and about all other settings 
for CES and TDM, see Configuring TDM Services.

Topic Page

PCR and SCR Requirements for PVCs on a CES Circuit 10-2

Setting the Partial Fill Parameter 10-3

Disabling and Reenabling Traffic Across the CES Circuit 10-4

Where to Go Next 10-5
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PCR and SCR Requirements for PVCs on a CES Circuit

To correctly support constant bit rate (CBR) bandwidth for CES, PVCs that are 
external to the router must provide a minimum peak cell rate (PCR) and 
sustainable cell rate (SCR). If the PVCs do not provide these minimum rates, the 
PVCs will experience data underruns, and the CES circuit will lose data.

The BCC and Site Manager automatically compute and set the PCR and SCR 
rates when you specify the timeslot and timeslot-subrate values in the BCC or 
the Number of Timeslots and Per Timeslot Subrate values in Site Manager. (See 
Configuring TDM Services for information about these parameters.) Table 10-1 
lists the minimum PCR and SCR settings required for the PVCs on the switches in 
the ATM network, in order for the PVCs to carry CES traffic between routers. 

Table 10-1. Minimum PCR and SCR Settings for CES PVCs

Timeslots Subrate (Kb/s) Data Rate (Kb/s) PCR (cells/s) SCR (cells/s)

1 56 56 187 187

1 64 64 215 215

2 64 128 427 427

3 64 192 640 640

4 64 256 852 852

5 64 320 1066 1066

6 64 384 1278 1278

7 64 448 1491 1491

8 64 512 1703 1703

9 64 576 1916 1916

10 64 640 2130 2130

11 64 704 2342 2342

12 64 768 2555 2555

13 64 832 2767 2767

14 64 896 2980 2980

15 64 960 3193 3193

16 64 1024 3406 3406

17 64 1088 3618 3618

18 64 1152 3622 3622
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Setting the Partial Fill Parameter

You can specify the number of octets of data per cell that the router will transfer. 
Setting the partial fill size to 0 turns off partial fill.

Using the BCC

To set the number of octets of data per cell, navigate to the CES prompt (for 
example, (box; atm/1/1/2/1; pvc-service/boston; pvc/1/1/2/1/0/33; 
ces/0/33/1/4/2/2) and enter:

partial-cell-fill <integer>

integer is the number of octets from 0 through 47 that you want CES to use.

For example, the following command sets the partial fill size to 32 octets per cell:

ces/0/33/1/4/2/2# partial-cell-fill 32
ces/0/33/1/4/2/2# 

Using Site Manager

To use partial fill, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The ATM Configuration window opens.

2. Click on Platform. The Platform menu opens.

3. Choose View CES. The CES Connections window opens.

4. Set the Partial Fill (octets/cell) 
parameter. Click on Help or see the 
parameter description on page A-21.

5. Click on Apply.

6. Click on Done. You return to the Configuration Manager 
window.
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Disabling and Reenabling Traffic Across the CES Circuit

You can disable or reenable traffic across the CES circuit. By default, when you 
first start CES by connecting an ATM PVC to a dual synchronous port set up as a 
CES H.110 circuit, the router enables traffic across the circuit.

Using the BCC

To disable or reenable traffic across the CES circuit, navigate to the CES prompt 
(for example, (box; atm/1/1/2/1; pvc-service/boston; pvc/1/1/2/1/0/33; 
ces/0/33/1/4/2/2) and enter:

admin-status {down | up}

For example, the following command disables the CES circuit:

ces/0/33/1/4/2/2# admin-status down
ces/0/33/1/4/2/2# 

Using Site Manager

To disable or reenable traffic across the CES circuit, complete the following tasks:

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The ATM Configuration window opens.

2. Click on Platform. The Platform menu opens.

3. Choose View CES. The CES Connections window opens.

4. Set the Administration Status 
parameter. Click on Help or see the 
parameter description on page A-21.

5. Click on Apply.

6. Click on Done. You return to the Configuration Manager 
window.
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Where to Go Next

Use the following table to determine where to go next. 

If you want to Go to

Learn about ATM concepts. Chapter 1

Start ATM. Chapter 2

Change default settings for ATM interface parameters. Chapter 3

Change default settings for ATM signaling parameters. Chapter 4

Change default settings for ATM PVC service record and PVC 
parameters.

Chapter 5

Customize traffic shaping parameters for the Passport 5430. Chapter 6

Change default settings for classical IP service record parameters. Chapter 7

Change default settings for LAN Emulation client service record 
parameters.

Chapter 8

Change default settings for ATM WAN SVC service record and WAN 
SVC parameters.

Chapter 9

Change default settings for the ATM router redundancy parameter. Chapter 11

Obtain information about Site Manager parameters. Appendix A

Monitor ATM using the BCC show commands. Appendix B
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Chapter 11
Customizing ATM Router Redundancy

Nortel Networks routers support warm standby router redundancy. This type of 
redundancy protects a network from the irrecoverable failure of an entire router. 
For general information about router redundancy, see “ATM Router Redundancy 
Concepts” on page 1-39.

This chapter describes how to customize an ATM router redundancy 
configuration.
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Configuring ATM Services
Setting the ATM Router Redundancy Monitoring Timer

Nortel Networks ATM router redundancy uses only one ATM-specific Site 
Manager parameter: ATM Monitoring Timer.

The ATM monitoring timer specifies the amount of time in milliseconds (ms) that 
the secondary router waits before beginning the process of becoming the primary 
router. By default, if the primary router experiences a loss of signal, it waits 
3000 ms for the signal to return. If the signal does not return within that time, the 
secondary router begins the process of becoming the primary router.

You can set the ATM monitoring timer to any value from 1 through 65,535 ms.

To set the ATM monitoring timer, complete the following tasks:

Note: For instructions on how to start ATM router redundancy, see “Starting 
ATM Router Redundancy” on page 2-20. For instructions on how to customize 
router redundancy parameters, see Configuring Interface and Router 
Redundancy.

Site Manager Procedure

You do this System responds

1. In the Configuration Manager window, 
click on the ATM interface (ATM1) that you 
want to modify.

The Select Connection Type window 
opens.

2. Click on ATM. The Edit ATM Connector window opens.

3. Click on Configure ATM Router 
Redundancy.

The Router Redundancy Circuit window 
opens.

4. Set the ATM Monitoring Timer 
parameter. Click on Help or see the 
parameter description on page A-81.

5. Click on OK. You return to the Edit ATM Connector 
window.

6. Click on Done. You return to the Select Connection Type 
window.

7. Click on Done. You return to the Configuration Manager 
window.
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Where to Go Next

Use the following table to determine where to go next. 

If you want to Go to

Learn about ATM concepts. Chapter 1

Start ATM. Chapter 2

Change default settings for ATM interface parameters. Chapter 3

Change default settings for ATM signaling parameters. Chapter 4

Change default settings for ATM PVC service record and PVC 
parameters.

Chapter 5

Customize traffic shaping parameters for the Passport 5430. Chapter 6

Change default settings for classical IP service record parameters. Chapter 7

Change default settings for LAN Emulation client service record 
parameters.

Chapter 8

Change default settings for ATM WAN SVC service record and WAN 
SVC parameters.

Chapter 9

Change the default settings for CES parameters. Chapter 10

Obtain information about Site Manager parameters. Appendix A

Monitor ATM using the BCC show commands. Appendix B
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Appendix A
Site Manager Parameters

After you enable an ATM circuit, you can use Site Manager to edit ATM 
parameters. Many ATM parameters are interdependent; how you edit some 
parameters depends on how you set others.

This appendix contains the Site Manager parameter descriptions for ATM 
services. You can display the same information using Site Manager online Help.

This appendix contains the following information:

Topic Page

Accessing ATM Parameters A-2

ATM Line Parameters A-5

ATM Interface Parameters A-11

ATM Service Record Parameters A-14

CES Parameters A-21

ATM Virtual Channel Link Parameters A-22

ATM WAN SVC Parameters A-32

LAN Emulation Parameters A-37

LES Parameters A-47

ATM Signaling Parameters A-49

ATM ILMI Signaling Parameters A-69

Signaling and ILMI Control VC Parameters A-73

ATM Signaling AAL Parameters A-77

ATM Router Redundancy Parameter A-81

OAM Parameters A-82

(continued)
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Configuring ATM Services
Accessing ATM Parameters

You can access ATM parameters using either:

• A window path 

• A menu path 

Both of these paths begin at the Configuration Manager window.

The window path provides detailed information about individual ATM interfaces. 
The menu path provides global information about all interfaces on the router.

Using the Window Path

ATM uses two main windows to access ATM parameters: the Select Connection 
Type window (ATM Configuration window on the Passport 5430) and the Edit 
ATM Connector window.

Select Connection Type Window

To display the Select Connection Type window, click on an ATM link module 
interface (labeled ATM1) in the Configuration Manager window.

From the Select Connection Type window, you can do any of the following:

• Access ATM parameters.

• Access MPLS parameters.

• Access interface parameters.

• Access line parameters.

• Delete ATM or MPLS from the interface.

ATMARP Parameters A-85

Adjacent Host Parameters A-87

Note: For information about how to configure MPLS parameters, see 
Configuring MPLS Services.

Topic Page
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Edit ATM Connector Window

The Edit ATM Connector window acts as a control access point for all ATM 
parameters. This window provides information specific to each individual ATM 
interface.

For any given interface, the Edit ATM Connector window provides the following 
attribute buttons:

• Service Attributes

• MPOA Server Attributes

• ATM Signaling

• Signaling AAL (SAAL)

• Interim Local Management Interface (ILMI)

• Configure ATM Router Redundancy

By clicking on any of these buttons, you can access and edit the parameters 
associated with that specific ATM interface (connector). 

To access parameters from the Edit ATM Connector window:

1. In the Configuration Manager window, click on an ATM interface 
(labeled ATM1).

The Select Connection Type window (BN and System 5000) or the ATM 
Configuration window (Passport 5430) opens.

2. Click on ATM.

The Edit ATM Connector window opens.

3. Click on the appropriate attribute category.

Note: For information about how to configure MPOA parameters, see 
Configuring MPOA Services.
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Using the Menu Path

The Protocols menu in the Configuration Manager window provides global 
interface and signaling information about every ATM interface on the router. For 
example, if you configure four ATM link modules on the router, and you select 
Protocols > ATM > Interfaces, the ATM Interface List window displays all four 
ATM interfaces that you configured on the router.

Accessing Global ATM Signaling Attributes

To access global ATM signaling attributes:

1. In the Configuration Manager window, click on Protocols.

2. Click on ATM.

3. Click on ATM Signaling.

The ATM Signaling Records List window opens.

Accessing Global ATM Interface Attributes

To access global ATM interface attributes:

1. In the Configuration Manager window, click on Protocols.

2. Click on ATM.

3. Click on Interfaces.

The ATM Interface List window opens.

Note: Because MPLS uses ATM to operate, the ATM Interface List window 
also displays MPLS interfaces. However, you cannot edit MPLS interface 
parameters from this window. For information about how to edit MPLS 
interface parameters, see Configuring MPLS Services.
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ATM Line Parameters

The type of ATM link module you use determines the line details that you can 
edit. This section describes how to edit the line details for ATM ARE link modules 
and the Model 5782 ATM router, as well as for the Passport 5430 ATM T1/E1 
PMC module.

Parameter: Enable

Path: Configuration Manager > Circuits > Edit Circuits > Edit > Line Attributes
Default: Enable
Options: Enable | Disable

Function: Enables or disables the line driver.
Instructions: Select Enable or Disable.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.2

Parameter: Interface MTU

Path: Configuration Manager > Circuits > Edit Circuits > Edit > Line Attributes
Default: 4608
Options: 1 to 9188

Function: Specifies the largest packet size (in octets) that the router can transmit on this 
interface.

Instructions: Enter a value that is appropriate for the network.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.9
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Parameter: Data Path Enable

Path: Configuration Manager > Circuits > Edit Circuits > Edit > Line Attributes
Default: Enable
Options: Enable | Disable

Function: Specifies whether or not the router disables the interface between the driver and 
the higher-level software (the data path interface) when you disconnect the cable 
from the ATM module.

If you select Enable, then when you disconnect the cable from the ATM module, 
the router disables the data path interface after the time you specify with the 
Data Path Notify Timeout parameter.

If you select Disable, the router does not disable the data path interface when 
you disconnect the cable from the ATM module.

Instructions: Select Enable or Disable. If you select Enable, be sure to enter an appropriate 
value for the Data Path Notify Timeout parameter.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.11

Parameter: Data Path Notify Timeout

Path: Configuration Manager > Circuits > Edit Circuits > Edit > Line Attributes
Default: 1 second
Options: 0 to 3600 seconds

Function: Specifies the time that the router waits before disabling the data path interface 
when you disconnect the cable from the ATM module, providing that you set the 
Data Path Enable parameter to Enable.

Instructions: Accept the default or enter an appropriate value.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.12
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Parameter: SVC Inactivity Timeout Enable

Path: Configuration Manager > Circuits > Edit Circuits > Edit > Line Attributes
Default: Enable
Options: Enable | Disable

Function: If you select Enable, the router disables any switched virtual circuits (SVCs) on 
which the router receives or transmits no cells for the number of seconds you 
specify using the SVC Inactivity Timeout (Secs) parameter.

If you select Disable, the router keeps SVCs open unless you close them by 
another method.

Instructions: Select Enable or Disable.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.13

Parameter: SVC Inactivity Timeout (Secs)

Path: Configuration Manager > Circuits > Edit Circuits > Edit > Line Attributes
Default: 1200 seconds
Options: 60 to 3600 seconds

Function: If the router receives or transmits no cells on an SVC for this number of seconds, 
it closes the SVC, providing that you set the SVC Inactivity Timeout Enable 
parameter to Enable.

Instructions: Enter an appropriate time, and be sure to set the SVC Inactivity Timeout Enable 
parameter to Enable.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.14
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Configuring ATM Services
Parameter: Framing Mode

Path: Configuration Manager > Circuits > Edit Circuits > Edit > Line Attributes
Default: SONET (for OC-3 lines) | DS3_CBIT (for DS-3 lines) | 

E3_G832 (for E-3 lines) | T1ADM (for DS-1 lines) | E1ADM (for E-1 lines)
Options: SDH | SONET | DS3_CBIT | DS3_M32 | CBITNOFALLBACK | 

CLEARCHANNEL | E3_G751 | E3_G832 | T1ADM | T1PLCP | E1ADM | 
E1PLCP

Function: Specifies the transceiver mode for the physical interface.
Instructions: Select a transceiver mode as follows:

• SDH or SONET for OC-3 modules
• DS3_CBIT, DS3_M32, CBITNOFALLBACK, or CLEARCHANNEL for 

DS-3 modules
• E3_G751 or E3_G832 for E-3 modules
• T1ADM or T1PLCP for DS-1 modules
• E1ADM or E1PLCP for E-1 modules

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.17

Parameter: Clocking Signal Source

Path: Configuration Manager > Circuits > Edit Circuits > Edit > Line Attributes
Default: Internal
Options: Loop | Internal

Function: Specifies whether the platform uses its internal clock or derives timing signals 
externally from an incoming clock on this interface.

Instructions: Select Loop to use external timing signals from an incoming clock; select 
Internal to use the clock in the platform.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.18
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Parameter: DS3 Line Build Out

Path: Configuration Manager > Circuits > Edit Circuits > Edit > Line Attributes
Default: Short
Options: Short | Long

Function: Conditions router signals to mitigate attenuation, which depends on the physical 
length of the line.

You can set this parameter only for DS-3 modules.
Instructions: Select Short for lines shorter than 225 ft; select Long for lines 225 ft or longer.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.23

Parameter: Transmit Waveform

Path: Configuration Manager > Circuits > Edit Circuits > Edit > Physical Layer 
Configuration > T1 > Port Details

Default: Short Haul 0 to 110 feet
Options: Long Haul 0 db | Long Haul 7.5 db | Long Haul 15.0 db | Long Haul 22.5 db | 

Short Haul 0 to 110 ft | Short Haul 110 to 220 ft | Short Haul 220 to 330 ft | 
Short Haul 330 to 440 ft | Short Haul 440 to 550 ft | Short Haul 550 to 660 ft.

Function: Conditions router signals to mitigate attenuation, which depends on the physical 
length of the line.

You can set this parameter only for DS-1 modules.
Instructions: Select the appropriate line length.

MIB Object ID: 1.3.6.1.4.1.18.3.4.9.3.1.28
308612-14.20 Rev 00 A-9



Configuring ATM Services
Parameter: DS3/E3 Scrambling (BN and System 5000)

Parameter: Cell Scrambling (Passport 5430)

Path: Configuration Manager > Circuits > Edit Circuits > Edit > Line Attributes
Default: On
Options: On | Off

Function: If you select On, the router randomizes cell payload sufficiently to guarantee 
cell synchronization. If you select Off, cell synchronization problems could 
occur.

Note that ATM devices with different settings for scrambling cannot 
communicate. For example, if you configure a router to enable scrambling and 
configure a hub to disable scrambling, the router and the hub cannot 
communicate.

You can set this parameter only when using DS-3, E-3, DS-1 and E-1 modules.
Instructions: Select On or Off. If you select On, be sure to enable scrambling for all devices 

on the network. If you select Off, be sure to disable scrambling for all devices on 
the network.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.2.1.22

Parameter: Per-VC Clipping

Path: Configuration Manager > Circuits > Edit Circuits > Edit > Line Attributes
Default: Disable
Options: Enable | Disable

Function: Enables or disables cell clipping on a per-VC basis. 
Instructions: Accept the default, Disable, for normal VC clipping. Enable this parameter if 

you want to clip cells on a per-VC basis.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.3.1.1.17
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ATM Interface Parameters

Interface parameters define the state of the ATM interface.

Parameter: Administrative State

Path: Configuration Manager > Circuits > Edit Circuits > Edit > Interface Attributes
Default: Up
Options: Up | Down

Function: Specifies whether this interface is enabled or disabled.
Instructions: Accept the default, Up, if you want traffic to flow over this interface. Set the 

state to Down if you do not want traffic to flow over this interface.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.1.1.3

Parameter: Enable ATM Signaling

Path: Configuration Manager > Circuits > Edit Circuits > Edit > Interface Attributes
Default: Enable
Options: Enable | Disable

Function: Specifies whether ATM signaling is enabled or disabled for this interface.

Signaling allows you to configure switched features (for example, SVCs and 
LANE) on the interface. 

If you do not intend to configure any switched features on this interface (that is, 
you want this interface to run only PVCs), disabling this parameter makes 
additional system resources available.

Instructions: Accept the default, Enable, if you want to enable signaling on this interface. Set 
the state to Disable if you want to disable signaling on this interface.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.1.1.16
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Parameter: Use Hardware MAC Address

Path: Configuration Manager > Circuits > Edit Circuits > Edit > Interface Attributes
Default: Enable
Options: Enable | Disable

Function: Specifies whether or not to use the hardware MAC address for this interface. 

When enabled, the Configuration Manager uses the ATM hardware MAC 
address of the link module as the end-station identifier when automatically 
generating the user part (suffix) of an SVC service record ATM address.

When disabled, the Configuration Manager uses the value specified in the MAC 
Address Override parameter to assign the end-station identifier when 
automatically generating the user part (suffix) of an SVC service record ATM 
address.

Instructions: Accept the default, Enable, if you want to use the MAC address of the ATM 
interface when automatically generating the end-station identifier portion of the 
ATM address user part.

Set this parameter to Disable if you want to use the MAC Address Override 
value when automatically generating the end-station identifier portion of the 
ATM address user part.

If you set this parameter to Disable, you must enter a value for the MAC 
Address Override parameter.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.1.1.18
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Parameter: MAC Address Override

Path: Configuration Manager > Circuits > Edit Circuits > Edit > Interface Attributes
Default: None
Options: Any valid MAC address

Function: Specifies the hardware MAC address for this interface. Also defines the 
end-station identifier for this interface when automatically generating the user 
part (suffix) of an SVC service record ATM address.

Using the MAC Address Override parameter is very helpful when you want to 
hot-swap ATM link modules. 

For example, when hot-swapping ATM link modules, you can enter the MAC 
address of the original ATM link module as the MAC Address Override value 
for the new ATM link module. This allows you to keep the information already 
configured on the existing ATM link module while maintaining the integrity of 
the existing client information on the network.

Instructions: Enter a valid MAC address.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.1.1.19
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ATM Service Record Parameters

Service record parameters define the ATM service records for an interface. The 
ATM Service Records List window also provides access to the following:

• PVC parameters (PVC service records only) in the ATM Virtual Channel Link 
window

• A list of all SVCs on that service record (SVC service records only) in the 
ATM Switched Virtual Circuit List window

• LEC parameters (SVC service records using LANE data encapsulation) in the 
LAN Emulation Parameters window

• WAN SVC parameters (WAN SVC service records only) in the ATM WAN 
SVC List window

Parameter: Enable/Disable

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes

Default: Enable
Options: Enable | Disable

Function: Enables or disables this service record.
Instructions: Accept the default, Enable, if you want traffic to flow on this service record and 

its VCs. Set to Disable if you do not want traffic to flow on this service record or 
any of its VCs.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.2.1.2
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Parameter: Data Encapsulation Type

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > Add

Default: LANE (signaling enabled) or LLC/SNAP (signaling disabled)
Options: LANE | LLC/SNAP | NLPID | NULL

Function: Identifies the data encapsulation type for this service record.

Select a data encapsulation type as follows:

• LLC/SNAP, NLPID, or NULL for service records containing PVCs
• LLC/SNAP for service records containing hybrid PVCs and WAN SVCs
• LANE for service records containing SVCs over which you want to run LAN 

emulation
• LLC/SNAP or NULL for service records containing SVCs over which you 

want to run classical IP (RFC 1577)

If you select NULL, the router interprets this as virtual, channel-based 
multiplexing, which is not supported for bridging.

Instructions: Select a data encapsulation type.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.2.1.5

Parameter: Virtual Connection Type

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > Add

Default: SVC (signaling enabled) or PVC (signaling disabled)
Options: PVC | SVC | MUXED_SVC

Function: Identifies the virtual connection type of this service record.
Instructions: Accept the default, SVC, if you want the service record to contain switched 

virtual circuits. Select PVC if you want the service record to contain permanent 
virtual circuits. Select MUXED_SVC if you want the service record to contain 
WAN switched virtual circuits.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.2.1.7
308612-14.20 Rev 00 A-15



Configuring ATM Services
Parameter: User Part Autogeneration

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > Add

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes

Default: Enable
Options: Enable | Disable

Function: Enables or disables autogeneration of the ATM address user part. Depending on 
the settings in the ATM Interface Attributes window, the ATM address user part 
is either the hardware MAC address or a MAC address override value.

Instructions: Accept the default, Enable, if you want the router to automatically generate the 
ATM address user part for the SVC service record.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.2.1.11

Parameter: ATM Addr User Part

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > Add

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes

Default: None
Options: 00000000000000 to FEFFFFFFFFFFFF

Function: The router allows you to autogenerate this parameter (see the User Part 
Autogeneration parameter on A-16). Depending on the settings in the ATM 
Interface Attributes window, this parameter autogenerates this address using 
either:

• The 6-byte hardware MAC address of the ATM interface
• A MAC address override value that you specify

In both cases, autogeneration creates a unique selector byte for each service 
record on the interface.

Instructions: Accept the default for autogeneration, or enter a value in the range specified.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.2.1.9
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Parameter: ATM Addr Net Prefix (Optional)

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > Add

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes

Default: None
Options: XX000000000000000000000000 to XXFFFFFFFFFFFFFFFFFFFFFFFF

where XX = 39, 45, or 47
Function: Specifies the network prefix of the ATM address for this service record. The 

network prefix specifies the ATM domain of which this service record is a part.

The XX byte must contain 39, 45, or 47. These values define the authority and 
format identifier (AFI). The AFI byte identifies the group responsible for 
allocating the prefix and the format the prefix uses. For more information about 
the AFI byte, see the ATM Forum UNI specification.

Instructions: Setting this parameter is optional. If you do not enter an ATM address network 
prefix in the range specified above, the service record accepts the first prefix 
value that it receives from the switch.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.2.1.8
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Parameter: Emulated LAN Name

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > Add

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: Default ELAN
Options: Leave blank or enter up to 128 alphanumeric characters

Function: Specifies the name of the emulated LAN that this LE client joins when it joins 
an emulated LAN. Clients that use automatic configuration mode use this 
parameter in their LE_CONFIGURE_REQUEST frames. Clients that use 
manual configuration mode use this parameter in their LE_JOIN_REQUEST 
frames.

Entering an ELAN name is optional. If you choose not to enter an ELAN name, 
the LAN emulation configuration server (LECS) assigns the LE client to an 
ELAN for this domain. However, because some switches do not support a 
default emulated LAN, Nortel Networks recommends that you assign an ELAN 
name to the LE client.

Instructions: Either leave this parameter blank or enter an ELAN name (up to 128 
alphanumeric characters) that identifies the emulated LAN you want this client 
to join.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.8
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Parameter: Emulated LAN Type

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > Add

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: Unspecified
Options: Unspecified | IEEE8023 | IEEE8025

Function: Specifies the data frame format this client uses when it joins an emulated LAN. 
Clients that use automatic configuration mode use this parameter in their 
LE_CONFIGURE_REQUEST frames to specify the LAN type. Clients that use 
manual configuration mode use this parameter in their LE_JOIN_REQUEST 
frames to specify the LAN type.

If you select manual configuration mode, you must set the emulated LAN type 
to either IEEE8023 or IEEE8025.

Instructions: Accept the default, Unspecified, if you want the client to obtain the LAN type 
from the LECS when it joins an emulated LAN. Select IEEE8023 if you want 
the client to join only Ethernet emulated LANs. Select IEEE8025 if you want 
the client to join only token ring emulated LANs.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.6

Parameter: MTU

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes

Default: 4608
Options: 0 to 9188

Function: Specifies the MTU, in bytes, that this service record can send. The MTU size is 
typically determined by the driver. However, this parameter allows you to 
override the driver default to accommodate connection to devices that require 
different MTU sizes.

Instructions: Accept the default or enter an MTU size for this service record.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.2.1.12
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Note: Some ATM devices do not negotiate MTU size. When connecting to 
such a device, Nortel Networks recommends that you specify an MTU size of 
9188 octets for full compatibility with RFC 1577.

Parameter: Service Name

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes

Default: Numeric value assigned by the router.
Options: Any alphanumeric string.

Function: Assigns a unique name to the service record.
Instructions: Accept the service name provided by the router or change the service name to 

rename the service record.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.2.1.15

Parameter: WAN SVC Routing Mode

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes 

Default: Disabled
Options: Disabled | Normal | Dial-Optimized

Function: Assigns a routing mode to the WAN SVC.
Instructions: Accept the default, Disabled, to stop the router from sending RIP updates on this 

WAN SVC. Select Normal if you plan to have more than one adjacent host per 
circuit or subnet. Select Dial-Optimized routing if you plan to have only one 
adjacent host per circuit or subnet. 

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.2.1.16
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CES Parameters

CES parameters define the operation of CES on the Passport 5430. For more 
information about CES and TDM, see Configuring TDM Services.

Parameter: Partial Fill (octets/cell)

Path: Configuration Manager > Platform > View CES
Default: 0
Options: 0 to 47

Function: Causes the router to send cells filled to the number of octets that you specify.
Instructions: Specify a value from 1 through 47. Otherwise, accept the default value (0) to 

disable partial fill.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.4.1.1.1.13

Parameter: Administration Status

Path: Configuration Manager > Platform > View CES
Default: Up
Options: Up | Down

Function: Specifies whether traffic is enabled or disabled across the CES circuit.
Instructions: Select Up to enable traffic. Select Down to disable traffic.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.4.1.1.1.19
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ATM Virtual Channel Link Parameters

ATM virtual channel link parameters define PVCs in a PVC service record.

Note: ATM does not allow duplicate VPI/VCI pairs on the same physical 
interface. However, duplicate VPI/VCI pairs can exist on different physical 
interfaces.

Parameter: VPI Number

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC > Add

Default: None
Options: 0 to 255

Function: Identifies the virtual path of the PVC. The VPI is part of the cell header. The 
header can contain a maximum of 8 VPI bits for a UNI connection. This bit 
range allows for path identifiers from 0 to 255.

Instructions: Enter a value from 0 to 255.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.3

Parameter: VCI Number

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC > Add

Default: None
Options: 32 to 8192

Function: Identifies the virtual channel of the PVC. The VCI is part of the cell header. The 
header can contain a maximum of 16 VCI bits. The maximum allowable VCI 
number you can set for BayRS is 8192.

Instructions: Enter a value from 32 to 8192.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.4

Note: Following the recommendation of the ATM Forum, virtual channel 
identifiers from 0 to 31 are reserved for signaling and added functionality.
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Parameter: Hybrid/Bridged VC

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: No
Options: Yes | No

Function: Specifies whether the PVC is set to hybrid access mode.
Instructions: Accept the default, No, if you want the PVC to work in group access mode only. 

Set to Yes if you want the PVC to operate as a hybrid VC.

For more information about the group and hybrid access modes, see “PVC 
Access Methods” on page 1-17.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.25

Parameter: Administrative State

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: Up
Options: Up | Down 

Function: Specifies the administrative state of the PVC. The Up state indicates that traffic 
flow is enabled on this PVC. The Down state indicates that traffic flow is 
disabled on this PVC.

Instructions: Accept the default, Up, if you want traffic to flow on this PVC. Set the state to 
Down if you do not want traffic to flow on this PVC.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.5
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Parameter: Xmit Peak Cell Rate (cells/s)

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: 2358 (PVC) or 1000 (ATM T1/E1 PVC)
Options: 128 to 353207 (ATM ARE OC-3 SONET/SDH ILI pairs and

Model 5782 ATM routers)
128 to 96000 (ATM ARE DS-3 ILI pairs)
128 to 80000 (ATM ARE E-3 ILI pairs; G.832 framing mode)
128 to 72000 (ATM ARE E-3 ILI pairs; G.751 framing mode)
0 to 3622 (ATM Passport 5430 DS-1 ILI pairs)
0 to 4528 (ATM Passport 5430 E-1 ILI pairs)

Function: Specifies the upper traffic limit, in cells/s, that the ATM connection can submit. 
How you set the peak cell rate depends on:

• The optical transmission rate of your ATM device
• The amount of traffic you expect on a particular VC
• The rate you want for each VC

Instructions: After you determine the transmission rate of your ATM device, set the peak cell 
rate within the specified range.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.8
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Parameter: Xmit Sustainable Cell Rate (cells/s)

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: 2358 (PVC) or 1000 (ATM T1/E1 PVC)
Options: 0, 128 to 353207 (ATM ARE OC-3 SONET/SDH ILI pairs and 

Model 5782 ATM routers)
0, 128 to 96000 (ATM ARE DS-3 ILI pairs)
0, 128 to 80000 (ATM ARE E-3 ILI pairs; G.832 framing mode)
0, 128 to 72000 (ATM ARE E-3 ILI pairs; G.751 framing mode)
0 to 3622 (ATM Passport 5430 DS-1 ILI pairs)
0 to 4528 (ATM Passport 5430 E-1 ILI pairs)

Function: Specifies the upper limit of the ATM connection conforming average rate. The 
average rate equals the total number of cells transmitted, divided by the duration 
of the connection.

Using the sustainable cell rate (SCR), you can define the future cell flow of a 
VC in greater detail than by using only the peak cell rate.

For ATM ARE ILI pairs and Model 5782 ATM routers, the SCR maps directly 
to the minimum cell rate (MCR). The MCR defines the minimum amount of 
guaranteed bandwidth allowed for PVCs and control VCs on the ATM line.
When setting the SCR, keep the following in mind:

• The SCR maps directly to the MCR.
• The MCR provides guaranteed bandwidth for PVCs and control VCs while 

allowing sufficient bandwidth for SVCs to operate.
• To be useful, the SCR must not exceed the PCR. 
• If you know the average rate, set the SCR approximately 10 percent higher 

than this value.
• VCs may fail to operate with SCR values lower than 128 cells/s.
• Entering 0 for the SCR turns off this function.
• The E-3 framing mode setting affects the maximum SCR.

Instructions: After you determine the transmission rate of your ATM device, set the 
sustainable cell rate within the specified range. Enter 0 to turn off this function.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.9
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Parameter: Xmit Burst Size (cells)

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: 40
Options: 1 to 65535

Function: Specifies the maximum number of sequential cells allowed on a VC, at the peak 
cell rate, before the VC must relinquish bandwidth to other VCs.

When you set the MBS, you should select a value larger than the largest packet 
your PVC or control VC can transmit (that is, the Maximum AAL CPCS 
Transmit SDU size). For example, if your VC accepts packets that are less than 
2358 bytes long (PVC default), set your MBS value from 45 to 50 cells.

Instructions: Set a value in the specified range.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.10

Parameter: Maximum AAL CPCS Transmit SDU Size

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: 4608
Options: 1 to 65535

Function: Specifies the maximum AAL CPCS SDU size, in bytes, that this VC supports in 
the transmit direction.

Instructions: Enter an octet value that represents the maximum packet size that you intend 
this VC to transmit. Nortel Networks recommends that you accept the default 
value of 4608 bytes. Most packets fall well within this limit.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.17
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Parameter: Maximum AAL CPCS Receive SDU Size

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: 4608
Options: 1 to 65535

Function: Specifies the maximum AAL CPCS SDU size, in bytes, that this VC supports in 
the receive direction.

Instructions: Enter an octet value that represents the maximum packet size that you intend 
this VC to receive. Nortel Networks recommends that you accept the default 
value of 4608 bytes. Most packets fall well within this limit.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.18

Parameter: Data Encapsulation Type

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: LLC/SNAP
Options: LLC/SNAP | NLPID | NULL

Function: Specifies the type of data encapsulation that you want this PVC to use. Select 
LLC/SNAP, NLPID, or NULL data encapsulation for:

• All PVCs on a service record
• Hybrid PVCs

Instructions: Nortel Networks recommends selecting LLC/SNAP. If you select NULL, the 
router interprets this as virtual, channel-based multiplexing, which is not 
supported for bridging.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.19
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Parameter: Congestion Indication

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: Off
Options: Off | On

Function: Specifies whether ATM signals when traffic congestion occurs on this interface.
Instructions: Select On to cause ATM to signal when traffic congestion occurs. Otherwise, 

accept the default.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.20

Parameter: Cell Loss Priority

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: Off 
Options: Off | On | Drop Preference

Function: Determines the state of the cell loss priority (CLP) bit in the ATM header. If you 
set cell loss priority to On, the router sets the CLP bit in the ATM header. If you 
set cell loss priority to Off, the router clears the CLP bit in the ATM header. 
Cells with the CLP bit set have a lower priority and if there is congestion these 
cells will be dropped before cells without the CLP bit set. 

Instructions: Accept the default, or select On or Drop Preference.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.21

Parameter: AAL Type

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: AAL5 Encapsulation
Options: AAL5 Encapsulation | AAL1 Encapsulation

Function: Determines the AAL encapsulation type used on this interface.
Instructions: Select AAL1 when configuring a TDM circuit.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.16
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Parameter: Service Category

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: Other
Options: Other | CBR | VBRRT | VBRNRT | ABR | UBR | UBRPLUS 

Function: Determines the service category used for this connection:

• CBR — The CBR service category provides a static amount of bandwidth that 
is continuously available for the duration of the connection. The CBR service 
is intended to support real-time applications, such as voice, video, and circuit 
emulation, that require tightly constrained delay variations. When you choose 
the CBR service category, you can determine the bandwidth of the connection 
by setting the PCR value. 

• VBRRT — The VBRRT service accommodates sources that are expected to 
transmit data at variable rates. The VBRRT service supports real-time 
applications that require tightly constrained delay and delay variation, such as 
voice and video applications. The PCR and SCR determine the behavior of a 
VBRRT connection.

• VBRNRT — The VBRNRT service accommodates non-real-time applications 
that have bursty traffic conditions. VBRNRT service supports statistical 
multiplexing of connections. The PCR and SCR determine the behavior of a 
VBRNRT connection.

• ABR — When establishing an ABR connection, the PCR determines the 
maximum required bandwidth and the MCR determines the minimum usable 
bandwidth. The bandwidth available from the network may vary but it cannot 
be less than the MCR. 

• UBR — The UBR service supports non-real-time applications such as 
traditional computer communications, for example, file transfer and e-mail. 
UBR service does not specify traffic-related service guarantees. The PCR 
determines the behavior of a UBR connection.

• UBRPLUS — The UBRPLUS service supports non-real-time applications, for 
example, traditional computer communications, such as file transfer and 
e-mail. UBRPLUS guarantees service equal to at least the MCR. If bandwidth 
is available, a UBRPLUS virtual circuit can use up to PCR, but no higher. 

Instructions: Select the appropriate service category. If configuring CES on this circuit, select 
CBR.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.38
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Parameter: VBR Type

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: Type1
Options: Type1 | Type2

Function: Identifies the VBR type for this connection. Two different ways exist to 
schedule VBR traffic based on cell loss priority (CLP). Type 1 VBR schedules 
VBR traffic by PCR and SCR according to the generic cell rate algorithm 
(GCRA) state, otherwise known as the leaky bucket. Type 2 VBR schedules 
cells by PCR.

Instructions: Select the appropriate VBR type.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.39

Parameter: Minimum Cell Rate (cells/second)

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: 10
Options:  0 to 3622 (for T1) | 0 to 4528 (for E1)

Function: Specifies the lowest rate at which ATM transmits cells across the interface.
Instructions: Accept the default, or select a value from 0 through 3622 for T1 interfaces or 

from 0 through 4528 for E1 interfaces.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.40

Parameter: Initial Cell Rate (cells/second)

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: 1000
Options: 0 to 3622 (for T1) | 0 to 4528 (for E1)

Function: Specifies the initial rate at which ATM transmits cells across the interface.
Instructions: Accept the default, or enter a value from 0 through 3622 for T1 interfaces or 

from 0 through 4528 for E1 interfaces.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.41
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Parameter: Rate Increase Factor

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: 4
Options: 0 to 15

Function: Specifies the increase in the cell transmit rate. The rate increase factor 
determines how quickly the cell rate for an ABR PVC can increase. The cell rate 
increases in the specified increment based on the traffic in the network. If 
bandwidth is available, the PVC begins to increase its rate in steps according to 
the rate increase factor. By default, the rate increase factor is set to 4. 

Instructions: Accept the default, or specify a value from 0 through 15.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.42

Parameter: Rate Decrease Factor

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: 4
Options: 0 to 15

Function: Specifies the decrease in the cell transmit rate. The rate decrease factor 
determines how quickly the cell rate for an ABR PVC can decrease. The cell 
rate decreases in the specified increment based on the traffic in the network. If 
the network is congested, the PVC begins to decrease its cell rate by the rate 
decrease factor. By default, the rate decrease factor is set to 4. 

Instructions: Accept the default, or specify a value from 0 through 15.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.43
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ATM WAN SVC Parameters

ATM WAN SVC parameters define the traffic shaping options for a particular 
WAN SVC.

Parameter: Enable/Disable

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > WAN SVC

Default: Enable
Options: Enable | Disable

Function: Enables or disables traffic shaping on this WAN SVC.
Instructions: Accept the default, Enable, if you want the router to use traffic shaping on this 

WAN SVC. Set to Disable if you do not want the router to use traffic shaping on 
this WAN SVC. 

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.13.1.2

Parameter: Adjacent Host ATM Address

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > WAN SVC

Default: None
Options: Any valid ATM address

Function: Identifies the ATM address of the IP or IPX adjacent host.
Instructions: Specify the ATM address of the IP or IPX adjacent host.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.13.1.5
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Parameter: Xmit Peak Cell Rate (cells/s)

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > WAN SVC

Default: 4716
Options: 128 to 353207 (ATM ARE OC-3 SONET/SDH ILI pairs and

Model 5782 ATM routers)
128 to 96000 (ATM ARE DS-3 ILI pairs)
128 to 80000 (ATM ARE E-3 ILI pairs; G.832 framing mode)
128 to 72000 (ATM ARE E-3 ILI pairs; G.751 framing mode)

Function: Specifies the upper traffic limit, in cells/s, that the ATM connection can submit. 
How you set the peak cell rate depends on:

• The optical transmission rate of your ATM device
• The amount of traffic you expect on a particular VC
• The rate you want for each VC

Instructions: After you determine the transmission rate of your ATM device, set the peak cell 
rate within the specified range.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.13.1.6
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Parameter: Xmit Sustainable Cell Rate (cells/s)

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > WAN SVC

Default: 4716
Options: 0, 128 to 353207 (ATM ARE OC-3 SONET/SDH ILI pairs and 

Model 5782 ATM routers)
0, 128 to 96000 (ATM ARE DS-3 ILI pairs)
0, 128 to 80000 (ATM ARE E-3 ILI pairs; G.832 framing mode)
0, 128 to 72000 (ATM ARE E-3 ILI pairs; G.751 framing mode)

Function: Specifies the upper limit of the ATM connection conforming average rate. The 
average rate equals the total number of cells transmitted, divided by the duration 
of the connection.

Using the sustainable cell rate (SCR), you can define the future cell flow of a 
VC in greater detail than by using only the peak cell rate.

For ATM ARE ILI pairs and Model 5782 ATM routers, the SCR maps directly 
to the minimum cell rate (MCR). The MCR defines the minimum amount of 
guaranteed bandwidth allowed SVCs on the ATM line.
When setting the SCR, keep the following in mind:

• The SCR maps directly to the MCR.
• The MCR allows sufficient bandwidth for SVCs to operate.
• To be useful, the SCR must not exceed the PCR. 
• If you know the average rate, set the SCR approximately 10 percent higher 

than this value.
• VCs may fail to operate with SCR values lower than 128 cells/s.
• Entering 0 for the SCR turns off this function.
• The E-3 framing mode setting affects the maximum SCR.

Instructions: After you determine the transmission rate of your ATM device, set the 
sustainable cell rate within the specified range. Enter 0 to turn off this function.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.13.1.7
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Parameter: Recv Peak Cell Rate (cells/s)

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > WAN SVC

Default: 4716
Options: 128 to 353207 (ATM ARE OC-3 SONET/SDH ILI pairs and

Model 5782 ATM routers)
128 to 96000 (ATM ARE DS-3 ILI pairs)
128 to 80000 (ATM ARE E-3 ILI pairs; G.832 framing mode)
128 to 72000 (ATM ARE E-3 ILI pairs; G.751 framing mode)

Function: Specifies the upper traffic limit, in cells/s, that the ATM connection can submit. 
How you set the peak cell rate depends on:

• The optical receive rate of your ATM device
• The amount of traffic you expect on a particular VC
• The rate you want for each VC

Instructions: After you determine the receive rate of your ATM device, set the peak cell rate 
within the specified range.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.13.1.8
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Parameter: Recv Sustainable Cell Rate (cells/s)

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > WAN SVC

Default: 4716
Options: 0, 128 to 353207 (ATM ARE OC-3 SONET/SDH ILI pairs and 

Model 5782 ATM routers)
0, 128 to 96000 (ATM ARE DS-3 ILI pairs)
0, 128 to 80000 (ATM ARE E-3 ILI pairs; G.832 framing mode)
0, 128 to 72000 (ATM ARE E-3 ILI pairs; G.751 framing mode)

Function: Specifies the upper limit of the ATM connection conforming average rate. The 
average rate equals the total number of cells received, divided by the duration of 
the connection.

Using the sustainable cell rate (SCR), you can define the future cell flow of a 
VC in greater detail than by using only the peak cell rate.

For ATM ARE ILI pairs and Model 5782 ATM routers, the SCR maps directly 
to the minimum cell rate (MCR). The MCR defines the minimum amount of 
guaranteed bandwidth allowed for SVCs on the ATM line.
When setting the SCR, keep the following in mind:

• The SCR maps directly to the MCR.
• The MCR allows sufficient bandwidth for SVCs to operate.
• To be useful, the SCR must not exceed the PCR. 
• If you know the average rate, set the SCR approximately 10 percent higher 

than this value.
• VCs may fail to operate with SCR values lower than 128 cells/s.
• Entering 0 for the SCR turns off this function.
• The E-3 framing mode setting affects the maximum SCR.

Instructions: After you determine the receive rate of your ATM device, set the sustainable cell 
rate within the specified range. Enter 0 to turn off this function.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.13.1.9
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LAN Emulation Parameters

LAN emulation parameters define LAN emulation clients in a LANE service 
record.

Parameter: Enable

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: Enable
Options: Enable | Disable

Function: Enables or disables LAN emulation on this service record.
Instructions: Accept the default, Enable, if you want LAN emulation to remain enabled on 

this service record. Select Disable if you do not want LAN emulation enabled on 
this service record.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.2

Parameter: Owner

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: None
Options: Leave blank or enter up to 128 alphanumeric characters

Function: Identifies this LAN emulation client. This parameter is optional.
Instructions: Either leave this parameter blank or enter a text string (up to 128 alphanumeric 

characters) to identify this LAN emulation client.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.4
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Parameter: Configuration Mode

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: Automatic
Options: Automatic | Manual

Function: Indicates whether this LAN emulation client configures automatically (that is, 
uses information from the LECS) or manually (that is, uses information from the 
LAN Emulation Parameters window).

Instructions: Accept the default, Automatic, if you want this client to configure automatically. 
Select Manual if you do not want the router to autoconfigure.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.5

Parameter: Emulated LAN Type

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: Unspecified
Options: Unspecified | IEEE8023 | IEEE8025

Function: Specifies the data frame format this client uses when it joins an emulated LAN. 
Clients that use automatic configuration mode use this parameter in their 
LE_CONFIGURE_REQUEST frames to specify the LAN type. Clients that use 
manual configuration mode use this parameter in their LE_JOIN_REQUEST 
frames to specify the LAN type.

If you select manual configuration mode, you must set the emulated LAN type 
to either IEEE8023 or IEEE8025.

Instructions: Accept the default, Unspecified, if you want the client to obtain the LAN type 
from the LAN emulation configuration server (LECS) when it joins an emulated 
LAN. Select IEEE8023 if you want the client to join only Ethernet emulated 
LANs. Select IEEE8025 if you want the client to join only token ring emulated 
LANs.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.6
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Parameter: Maximum Data Frame Size

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: Unspecified (default for token ring is 4544)
Options: Unspecified | 1516 | 4544 | 9234 | 18190

Function: Specifies the maximum data frame size (in octets) that this client uses when it 
joins an emulated LAN. Clients that use automatic configuration mode use this 
parameter in their LE_CONFIGURE_REQUEST frames. Clients that use 
manual configuration mode use this parameter in their LE_JOIN_REQUEST 
frames.

Accept the default value, Unspecified, if you want the client to obtain the 
maximum data frame size when it joins an emulated LAN. Select 1516, 4544, 
9234, or 18190 if you want to designate the maximum data frame size that this 
client can:

• Send on the multicast send VCC.
• Receive on the multicast forward VCC.
• Send and receive on data direct VCCs.

Selecting manual configuration mode automatically sets the maximum data 
frame size to 1516.

Instructions: Accept the default, Unspecified, or select 1516, 4544, 9234, or 18190.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.7
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Parameter: Emulated LAN Name

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: Default ELAN
Options: Leave blank or enter up to 128 alphanumeric characters

Function: Specifies the name of the emulated LAN that this LE client joins when it joins 
an emulated LAN. Clients that use automatic configuration mode use this 
parameter in their LE_CONFIGURE_REQUEST frames. Clients that use 
manual configuration mode use this parameter in their LE_JOIN_REQUEST 
frames.

Entering an ELAN name is optional. If you choose not to enter an ELAN name, 
the LAN emulation configuration server (LECS) assigns the LE client to an 
ELAN for this domain. However, because some switches do not support a 
default emulated LAN, Nortel Networks recommends that you assign an ELAN 
name to the LE client.

Instructions: Either leave this parameter blank or enter an ELAN name (up to 128 
alphanumeric characters) that identifies the emulated LAN you want this client 
to join.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.8

Parameter: Control Timeout

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: 5
Options: 5 to 32767

Function: Specifies the timeout period used for timing out most request/response control 
frame interactions.

Instructions: Accept the default, 5, or enter a value from 5 to 32767.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.10
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Parameter: Max Unknown Frame Count

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: 1
Options: 1 to 10

Function: Specifies the maximum number of unknown frames an LE client can send 
within the interval specified with the Max Unknown Frame Time parameter. A 
frame is considered unknown when the LE client does not recognize the 
destination MAC address. In this case, the unknown frame goes to the BUS for 
distribution.

Instructions: Accept the default, 1, or enter a value from 1 to 10.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.11

Parameter: Max Unknown Frame Time

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: 1
Options: 1 to 60

Function: Specifies the maximum amount of time (in seconds) allowed to send the number 
of unknown frames specified with the Max Unknown Frame Count parameter.

For example, if you use the defaults for these parameters, a LAN emulation 
client can one unknown frame within 1 second for any given MAC address 
without having to initiate the Address Resolution Protocol (ARP) to resolve that 
MAC address.

Instructions: Accept the default, 1, or enter a value from 1 to 60.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.12
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Parameter: VCC Timeout Period Enable

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: Enable
Options: Enable | Disable

Function: Disables or reenables the virtual channel connection (VCC) timeout period. 
When you enable this parameter, a LAN emulation client can release any unused 
data direct or multicast send VCCs after the VCC timeout period expires. The 
ATM drivers support a timeout period of 20 minutes.

Instructions: Accept the default, Enable, if you want this LAN emulation client to release 
unused data direct or multicast send VCCs after the VCC timeout period 
expires. Select Disable if you do not want this LAN emulation client to release 
unused data direct or multicast send VCCs after the timeout period expires.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.13

Parameter: Max Retry Count

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: 1
Options: 1 or 2

Function: Specifies the maximum number of times a LAN emulation client can retry an 
LE_ARP_REQUEST (following the original request) for a given frame MAC 
address.

Instructions: Accept the default, 1, or enter 2 as the new value.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.14
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Parameter: Aging Time

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: 300
Options: 10 to 300

Function: Specifies the maximum amount of time (in seconds) that a LAN emulation 
client can maintain an entry in its LAN emulation ARP cache without verifying 
the relationship of that entry.

Instructions: Accept the default, 300, or enter a value from 10 to 300.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.15

Parameter: Forward Delay Time

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: 15
Options: 4 to 30

Function: When there are no changes occurring in the network topology, this parameter 
specifies the maximum amount of time (in seconds) that a LAN emulation client 
can maintain an entry in its LAN emulation ARP cache without verifying the 
relationship of that entry.

Instructions: Accept the default, 15, or enter a value from 4 to 30.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.16

Parameter: Expected LE_ARP Response Time

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: 3
Options: 1 to 30

Function: Specifies the amount of time (in seconds) that the LAN emulation client expects 
an ARP request and ARP response cycle to take. The LAN emulation client uses 
this value during retries and verifications.

Instructions: Accept the default, 3, or enter a value from 1 to 30.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.17
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Parameter: Flush Timeout

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: 4
Options: 1 to 4

Function: Specifies the amount of time (in seconds) that the LAN emulation client waits to 
receive a flush response (after sending a flush request) before it takes recovery 
action by switching to the BUS.

Instructions: Accept the default, 4, or enter a value from 1 to 4.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.18

Parameter: Path Switching Delay

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: 6
Options: 1 to 8

Function: Specifies the amount of time (in seconds) that the LAN emulation client waits 
after sending a frame over an existing VCC before it switches to a new VCC 
(this applies to multicast and data direct VCCs). You can use this parameter to 
bypass the flush protocol (that is, when you disable the Flush Protocol 
parameter, the data for a specific MAC address automatically begins flowing 
over a new VCC when the path switching delay time elapses).

Instructions: Accept the default, 6, or enter a value from 1 to 8.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.19
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Parameter: Emulated LAN Segment ID

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: 0
Options: 0 to 4095

Function: Specifies the ring ID (in decimal) on which this token ring client resides. You 
need only set this parameter for IEEE 802.5 LANE clients that are:

• Token ring end stations
• Routing IP or IPX across an SRB token ring network

Instructions: Accept the default, 0, or enter a value from 0 to 4095.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.20

Parameter: Flush Protocol

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: Enable
Options: Enable | Disable

Function: Enables or disables the flush protocol on this LE client.

The flush protocol ensures that data destined for a particular MAC address 
arrives in sequence. Following a flush request, the flush protocol drops cells for 
this MAC address while waiting for:

• The flush response from that MAC address
• The flush timeout to expire for that MAC address

If the client receives a flush response for the MAC address, the cells for this 
MAC address begin flowing over a new virtual circuit. However, if the flush 
timeout expires for this MAC address, the cells begin flowing to the BUS.

When disabled, cells containing the same MAC address are dropped while 
waiting for the Path Switching Delay parameter to time out. After the path 
switching delay time elapses, the data automatically begins flowing over a new 
virtual circuit.

Instructions: Accept the default, Enable, if you want the flush protocol to operate on this 
LAN emulation client. Select Disable if you do not want the flush protocol to 
operate on this LAN emulation client.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.25
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Parameter: LE Config Server ATM Address

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: None
Options: Any valid LAN emulation configuration server (LECS) ATM address

Function: Specifies the LECS ATM address. Entering an address for this parameter is 
optional. If you do not enter an address, the LE client uses the well-known 
LECS ATM address to open a configuration VCC to the configuration service.

Instructions: Leave blank or enter the ATM address of the LECS.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.30

Parameter: LAN Emulation Version 2

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC

Default: Disable
Options: Enable | Disable

Function: Enables and disables LAN emulation Version 2.
Instructions: Accept the default, Disable, if this LAN emulation client operates in a standard 

LAN emulation network. Select Enable if you want this LAN emulation client to 
operate in an MPOA network.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.1.1.31
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LES Parameters

LAN emulation server (LES) parameters define LAN emulation servers for LANE 
clients.

Parameter: Enable

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC > LES

Default: Enable
Options: Enable | Disable

Function: Enables or disables the chosen LAN emulation server (LES) on this service 
record.

Instructions: Accept the default, Enable, if you want the LAN emulation client to use this 
LES address in the specified order of preference. Select Disable if you do not 
want the LAN emulation client to consider this LES address.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.10.1.2

Parameter: LE Server ATM Address Network Prefix 

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC > LES

Default: 39000000000000000000000000
Options: XX000000000000000000000000 to XXFFFFFFFFFFFFFFFFFFFFFFFF

where XX = 39, 45, or 47
Function: Specifies the network prefix of the ATM address for this LAN emulation server 

(LES). The network prefix specifies the ATM domain of which this LES is a 
part.

The XX byte must be 39, 45, or 47. This value defines the authority and format 
identifier (AFI). The AFI byte identifies the group responsible for allocating the 
prefix and the format the prefix uses. For more information about the AFI byte, 
see the ATM Forum UNI specification.

Instructions: Accept the default network prefix, or if the LES resides in a different ATM 
domain, enter the network prefix for that domain.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.10.1.5
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Parameter: LE Server ATM Address User Part

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC > LES

Default: None
Options: 00000000000000 to FFFFFFFFFFFFFF

Function: Specifies the user part (suffix) of the ATM address for a LAN emulation server 
(LES) on your network. The user part suffix consists of a 6-byte end-station 
identifier and a 1-byte selector field.

The user part and the network prefix form a complete ATM address.
Instructions: Enter the ATM address user part of the LES.

MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.10.1.5

Parameter: LE Server Name

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > LEC > LES

Default: Numeric value assigned by the router.
Options: Any alphanumeric string.

Function: Assigns a unique name to the LAN emulation server (LES).
Instructions: Accept the LES name provide by the router or change the name to rename the 

server.
MIB Object ID: 1.3.6.1.4.1.18.3.5.9.5.20.10.1.6
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ATM Signaling Parameters

ATM signaling parameters define the connection and timer limits the router uses 
to set up, maintain, and clear a switched connection.

The ATM Signaling Parameters window also provides access to the signaling VC 
parameters. The signaling VC provides a dedicated VPI (0) and VCI (5) for ATM 
signaling functions.

For control VC parameter descriptions, see “Signaling and ILMI Control VC 
Parameters” on A-73.

Parameter: Enable

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: Enable
Options: Enable | Disable

Function: Enables or disables ATM signaling on this interface.

When you disable signaling on the interface, the ATM Service Record 
Parameters window automatically sets the Data Encapsulation Type parameter 
to LLC/SNAP and the Virtual Connection Type parameter to PVC.

Instructions: Accept the default, Enable, if you want signaling to remain enabled on this 
interface. Set to Disable if you do not want signaling enabled on this interface.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.2
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Parameter: Protocol Standard

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: UNI_V30
Options: UNI_V30 | UNI_V31 | UNI_V40

Function: Specifies how the interface defines Service Specific Connection Oriented 
Protocol (SSCOP) frames. Version 3.0, Version 3.1, and Version 4.0 SSCOP 
frames are incompatible.

Instructions: You must assign the same protocol standard for both the router interface and the 
switch. Accept the default, UNI_V30, if the switch uses UNI Version 3.0 to 
define SSCOP frames. Select UNI_V31 if the switch uses UNI Version 3.1 to 
define SSCOP frames. Select UNI_V40 if the switch uses UNI Version 4.0 to 
define SSCOP frames.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.15

Parameter: Max Number of SVC Applications

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 20
Options: 1 to 32767

Function: Specifies the maximum number of SVC applications allowed for this circuit. 
The number of SVC applications corresponds to the number of LAN emulation 
or IP (RFC 1577) clients allowed for the circuit.

Instructions: Accept the default, 20, or enter a value from 1 to 32767.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.6
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Parameter: Max Point to Point Connections

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 1000
Options: 0 to 32767

Function: Specifies the maximum number of simultaneous point-to-point connections 
allowed for this circuit.

Instructions: Accept the default, 1000, or enter a value from 0 to 32767.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.7

Parameter: Max Point to Multipoint Connections

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 40
Options: 0 to 32767

Function: Specifies the maximum number of simultaneous point-to-multipoint 
connections allowed for this circuit.

Instructions: Accept the default, 40, or enter a value from 0 to 32767.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.8
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Parameter: Max Parties in Multipoint Connections

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 1
Options: 0 to 32767

Function: Specifies the maximum number of simultaneous parties in a point-to-multipoint 
connection allowed for this circuit.

Instructions: Accept the default, 1, or enter a value from 0 to 32767.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.9

Parameter: Min Memory Threshold

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 20%
Options: 10% | 20% | 30% | 40% | 50% | 60% | 70% | 80% | 90% | 100%

Function: Specifies the minimum percentage of buffer memory necessary to enable a new 
call.

Instructions: Accept the default, 20%, or select another percentage.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.11
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Parameter: VPI

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 0
Options: 0 to 255

Function: Specifies the virtual path identifier (VPI) for the signaling VC. The signaling 
VC is a dedicated VPI/VCI pair reserved for signaling messages.

Instructions: Accept the default value, 0, or enter a value from 0 to 255.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.13

Caution: The signaling VC (0/5) and the ILMI VC (0/16) are reserved. These 
VCs remain in an operational state as long as signaling is enabled on the ATM 
interface. Because most ATM devices use these VPI/VCI pairs for signaling, 
Nortel Networks recommends that you not change these values.
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Parameter: VCI

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 5
Options: 1 to 65535

Function: Specifies the virtual channel identifier (VCI) for the signaling VC. The signaling 
VC is a dedicated VPI/VCI pair reserved for signaling messages.

Instructions: Accept the default, 5, or enter a value between 1 and 8192, which is the 
allowable range for BayRS.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.14

Caution: The signaling VC (0/5) and the ILMI VC (0/16) are reserved. These 
VCs remain in an operational state as long as signaling is enabled on the ATM 
interface. Because most ATM devices use these VPI/VCI pairs for signaling, 
Nortel Networks recommends that you not change these values.
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Parameter: T301

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 180
Options: 180 to 1024

Function: Specifies the Alert Received timer value (in seconds). This timer begins when 
the circuit initiates a call/connection request by receiving an ALERT message 
over the signaling VC.

The Alert Received timer stops when the circuit receives a CONNECT message 
(indicating connection) from the network.

If the circuit does not receive a CONNECT message within the allotted time, it 
clears the connection.

This timer can be used with UNI Version 4.0 and later.
Instructions: Accept the default, 180, or enter a value from 180 to 1024.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.41
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Parameter: T303

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 4
Options: 1 to 24

Function: Specifies the Setup Sent timer value (in seconds). This timer begins when the 
circuit initiates a call/connection request by sending a SETUP message over the 
signaling VC.

The Setup Sent timer stops when the circuit receives a CONNECT message 
(indicating connection), a CALL PROCEEDING message (indicating that the 
network received the SETUP message), or a RELEASE COMPLETE message 
(indicating the rejection of the SETUP message) from the network.

If the circuit does not receive one of these messages within the allotted time, it 
transmits the SETUP message again. If the circuit still does not receive a 
response, it clears the connection.

Instructions: Accept the default, 4, or enter a value from 1 to 24.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.25
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Parameter: T304

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 30
Options: 30 to 120

Function: Specifies the Setup Acknowledgement timer value (in seconds). This timer 
begins when the circuit initiates a call/connection request by sending a SETUP 
ACK message over the signaling VC.

The Setup Acknowledgement timer stops when the circuit receives a 
CONNECT message (indicating connection), a CALL PROCEEDING message 
(indicating that the network received the SETUP message), or an ALERT from 
the network.

If the circuit does not receive one of these messages within the allotted time, it 
clears the connection.

This timer can be used with UNI Version 4.0 and later.
Instructions: Accept the default, 30, or enter a value from 30 to 120.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.42
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Parameter: T308

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 30
Options: 1 to 180

Function: Specifies the Release Sent timer value (in seconds). This timer begins when the 
circuit sends a RELEASE message to initiate clearing of an SVC. Sending a 
RELEASE message places the network in the release request state.

The Release Sent timer stops when the circuit receives either a RELEASE 
message (that is, both the circuit and the network sent RELEASE messages at 
the same time) or a RELEASE COMPLETE message from the network.

If the timer expires before the circuit receives one of these messages, the circuit 
transmits the RELEASE message again. If the circuit still does not receive a 
response, the circuit releases the call reference and begins a restart procedure.

Instructions: Accept the default, 30, or enter a value from 1 to 180.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.26
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Parameter: T309

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 10
Options: 1 to 540

Function: Specifies the SAAL Data Link Connect timer value (in seconds). This timer 
begins when a signaling AAL malfunction occurs.

The SAAL Data Link Connect timer stops when the circuit reestablishes SAAL 
(that is, when the circuit sends an AAL-ESTABLISH-REQUEST and receives 
an AAL-ESTABLISH-CONFIRM message).

If the timer expires before the circuit can reestablish SAAL, the circuit clears the 
connection.

Instructions: Accept the default, 10, or enter a value from 1 to 540.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.27

Parameter: T310

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 10
Options: 1 to 60

Function: Specifies the Call Proceeding Received timer value (in seconds). This timer 
begins when the circuit receives a CALL PROCEEDING message from the 
network.

If the router does not receive a CONNECT or RELEASE message before this 
timer expires, it clears the connection for that virtual circuit.

Instructions: Accept the default, 10, or enter a value from 1 to 60.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.28
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Parameter: T313

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 4
Options: 1 to 24

Function: Specifies the Connect Sent timer value (in seconds). This timer begins when the 
circuit sends a CONNECT message to the network.

The Connect Sent timer stops when the circuit receives a CONNECT 
ACKNOWLEDGE message from the network (indicating the completion of the 
ATM connection for that interface).

If the timer expires before the circuit receives a CONNECT ACKNOWLEDGE 
message, the circuit clears the connection.

Instructions: Accept the default, 4, or enter a value from 1 to 24.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.29
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Parameter: T316

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 120
Options: 1 to 720

Function: Specifies the Restart Request Sent on Interface timer value (in seconds). This 
timer begins when the circuit sends a RESTART message to the network. The 
circuit uses the RESTART message to return all VCs on the interface to the idle 
condition.

The Restart Request Sent on Interface timer stops when the circuit receives a 
RESTART ACKNOWLEDGE message from the network.

If the timer expires before the circuit receives a RESTART ACKNOWLEDGE 
message, the circuit can transmit as many RESTART messages as specified with 
the Num Restarts ReXmitted parameter (see the parameter description on A-67). 
If the circuit still does not receive a response, the circuit enters the null state 
until the appropriate maintenance action is taken.

Instructions: Accept the default, 120, or enter a value from 1 to 720.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.30
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Parameter: T316c

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 120
Options: 1 to 720

Function: Specifies the Restart Request Sent on Channel timer value (in seconds). This 
timer begins when the circuit sends a RESTART message to the network. The 
circuit uses the RESTART message to return this individual VC on the interface 
to the idle condition.

The Restart Request Sent on Channel timer stops when the circuit receives a 
RESTART ACKNOWLEDGE message from the network.

If the timer expires before the circuit receives a RESTART ACKNOWLEDGE 
message, the circuit can transmit as many RESTART messages as specified with 
the Num Restarts ReXmitted parameter (see the parameter description on A-67). 
If the circuit still does not receive a response, the circuit enters the null state 
until the appropriate maintenance action is taken.

Instructions: Accept the default, 120, or enter a value from 1 to 720.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.31
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Parameter: T322

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 4
Options: 1 to 24

Function: Specifies the Status Enquiry Sent timer value (in seconds). This timer begins 
when the circuit sends a STATUS ENQUIRY message to the network. This 
message checks the validity of a call by requesting the call state (that is, active, 
in progress, or null). The Status Enquiry Sent timer stops when the circuit 
receives a STATUS message from the network.

If the timer expires before the circuit receives a STATUS message, the circuit 
can transmit as many STATUS ENQUIRY messages as specified with the Num 
Stat Enquiries ReXmitted parameter (see the parameter description on A-68). If 
the circuit still does not receive a response, the circuit clears the call.

Instructions: Accept the default, 4, or enter a value from 1 to 24.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.32
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Parameter: TDisc

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 4
Options: 1 to 180

Function: Specifies the SAAL Data Link Disconnect timer value (in seconds). This 
internal timer alerts upper layers that the link is down. The timer begins if the 
entire link goes down for any reason.

When the link goes down, the SAAL sends a DISCONNECT REQUEST 
message to the upper-layer application manager. The SAAL sends a disconnect 
request every time the SAAL Data Link Disconnect timer expires and continues 
to send this message until the link becomes operational.

Instructions: Accept the default, 4, or enter a value from 1 to 180.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.33
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Parameter: T397

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 180
Options: 180 to 1024

Function: Specifies the Alerting Received timer value (in seconds). This timer begins 
when the circuit sends an ALERTING or ADD PARTY ALERTING message to 
a party (the receiver of the message) on the network.

The Alerting Received timer stops when the circuit receives a DROP PARTY 
ACKNOWLEDGE message (indicating that the end point used for the party has 
been released) or a RELEASE message (indicating that the end point used for 
the party has been released and there are no remaining parties).

This timer can be used with UNI Version 4.0 and later.
Instructions: Accept the default, 180, or enter a value from 180 to 1024.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.43
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Parameter: T398

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 4
Options: 1 to 24

Function: Specifies the Drop Party Sent timer value (in seconds). This timer applies to 
multipoint connections only and begins when the circuit sends a DROP PARTY 
message to a party (the receiver of the message) on the network.

The Drop Party Sent timer stops when the circuit receives a DROP PARTY 
ACKNOWLEDGE message (indicating that the end point used for the party has 
been released) or a RELEASE message (indicating that the end point used for 
the party has been released and there are no remaining parties).

Instructions: Accept the default, 4, or enter a value from 1 to 24.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.34
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Parameter: T399

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 14
Options: 1 to 84

Function: Specifies the Add Party Sent timer value (in seconds). This timer applies to 
multipoint connections only and begins when the circuit sends an ADD PARTY 
message to a party (the receiver of the message) on the network.

The Add Party Sent timer stops when the circuit receives an ADD PARTY 
ACKNOWLEDGE message (indicating the connection to the party), an ADD 
PARTY REJECT message (indicating the inability to add the party), or a 
RELEASE message (indicating the inability to add the party and the absence of 
any remaining parties).

If the timer expires before the circuit receives an ADD PARTY 
ACKNOWLEDGE, ADD PARTY REJECT, or RELEASE message, the circuit 
clears the party.

Instructions: Accept the default, 14, or enter a value from 1 to 84.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.35

Parameter: Num Restarts ReXmitted

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 3
Options: 1 to 100

Function: Specifies the number of RESTART messages retransmitted before the link is 
considered down.

Instructions: Accept the default, 3, or enter a value from 1 to 100.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.36
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Parameter: Num Stat Enquiries ReXmitted

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 3
Options: 1 to 100

Function: Specifies the number of STATUS ENQUIRY messages retransmitted before the 
link is considered down.

Instructions: Accept the default, 3, or enter a value from 1 to 100.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.37

Parameter: Num Messages/Sec for Call Pacing

Path: Configuration Manager > Protocols > ATM > ATM Signaling

and

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > ATM 
Signaling

Default: 0
Options: 0 to 2147483647

Function: Specifies the maximum number of signaling messages the interface can transmit 
per second. The default value, 0, turns off this feature.

Instructions: Accept the default value, 0, or enter a value from 1 to 2147483647.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.7.1.40
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ATM ILMI Signaling Parameters

ILMI signaling parameters define the SNMP timers and retry limits for 
registration with the ATM switch. For control VC parameter descriptions, see 
“Signaling and ILMI Control VC Parameters” on A-73.

Parameter: Enable

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI)

Default: Enable
Options: Enable | Disable

Function: Enables or disables ILMI on this interface.
Instructions: Accept the default, Enable, if you want ILMI to remain enabled on this 

interface. Select Disable if you do not want ILMI enabled on this interface.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.9.1.2

Parameter: ILMI VPI

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI)

Default: 0
Options: 0 to 255

Function: Specifies the virtual path identifier (VPI) for the ILMI VC.
Instructions: Accept the default, 0, or enter a value from 0 to 255.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.9.1.8

Caution: The signaling VC (0/5) and the ILMI VC (0/16) are reserved. These 
VCs remain in an operational state as long as signaling is enabled on the ATM 
interface. Because most ATM devices use these VPI/VCI pairs for signaling, 
Nortel Networks recommends that you not change these values.
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Parameter: ILMI VCI

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI)

Default: 16
Options: 1 to 65535

Function: Specifies the virtual channel identifier (VCI) for the ILMI VC.
Instructions: Accept the default, 16, or enter any number from 1 to 8192, the maximum 

allowable VCI number you can set for BayRS.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.9.1.9

Caution: The signaling VC (0/5) and the ILMI VC (0/16) are reserved. These 
VCs remain in an operational state as long as signaling is enabled on the ATM 
interface. Because most ATM devices use these VPI/VCI pairs for signaling, 
Nortel Networks recommends that you not change these values.

Parameter: ILMI Get Timer

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI)

Default: 3
Options: 1 to 120

Function: Specifies the ILMI Get Request timer value (in seconds). The Get Request timer 
sets the amount of time allowed to receive a GET_RESPONSE message after 
sending a GET_REQUEST message.

Instructions: Accept the default, 3, or enter a value from 1 to 120.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.9.1.13
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Parameter: ILMI Get Retry Count

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI)

Default: 3
Options: 1 to 100

Function: Specifies the number of retransmissions of the ILMI GET_REQUEST message 
before the link is considered down.

Instructions: Accept the default, 3, or enter a value from 1 to 100.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.9.1.14

Parameter: ILMI Get Next Timer

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI)

Default: 3
Options: 1 to 120

Function: Specifies the ILMI Get Next Request timer value (in seconds). The Get Next 
Request timer sets the amount of time allowed to receive a 
GET_NEXT_RESPONSE message after sending a GET_NEXT_REQUEST 
message.

Instructions: Accept the default, 3, or enter a value from 1 to 120.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.9.1.15

Parameter: ILMI Get Next Retry Count

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI)

Default: 3
Options: 1 to 100

Function: Specifies the number of retransmissions of the ILMI GET_NEXT_REQUEST 
message before the link is considered down.

Instructions: Accept the default, 3, or enter a value from 1 to 100.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.9.1.16
308612-14.20 Rev 00 A-71



Configuring ATM Services
Parameter: ILMI Set Timer

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI)

Default: 3
Options: 1 to 120

Function: Specifies the ILMI Set Request timer value (in seconds). The Set Request timer 
sets the amount of time allowed to receive a SET_RESPONSE message after 
sending a SET_REQUEST message.

Instructions: Accept the default, 3, or enter a value from 1 to 120.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.9.1.17

Parameter: ILMI Set Retry Count

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI)

Default: 3
Options: 1 to 100

Function: Specifies the number of retransmissions of the ILMI SET_REQUEST message 
before the link is considered down.

Instructions: Accept the default, 3, or enter a value from 1 to 100.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.9.1.18
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Signaling and ILMI Control VC Parameters

The parameters for signaling and ILMI control VCs are identical.

Parameter: Xmit Peak Cell Rate (cells/s)

Path: Configuration Manager > Protocols > ATM > ATM Signaling > Sig VC

or

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI) > ILMI VC

Default: 4716
Options: 128 to 353207 (ATM ARE OC-3 SONET/SDH ILI pairs and

Model 5782 ATM routers)
128 to 96000 (ATM ARE DS-3 ILI pairs)
128 to 80000 (ATM ARE E-3 ILI pairs; G.832 framing mode)
128 to 72000 (ATM ARE E-3 ILI pairs; G.751 framing mode)

Function: Specifies the upper traffic limit, in cells/s, that the ATM connection can support. 
How you set the peak cell rate depends on:

• The optical transmission rate of your ATM device
• The amount of traffic you expect on a particular VC
• The rate you want for each VC

Instructions: After you determine the transmission rate of your ATM device, set the peak cell 
rate within the specified range.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.8
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Parameter: Xmit Sustainable Cell Rate (cells/s)

Path: Configuration Manager > Protocols > ATM > ATM Signaling > Sig VC

or

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI) > ILMI VC

Default: 4716 
Options: 0, 128 to 353207 (ATM ARE OC-3 SONET/SDH ILI pairs and

Model 5782 ATM routers)
0, 128 to 96000 (ATM ARE DS-3 ILI pairs)
0, 128 to 80000 (ATM ARE E-3 ILI pairs; G.832 framing mode)
0, 128 to 72000 (ATM ARE E-3 ILI pairs; G.751 framing mode)

Function: Specifies the upper limit of the ATM connection conforming average rate. The 
average rate equals the total number of cells transmitted, divided by the duration 
of the connection.

Using the sustainable cell rate (SCR), you can define the future cell flow of a 
VC in greater detail than by using only the peak cell rate.

The SCR maps directly to the minimum cell rate (MCR). The MCR defines the 
minimum amount of guaranteed bandwidth allowed for PVCs and control VCs 
on the ATM line.
When setting the SCR, keep the following in mind:

• The SCR maps directly to the MCR.
• The MCR provides guaranteed bandwidth for PVCs and control VCs while 

allowing sufficient bandwidth for SVCs to operate.
• To be useful, the SCR must not exceed the PCR. 
• If you know the average rate, set the SCR approximately 10 percent higher 

than this value.
• VCs may fail to operate with SCR values lower than 128 cells/s.
• Entering 0 for the SCR turns off this function.
• The E-3 framing mode setting affects the maximum SCR.

Instructions: After you determine the transmission rate of your ATM device, set the 
sustainable cell rate within the specified range. Enter 0 to turn off this function.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.9
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Parameter: Xmit Burst Size (cells)

Path: Configuration Manager > Protocols > ATM > ATM Signaling > Sig VC

or

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI) > ILMI VC

Default: 40
Options: 1 to 65535

Function: Specifies the maximum number of sequential cells allowed on a VC, at the peak 
cell rate, before the VC must relinquish bandwidth to other VCs.

When setting the MBS, you should select a value larger than the largest packet 
that your control VC can transmit (that is, the Maximum AAL CPCS Transmit 
SDU Size). For example, if your VC accepts packets that are less than 2358 
bytes long (PVC default), set your MBS value from 45 to 50 cells.

Instructions: Set a value in the specified range.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.10
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Parameter: Maximum AAL CPCS Transmit SDU Size

Path: Configuration Manager > Protocols > ATM > ATM Signaling > Sig VC

or

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI) > ILMI VC

Default: 4608
Options: 1 to 65535

Function: Specifies the maximum AAL CPCS SDU size, in bytes, that this VC supports in 
the transmit direction.

Instructions: Enter the maximum packet size that you intend this VC to transmit. Nortel 
Networks recommends that you accept the default value of 4608 bytes. Most 
packets fall well within this limit.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.17

Parameter: Maximum AAL CPCS Receive SDU Size

Path: Configuration Manager > Protocols > ATM > ATM Signaling > Sig VC

or

Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Interim 
Local Management Interface (ILMI) > ILMI VC

Default: 4608
Options: 1 to 65535

Function: Specifies the maximum AAL CPCS SDU size, in bytes, that this VC supports in 
the receive direction.

Instructions: Enter the maximum packet size that you intend this VC to receive. Nortel 
Networks recommends that you accept the default value of 4608 bytes. Most 
packets fall well within this limit.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.18
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ATM Signaling AAL Parameters

Signaling AAL (SAAL) parameters define the connection and timer settings the 
router uses to maintain a switched connection. SAAL provides reliable transport 
of signaling messages within the ATM protocol reference model.

Parameter: Enable

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Signaling 
AAL (SAAL)

Default: Enable
Options: Enable | Disable

Function: Enables or disables SAAL on this interface.
Instructions: Accept the default, Enable, if you want SAAL to remain enabled on this 

interface. Select Disable if you do not want SAAL enabled on this interface.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.8.1.2

Parameter: Link Connection Arbitration

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Signaling 
AAL (SAAL)

Default: Active
Options: Active | Passive

Function: Determines whether SAAL initiates link connections or waits for connections.
Instructions: Accept the default, Active, if you want this interface to initiate connections. 

Select Passive if you do not want this interface to initiate connections.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.8.1.8
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Parameter: Poll Timer

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Signaling 
AAL (SAAL)

Default: 7
Options: 1 to 120

Function: Specifies the Service Specific Connection Oriented Protocol (SSCOP) poll timer 
value (in tenths of a second). This value sets the allowable time between poll 
protocol data unit (PDU) transmissions.

The poll timer ensures that the receiver continues to return a solicited status 
(STAT) PDU to the sender on a regular basis. The timely receipt of STAT PDUs 
restarts the poll timer and allows for more efficient transmission error recovery.

Instructions: Accept the default, 7, or enter a value from 1 to 120.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.8.1.9

Parameter: Keep Alive Timer

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Signaling 
AAL (SAAL)

Default: 20
Options: 1 to 120

Function: Specifies the SSCOP keepalive timer value (in tenths of a second). This value 
sets the allowable time between poll PDU transmissions if there are no pending 
sequence data (SD) PDUs.

The keepalive timer is generally greater than the poll timer and greater than the 
length of one round-trip delay.

Instructions: Accept the default, 20, or enter a value from 1 to 120.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.8.1.10
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Parameter: No Response Timer

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Signaling 
AAL (SAAL)

Default: 70
Options: 1 to 120

Function: Specifies the SSCOP no response timer value (in tenths of a second). This value 
sets the allowable time between the receipt of STAT PDUs.

So as not to interrupt the flow of data, SSCOP does not require a reply to every 
poll PDU. This can cause problems in detecting a failed connection. To alleviate 
this problem, the no response timer runs parallel to the poll timer. If both the no 
response timer and the poll timer expire, SSCOP clears the connection.

The no response timer value must equal at least the sum of the keepalive timer 
plus the length of one round-trip delay.

Instructions: Accept the default, 70, or enter a value from 1 to 120.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.8.1.11

Parameter: Connection Control Timer

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Signaling 
AAL (SAAL)

Default: 10
Options: 1 to 120

Function: Specifies the SSCOP connection control (CC) timer value (in tenths of a 
second). This value sets the allowable time between the transmission of begin 
(BGN), END, resynchronization (RS), and error recovery (ER) PDUs, so long 
as the sender has not received an acknowledgment to any of these PDUs.

The CC timer must equal at least the length of one round-trip delay.
Instructions: Accept the default, 10, or enter a value from 1 to 120.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.8.1.12
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Parameter: Max Connection Control

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Signaling 
AAL (SAAL)

Default: 4
Options: 1 to 20

Function: Specifies the SSCOP maximum connection control value. This value sets the 
maximum number of times the sender can transmit a BGN, END, RS, or ER 
PDU.

Instructions: Accept the default, 4, or enter a value from 1 to 20.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.8.1.13

Parameter: Max PD Before Poll

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Signaling 
AAL (SAAL)

Default: 25
Options: 1 to 120

Function: Specifies the SSCOP maximum poll data (PD) value. This value sets the 
maximum value of the poll data state variable before transmitting a poll PDU. 
The poll data state variable increments upon transmission of a sequenced data 
(SD) PDU and resets to 0 upon transmission of a poll PDU.

Instructions: Accept the default, 25, or enter a value from 1 to 120.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.8.1.14
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ATM Router Redundancy Parameter

This section describes the ATM Monitoring Timer parameter for implementing 
ATM router redundancy. For information about all other router redundancy 
parameters, see Configuring Interface and Router Redundancy.

Parameter: Max STAT PDU Elements

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Signaling 
AAL (SAAL)

Default: 67
Options: Odd integer from 3 to 119

Function: Specifies the SSCOP maximum STAT PDU value. This value sets the maximum 
number of list elements allowed in a STAT PDU.

The sending device uses the value of this parameter for segmentation purposes. 
When the number of list elements exceeds this value, the STAT message 
segments. As a general rule, the default value, 67, causes the STAT PDU to fill 
six ATM cells using AAL 5.

Instructions: Accept the default, 67, or enter an odd integer from 3 to 119.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.8.1.15

Parameter: ATM Monitoring Timer

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Configure 
ATM Router Redundancy

Default: 3000
Options: 1 to 65535

Function: Specifies the amount of time in milliseconds (ms) that the secondary router 
waits before beginning the process of becoming the primary router. By default, 
if the router experiences a loss of signal, it waits 3000 ms for the signal to return. 
If the signal does not return within that time, the secondary router begins the 
process of becoming the primary router.

Instructions: Accept the default, 3000, or enter another value.
MIB Object ID: 1.3.6.1.4.1.18.3.5.17.1.34
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OAM Parameters

This section describes ATM PVC Operations and Management (OAM) 
parameters.

Parameter: OAM Loopback Enable

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: Disable
Options: Enable | Disable

Function: Specifies whether or not the ATM PVC sends OAM loopback cells.
Instructions: Select Enable if you want the ATM PVC to send OAM loopback cells. Select 

Disable if you do not want the ATM PVC to send OAM loopback cells.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.31

Note: You must configure OAM loopback on all PVCs on a service record for 
the feature to function properly. Service record status is based on the OAM 
loopback status of all PVCs on the service record. 

Parameter: OAM Loopback Cell Interval

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: 5
Options: 1 to 255 seconds

Function: Specifies the OAM loopback cell interval in seconds. This value specifies how 
often an ATM PVC sends an OAM loopback cell in the data stream.

Instructions: Specify an interval from 1 to 255 seconds.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.32
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Parameter: OAM Threshold 1

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: 1
Options: 1 to 255

Function: Specifies the number of OAM loopback cells that do not receive an OAM 
loopback response before the service record alerts the upper-layer protocol (for 
example, IP) that the PVC is not operational.

Instructions: Specify a threshold value from 1 to 255 cells.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.33

Parameter: OAM Threshold 2

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: 2
Options: 1 to 255

Function: Specifies the number of consecutive OAM loopback response cells that the PVC 
service record must receive before declaring that the PVC is operational again.

Instructions: Specify a threshold value from 1 to 255 cells.
MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.34
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Parameter: OAM Alarm Enable

Path: Configuration Manager > Circuits > Edit Circuits > Edit > ATM > Service 
Attributes > PVC

Default: Disable
Options: Enable | Disable

Function: Specifies whether OAM alarm notification is enabled. When enabled, OAM 
alarm notification tells the upper-layer protocol that the PVC has received an 
OAM alarm and that the service record is down. By default, OAM alarm 
notification is disabled; that is, OAM alarms are ignored and no message is sent 
to the upper-layer protocol.

Instructions: Select Enable if the connecting switch has OAM alarm capability and you want 
the ATM PVC to notify the upper-layer protocol of any OAM alarms. Select 
Disable if the connecting switch does not have OAM alarm capability, or if you 
do not want the ATM PVC to notify the upper-layer protocol of any OAM 
alarms.

MIB Object ID: 1.3.6.1.4.1.18.3.4.23.1.5.1.35
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ATMARP Parameters

This section describes IP interface parameters for implementing ATMARP. 
ATMARP is an address resolution scheme used for classical IP over ATM.

Parameter: ATM ARP Mode

Path: Configuration Manager > Protocols > IP > Interfaces
Default: Client
Options: Client | Server | None

Function: Specifies whether ATMARP is running as a client or server on this interface.
Instructions: You must configure one ATMARP server for each LIS that you define. If you are 

configuring a WAN SVC, select None.
MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.24.1.49

Parameter: ARP Server ATM Address Network Prefix

Path: Configuration Manager > Protocols > IP > Interfaces
Default: None
Options: XX000000000000000000000000 to XXFFFFFFFFFFFFFFFFFFFFFFFF

where XX = 39, 45, or 47
Function: Specifies the ATM address network prefix of the ATMARP server on your 

network. The network prefix and the user part form a complete ATM address.

The XX byte must contain 39, 45, or 47. These values define the authority and 
format identifier (AFI). The AFI byte identifies the group responsible for 
allocating the prefix and the format that the prefix uses. For more information 
about the AFI byte, see the ATM Forum UNI specification.

Instructions: Enter the ATM address network prefix of the ATMARP server on your network.
MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.4.1.113
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Parameter: ARP Server ATM Address User Part

Path: Configuration Manager > Protocols > IP > Interfaces
Default: None
Options: 00000000000000 to FEFFFFFFFFFFFF

Function: Specifies the user part (suffix) of the ATM address for the ATMARP server on 
your network. The user part suffix consists of a 6-byte end-station identifier and 
a 1-byte selector field. The user part and the network prefix form a complete 
ATM address.

Instructions: Enter the ATM address user part of the ATMARP server for your network.
MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.4.1.113

Parameter: Registration Refresh Interval

Path: Configuration Manager > Protocols > IP > Interfaces
Default: 900 seconds for a client

1200 seconds for a server
Options: Any interval (in seconds)

Function: For a client, this parameter specifies the interval between registration refreshes. 
For a server, this parameter specifies the duration for which the registration is 
valid.

Instructions: Determine whether ATMARP is running as a client or server on this interface 
and enter an appropriate value.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.24.1.52

Parameter: SSCS Type Field

Path: Configuration Manager > Protocols > IP > Interfaces
Default: 0x00000000
Options: 0 to 0x7FFFFFFF

Function: Enables and disables the SSCS type field for interoperability with an IBM 
ATMARP server. The service specific convergence sublayer (SSCS) is the 
portion of the CS that is dependent on the type of traffic being converted.

Instructions: To disable the SSCS type field, accept the default value (0). To enable this field, 
enter 0x00200000.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.24.1.53
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Adjacent Host Parameters

This section describes ATM IP parameters for creating adjacent hosts in a 
classical IP over ATM environment. For additional information about adjacent 
hosts, see Configuring IP, ARP, RARP, RIP, and OSPF Services.

Parameter: Enable

Path: Configuration Manager > Protocols > IP > Adjacent Hosts
Default: Enable
Options: Enable | Disable

Function: Specifies the state (active or inactive) of the adjacent host in the IP routing table.
Instructions: Select Disable to make the adjacent host record inactive in the IP routing table; 

the IP router will not consider this adjacent host.

Select Enable to make the adjacent host record active again in the IP routing 
table.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.6.1.2

Parameter: IP Adjacent Host Address

Path: Configuration Manager > Protocols > IP > Adjacent Hosts > Add
Default: None
Options: Any valid IP address

Function: Specifies the IP address of the device that you want to configure as an adjacent 
host.

Instructions: Enter the IP address in dotted-decimal notation.
MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.6.1.4

Parameter: Next Hop Interface Addr

Path: Configuration Manager > Protocols > IP > Adjacent Hosts
Default: 0.0.0.0
Options: Any valid IP address

Function: Specifies the IP address of the router’s network interface to the adjacent host.
Instructions: Enter the IP address in dotted-decimal notation.

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.6.1.4
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Parameter: MAC/ATM Address, DLCI, VPI/VCI

Path: Configuration Manager > Protocols > IP > Adjacent Hosts
Default: None
Options: Depends on the data link you selected

Function: Specifies the physical address of the adjacent host. This value can be any of the 
following:

• A 48-bit physical address
• A 64-bit SMDS address
• An ATM VPI/VCI pair (for ATM PVCs)
• The ATM address of the ATM interface (for ATM SVCs)

Instructions: Enter the MAC address as a 12-digit hexadecimal number (canonical format), a 
32-digit hexadecimal number (SMDS), a VPI/VCI pair (for example, 0/32), or a 
40-digit ATM address (for example, 
390000000000000000000000000000A20037B801).

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.6.1.6

Parameter: Host Encapsulation

Path: Configuration Manager > Protocols > IP > Adjacent Hosts
Default: Ethernet
Options: Ethernet | SNAP | PDN | DDN | SNAPIP | NULL

Function: Specifies the adjacent host’s encapsulation method.
Instructions: Select Ethernet or SNAP if you are defining a point-to-point network interface, 

or if the adjacent host resides on an Ethernet. For an X.25 interface, select Public 
Data Network (PDN) or Defense Data Network (DDN). For an adjacent host on 
an ATM logical IP subnet, select SNAP. (SNAPIP and NULL also specify host 
encapsulation methods for ATM networks.)

MIB Object ID: 1.3.6.1.4.1.18.3.5.3.2.1.6.1.7
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Appendix B
Monitoring ATM Using the BCC show Command

This appendix describes how to use the BCC show command to obtain ATM, 
LANE, and classical IP statistical data from the management information base 
(MIB). The type and amount of data displayed depend on the specific ATM 
settings that you want to view. This appendix includes descriptions of the 
following show commands:

Command Page

show atm interfaces B-2

show atm line B-3

show atm services B-6

show atm signaling B-6

show atm stats vcs B-7

show atm vcs B-8

show ces config B-9

show ces stats B-10

show classical-ip configuration B-11

show classical-ip interface B-11

show classical-ip stats B-12

show classical-ip table B-12

show dsx3 circuits B-13

show dsx3 current B-14

show dsx3 history B-17

show lane clients B-20

show lane configuration B-21

(continued)
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show atm interfaces

The show atm interfaces command displays the ATM interface table. This table contains 
information about all ATM interfaces on the router or specific information based on the 
filters you use.

This command allows for the following command filters (flags) and filter arguments:

The output includes the following information:

show lane data-vcs B-21

show lane le-arp B-22

show lane le-rd-arp B-23

show lane les B-24

show lane mac B-24

show lane servers B-25

show lane stats B-26

show sonet circuits B-27

show sonet current B-28

show sonet history B-31

-slot <slot>[/<connector>] Displays information about the specified slot or slot/connector pair 
only.

-enabled Displays information for only those interfaces enabled on the router 
or on the specified slot or slot/connector pair.

-disabled Displays information for only those interfaces disabled on the router 
or on the specified slot or slot/connector pair.

Slot Slot number on which the interface resides.

Conn Connector number of the interface.

Circuit Circuit name assigned to the interface.

State State of the ATM line: Up, Down, Init (initializing), Disabled, or 
Absent.

VPCs Maximum number of virtual path connections supported by the ATM 
interface.

Command Page
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show atm line

The show atm line command displays information about the ATM Adaptation Layer 
Controller (ALC) link module service.

The show atm line command supports the following subcommand options:

In addition, you can specify any of the following filters (flags) with the above 
subcommand options:

VCCs Maximum number of virtual channel connections supported by the 
ATM interface.

Addr Type Type of ATM address configured for use by the ATM interface: 
Private, NSAP E.164, Native E.164, Other, Null, or NotDefined.

Signaling Whether signaling is enabled or disabled on the ATM interface.

Sig Version The signaling standard configured for the ATM interface: UNI3.0 or 
UNI3.1.

errors phy errors

phy config stats

-slot <slot>[/<connector>] Displays ATM line information for the specified slot or 
slot/connector pair only.

-enabled Displays ATM line information for enabled ATM lines only.

-disabled Displays ATM line information for disabled ATM lines only.

-sample Displays a snapshot of ATM line information taken at 10-second 
intervals.
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errors [-enabled | -disabled] [-slot <slot> | -slot <slot>/<connector>] [-sample]

Displays the ATM module physical interface errors table for the ATM routing engine 
(ARE).

The output includes the following line receive error statistics:

phy config [-enabled | -disabled] [-slot <slot> | -slot <slot>/<connector>] 
[-sample]

Displays the ATM module physical interface table for the ATM routing engine (ARE).

The output includes the following physical interface statistics:

Slot Slot number on which the ATM physical interface resides.

Conn Connector number of the physical interface.

Circuit Circuit name assigned to the interface.

Invalid Headers Number of received cells dropped because of incorrect header 
format.

Over Sized SPDUs Number of packets dropped because their size was greater than the 
MTU specified for the interface.

Crc Errors Cyclical redundancy check errors.

Crc10 Errors Number of OAM cells dropped because they had an invalid CRC-10.

Rx Lack of Rsrcs Number of packets dropped because no host buffers were available 
to hold the incoming data. 

Slot Slot number on which the ATM physical interface resides.

Conn Connector number of the physical interface.

Circuit Circuit name assigned to the interface.

Phy State Physical state of the ATM line (Up or Down).

Speed (Mbps) Estimate of the interface's current bandwidth: 155,520,000 Mb/s, 
140,000,000 Mb/s, 100,000,000 Mb/s, 44,736,000 Mb/s, or 
34,368,000 Mb/s.

Type Interface type: OC-3 MM (multimode), OC-3 SM (single mode), 
DS-3, or E-3.

Framing Mode Transceiver mode: SDH, SONET, CBIT, M23, G751, or G832.
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phy errors [-enabled | -disabled] [-slot <slot> | -slot <slot>/<connector>] 
[-sample]

Displays the ATM module physical interface errors table for the ATM routing engine 
(ARE).

The output includes the following physical interface error statistics:

stats [-enabled | -disabled] [-slot <slot> | -slot <slot>/<connector>] [-sample]

Displays the ATM module I/O statistics table for the ATM routing engine (ARE).

The output includes the following module I/O statistics:

Slot Slot number on which the ATM physical interface resides.

Conn Connector number of the physical interface.

Circuit Circuit name assigned to the interface.

Tc. Alarm State State of the driver: Up, Down, Init (initializing), Download 
(downloading), Config (configuring), or Not Present. Note that this 
parameter does not represent the state of the physical interface.

HEC Detected Number of uncorrectable header error check (HEC) errors detected.

HEC Corrected Number of correctable HEC errors detected.

Out of Cell Delineation Number of times an out-of-cell delineation occurs. An out-of-cell 
delineation occurs when 7 consecutive ATM cells have HEC errors.

Slot Slot number on which the ATM physical interface resides.

Conn Connector number of the physical interface.

Circuit Circuit name assigned to the interface.

Received Packets Number of packets received at the transceiver receive interface that 
have not been discarded. 

Transmitted Packets Number of packets transmitted at the transceiver transmit interface.

Invalid Headers Number of invalid headers detected by the transceiver interface.

Rx CRC Errors Number of receive CRC errors detected by the transceiver interface.

Total Errors Total number of errors detected by the transceiver interface.
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show atm services

The show atm services command displays all ATM service record instances or a subset 
of service record instances, along with the AAL data encapsulation type, state, VC type, 
and ATM address (a combination of network prefix and user part).

This command allows for the following command filters (flags) and filter arguments:

The output includes the following information:

show atm signaling

The show atm signaling command displays all ATM interfaces, whether or not they have 
signaling enabled or disabled, and what version of signaling they are running.

This command allows for the following command filters (flags) and filter arguments:

The output includes the following information:

-slot <slot>[/<connector>] Displays information about the specified slot or slot/connector pair 
only.

-service <servicename> Displays information about the specified service record only.

Service Service name associated with this service record.

Encaps Encapsulation type of this VC: LAN Emulation, LLC/SNAP, NLPID, 
or NULL.

State State of the ATM line: Up, Down, Init (initializing), Reject, or Absent.

Type Type of virtual circuit: PVC or SVC.

ATM Address ATM address of this service record. This parameter applies only to 
SVC service records.

-slot <slot>[/<connector>] Displays information about the specified slot or slot/connector pair 
only.

-service <servicename> Displays information about the specified service record only.

Slot/<Module>/Conn The slot, module, and connector number of the ATM circuit.

Signaling Whether signaling is enabled or disabled on the interface.

Sig Version The signaling version that the interface is using.
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show atm stats vcs

The show atm stats vcs command displays the ATM interface VC statistics table for the 
ATM routing engine (ARE). This table contains statistical information for all ATM VCs 
on the router or specific information based on the filters you use.

This command allows for the following command filters (flags) and filter arguments:

The output includes the following information:

-slot <slot>[/<connector>] Displays statistical information about the specified slot or
slot/connector pair only.

-service <servicename> Displays statistical information about the specified service record 
only.

-vpi Displays statistical information for the specified virtual path 
identifier (VPI) only.

-vci Displays statistical information for the specified virtual channel 
identifier (VCI) only.

Service Name of the service record containing the virtual channel (VC).

VPI Virtual path identifier (VPI) of the VC.

VCI Virtual channel identifier (VCI) of the VC.

Cells Tx Number of assigned ATM layer cells transmitted at the transceiver 
transmit interface (T-count).

Cells Rx Number of ATM layer cells received at the transceiver receive 
interface that were not discarded (R-count).

Packets Tx Number of packets transmitted at the transceiver transmit interface.

Packets Rx Number of packets received at the transceiver receive interface that 
were not discarded. 
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show atm vcs

The show atm vcs command displays the ATM interface VCL table. This table contains 
information about all ATM virtual channel links on the router or specific information 
based on the filters you use.

This command allows for the following command filters (flags) and filter arguments:

The output includes the following information:

-slot <slot>[/<connector>] Displays VC information about the specified slot or slot/connector 
pair only.

-service <servicename> Displays VC information about the specified service record only.

-vpi Displays VC information for the specified virtual path identifier (VPI) 
only.

-vci Displays VC information for the specified virtual channel identifier 
(VCI) only.

Service Name of the service record containing the virtual channel (VC).

VPI Virtual path identifier (VPI) of the VC.

VCI Virtual channel identifier (VCI) of the VC.

Type Type of VC: SVC or PVC.

State State of the ATM line: Up, Down, Init (initializing), Disabled, or 
Absent.

Hybrid/Bridged VCs? Whether this is a hybrid/bridged VC. Yes means the VC operates as 
a hybrid access mode VC; No means the VC works in group access 
mode only.

AAL ATM Adaptation Layer type of this VC: AAL5.

Encaps Encapsulation type of this VC: LLC/SNAP, NULL, LANE8023, 
LANE8025, NLPID, Unknown, or OTHER.

Xmt PCR Transmit peak cell rate (PCR) for this VC (in cells/s).

Xmt SCR Transmit sustainable cell rate (SCR) for this VC (in cells/s).
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show ces config

The show ces config command displays the CES configuration information for all CES 
VCs on the router or specific information based on the filters you use.

This command allows for the following command filters (flags) and filter arguments:

The output includes the following information:

-vpi Displays CES statistical information for the specified virtual path 
identifier (VPI) only.

-vci Displays CES statistical information for the specified virtual channel 
identifier (VCI) only.

Atm
Slot/Pci_Slot/module/
Connector

The ATM slot/PCI_slot/module/connector location of the CES 
interface.

DualSync
Slot/Pci_Slot/module/
Connector

The dual synchronous slot/PCI_slot/module/connector location of 
the CES interface.

VPI Virtual path identifier (VPI) of the VC.

VCI Virtual channel identifier (VCI) of the VC.

Circuit Name The circuit name of CES interface.

Atm t1/e1 Mode The framing (transceiver) mode for the physical interface.

Timeslot Subrate The data rate within each and every timeslot within this TDM circuit.

Timeslot Number Number of timeslots occupied by this H.110 TDM circuit.

Admin Status The desired administrative status of the CES internetworking 
function.

Operation Status The operational status of the CES internetworking function.

CBR Service Define whether DSx/Ex service is structured or unstructured.

CBR Clock Mode Define whether DSx/Ex service clocking mode.

CAS Mode The mode that selects which AAL1 format should be used.

Partial Fill Cell Number of user octets per cell.

Max Buffer The maximum size in 10 microsecond increments of the reassembly 
buffer.
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show ces stats 

The show ces stats command displays the CES statistics table. This table contains 
statistical information for all CES VCs on the router or specific information based on the 
filters you use.

This command allows for the following command filters (flags) and filter arguments:

The output includes the following information:

Max Cell Receive The maximum cell arrival jitter in 10 usec increments that the 
reassembly process will tolerate in the cell stream without producing 
errors on the CBR service interface.

Conn Type The type of ATM connectivity between associated CES IWFs.

-vpi Displays CES statistical information for the specified virtual path 
identifier (VPI) only.

-vci Displays CES statistical information for the specified virtual channel 
identifier (VCI) only.

Atm
Slot/Pci_Slot/module/
Connector

The ATM slot/PCI_slot/module/connector location of the CES 
interface.

DualSync
Slot/Pci_Slot/module/
Connector

The DualSync slot/Pci_Slot/module/connector location of the CES 
interface.

VPI Virtual path identifier (VPI) of the VC.

VCI Virtual channel identifier (VCI) of the VC.

Circuit Name The circuit name of CES interface.

Reassembler Cells Number of cells played out to the CES service interface.

Header Errors Number of AAL1 header errors detected, including those corrected.

Reframes Number of events the AAL1 reassembler found.

Parity Errors Number of events in which the AAL1 reassembler detects a parity 
check failure where it expects a structured data pointer.

AAL1 Sequence Errors Number of times that the sequence number of an incoming AAL1 
Type 1 SAR-PDU causes a transition from the ‘sync’ state to the ‘out 
of sequence’ state, as defined by ITU-T I.363.1.
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show classical-ip configuration

The show classical-ip configuration command displays information for all classical IP 
interfaces on the ATM router or for one specific IP address. This command allows for the 
following command filter (flag) and filter argument:

The output includes the following information:

show classical-ip interface

The show classical-ip interface command displays information for all classical IP 
interfaces on the ATM router or for one specific IP address. This command allows for the 
following command filter (flag) and filter argument:

The output includes the following information:

Lost Cells Number of lost cells, as detected by the AAL1 sequence number 
processing.

Misinsert Cells Number of AAL1 sequence violations which the AAL convergence 
sublayer interprets as a misinserted cell, as defined by ITU-T 
I.363.1.

Underflows Number of times the CES reassembly buffer underflows.

Overflows Number of times the CES reassembly buffer overflows.

Cell Loss Status The status of the cells lost.

-ipaddr <ip_address> Displays information about the specified IP address only.

Interface The IP address of the classical IP interface.

Mode The mode of the classical IP interface (client or server).

Server Address (if client) The ATM address of the server with which the classical IP client 
communicates.

-ipaddr <ip_address> Displays information about the specified IP address only.

Interface IP address of the classical IP interface.
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show classical-ip stats

The show classical-ip stats command displays statistics for all classical IP interfaces on 
the ATM router or for one specific IP address. This command allows for the following 
command filter (flag) and filter argument:

The output includes the following information:

show classical-ip table

The show classical-ip table command displays information for each classical IP 
interface. This command allows for the following command filter (flag) and filter 
argument:

Address ATM address of the server with which the classical IP client 
communicates.

Server Conn. State The state of the connection to the ATMARP server.

-ipaddr <ip_address> Displays statistical information about the specified IP address only.

Interface IP address of the classical IP interface.

Open SVCs Number of open SVCs. 

Calls Attempted Number of calls ATMARP has attempted.

Calls Succeeded Number of originated calls that have completed successfully.

Failed May Retry Number of attempted calls that failed but were retried.

Failed No Retry Number of attempted calls that failed but were not retried.

Calls Accepted Number of received calls that were accepted.

-ipaddr <ip_address> Displays information about the specified IP address only.
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The output includes the following information:

show dsx3 circuits

The show dsx3 circuits command displays information about the DSX3 circuits in the 
configuration.

The output includes the following information:

IP Address IP address of the classical IP interface.

Life The interval between registration refreshes; the duration a 
registration is considered valid.

ATM Address ATM address associated with the classical IP client.

Vpi.Vci VPI/VCI pair associated with the classical IP client.

Slot/<Module>/Conn The slot, module, and connector number of the DSX3 circuit.

Circuit Name of the circuit associated with this line.

Sec into Interval Number of seconds into the current 15-minute interval.

# of Intervals Number of complete 15-minute intervals. The value is 96 unless the 
interface was brought online within the last 24 hours. In that case, 
the value is the number of complete 15-minute intervals since the 
interface has been online.

Line Coding The line coding on this circuit. The line coding options are:
• B3ZS 
• HDB3
The line coding specifies patterns of normal bits and bipolar 
violations used to replace sequences of zero bits of a certain length.

Line Type Status The line status of the interface. The possible status values are:
• NoAlarm — no alarm present
• RRAI — receiving yellow remote alarm indication
• TRAI — transmitting yellow remote alarm indication
• RAIS — receiving Alarm Indications Signal (AIS) failure state
• TAIS — transmitting AIS failure state
• LOF — receiving Loss of Frame (LOF) failure state
• LOS — receiving Loss of Signal (LOS) failure state
• Loopback — looping the received signal
• TestCode — receiving a test pattern
• LowSignal — low signal
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show dsx3 current

The show dsx3 current command displays line, Pbit, Cbit, and Plcp statistics for the 
DSX3 circuits in the configuration.

The output includes the following information:

Slot/<Module>/Conn The slot, module, and connector number of the DSX3 circuit.

Circuit Name of the circuit associated with this line.

Sec into Interval Number of seconds into the current 15-minute interval.

# of Intervals Number of complete 15-minute intervals.

Line Coding The line coding on this circuit. The line coding options are:
• B3ZS 
• HDB3

Line Type Status The line status of the interface. The possible status values are:
• NoAlarm — no alarm present
• RRAI — receiving yellow remote alarm indication
• TRAI — transmitting yellow remote alarm indication
• RAIS — receiving Alarm Indications Signal (AIS) failure state
• TAIS — transmitting AIS failure state
• LOF — receiving Loss of Frame (LOF) failure state
• LOS — receiving Loss of Signal (LOS) failure state
• Loopback — looping the received signal
• TestCode — receiving a test pattern
• LowSignal — low signal

Line Stats

Circuit Name of the circuit associated with this line.

Interval The current interval.

LESs Number of line errored seconds (LESs) in the current interval. An 
LES is a second in which one or more coding violations occurred or 
one or more LOS defects were detected.

SEFSs Number of severely errored framing seconds (SEFSs) in the current 
interval. An SEFS is a second with one or more OOF errors or an 
AIS defect.

UASs Number of unavailable seconds (UASs) in the current interval.

LCVs Number of line coding violations (LCVs) in the current interval. A 
line coding violation is a count of both bipolar violations (BPVs) and 
excessive zero (EXZ) error events.
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Pbit Status

Circuit Name of the circuit associated with this line.

Interval The current interval.

PESs Number of P-bit errored seconds (PESs) in the current interval. A 
PES is a second with one or more P-bit coding violations, one or 
more OOF defects, or a detected incoming AIS. The PES does not 
increment when counting UASs.

PSESs Number of P-bit severely errored seconds (PSESs) in the current 
interval. A PSES is a second with 44 or more PCVs, one or more 
OOF defects, or a detected incoming AIS. The PSES value does not 
increment when counting UASs.

UASs Number of unavailable seconds (UASs) in the current interval.

PCVs Number of P-bit coding violations (PCVs) in the current interval. For 
all DS3/E3 applications, a coding violation error event is a P-bit 
Parity Error event. A P-bit Parity Error event occurs when the DS-3/
E-3 M-frame receives a P-bit code that is not identical to the 
corresponding locally calculated code.

Cbit Stats

Circuit Name of the circuit associated with this line.

Interval The current interval.

CESs Number of C-bit errored seconds (CESs) in the current interval. A 
CES is a second with one or more CCVs, one or more OOF defects, 
or a detected incoming AIS. This count is only for the C-bit Parity 
DS3 applications. The CES value does not increment when 
counting UASs.

CSESs Number of C-bit severely errored seconds (CSESs) in the current 
interval. A CSES is a second with 44 or more CCVs, one or more 
OOF defects, or a detected incoming AIS. This count applies only to 
C-bit Parity DS3 applications. The CSES value does not increment 
when counting UASs.

UASs Number of unavailable seconds (UASs) in the current interval.

CCVs Number of C-bit coding violations (CCVs) in the current interval. For 
C-bit Parity and SYNTRAN DS3 applications, this is the count of 
coding violations reported via the C-bits. For C-bit Parity, it is a 
count of C-bit parity errors occurring in the accumulation interval.
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FarEnd Cbit Stats

Circuit Name of the circuit associated with this line.

Interval The current interval.

CESs Number of C-bit errored seconds (CESs) in the current interval. A 
CES is a second with one or more CCVs, one or more OOF defects, 
or a detected incoming AIS. This count is only for C-bit Parity DS3 
applications. The CES value does not increment when counting 
UASs.

CSESs Number of C-bit severely errored seconds (CSESs) in the current 
interval. A CSES is a second with 44 or more CCVs, one or more 
OOF defects, or a detected incoming AIS. This count applies only to 
C-bit Parity DS3 applications. The CSES value does not increment 
when counting UASs.

UASs Number of unavailable seconds (UASs) in the current interval.

CCVs Number of C-bit coding violations (CCVs) in the current interval. For 
C-bit Parity DS3 applications, this is the count of coding violations 
reported via the C-bits. For C-bit Parity, it is a count of C-bit parity 
errors occurring in the accumulation interval.

DS3 Plcp Stats

Circuit Name of the circuit associated with this line.

Interval The current interval.

SEFSs Number of severely errored framing seconds (SEFSs) in the current 
interval. An SEFS is a second with one or more OOF errors or an 
AIS defect.

UASs Number of unavailable seconds (UASs) in the current interval.

Status Indicates the line status of the interface. The possible status values 
are:
• NoAlarm — no alarm present
• RRAI — receiving yellow remote alarm indication
• TRAI — transmitting yellow remote alarm indication
• RAIS — receiving Alarm Indications Signal (AIS) failure state
• TAIS — transmitting AIS failure state
• LOF — receiving Loss of Frame (LOF) failure state
• LOS — receiving Loss of Signal (LOS) failure state
• Loopback — looping the received signal
• TestCode — receiving a test pattern
• LowSignal — low signal
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show dsx3 history

The show dsx3 history command displays line, Pbit, Cbit, and Plcp statistics for the 
DSX3 circuits in the configuration over specific intervals.

The output includes the following information:

Slot/<Module>/Conn The slot, module, and connector number of the DSX3 circuit.

Circuit Name of the circuit associated with this line.

Sec into Interval Number of seconds into the current interval.

# of Intervals Number of complete intervals.

Line Coding The line coding on this circuit. The line coding options are:
• B3ZS 
• HDB3

Line Type Status The line status of the interface. The possible status values are:
• NoAlarm — no alarm present
• RRAI — receiving yellow remote alarm indication
• TRAI — transmitting yellow remote alarm indication
• RAIS — receiving Alarm Indications Signal (AIS) failure state
• TAIS — transmitting AIS failure state
• LOF — receiving Loss of Frame (LOF) failure state
• LOS — receiving Loss of Signal (LOS) failure state
• Loopback — looping the received signal
• TestCode — receiving a test pattern
• LowSignal — low signal

Line Stats

Circuit Name of the circuit associated with this line.

Interval A historical breakdown of intervals, including:
• The current interval (incomplete)
• All but the last two intervals (that is, all intervals except the 

current interval and the previous interval)
• The previous interval (that is, the last complete interval)
• All of the intervals (total)

LESs Number of line errored seconds (LESs) for each interval category.

SEFSs Number of severely errored framing seconds (SEFSs) for each 
interval category.

UASs Number of unavailable seconds (UASs) for each interval category.

LCVs Number of line coding violations (LCVs) for each interval category.
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Pbit Status

Circuit Name of the circuit associated with this line.

Interval A historical breakdown of intervals, including:
• The current interval (incomplete)
• All but the last two intervals (that is, all intervals except the 

current interval and the previous interval)
• The previous interval (that is, the last complete interval)
• All of the intervals (total)

PESs Number of P-bit errored seconds (PESs) for each interval category.

PSESs Number of P-bit severely errored seconds (PSESs) for each interval 
category.

UASs Number of unavailable seconds (UASs) for each interval category.

PCVs Number of P-bit coding violations (PCVs) for each interval category.

Cbit Stats

Circuit Name of the circuit associated with this line.

Interval A historical breakdown of intervals, including:
• The current interval (incomplete)
• All but the last two intervals (that is, all intervals except the 

current interval and the previous interval)
• The previous interval (that is, the last complete interval)
• All of the intervals (total)

CESs Number of C-bit errored seconds (CESs) for each interval category.

CSESs Number of C-bit severely errored seconds (CSESs) for each interval 
category.

UASs Number of unavailable seconds (UASs) for each interval category.

CCVs Number of C-bit coding violations (CCVs) for each interval category.
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FarEnd Cbit Stats

Circuit Name of the circuit associated with this line.

Interval A historical breakdown of intervals, including:
• The current interval (incomplete)
• All but the last two intervals (that is, all intervals except the 

current interval and the previous interval)
• The previous interval (that is, the last complete interval)
• All of the intervals (total)

CESs Number of C-bit errored seconds (CESs) for each interval category.

CSESs Number of C-bit severely errored seconds (CSESs) for each interval 
category.

UASs Number of unavailable seconds (UASs) for each interval category.

CCVs Number of C-bit coding violations (CCVs) for each interval category.

DS3 Plcp Stats

Circuit Name of the circuit associated with this line.

Interval A historical breakdown of intervals, including:
• The current interval (incomplete)
• All but the last two intervals (that is, all intervals except the 

current interval and the previous interval)
• The previous interval (that is, the last complete interval)
• All of the intervals (total)

SEFSs Number of severely errored framing seconds (SEFSs) for each 
interval category.

UASs Number of unavailable seconds (UASs) for each interval category.

Status Indicates the line status of the interface. The possible status values 
are:
• NoAlarm — no alarm present
• RRAI — receiving yellow remote alarm indication
• TRAI — transmitting yellow remote alarm indication
• RAIS — receiving Alarm Indications Signal (AIS) failure state
• TAIS — transmitting AIS failure state
• LOF — receiving Loss of Frame (LOF) failure state
• LOS — receiving Loss of Signal (LOS) failure state
• Loopback — looping the received signal
• TestCode — receiving a test pattern
• LowSignal — low signal
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show lane clients

The show lane clients command displays the ATM LAN emulation client running config 
info table. This command allows for the following command filter (flag) and filter 
argument:

The output includes the following information:

-service <servicename> Displays information about the specified service record only.

Slot Slot number on which the LAN emulation client resides.

Conn Physical port number on which the LAN emulation client resides.

Service Name of the service record containing the client.

LecID LEC ID that the LE server (LES) assigns during the join state.

State State for the LEC: INITIAL, LECSCONNECT, CONFIGURE, JOIN, 
INITIAL_REG, BUSCONNECT, or OPERATIONAL.

Fail Code Status code from the last failed configure or join response.

Cfg Src Indicates whether this LEC used the LAN emulation configuration 
server (LECS) and if so, what method is used to establish the 
configuration direct VCC: VIAILMI, KNOWNADR, CFGPVC, or NO 
LECS.

LAN type Data frame format this client is now using: Unspecified, IEEE 802.3, 
or IEEE 802.5.

Max Data Frm Size Maximum data frame size this client is now using: Unspecified, 
1516, 4544, 9234, or 18190.

ELAN Name The name of the emulated LAN (ELAN) that this client last joined.

Proxy Indicates whether the LEC acts as a proxy when it joins an ATM 
emulated LAN: 1 (true) or 2 (false).

Primary addr ATM address of the LEC.

Cfg Server addr ATM address of the LAN emulation configuration server.

LE Server addr ATM address of the LAN emulation server.
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show lane configuration

The show lane configuration command displays portions of the ATM LAN emulation 
client table. This command allows for the following command filter (flag) and filter 
argument:

The output includes the following information:

show lane data-vcs

The show lane data-vcs command displays portions of the ATM LAN emulation client 
table. This command allows for the following command filter (flag) and filter argument:

The output includes the following information:

-service <servicename> Displays information about the specified service record only.

Slot Slot number on which the LAN emulation client resides.

Conn Physical port number on which the LAN emulation client resides.

Service Name of the service record containing the client.

LAN Name Emulated LAN name this client will use the next time it returns to the 
initial state.

LAN Type Data frame format that this client will use the next time it returns to 
the initial state: Unspecified, IEEE 802.3, or IEEE 802.5.

State State of the LEC: INITIAL, LECSCONNECT, CONFIGURE, JOIN, 
INITIAL_REG, BUSCONNECT, or OPERATIONAL.

Mode The configuration mode of the LAN emulation client: AUTO or 
MANUAL.

LECS ATM addr Configured ATM address of the LAN emulation configuration server.

-service <servicename> Displays information about the specified service record only.

Slot Slot number on which the LAN emulation client resides.

Conn Physical port number on which the LAN emulation client resides.

Service Name of the service record containing the client.

Data Direct The VPI/VCI pair that identifies the data direct VCCs (if they exist) at 
the point where they connect to this LEC.
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show lane le-arp

The show lane le-arp command displays the ATM LAN emulation client MAC-to-ATM 
cache table. This command allows for the following command filter (flag) and filter 
argument:

The output includes the following information:

-service <servicename> Displays information about the specified service record only.

Slot Slot number on which the LAN emulation client resides.

Conn Physical port number on which the LAN emulation client resides.

Service Name of the service record containing the client.

IsRemote Indicates whether the MAC address belongs to a remote client.

EntryType Indicates how this table entry was created: LEARNED, LEARNED 
CTRL, LEARNED DATA, STATIC VOL, STATIC NONVOL, or 
OTHER.

For the router, the LEC always learns this entry using the control 
VCC; the entry type is never STATIC.

Status Row status: ENABLE or DISABLE. For the router, the status is 
always ENABLE.

VPI Virtual path identifier (VPI) associated with this MAC address.

VCI Virtual channel identifier (VCI) associated with this MAC address.

MAC Address Remote MAC address.

ATM Address ATM address representing the MAC address.
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show lane le-rd-arp

The show lane le-rd-arp command displays the ATM LAN emulation client RD-to-ATM 
ARP cache table. This command allows for the following command filter (flag) and filter 
argument:

The output includes the following information:

-service <servicename> Displays information about the specified service record only.

Slot Slot number on which the LAN emulation client resides.

Conn Physical port number on which the LAN emulation client resides.

Service Name of the service record containing the client.

EntryType Indicates how this table entry was created: LEARNED, LEARNED 
CTRL, LEARNED DATA, STATIC VOL, STATIC NONVOL, or 
OTHER.

For the router, the LEC always learns this entry using the control 
VCC; the entry type is never STATIC.

Status Row status: ENABLE or DISABLE. For the router, the status is 
always ENABLE.

VPI The virtual path identifier (VPI) for the LEC.

VCI The virtual channel identifier (VCI) for the LEC.

SEG ID The segment ID on which the LEC resides.

Br# The bridge number on which the LEC resides.

ATM Address The ATM address associated with the LEC.
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show lane les

The show lane les command displays the ATM LAN emulation servers in the order they 
were configured.

The output includes the following information:

show lane mac

The show lane macs command displays the ATM LAN emulation client MAC address 
table. This command allows for the following command filter (flag) and filter argument:

The output includes the following information:

Slot/Module/Connector The slot location of the ATM module within the chassis, the module 
number (System 5000 platforms only), and the connector number.

Service Name of the service record containing the client.

LES Name Name you assigned to the LAN emulation server entry.

State State of the LES entry: enabled or disabled.

LES Address The LAN emulation server ATM address.

-service <servicename> Displays information about the specified service record only.

Slot Slot number on which the LAN emulation client resides.

Conn Physical port number on which the LAN emulation client resides.

Service Name of the service record containing the client.

MAC Address The local MAC address on this ATM interface that the LEC uses.

ATM address registered for 
MAC address

The ATM address configured for the service record that this LEC 
uses.
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show lane servers

The show lane servers command displays the ATM LAN emulation client server VCC 
table. This command allows for the following command filter (flag) and filter argument:

The output includes the following information:

-service <servicename> Displays information about the specified service record only.

Slot Slot number on which the LAN emulation client resides.

Conn Physical port number on which the LAN emulation client resides.

Service Name of the service record containing the client.

Config Direct VPI The virtual path identifier (VPI) that identifies the configuration direct 
VCC (if it exists) at the point where it connects to this LEC.

Config Direct VCI The virtual channel identifier (VCI) that identifies the configuration 
direct VCC (if it exists) at the point where it connects to this LEC.

Control Direct VPI The VPI that identifies the control direct VCC (if it exists) at the point 
where it connects to this LEC.

Control Direct VCI The VCI that identifies the control direct VCC (if it exists) at the point 
where it connects to this LEC.

Control Distributed VPI The VPI that identifies the control distributed VCC (if it exists) at the 
point where it connects to this LEC.

Control Distributed VCI The VCI that identifies the control distributed VCC (if it exists) at the 
point where it connects to this LEC.

Multicast Send VPI The VPI that identifies the multicast send VCC (if it exists) at the 
point where it connects to this LEC.

Multicast Send VCI The VCI that identifies the multicast send VCC (if it exists) at the 
point where it connects to this LEC.

Multicast Forward VPI The VPI that identifies the multicast forward VCC (if it exists) at the 
point where it connects to this LEC.

Multicast Forward VCI The VCI that identifies the multicast forward VCC (if it exists) at the 
point where it connects to this LEC.
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show lane stats

The show lane stats command displays the ATM LAN emulation statistics table. This 
command allows for the following command filter (flag) and filter argument:

The output includes the following information:

-service <servicename> Displays statistical information about the specified service record 
only.

Slot Slot number on which the LAN emulation client resides.

Conn Physical port number on which the LAN emulation client resides.

Service Name of the service record containing the client.

Req Out Number of MAC-to-ATM ARP requests this LEC sent over the 
logical user-to-network interface (LUNI) associated with this 
emulated packet interface.

Req In Number of MAC-to-ATM ARP requests this LEC received over the 
LUNI associated with this emulated packet interface.

ReplyOut Number of MAC-to-ATM ARP replies this LEC sent over the LUNI 
associated with this emulated packet interface.

ReplyIn Number of MAC-to-ATM ARP replies this LEC received over the 
LUNI associated with this emulated packet interface.

FrameOut Total number of control packets this LEC sent over the LUNI 
associated with this emulated packet interface.

FrameIn Total number of control packets this LEC received over the LUNI 
associated with this emulated packet interface.

SVCFails Number of SVCs this LEC unsuccessfully tried to open.
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show sonet circuits

The show sonet circuits command displays portions of the SONET entries table. 

The output includes the following information:

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit The name of the circuit associated with this line.

Sec into Interval Number of seconds into the current 15-minute interval.

# of Intervals Number of complete 15-minute intervals. The value is 96 unless the 
interface was brought online within the last 24 hours. In that case, 
the value is the number of complete 15-minute intervals since the 
interface has been online.

Line Coding The line coding on this circuit. The line coding options are:
• B3ZS 
• HDB3
The line coding specifies patterns of normal bits and bipolar 
violations used to replace sequences of zero bits of a certain length.

Line Type Status The line status of the interface. The possible status values are:
• NoAlarm — no alarm present
• RRAI — receiving yellow remote alarm indication
• TRAI — transmitting yellow remote alarm indication
• RAIS — receiving Alarm Indications Signal (AIS) failure state
• TAIS — transmitting AIS failure state
• LOF — receiving Loss of Frame (LOF) failure state
• LOS — receiving Loss of Signal (LOS) failure state
• Loopback — looping the received signal
• TestCode — receiving a test pattern
• LowSignal — low signal
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show sonet current

The show sonet current command displays portions of the SONET entries table. 

The output includes the following information:

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Sec into Interval Number of seconds into the current 15-minute interval.

# of Intervals Number of complete 15-minute intervals.

Line Coding The line coding on this circuit. The line coding options are:
• B3ZS 
• HDB3

Line Type Status The line status of the interface. The possible status values are:
• NoAlarm — no alarm present
• RRAI — receiving yellow remote alarm indication
• TRAI — transmitting yellow remote alarm indication
• RAIS — receiving Alarm Indications Signal (AIS) failure state
• TAIS — transmitting AIS failure state
• LOF — receiving Loss of Frame (LOF) failure state
• LOS — receiving Loss of Signal (LOS) failure state
• Loopback — looping the received signal
• TestCode — receiving a test pattern
• LowSignal — low signal

Line Stats

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Interval The current interval.

LESs Number of line errored seconds (LESs) in the current interval. An 
LES is a second in which one or more coding violations occurred or 
one or more LOS defects were detected.

SEFSs Number of severely errored framing seconds (SEFSs) in the current 
interval. An SEFS is a second with one or more OOF errors or an 
AIS defect.

UASs Number of unavailable seconds (UASs) in the current interval.

LCVs Number of line coding violations (LCVs) in the current interval. A 
line coding violation is a count of both bipolar violations (BPVs) and 
excessive zero (EXZ) error events.
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Pbit Status

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Interval The current interval.

PESs Number of P-bit errored seconds (PESs) in the current interval. A 
PES is a second with one or more P-bit coding violations, one or 
more OOF defects, or a detected incoming AIS. The PES does not 
increment when counting UASs.

PSESs Number of P-bit severely errored seconds (PSESs) in the current 
interval. A PSES is a second with 44 or more PCVs, one or more 
OOF defects, or a detected incoming AIS. The PSES value does not 
increment when counting UASs.

UASs Number of unavailable seconds (UASs) in the current interval.

PCVs Number of P-bit coding violations (PCVs) in the current interval. For 
all SONET applications, a coding violation error event is a P-bit 
Parity Error event. A P-bit Parity Error event occurs when the 
SONET M-frame receives a P-bit code that is not identical to the 
corresponding locally calculated code.

Cbit Stats

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Interval The current interval.

CESs Number of C-bit errored seconds (CESs) in the current interval. A 
CES is a second with one or more CCVs, one or more OOF defects, 
or a detected incoming AIS. This count is only for the C-bit Parity 
SONET applications. The CES value does not increment when 
counting UASs.

CSESs Number of C-bit severely errored seconds (CSESs) in the current 
interval. A CSES is a second with 44 or more CCVs, one or more 
OOF defects, or a detected incoming AIS. This count applies only to 
C-bit Parity SONET applications. The CSES value does not 
increment when counting UASs.

UASs Number of unavailable seconds (UASs) in the current interval.

CCVs Number of C-bit coding violations (CCVs) in the current interval. For 
C-bit Parity and SONET applications, this is the count of coding 
violations reported via the C-bits. For C-bit Parity, it is a count of 
CP-bit parity errors occurring in the accumulation interval.
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FarEnd Cbit Stats

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Interval The current interval.

CESs Number of C-bit errored seconds (CESs) in the current interval. A 
CES is a second with one or more CCVs, one or more OOF defects, 
or a detected incoming AIS. This count is only for C-bit Parity DS3 
applications. The CES value does not increment when counting 
UASs.

CSESs Number of C-bit severely errored seconds (CSESs) in the current 
interval. A CSES is a second with 44 or more CCVs, one or more 
OOF defects, or a detected incoming AIS. This count applies only to 
C-bit Parity DS3 applications. The CSES value does not increment 
when counting UASs.

UASs Number of unavailable seconds (UASs) in the current interval.

CCVs Number of C-bit coding violations (CCVs) in the current interval. For 
C-bit Parity SONET applications, this is the count of coding 
violations reported via the C-bits. For C-bit Parity, it is a count of 
CP-bit parity errors occurring in the accumulation interval.

DS3 Plcp Stats

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Interval The current interval.

SEFSs Number of severely errored framing seconds (SEFSs) in the current 
interval. An SEFS is a second with one or more OOF errors or an 
AIS defect.
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show sonet history

The show sonet history command displays portions of the SONET entries table. 

The output includes the following information:

UASs Number of unavailable seconds (UASs) in the current interval.

Status Indicates the line status of the interface. The possible status values 
are:
• NoAlarm — no alarm present
• RRAI — receiving yellow remote alarm indication
• TRAI — transmitting yellow remote alarm indication
• RAIS — receiving Alarm Indications Signal (AIS) failure state
• TAIS — transmitting AIS failure state
• LOF — receiving Loss of Frame (LOF) failure state
• LOS — receiving Loss of Signal (LOS) failure state
• Loopback — looping the received signal
• TestCode — receiving a test pattern
• LowSignal — low signal

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Sec into Interval Number of seconds into the current interval.

# of Intervals Number of complete intervals.

Line Coding The line coding on this circuit. The line coding options are:
• B3ZS 
• HDB3

Line Type Status The line status of the interface. The possible status values are:
• NoAlarm — no alarm present
• RRAI — receiving yellow remote alarm indication
• TRAI — transmitting yellow remote alarm indication
• RAIS — receiving Alarm Indications Signal (AIS) failure state
• TAIS — transmitting AIS failure state
• LOF — receiving Loss of Frame (LOF) failure state
• LOS — receiving Loss of Signal (LOS) failure state
• Loopback — looping the received signal
• TestCode — receiving a test pattern
• LowSignal — low signal
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Line Stats

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Interval A historical breakdown of intervals, including:
• The current interval (incomplete)
• All but the last two intervals (that is, all intervals except the 

current interval and the previous interval)
• The previous interval (that is, the last complete interval)
• All of the intervals (total)

LESs Number of line errored seconds (LESs) for each interval category.

SEFSs Number of severely errored framing seconds (SEFSs) for each 
interval category.

UASs Number of unavailable seconds (UASs) for each interval category.

LCVs Number of line coding violations (LCVs) for each interval category.

Pbit Status

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Interval A historical breakdown of intervals, including:
• The current interval (incomplete)
• All but the last two intervals (that is, all intervals except the 

current interval and the previous interval)
• The previous interval (that is, the last complete interval)
• All of the intervals (total)

PESs Number of P-bit errored seconds (PESs) for each interval category.

PSESs Number of P-bit severely errored seconds (PSESs) for each interval 
category.

UASs Number of unavailable seconds (UASs) for each interval category.

PCVs Number of P-bit coding violations (PCVs) for each interval category.

Cbit Stats

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.
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Interval A historical breakdown of intervals, including:
• The current interval (incomplete)
• All but the last two intervals (that is, all intervals except the 

current interval and the previous interval)
• The previous interval (that is, the last complete interval)
• All of the intervals (total)

CESs Number of C-bit errored seconds (CESs) for each interval category.

CSESs Number of C-bit severely errored seconds (CSESs) for each interval 
category.

UASs Number of unavailable seconds (UASs) for each interval category.

CCVs Number of C-bit coding violations (CCVs) for each interval category.

FarEnd Cbit Stats

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Interval A historical breakdown of intervals, including:
• The current interval (incomplete)
• All but the last two intervals (that is, all intervals except the 

current interval and the previous interval)
• The previous interval (that is, the last complete interval)
• All of the intervals (total)

CESs Number of C-bit errored seconds (CESs) for each interval category.

CSESs Number of C-bit severely errored seconds (CSESs) for each interval 
category.

UASs Number of unavailable seconds (UASs) for each interval category.

CCVs Number of C-bit coding violations (CCVs) for each interval category.

SONET Plcp Stats

Slot/<Module>/Conn The slot, module, and connector number of the SONET circuit.

Circuit Name of the circuit associated with this line.

Interval A historical breakdown of intervals, including:
• The current interval (incomplete)
• All but the last two intervals (that is, all intervals except the 

current interval and the previous interval)
• The previous interval (that is, the last complete interval)
• All of the intervals (total)
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SEFSs Number of severely errored framing seconds (SEFSs) for each 
interval category.

UASs Number of unavailable seconds (UASs) for each interval category.

Status Indicates the line status of the interface. The possible status values 
are:
• NoAlarm — no alarm present
• RRAI — receiving yellow remote alarm indication
• TRAI — transmitting yellow remote alarm indication
• RAIS — receiving Alarm Indications Signal (AIS) failure state
• TAIS — transmitting AIS failure state
• LOF — receiving Loss of Frame (LOF) failure state
• LOS — receiving Loss of Signal (LOS) failure state
• Loopback — looping the received signal
• TestCode — receiving a test pattern
• LowSignal — low signal
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Index
A

AAL CPCS Receive SDU Size
parameter description

control VCs, A-76
PVCs, A-27

setting
control VCs, 4-58
PVCs, 5-16

AAL CPCS Transmit SDU Size
parameter description

control VCs, A-76
PVCs, A-26

setting
control VCs, 4-55
PVCs, 5-14

AAL type
parameter description, A-28
setting, 6-17

AAL, described, 1-9

ABR, 6-8

accessing
ATM networks

PVCs, 1-17 to 1-20
SVCs, 1-22

ATM windows, A-2

acronyms, xxiv

Add Party Sent timer. See T399

adding
ATM circuit, 2-9, 2-10
ATM to the router, 2-18
protocols

to existing service record, 2-16
to new service record, 2-15

PVCs, 2-18
service records

classical IP, 2-12
LANE, 2-13
308612-14.20 Rev 00
PVC, 2-11
WAN SVC, 2-13

address resolution, ATM, 1-31

addresses
assigning, 1-22
autogenerating, 3-20, 7-3, 8-3
parts of, 1-22

Adjacent Host ATM Address
parameter description, A-32

adjacent host parameters, descriptions of, A-87

adjacent hosts, defined, 1-33

Administrative State
assigning to

interfaces, 3-18
PVCs, 5-8

parameter description, A-11, A-23

Aging Time
parameter description, A-43
setting, 8-37

alarm notification, OAM
enabling or disabling, 5-21

ARP Server ATM Address Network Prefix parameter, 
2-12, 7-10, A-85

ARP Server ATM Address User Part parameter, 2-12, 
7-10, A-86

ARP support, 1-27

arp-mode command, 7-9

ATM
address resolution, 1-31
addresses

assigning, 1-22
autogenerating, 3-20, 7-3, 8-3
parts of, 1-22
Index-1



ATM (continued)
cell

described, 1-2
switching, 1-4
technology, 1-2

circuit, adding, 2-9, 2-10
concepts, 1-2 to 1-6
data transmission, 1-4
deleting from router, 2-26
interface, customizing, 3-1
layers

AAL 5, 1-9
ATM Adaptation Layer (AAL), 1-7
in protocol reference model, 1-6 to 1-9

router redundancy
customizing, 11-1
described, 1-39
parameter, description of, A-81
starting, 2-1, 2-20

signaling support, 4-2
starting

configuration tools, 2-1
router redundancy, 2-20
with BCC, 2-2
with Site Manager, 2-9

traffic parameters, modifying
control VCs, 4-45
PVCs, 5-10
WAN SVCs, 9-6

windows, accessing, A-2

ATM Addr Net Prefix
entering a value for, 1-23
parameter description, A-17
service record

classical IP, 7-5
LEC/LANE, 8-5

ATM Addr User Part
entering a value for, 1-23
parameter description, A-16
service record

classical IP, 7-7
LEC/LANE, 8-6

ATM ARP Mode parameter, 2-12, 7-10, A-85

ATM layer, described, 1-8

ATM Monitoring Timer
parameter description, A-81
setting, 11-2

ATMARP
configuring, 1-32
configuring on IP interface in a LIS, 7-8
defined, 1-31
parameters, descriptions of, A-85

atmarp-server-address command, 7-9

atmarp-server-aging command, 7-9

atmarp-server-interval command, 7-9

available bit rate (ABR) service category, 6-8

B

BCC
adding IP with, 2-7
adding IPX with, 2-8
protocols supported, 2-7
show commands, B-1
starting ATM with, 2-2

Broadband Integrated Services Digital Network 
(B-ISDN), 1-2

broadcast and unknown server (BUS), described, 1-35

Burst Size, setting
control VCs, 4-51
PVCs, 6-5

BUS connect state, LAN emulation, 1-38

C

Call Proceeding Received timer. See T310

calls, pacing, 4-28

CBR (constant bit rate)
described, 6-7
PCR and SCR requirements for CES, 10-2
used with CES, 1-38

cell loss priority
setting, 6-3, A-28

cell loss priority (CLP), turning on and off, 6-3

cells
converting to, 1-27
header, 1-3
information field, 1-4

CES traffic
enabling, 10-4
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classical IP
concepts, 1-28 to 1-31
defining service records for, 2-5

Clear function, router redundancy, 2-20

Clocking Signal Source
defining, 3-11
parameter description, A-8

CLP
turning on and off, 6-3

commands, show, B-1

configuration files, router redundancy
creating group, 2-21
creating member, 2-23
downloading, 2-25

Configuration Manager Protocols menu, using, A-4

Configuration Mode
LEC, selecting, 8-8
parameter description, A-38

configure state, LAN emulation, 1-37

congestion indication
parameter description, A-28
setting, 6-2

Connect Sent Timer. See T313

Connection Control Timer
parameter description, A-79
setting, 4-67

connections
memory, 4-14
setting thresholds, 4-9

constant bit rate (CBR)
described, 6-7
PCR and SCR requirements for CES, 10-2
used with CES, 1-38

Control Timeout
parameter description, A-40
setting, 8-32

control VCs
customizing

ILMI, 4-58
signaling, 4-58

defining, 4-39
parameters

descriptions of, A-73
Maximum AAL CPCS Receive SDU Size, A-76

Maximum AAL CPCS Transmit SDU Size, A-76
Xmit Sustainable Cell Rate, A-74

traffic parameters, 4-45

conventions, text, xxii

convergence sublayer (CS), described, 1-9

counters, modifying ILMI, 4-31 to 4-38

customer support, xxviii

customizing
control VCs

ILMI, 4-58
signaling, 4-58

ILMI, 4-29 to 4-38
LE clients, 8-48
PVCs, 5-1
SAAL, 4-61 to 4-70
SSCOP, 4-61 to 4-71

customizing WAN SVCs, 9-1, 10-1

D

data encapsulation
assigning, PVCs, 5-17
assigning, WAN SVCs, 9-13
methods of, 1-13
rules for PVCs, 1-16
selecting, 1-15

Data Encapsulation Type
assigning

PVCs, 5-17
WAN SVCs, 9-13

parameter description
PVCs, A-27
service record, A-15

data frame size, setting, 8-26

Data Link Connection timer. See T309

Data Link Disconnect timer. See TDisc

Data Path Enable, parameter description, A-6

Data Path Notify Timeout
parameter description, A-6
specifying, 3-5

data path notify, enabling/disabling, 3-5

data transmission, described, 1-4

deleting protocols from a service record, 2-17
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down threshold, OAM, setting, 5-20

Drop Party Sent Timer. See T398

drop preference and CLP, 6-3

DS3 Line Build Out
parameter description, A-9
specifying, 3-12, 3-13

DS3 Scrambling
turning on/off, 3-14

E

Edit ATM Connector window, using, A-3

Emulated LAN Name
entering, 8-10
parameter description, A-18, A-40

Emulated LAN Segment ID
parameter description, A-45
specifying, 8-14

Emulated LAN Type
defining, 8-12
parameter description, A-19, A-38

Enable ATM Signaling parameter, A-11

Enable parameter
adjacent host, A-87
ILMI

description, A-69
using, 4-29

LANE
description, A-37
using, 8-15

LES/BUS address, description, A-47
line

description, A-5
using, 3-2

SAAL
description, A-77
using, 4-62

signaling
description, A-49
using, 4-3

SSCOP, using, 4-62

Enable/Disable (service record)
parameter description, A-14, A-32
using, 5-2, 7-2, 8-2, 9-2

encapsulation, multiprotocol, 1-13

error checking, 1-27

Expected LE_ARP Response Time
parameter description, A-43
specifying, 8-40

F

Flush Protocol
defined, 8-44
enabling/disabling, 8-44
parameter description, A-45

Flush Timeout
parameter description, A-44
setting, 8-46

Forward Delay Time
parameter description, A-43
setting, 8-39

Framing Mode
assigning, 3-9
parameter description, A-8

G

Get Next Retry Count. See ILMI Get Next Retry Count

Get Next Timer. See ILMI Get Next Timer

Get Retry Count. See ILMI Get Retry Count

Get Timer. See ILMI Get Timer

group configuration files, router redundancy, creating, 
2-21

H

Hardware MAC Address
enabling/disabling, 3-20
parameter description, A-12

Host Encapsulation parameter, A-88

hybrid access (PVCs)
described, 1-19 to 1-21
designating, 5-7

Hybrid/Bridged VC parameter, A-23
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ILMI
control VCs, customizing, 4-58
customizing, 4-29 to 4-38
enabling/disabling, 4-29
parameters, descriptions of, A-69
support, 4-29

ILMI Get Next Retry Count
parameter description, A-71
setting, 4-35

ILMI Get Next Timer
parameter description, A-71
setting, 4-34

ILMI Get Retry Count
parameter description, A-71
setting, 4-33

ILMI Get Timer
parameter description, A-70
setting, 4-31

ILMI Set Retry Count
parameter description, A-72
setting, 4-38

ILMI Set Timer
parameter description, A-72
setting, 4-37

ILMI VCI
changing, 4-42
parameter description, A-70

ILMI VPI
changing, 4-40
parameter description, A-69

initial cell rate
parameter description, A-30
setting, 6-11

Initial Registration State, LAN emulation, 1-38

initial state, LAN emulation, 1-37

Interface MTU
defining, 3-3
parameter description, A-5
See also MTU

interface parameters, descriptions of, A-11 to A-13

interface, enabling/disabling, 3-18

Interim Local Management Interface. See ILMI

Inverse ARP support, 1-27

IP adjacent host
Enable parameter, A-87
Host Encapsulation parameter, A-88
IP Adjacent Host Address parameter, A-87
MAC Address parameter, A-88
Next Hop Interface Addr parameter, A-87

IP Adjacent Host Address parameter, A-87

ISDN protocol model, 1-6

J

join state, LAN emulation, 1-37

K

Keep Alive Timer
modifying, 4-65
parameter description, A-78

L

LAN emulation
broadcast and unknown server (BUS), described, 

1-35
BUS connect state, 1-38
client. See LEC
components, 1-34
concepts, 1-33 to 1-38
Configuration Server (LECS), described, 1-34
customizing, 8-48
enabling protocols for, 1-12
parameters, descriptions of, A-37 to A-46
retry counters, modifying, 8-32 to 8-42
server (LES), described, 1-34
states, 1-36 to 1-38
timers, modifying, 8-32 to 8-42

LAN emulation configuration server, described, 1-34

LAN emulation server. See LES

LAN Emulation Version 2
enabling/disabling, 8-49
parameter description, A-46

LANE encapsulation, defined, 1-13
See also data encapsulation

LE client. See LEC
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LE Config Server ATM Address
parameter description, A-46
specifying for LEC, 8-48

LE Server ATM Address Network Prefix parameter, 
A-47

LE Server ATM Address User Part parameter, A-48

LE Server ATM Address, entering, 8-17

LE Server Name parameter, A-48

LE server name, changing, 8-21

LEC
described, 1-34
enabling/disabling, 8-15
LE Server ATM Address, assigning, 8-17
owner, specifying, 8-16
service records, defining, 2-5

LECS address
described, 1-34
specifying for LEC service, 8-48

LECS connect state, LAN emulation, 1-37

LES
assigning, 8-17
deleting, 8-24
described, 1-34
enabling/disabling, 8-19
inserting out of sequence, 8-22
modifying, 8-23
parameters, descriptions of, A-47
redundant, 1-35

line parameters, descriptions of, A-5 to A-10

Link Connection Arbitration
defining, 4-63
parameter description, A-77

LLC/SNAP encapsulation, defined, 1-14
See also data encapsulation

loopback, OAM
enabling and disabling, 5-19
loopback interval, changing, 5-20
thresholds, setting, 5-20

M

MAC address
enabling/disabling, 3-20
override value, entering, 3-21

MAC Address Override parameter, A-13

MAC Address parameter, A-88

Max Connection Control
parameter description, A-80
setting, 4-67

Max Number of SVC Applications
parameter description, A-50
specifying, 4-7

Max Parties in Multipoint Connections
parameter description, A-52
setting, 4-13

Max PD Before Poll
parameter description, A-80
setting, 4-69

Max Point to Multipoint Connections
parameter description, A-51
setting, 4-11

Max Point to Point Connections
defining, 4-9
parameter description, A-51

Max Retry Count
parameter description, A-42
setting, 8-36

Max STAT PDU Elements
parameter description, A-81
setting, 4-70

Max Unknown Frame Count
parameter description, A-41
setting, 8-28

Max Unknown Frame Time
parameter description, A-41
specifying, 8-30

Maximum AAL CPCS Receive SDU Size
parameter description

control VCs, A-76
PVCs, A-27

setting
control VCs, 4-58
PVCs, 5-16

Maximum AAL CPCS Transmit SDU Size
parameter description

control VCs, A-76
PVCs, A-26
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Maximum AAL CPCS Transmit SDU Size (continued)
setting

control VCs, 4-55
PVCs, 5-14

Maximum Burst Size
described, 1-26, 4-51, 6-5
formula for calculating, 4-51, 6-5
parameter description

control VCs, A-75
PVCs, A-26

setting
control VCs, 4-51
PVCs, 6-5

Maximum Data Frame Size
parameter description, A-39
setting, 8-26

maximum transmission unit. See MTU

MBS. See Maximum Burst Size

member configuration files, router redundancy, 
creating, 2-23

menu path, using, A-4

messages, retransmitting, 4-25

Min Memory Threshold parameter, A-52

minimum cell rate
parameter description, A-30
setting, 6-13

minimum memory threshold, setting, 4-14

Monitoring Timer
parameter description, A-81
setting, 11-2

MTU
defining, 3-3, 5-3, 9-3
parameter description, A-19

multicast packet support, purpose, 1-27

multiprotocol encapsulation support, 1-13

N

Next Hop Interface Addr parameter, A-87

NLPID
See also data encapsulation

NLPID, defined, 1-14

No Response Timer
modifying, 4-66
parameter description, A-79

non-real-time variable bit rate (VBNRT) service 
category, 6-8

NULL encapsulation
defined, 1-14
See also data encapsulation

Num Messages/Sec for Call Pacing parameter, A-68

Num Restarts ReXmitted
parameter description, A-67
setting, 4-25

Num Stat Enquiries ReXmitted
parameter description, A-68
setting, 4-26

O

OAM (Operations and Management)
alarm notification, enabling and disabling, 5-21
loopback interval, changing, 5-20
loopback, enabling and disabling, 5-19
thresholds, setting, 5-20

OAM Alarm Enable parameter, A-84

OAM Loopback Cell Interval parameter, A-82

OAM Loopback Enable parameter, A-82

OAM parameters
changing, 5-19
descriptions of, A-82

OAM Threshold 1 parameter, A-83

OAM Threshold 2 parameter, A-83

operational state, LAN emulation, 1-38

Operations and Management parameters, descriptions 
of, A-82

Owner
parameter description, A-37
specifying, 8-16

P

pacing calls, 4-28

parameter descriptions, Site Manager, A-1
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partial fill
parameter description, A-21
setting, 10-3

parties, defining, 4-9

Path Switching Delay
parameter description, A-44
setting, 8-42

PCR. See Peak Cell Rate

PDU values, defining, 4-67

Peak Cell Rate
described, 1-24, 4-45, 5-10, 9-9
See also Xmit Peak Cell Rate
setting

control VCs, 4-45
PVCs, 5-10
WAN SVCs, 9-9

Per-VC Clipping
enabling/disabling, 3-16
parameter description, A-10

physical layer, described, 1-7

Poll Timer
modifying, 4-65
parameter description, A-78

primary configuration files, router redundancy, 
creating, 2-23

prioritizing traffic, 1-6

priority queueing, 1-6

product support, xxviii

protocol prioritization, 1-6

Protocol Standard
assigning, 4-5
parameter description, A-50

protocols
adding

to existing service record, 2-16
to new service record, 2-15

enabling for
hybrid access (nonbridging), 1-12
LAN emulation, 1-12

removing from service record, 2-17
supported, 1-10

publications, hard copy, xxvii

PVC parameters, descriptions of, A-22 to A-27

PVCs
access methods for, 1-17 to 1-20
adding, 2-6, 2-18
and service records, 1-10
copying, 5-23
customizing, 5-1
defining service records for, 2-4
deleting, 5-24
enabling/disabling, 5-8
encapsulation methods, 1-13 to 1-16
hybrid access, 1-19 to 1-21
multiple per service record, 1-17
one per service record, 1-18
PCR and SCR settings for CES, 10-2

R

rate decrease factor
parameter description, A-31
setting, 6-16

rate increase factor
parameter description, A-31
setting, 6-14

real-time variable bit rate (VBR) service category, 6-8

Recv Peak Cell Rate, parameter description
WAN SVC, A-35

Recv Sustainable Cell Rate, parameter description
WAN SVC, A-36

redundant LESs, 8-17

Registration Refresh Interval parameter, 7-10, A-86

Release Sent timer. See T308

removing protocols from a service record, 2-17

response time, LE_ARP. See Expected LE_ARP 
Response Time

Restart Request Sent on Channel timer. See T316c

Restart Request Sent on Interface timer. See T316

restarts, enabling/disabling, 4-27

retransmissions, defining, 4-25

router redundancy, ATM
customizing, 11-1
described, 1-39
starting, 2-1

router redundancy, requirements, 1-40
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S

SAAL
customizing, 4-61 to 4-70
Data Link Connect timer. See T309
Data Link Disconnect timer. See TDisc
enabling/disabling, 4-62
parameters, A-77 to A-81

SCR. See Sustainable Cell Rate

SDU size, setting
receive

control VCs, 4-58
PVCs, 5-16

transmit
control VCs, 4-55
PVCs, 5-14

secondary configuration files, creating, 2-24

segmentation and reassembly (SAR) sublayer, 1-9

Select Connection Type window, using, A-2

Server (LES), redundant, 1-35

service category
available bit rate, 6-8
CBR, 6-7
non-real-time variable bit rate, 6-8
parameter description, A-29
real-time variable bit rate, 6-8
setting, 6-7
unspecified bit rate, 6-8
unspecified bit rate plus, 6-8

Service Name parameter, A-20

service record parameters, descriptions of, A-14 to 
A-20

service records
adding

classical IP, 2-12
LANE, 2-13
PVC, 2-11
WAN SVC, 2-13

customizing
classical IP, 7-1
LEC/LANE, 8-1
PVC, 5-1
WAN SVC, 9-1, 10-1

data encapsulation types for, 2-10
defined, 1-10

defining
classical IP, 2-5
LEC, 2-5
PVC, 2-4

deleting
classical IP, 7-11
LEC/LANE, 8-50
PVC, 5-6

enabling/disabling
classical IP, 7-2
LEC/LANE, 8-2
PVC, 5-2
WAN SVC, 9-2

Set Retry Count. See ILMI Set Retry Count

Set Timer. See ILMI Set Timer

Setup Sent timer. See T303

show atm interfaces command, B-2

show atm line command, B-3

show atm services command, B-6

show atm signaling command, B-6

show atm stats vcs command, B-7, B-9, B-10

show atm vcs command, B-8

show classical-ip configuration command, B-11

show classical-ip interface command, B-11

show classical-ip stats command, B-12

show classical-ip table command, B-12

show commands, B-1

show dsx3 circuits command, B-13

show dsx3 current command, B-14

show dsx3 history command, B-17

show lane configuration command, B-21

show lane data-vcs command, B-21

show lane le-arp command, B-22

show lane le-rd-arp command, B-23

show lane les command, B-24

show lane macs command, B-24

show lane servers command, B-25

show lane stats command, B-26

show sonet circuits command, B-27

show sonet current command, B-28
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show sonet history command, B-31

signaling
customizing, 4-1
enabling initially, 2-3
enabling/disabling, 3-19, 4-3
parameters, descriptions of, A-49 to A-68
support, 4-2
timer resolution, defining, 4-15
VCI, changing, 4-42
VPI, changing, 4-40

Signaling AAL. See SAAL

Site Manager, starting ATM with, 2-9

SSCOP
connection control, 4-67
customizing, 4-61 to 4-71
enabling/disabling, 4-62
poll data, 4-69
STAT PDU elements, 4-70
support, 4-61

SSCS Type Field parameter, 7-10

starting ATM services, 2-1

Status Enquiry Sent timer. See T322

support, Nortel Networks, xxviii

Sustainable Cell Rate
described, 1-25
setting

control VC, 4-48
PVCs, 5-12
WAN SVCs, 9-11

SVC applications, specifying number of, 4-7

SVC Inactivity Timeout
enabling/disabling, 3-7
parameter description, A-7
specifying, 3-7

SVC Inactivity Timeout Enable parameter, A-7

SVCs
access methods, 1-22
and service records, 1-10
encapsulation methods, 1-13 to 1-16

T

T303
parameter description, A-55, A-56, A-57, A-65

T308
parameter description, A-58
setting, 4-18

T309
parameter description, A-59
setting, 4-18

T310
parameter description, A-59
setting, 4-18

T313
parameter description, A-60
setting, 4-19

T316
parameter description, A-61
setting, 4-19

T316c
parameter description, A-62
setting, 4-20

T322
parameter description, A-63
setting, 4-20

T398
parameter description, A-66
setting, 4-22

T399
parameter description, A-67
setting, 4-22

TDisc
parameter description, A-64
setting, 4-21

technical publications, xxvii

technical support, xxviii

template, group configuration file, creating, 2-20

text conventions, xxii

This, 1-40

thresholds, connection, 4-9

thresholds, OAM, setting for loopback cells, 5-20

timer resolution, defining, 4-15

timers, modifying
ILMI, 4-31 to 4-38
LEC/LANE, 8-32 to 8-42
See also specific timer
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timers, modifying (continued)
signaling, 4-16 to 4-23
SSCOP/SAAL, 4-65

traffic parameters, modifying
control VCs, 4-45
PVCs, 5-10
WAN SVCs, 9-6

traffic priorities, 1-6

transmission path, defined, 1-5

U

UBR, 6-8

UBRPLUS, 6-8

UNI version, assigning, 4-5

unknown frames, controlling, 8-28

unspecified bit rate (UBR) service category, 6-8

unspecified bit rate plus (UBRPLUS) service category, 
6-8

up threshold, OAM, setting, 5-20

User Part Autogeneration
enabling/disabling, 7-3, 8-3
parameter description, A-16

V

VBNRT, 6-8

VBR, 6-8

VBR type
parameter description, A-30
setting, 6-10

VCC Timeout Period Enable
enabling/disabling, 8-34
parameter description, A-42

VCCs, defining maximum number of, 3-23

VCI (signaling)
See also ILMI VCI

VCI Number parameter, A-22

VCI parameter (signaling), A-54

video streaming data support, 1-38

virtual channel identifier (VCI), defined, 1-4

virtual channel, defined, 1-4

virtual circuits. See PVCs or SVCs

Virtual Connection Type parameter, A-15

virtual connections, compared, 1-6

virtual path identifier (VPI), defined, 1-5

virtual path, defined, 1-5

VPCs, defining maximum number of, 3-23

VPI (signaling)
parameter description, A-53
See also ILMI VPI

VPI Number parameter, A-22

VPI/VCI pairs, setting, 2-6
See also VPI Number or VCI Number

W

WAN SVC Routing Mode, parameter description, 
A-20

WAN SVCs
customizing, 9-1, 10-1

window path, using, A-2, A-3

windows, accessing, A-2

X

Xmit Burst Size, parameter description
control VCs, A-75
PVCs, A-26

Xmit Peak Cell Rate, parameter description
control VC, A-73
PVC, A-24
WAN SVC, A-33

Xmit Sustainable Cell Rate, parameter description
control VC, A-74
PVC, A-25
WAN SVC, A-34
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